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2 Tasks


This chapter describes how to perform tasks in the Oracle Service Bus IDE, such as working with projects and resources, business and proxy services, Split-Joins, message flows, and global resources.

This chapter includes the following sections:

	
Section 2.1, "Working with Projects, Folders, Resources, and Configurations"


	
Section 2.2, "Working with Business Services"


	
Section 2.3, "Working with Proxy Services"


	
Section 2.4, "Working with Proxy Service Message Flows"


	
Section 2.5, "Working with Alert Destinations"


	
Section 2.6, "Working with MQ Connections"


	
Section 2.7, "Working with Oracle Enterprise Repository and Harvester."


	
Section 2.8, "Working with UDDI Registries"


	
Section 2.9, "Working with Split-Join"


	
Section 2.10, "Using the Oracle Service Bus Debugger"






2.1 Working with Projects, Folders, Resources, and Configurations

This section tells how to perform the following tasks:

	
Section 2.1.1, "Resource Naming Restrictions"


	
Section 2.1.2, "Editing Resources"


	
Section 2.1.3, "Cloning Oracle Service Bus Projects and Folders"


	
Section 2.1.4, "Creating Oracle Service Bus Configuration Projects"


	
Section 2.1.5, "Creating Oracle Service Bus Projects"


	
Section 2.1.6, "Creating Servers"


	
Section 2.1.7, "Creating Custom Resources"


	
Section 2.1.8, "Creating and Editing JNDI Provider Resources"


	
Section 2.1.9, "Creating Proxy Server Resources"


	
Section 2.1.10, "Creating Message Format Files"


	
Section 2.1.11, "Exporting Resources"


	
Section 2.1.12, "Generating an Effective WSDL"


	
Section 2.1.13, "Modifying JAR Dependencies"


	
Section 2.1.14, "Importing Resources"


	
Section 2.1.15, "Creating Service Account Resources"


	
Section 2.1.16, "Creating Service Key Provider Resources"


	
Section 2.1.17, "Creating SMTP Server Resources"


	
Section 2.1.18, "Creating XQuery Transformations"


	
Section 2.1.19, "Creating XSL Transformations"






2.1.1 Resource Naming Restrictions

When naming any directory or resource in an Oracle Service Bus configuration, the following characters are allowed:

	
All Java identifier characters, including Java keywords, as described in the "Identifiers" and "Keywords" sections of the Java Language Specification at http://docs.oracle.com/javase/specs/jls/se5.0/html/lexical.html


	
Blanks, periods, and hyphens within the names (not leading or trailing)




Characters such as / \ * : " < > ? | are not allowed.






2.1.2 Editing Resources

Edit resources using the built-in editors. For example, to edit a proxy service you click its name in the Project Explorer and the proxy service editor appears.

Do not manually edit resource files as text or XML files. This can result in unpredictable behavior. Do not manually edit these resource types:

	
Alert Destination


	
Business Service


	
Custom Resources


	
Proxy Service


	
Service Account


	
Service Key Provider


	
Split-Join


	
JNDI Provider


	
SMTP Server


	
Proxy Server


	
UDDI Registry









2.1.3 Cloning Oracle Service Bus Projects and Folders

To clone Oracle Service Bus projects and folders:

	
In the Project Explorer, right-click the Oracle Service Bus project or folder you want to clone.


	
From the menu, select Oracle Service Bus > Clone to display the Select Clone Target Dialog.









2.1.4 Creating Oracle Service Bus Configuration Projects

In the Oracle Service Bus perspective, select File > New > Oracle Service Bus Configuration Project to display the New Oracle Service Bus Configuration Project Wizard.

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.

For configuration details, see Section 4.4.3, "Oracle Service Bus Configuration Page."






2.1.5 Creating Oracle Service Bus Projects

In the Oracle Service Bus perspective, select File > New > Oracle Service Bus Project to display the New Oracle Service Bus Project Wizard.

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.




	
Note:

You can create an Oracle Service Bus project in an Oracle Service Bus configuration project only.









For configuration details, see Section 4.4.4, "New Oracle Service Bus Project."






2.1.6 Creating Servers

You can deploy (publish) and test your Oracle Service Bus configuration on a running server in Eclipse. When connected to a running server in development, you can also connect to resources in the runtime environment such as JNDI resources and remote EJBs.

If you have an existing Oracle WebLogic Server you want to connect to, the server creation process simply involves you pointing at the existing server domain. You can also create a new server using the Oracle Fusion Middleware Configuration Wizard.

To Create a Server in Eclipse 

	
In the Oracle Service Bus perspective, select File > New > Server. The New Server wizard appears.


	
Select the server type/version you want to create or connect to.


	
For Server's host name, enter localhost for a local server or enter the name or IP address of the remote computer hosting an existing server.


	
The Server name is for display purposes in Eclipse.


	
Click Next.


	
For WebLogic home, click Browse and select the WL_HOME in the Oracle Fusion Middleware installation where the server domain is to reside (or already resides). For example, if you are creating a new server in MW_HOME_1, select the MW_HOME_1/WL_HOME; or if you are connecting to an existing server domain in MW_HOME_2, select the MW_HOME_2/WL_HOME.




	
Note:

You cannot reference a WL_HOME that is outside of the server's installation MW_HOME, even if the external MW_HOME is the same product version.










	
The Java home should be populated automatically. To use a different JRE, such as the default Oracle JRockit JRE, click Browse and select the JRE under the same MW_HOME as the server.


	
Click Next.


	
Select whether the server is Local or Remote. Remote implies an existing remote server.

	
If Local, either select an existing server in the Domain Directory field or click the link to create a new domain. After creating a new domain, select it in the Domain Directory field.

Set other options as desired, such as automatic publishing and debug mode.

For information on creating a new Oracle Service Bus domain, see "Installing and Configuring Oracle Service Bus 11g" in the Oracle Fusion Middleware Installation Guide for Oracle Service Bus Installation Guide.


	
If Remote, enter the connection settings to an existing remote server.





	
Click Next.


	
Move any Oracle Service Bus configuration(s) you want to publish on the server to the Configured pane.

To modify this targeting after you create the server, right-click the server and select Add and Remove.


	
Click Finish. The new server appears in the Servers view in Eclipse, where you can start, stop, and publish to the server.




For information on running a server in debug mode, for which the Oracle Service Bus plug-ins for Eclipse provide special functionality, see Section 2.10, "Using the Oracle Service Bus Debugger."






2.1.7 Creating Custom Resources

In the Oracle Service Bus perspective, select File > New > Custom Resource to display New Custom Resource Wizard.

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.




	
Note:

You can create a custom resource in an Oracle Service Bus project only.









For configuration details, see Section 4.5, "Custom Resources."






2.1.8 Creating and Editing JNDI Provider Resources

In the Oracle Service Bus perspective, select File > New > JNDI Provider to display the New JNDI Provider Resource Wizard.

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.




	
Note:

You can create a JNDI provider resource in an Oracle Service Bus configuration project only.









To edit JNDI provider resources:

	
In the Project Explorer, find the Oracle Service Bus configuration project containing the JNDI provider resource you want to edit.


	
Double-click the name of the JNDI provider to display the JNDI Provider Editor.




For configuration details, see Section 4.8, "JNDI Providers."






2.1.9 Creating Proxy Server Resources

In the Oracle Service Bus perspective, select File > New > Proxy Server to display the New Proxy Server Resource wizard.

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.




	
Note:

You can create a proxy server resource in an Oracle Service Bus configuration project only.









To edit proxy server resources:

	
In the Project Explorer, find the Oracle Service Bus configuration project containing the proxy server resource you want to edit.


	
Double-click the name of the proxy server to display the Proxy Server Editor.




For configuration details, see Section 4.9, "Proxy Servers."






2.1.10 Creating Message Format Files

In the Oracle Service Bus perspective, select File > New > MFL to display the New Message Format File wizard.

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.




	
Note:

You can create a message format file in an Oracle Service Bus project only.









For configuration details, see Section 4.11.16, "MFL Transform Action Properties."






2.1.11 Exporting Resources

This section describes different ways to export Oracle Service Bus resources from Eclipse.

Since these procedures require an Eclipse installation, you can only perform these procedures on platforms that support the Oracle Service Bus plug-ins for Oracle Enterprise Pack for Eclipse. For unsupported platforms, export using the Oracle Service Bus Administration Console. See "Import/Export" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus at http://www.oracle.com/pls/as111170/lookup?id=OSBAG1311.

This section includes the following topics:

	
Section 2.1.11.1, "Using the Export Wizard"


	
Section 2.1.11.2, "Using the Command Line or a Script to Export an Oracle Service Bus Configuration"







	
Note:

XML files, which are a type of Oracle Service Bus resource, are automatically exported from Eclipse when you use any of the following export procedures. If you do not want to export XML files, exclude them using the Eclipse Resource Filter feature on a project or folder. The Export Wizard also lets you exclude files and resources from export.











2.1.11.1 Using the Export Wizard

In the Oracle Service Bus perspective, select File > Export to display the Export wizard. See the following topics for more information:

	
Section 4.6.1, "Export Wizard - Oracle Service Bus Configuration JAR Export Page"


	
Section 4.6.2, "Export Wizard - Export to Server - Select Resources Page"









2.1.11.2 Using the Command Line or a Script to Export an Oracle Service Bus Configuration

This section describes scripting and command-line options for exporting an Oracle Service Bus configuration:

	
Section 2.1.11.2.1, "Before You Begin"


	
Section 2.1.11.2.2, "Exporting a Configuration Using the Command Line"


	
Section 2.1.11.2.3, "Exporting a Configuration Using Ant"


	
Section 2.1.11.2.4, "Exporting a Configuration Using WLST"






2.1.11.2.1 Before You Begin

Make sure the following prerequisites are in place before you begin.

	
OSB_ORACLE_HOME/lib/sb-kernel-api.jar is in your classpath.


	
The resource JAR names in your scripts contain the correct version numbers.


	
The correct version of Java is installed. This should be Oracle JDK 1.6.0_35 or later, or Oracle JDK 1.7.0_07 or later.


	
Oracle Service Bus 10gR3 MP1 or later and Eclipse is installed.


	
See Section 2.1.1, "Resource Naming Restrictions" for JAR naming guidance.




When performing the export, you might see exception stack traces in the output or the workspace log file if workspace files are read-only. An exit value of 0 means the export succeeded.






2.1.11.2.2 Exporting a Configuration Using the Command Line

Oracle Service Bus provides a ConfigExport class that you can configure and launch using the following command line arguments. Command line export is for more advanced users who need more flexibility.

Exporting from the command line generates an Oracle Service Bus configuration JAR from the Eclipse workspace.


java -Xms384m -Xmx768m
-Dmiddleware.home=FMW_HOME
-Dosgi.bundlefile.limit=500
-Dosgi.nl=en_US
-Dosb.home=OSB_ORACLE_HOME
-Dweblogic.home=WEBLOGIC_HOME
-Dharvester.home=${osb.home}/HARVESTER_HOME
-Dsun.lang.ClassLoader.allowArraySyntax=true
-jar ECLIPSE_HOME/eclipse/plugins/org.eclipse.equinox.launcher_launcher_version.jar
-data WORKSPACE_DIR 
-application com.bea.alsb.core.ConfigExport
-configProject PROJECT_NAME 
-configJar config_filename.jar
-configSubProjects projects_to_export
-includeDependencies true/false
-includeSystemResources true/false


where

	
FMW_HOME is the Oracle Fusion Middleware home directory. Make sure this is the first argument you enter.


	
OSB_ORACLE_HOME is the top-level Oracle Service Bus directory in the Oracle Fusion Middleware home.


	
WEBLOGIC_HOME is the location of the installed Oracle WebLogic Server.


	
HARVESTER_HOME is the location of Harvester, an Oracle Enterprise Repository tool that lets you harvest enterprise artifacts into Oracle Enterprise Repository from multiple sources, including Oracle Service Bus. An Oracle Service Bus installation includes Harvester.


	
ECLIPSE_HOME is the location of the installed Eclipse that is linked to the Oracle Service Bus IDE plug-ins.


	
launcher_version is the version of the Eclipse launcher JAR.


	
WORKSPACE_DIR is the location that contains Oracle Service Bus artifacts to be exported. For example, c:/oracle/user_projects/workspaces/default. If this location contains an Eclipse workspace, the workspace is used and the configuration jar is exported from the workspace projects. If this location does not contain a workspace, but instead contains only Eclipse Oracle Service Bus projects, the utility imports the projects into a temporary workspace for the configuration JAR export.


	
PROJECT_NAME is the name of the Oracle Service Bus Configuration project to be exported. For example, "OSB Configuration." If you do not specify this argument, the first Oracle Service Bus Configuration Project found in the workspace is exported.


	
config_filename.jar is the name and location of the Oracle Service Bus Configuration JAR to be exported. For example, c:/sbconfig.jar.


	
configSubProjects projects_to_export is one or more specific projects within a configuration to export. If you do not specify configSubProjects, all projects in the configuration are exported.


	
includeDependencies true/false determines whether configuration-level dependencies such as JNDI Providers and Proxy Servers are included in the export.


	
includeSystemResources true/false determines whether system resources are included in the export. In order to include system resources, both includeSystemResources and includeDependencies must be true.




Following is an example of exporting an Oracle Service Bus Configuration from the command line.




	
Note:

Following is a sample command line operation. If you use this sample, be sure to check paths and file names against your current installation for accuracy.










java -Xms384m -Xmx768m
-Dosgi.bundlefile.limit=500
-Dosgi.nl=en_US
-Dosb.home=D:/oracle/Oracle_OSB1
-Dweblogic.home=D:/oracle/wlserver_10.3
-Dharvester.home=${osb.home}/harvester
-Dsun.lang.ClassLoader.allowArraySyntax=true
-jar D:/oracle/oepe_11gR1PS1/eclipse/plugins/org.eclipse.equinox.launcher_1.0.201.R35x_v20090715.jar
-data D:/oracle/user_projects/myWorkspace
-application com.bea.alsb.core.ConfigExport
-configProject config
-configJar sbconfig.jar
-configSubProjects OSB Project 1,OSB Project 2
-includeDependencies true
-includeSystemResources true






2.1.11.2.3 Exporting a Configuration Using Ant

You can export an Oracle Service Bus configuration using an Apache Ant buildfile. Exporting with Ant generates an Oracle Service Bus configuration JAR from the Eclipse workspace. If you use a source code control repository to store Service Bus projects and resources, you can use Ant to check out projects from the source repository, generate a configuration .jar file, start Service Bus, and import the configuration to Service Bus.

Following is a sample Ant buildfile with an accompanying properties file.




	
Note:

Following is a sample script. If you use this sample script, be sure to check paths and file names against your current installation for accuracy.









Ant Buildfile Example


<project name="ConfigExport">
    <property file="./build.properties"/>
    <property name="eclipse.home" value="${oracle.home}/oepe_11gR1PS2"/>
    <property name="weblogic.home" value= "${oracle.home}/wlserver_10.3"/>
    <property name="metadata.dir" value="${workspace.dir}/.metadata"/>
    <target name="export">
        <available file="${metadata.dir}" type="dir"
         property="metadata.dir.exists"/>
        <java dir="${eclipse.home}"
jar="${eclipse.home}/plugins/org.eclipse.equinox.launcher_1.0.201.R35x_v20090715.jar"
          fork="true"
          failonerror="true"
          maxmemory="768m">
           <arg line="-data ${workspace.dir}"/>
           <arg line="-application com.bea.alsb.core.ConfigExport"/>
           <arg line="-configProject ${config.project}"/>
           <arg line="-configJar ${config.jar}"/>
           <arg line="-configSubProjects ${config.subprojects}"/>
           <arg line="-includeDependencies ${config.includeDependencies}"/>
           <sysproperty key="weblogic.home" value="${weblogic.home}"/>
           <sysproperty key="osb.home" value="${osb.home}"/>
           <sysproperty key="osgi.bundlefile.limit" value="500"/>
           <sysproperty key="harvester.home" value="${osb.home}/harvester"/>
           <sysproperty key="osgi.nl" value="en_US"/>
           <sysproperty key="sun.lang.ClassLoader.allowArraySyntax" value="true"/>
        </java>
<antcall target="deleteMetadata"/>
    </target>
<target name="deleteMetadata" unless="metadata.dir.exists">
         <delete failonerror="false" includeemptydirs="true"
          dir="${metadata.dir}"/>
</target>
</project>


build.properties Example


oracle.home=c:/oracle
workspace.dir=c:/oracle/user_projects/workspaces/default
config.project="OSB Configuration"
config.jar=c:/sbconfig.jar
config.subprojects="OSB Project 1,OSB Project 2"
config.includeDependencies=true


Running "ant export" (after you run the setDomainEnv script) results in exporting the project "OSB Configuration" from the default workspace to c:\sbconfig.jar.






2.1.11.2.4 Exporting a Configuration Using WLST

You can export an Oracle Service Bus configuration using the WebLogic Scripting Tool (WLST). Exporting with WLST generates an Oracle Service Bus configuration JAR from a running Oracle Service Bus server.

For more information, see "WLST scripts to import/export and customize OSB configuration jar" on the Oracle Service Bus Samples page at http://www.oracle.com/technetwork/middleware/service-bus/learnmore/index.html.










2.1.12 Generating an Effective WSDL

To generate an effective WSDL:

	
In the Project Explorer, find the proxy service or business service from which you want to generate the effective WSDL.


	
Right-click the name of the service and select Oracle Service Bus > Generate Effective WSDL from the menu.


	
Select a location and save the file.

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.









2.1.13 Modifying JAR Dependencies

To modify JAR dependencies:

	
In the Project Explorer, find the JAR file whose dependencies you want to modify.


	
Right-click the name of the file and select Oracle Service Bus > Modify JAR Dependencies from the menu.


	
Make modifications in the Modify JAR Dependencies Dialog.









2.1.14 Importing Resources

This section describes different ways to import resources into Oracle Service Bus.

Since these procedures require an Eclipse installation, you can only perform these procedures on platforms that support the Oracle Service Bus plug-ins for Oracle Enterprise Pack for Eclipse. For unsupported platforms, import using the Oracle Service Bus Administration Console. See "Import/Export" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus at http://www.oracle.com/pls/as111170/lookup?id=OSBAG1311.

This section includes the following topics:

	
Section 2.1.14.1, "Using the Import Wizard"


	
Section 2.1.14.2, "Using the Command Line or a Script to Import an Oracle Service Bus Configuration"






2.1.14.1 Using the Import Wizard

In the Oracle Service Bus perspective, select File > Import to display the Import wizard. See:

	
Section 4.7.1, "Import Wizard - Config JAR Import - Load Resources Page"


	
Section 4.7.2, "Import Wizard - Config JAR Import - Review Resources Page"


	
Section 4.7.3, "Import Wizard - Config ZIP Import - Load Resources Page"


	
Section 4.7.4, "Import Wizard - Config ZIP Import - Review Resources Page"


	
Section 4.7.5, "Import Wizard - URL Import - Load Resources Page"


	
Section 4.7.6, "Import Wizard - URL Import - Review Resources Page"









2.1.14.2 Using the Command Line or a Script to Import an Oracle Service Bus Configuration

You can use scripting or the command line to importing an Oracle Service Bus configuration. Importing from the command line or with an Ant script imports an Oracle Service Bus configuration JAR into an Eclipse workspace. Use the examples in Section 2.1.11.2.3, "Exporting a Configuration Using Ant" and Section 2.1.11.2.2, "Exporting a Configuration Using the Command Line" for guidance on importing.

You can also import an Oracle Service Bus configuration using the WebLogic Scripting Tool (WLST). Importing with WLST imports an Oracle Service Bus configuration JAR into the Oracle Service Bus runtime environment. For more information, see "WLST scripts to import/export and customize OSB configuration jar" on the Oracle Service Bus Samples page at http://www.oracle.com/technetwork/middleware/service-bus/learnmore/index.html.








2.1.15 Creating Service Account Resources

In the Oracle Service Bus perspective, select File > New > Service Account to display the New Service Account Resource Wizard.

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.




	
Note:

You can create a service account resource in an Oracle Service Bus project only.









For configuration details, see Section 4.19, "Service Accounts."






2.1.16 Creating Service Key Provider Resources

In the Oracle Service Bus perspective, select File > New > Service Key Provider to display the New Service Key Provider Resource Wizard.

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.




	
Note:

You can create a service key provider resource in an Oracle Service Bus project only.









For configuration details, see Section 4.17, "New Service Key Provider Resource."






2.1.17 Creating SMTP Server Resources

In the Oracle Service Bus perspective, select File > New > SMTP Server to display the New SMTP Server Resource Wizard.

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.




	
Note:

You can create an SMTP server resource in an Oracle Service Bus configuration project only.









For configuration details, see Section 4.13, "SMTP Servers."






2.1.18 Creating XQuery Transformations

In the Oracle Service Bus perspective, select File > New > XQuery Transformation to display the XQuery/XSLT Expression Editor. For more information, see Part II, "XQuery Mapper".

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.




	
Note:

You can create an XQuery transformation resource in an Oracle Service Bus project only.














2.1.19 Creating XSL Transformations

In the Oracle Service Bus perspective, select File > New > XSL Transformation to display the XPath Expression Editor.

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.




	
Note:

You can create an XSL transformation resource in an Oracle Service Bus project only.









For configuration details, see Section 4.20, "Expression Editors."








2.2 Working with Business Services

The following topics describe how to create and work with business services in the Oracle Service Bus plug-ins.

	
Section 2.2.1, "Creating Business Services"


	
Appendix 2, "Generating a JCA Business Service from an Outbound JCA File"


	
Section 2.2.3, "Generating a Business Service from Oracle Enterprise Repository"


	
Section 2.2.4, "Editing Business Services"






2.2.1 Creating Business Services

In the Oracle Service Bus perspective, select File > New > Business Service to display the New Business Service wizard.

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.

For information on business service configuration, see:

	
Section 4.2.1, "Business Service General Configuration Page"


	
Section 4.2.2, "Business Service Message Type Configuration Page"


	
Section 4.2.6, "Business Service - Service Policy Configuration Page"


	
Section 4.2.3, "Business Service SOAP Binding Configuration Page"


	
Section 4.2.4, "Business Service Transport Configuration Page"



	
Note:

You can create a business service in an Oracle Service Bus project only.












2.2.1.1 Generating a Business Service from an Existing Service

To generate a business service from an existing proxy or business service:

	
In the Project Explorer, right-click the existing service and select Oracle Service Bus > Generate Business Service.


	
Name and configure the service.











2.2.2 Generating a JCA Business Service from an Outbound JCA File

Oracle Service Bus lets you generate business services from outbound JCA files. JCA services, which use the Oracle Service Bus JCA transport, communicate with back-end Enterprise Information Systems (EIS) through a JCA adapter framework and JCA-compliant adapters. For example, you could update back-end database records using an Oracle Service Bus JCA business service that communicates with the Oracle Database Adapter.

To create a JCA business service in Oracle Service Bus:

	
In Oracle JDeveloper, create a JCA file, its associated abstract WSDL, and any other required resources, such as a TopLink mapping file. For more information, see the Oracle Fusion Middleware User's Guide for Technology Adapters.


	
Import the JCA resource files into an Oracle Service Bus project so all references to dependencies are maintained. For more information, see Section 2.1.14, "Importing Resources."


	
In Eclipse, right-click the outbound JCA file and choose Oracle Service Bus > Generate Service.


	
In the JCA Generate Business Service window, select the folder location for the new service, and, if desired, change the default service name.

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.


	
Click OK. Oracle Service Bus generates the business service and the concrete WSDL that is used by the business service.




For more information on the Oracle Service Bus JCA transport, see "JCA Transport" in the Oracle Fusion Middleware Developer's Guide for Oracle Service Bus at http://www.oracle.com/pls/as111170/lookup?id=OSBDV910.






2.2.3 Generating a Business Service from Oracle Enterprise Repository

You can generate business services from service artifacts in Oracle Enterprise Repository. For more information, see Section 2.7.1, "Generating Business Services from Oracle Enterprise Repository."

You can also upload Oracle Service Bus projects to Oracle Enterprise Repository with Harvester, described in Section 2.7, "Working with Oracle Enterprise Repository and Harvester."



2.2.3.1 Re-generating an Existing Business Service from Oracle Enterprise Repository

You can regenerate a business service you previously generated from Oracle Enterprise Repository by following the same process described in Section 2.2.3, "Generating a Business Service from Oracle Enterprise Repository." Re-generating lets you pick up service updates in your development environment.

When you regenerate a service, Oracle Service Bus merges the service definitions, updating the existing service with changes in the Oracle Enterprise Repository but retaining service account and large message support configurations you have made in the development environment.








2.2.4 Editing Business Services

To edit business services:

	
In the Project Explorer, find the business service you want to edit.


	
Double-click the name of the service.


	
Select the page containing the options you want to edit. See:

	
Section 4.2.1, "Business Service General Configuration Page"


	
Section 4.2.2, "Business Service Message Type Configuration Page"


	
Section 4.2.6, "Business Service - Service Policy Configuration Page"


	
Section 4.2.3, "Business Service SOAP Binding Configuration Page"


	
Section 4.2.4, "Business Service Transport Configuration Page"


	
Section 4.2.5, "Business Service Message Handling Configuration Page"














2.3 Working with Proxy Services

The following topics describe how to create and work with proxy services in the Oracle Service Bus plug-ins.

	
Section 2.3.1, "Creating Proxy Services"


	
Section 2.3.2, "Generating a JCA Proxy Service from an Inbound JCA File"


	
Section 2.3.3, "Consuming Oracle Service Bus Proxy Services in Oracle JDeveloper with WSIL"


	
Section 2.3.4, "Editing Proxy Services"






2.3.1 Creating Proxy Services

In the Oracle Service Bus perspective, select File > New > Proxy Service to display the New Proxy Service wizard.

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.

Do not use the following characters in your service names: leading space, trailing space, / \ * : " < > ? |

For information on proxy service configuration, see:

	
Section 4.3.1, "Proxy Service General Configuration Page"


	
Section 4.3.8, "Proxy Service Security Configuration Page"


	
Section 4.3.2, "Proxy Service Message Type Configuration Page"


	
Section 4.3.3, "Proxy Service Operation Selection Configuration Page"


	
Section 4.3.4, "Proxy Service Message Handling Configuration Page"


	
Section 4.3.7, "Proxy Service - Service Policy Configuration Page"


	
Section 4.3.5, "Proxy Service SOAP Binding Configuration Page"


	
Section 4.3.6, "Proxy Service Transport Configuration Page"



	
Note:

You can create a proxy service in an Oracle Service Bus project only.












2.3.1.1 Generating a Proxy Service from an Existing Service

To generate a proxy service from an existing business or proxy service:

	
In the Project Explorer, right-click the existing service and select Oracle Service Bus > Generate Proxy Service.


	
Name and configure the service.




For a proxy services generated from a business service, the message flow automatically includes a route node to the business service.








2.3.2 Generating a JCA Proxy Service from an Inbound JCA File

Oracle Service Bus lets you generate proxy services from inbound JCA files. JCA services, which use the Oracle Service Bus JCA transport, communicate with Enterprise Information Systems (EIS) through a JCA adapter framework and JCA-compliant adapters. For example, you could invoke an external service from an EIS application through Oracle Service Bus using JCA.

To create a JCA proxy service in Oracle Service Bus:

	
In Oracle JDeveloper, create a JCA file, its associated abstract WSDL, and any other required resources, such as a TopLink mapping file. For more information, see the Oracle Fusion Middleware User's Guide for Technology Adapters.


	
Import the JCA resource files into an Oracle Service Bus project so that all references to dependencies are maintained. For more information, see Section 2.1.14, "Importing Resources."


	
In Eclipse, right-click the inbound JCA file and choose Oracle Service Bus > Generate Service.


	
In the JCA Generate Proxy Service window, select the folder location for the new service, and, if desired, change the default service name.

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.


	
Click OK. Oracle Service Bus generates the proxy service and the concrete WSDL that is used by the proxy service.




For more information on the Oracle Service Bus JCA transport, see "JCA Transport" in the Oracle Fusion Middleware Developer's Guide for Oracle Service Bus at http://www.oracle.com/pls/as111170/lookup?id=OSBDV910.






2.3.3 Consuming Oracle Service Bus Proxy Services in Oracle JDeveloper with WSIL

Oracle Service Bus makes its WSDL-based proxy services available through the Web Services Inspection Language (WSIL), letting you consume Oracle Service Bus WSDL proxy services in Oracle JDeveloper for service orchestration in Oracle SOA Suite.

The Oracle Service Bus WSIL servlet automatically registers WSDL-based proxy services deployed in the Oracle Service Bus runtime environment. By creating a WSIL connection in JDeveloper, you can access those proxy services through different URL patterns that map to different hierarchy levels, such as project, folder, and individual service. For example, when you connect to the Oracle Service Bus WSIL servlet with a project-level URL, you can see all the child folders and WSDL-based proxy services in that project in Oracle JDeveloper.

The following procedure guides you through the process of creating a WSIL connection in JDeveloper and generating Web service references out of Oracle Service Bus WSDL proxy services for use in SOA applications.

	
In Oracle JDeveloper, open or create a SOA application.


	
Create a new WSIL connection.

In the Resource Palette, click the New icon and choose New Connection > WSIL.

In the Create WSIL Connection window:

	
Enter the connection name.

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.


	
Enter the credentials for one of the following Oracle Service Bus roles: IntegrationAdmin, IntegrationDeployer, IntegrationOperator, or IntegrationMonitor.


	
Enter the URL to the Oracle Service Bus WSIL in one of the following formats:

	
Domain (gets all projects, folders, and WSDL proxy services) – http://host:port/sbinspection.wsil


	
Project (gets all child folders and WSDL proxy services) – http://host:port/sbinspection.wsil?refpath=project_name


	
Folder (in a project, gets the folder, all child folders, and WSDL proxy services) – http://host:port/sbinspection.wsil?refpath=project_name/folder_path. For example: http://localhost:7021/sbinspection.wsil?refpath=MortgageBroker/ProxyServices


	
Proxy Service (gets an individual WSDL proxy service) – http://host:port/sbinspection.wsil?refpath=project_name/folder_path/wsdl_proxy_service. For example: http://localhost:7021/sbinspection.wsil?refpath=MortgageBroker/ProxyServices/loanGateway1




In a cluster, the WSIL servlet is deployed on Managed Servers and not the Admin Server. Use a Managed Server host name and port in the URL.




When finished, click OK. The WSIL connection is displayed in the Resource Palette in the hierarchy determined by the URL you entered.


	
To use an Oracle Service Bus WSDL proxy service in your SOA application, create a Web service reference to it.

In the Component Palette, create a new Web service. In the Create Web Service window, click the WSDL URL browse icon.

In the SOA Resource Browser, select Resource Palette, and select the Oracle Service Bus WSDL proxy service in the WSIL connection created in the previous step.

When you create the Web service reference to an Oracle Service Bus WSDL proxy service, you can use it as an external reference in your SOA application.




The Oracle Service Bus WSIL servlet leverages the SBResource servlet. If the SBResource is undeployed, the WSIL connection is not available.






2.3.4 Editing Proxy Services

To edit proxy services:

	
In the Project Explorer, find the proxy service you want to edit.


	
Double-click the name of the service.


	
Select the page containing the options you want to edit. See:

	
Section 4.3.1, "Proxy Service General Configuration Page"


	
Section 4.3.8, "Proxy Service Security Configuration Page"


	
Section 4.3.2, "Proxy Service Message Type Configuration Page"


	
Section 4.3.3, "Proxy Service Operation Selection Configuration Page"


	
Section 4.3.4, "Proxy Service Message Handling Configuration Page"


	
Section 4.3.7, "Proxy Service - Service Policy Configuration Page"


	
Section 4.3.5, "Proxy Service SOAP Binding Configuration Page"


	
Section 4.3.6, "Proxy Service Transport Configuration Page"














2.4 Working with Proxy Service Message Flows

The following topics describe how to add and configure nodes and actions to proxy service message flows.

	
Section 2.4.1, "Constructing Proxy Service Message Flows"


	
Section 2.4.2, "Adding and Configuring Alert Actions in Message Flows"


	
Section 2.4.3, "Adding and Configuring Assign Actions in Message Flows"


	
Section 2.4.4, "Adding and Configuring Conditional Branch Nodes in Message Flows"


	
Section 2.4.6, "Adding and Configuring Dynamic Publish Actions in Message Flows"


	
Section 2.4.7, "Adding and Configuring Dynamic Routing Actions in Message Flows"


	
Section 2.4.8, "Adding and Configuring Error Handlers in Message Flows"


	
Section 2.4.9, "Adding and Configuring For-Each Actions in Message Flows"


	
Section 2.4.10, "Adding and Configuring If-Then Actions in Message Flows"


	
Section 2.4.11, "Adding and Configuring Insert Actions in Message Flows"


	
Section 2.4.12, "Adding and Configuring Java Callout Actions in Message Flows"


	
Section 2.4.13, "Adding and Configuring Log Actions in Message Flows"


	
Section 2.4.14, "Adding and Configuring MFL Transform Actions in Message Flows"


	
Section 2.4.15, "Adding and Configuring Operational Branch Nodes in Message Flows"


	
Section 2.4.16, "Adding and Configuring Pipeline Pair Nodes in Message Flows"


	
Section 2.4.17, "Adding and Configuring Publish Actions in Message Flows"


	
Section 2.4.18, "Adding and Configuring Publish Table Actions in Message Flows"


	
Section 2.4.19, "Adding and Configuring Raise Error Actions in Message Flows"


	
Section 2.4.20, "Adding and Configuring Rename Actions in Message Flows"


	
Section 2.4.21, "Adding and Configuring Replace Actions in Message Flows"


	
Section 2.4.23, "Adding and Configuring Report Actions in Message Flows"


	
Section 2.4.21, "Adding and Configuring Replace Actions in Message Flows"


	
Section 2.4.22, "Adding and Configuring Reply Actions in Message Flows"


	
Section 2.4.24, "Adding and Configuring Resume Actions in Message Flows"


	
Section 2.4.25, "Adding and Configuring Route Nodes in Message Flows"


	
Section 2.4.26, "Adding and Configuring Routing Actions in Message Flows"


	
Section 2.4.27, "Adding and Configuring Routing Options Actions in Message Flows"


	
Section 2.4.28, "Adding and Configuring Routing Table Actions in Message Flows"


	
Section 2.4.29, "Adding and Configuring Service Callout Actions in Message Flows"


	
Section 2.4.30, "Adding and Configuring Skip Actions in Message Flows"


	
Section 2.4.31, "Adding and Configuring Stages in Message Flows"


	
Section 2.4.32, "Adding and Configuring Transport Headers Actions in Message Flows"


	
Section 2.4.33, "Adding and Configuring Validate Actions in Message Flows"






2.4.1 Constructing Proxy Service Message Flows

When you create a proxy service, a message flow is created by default, with an empty starting node. The process for constructing the message flow follows this general pattern:

	
Open the Message Flow Editor for the proxy service. To open the proxy service, double-click its name in Project Explorer. The Message Flow Editor appears as a tab in the proxy service view.


	
Open the Message Flow Design Palette. To open the palette, in the Oracle Service Bus perspective, select Window > Show View > Design Palette.


	
Open the Properties view, if it is not already open:

	
In the Oracle Service Bus perspective, select Window > Show View > Other.


	
In the Show View dialog, select General > Properties.





	
Drag nodes and actions from the Message Flow Design Palette to the Message Flow Editor.

Alternatively, you can right-click a node or action in the Message Flow Editor to display menus of nodes and actions that can be inserted in that location. The menu contains one or more the following:

	
Insert > (list of nodes and actions)


	
Insert Into > (list of nodes and actions)


	
Insert After > (list of nodes and actions)


	
Add Error Handler





	
Configure nodes and actions:

	
In the Proxy Service Editor, select the node or action.

Alternatively, you can select a node or an action from the Outline view. To open the Outline view, in the Oracle Service Bus perspective, select Window > Show View > Outline.


	
In the Properties view, set the properties for the selected node or action. For instructions on how to configure the nodes and actions, click the Properties view for a node or action, and press F1 for help.












2.4.2 Adding and Configuring Alert Actions in Message Flows

Use the alert action to generate alerts based on message context in a pipeline, to send to an alert destination.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add an alert action 

	
In the Message Flow Design Palette, open the Stage Actions > Reporting list, if it is not already open.


	
Drag the alert action to the desired location in the message flow.




To configure the alert action 

	
In the Message Flow Editor, click the alert action, if it is not already selected.


	
On the Alert Action Properties page, edit properties.

For configuration details, see Section 4.11.1, "Alert Action Properties."









2.4.3 Adding and Configuring Assign Actions in Message Flows

Use an assign action to assign the result of an XQuery expression to a context variable.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows".

To add an assign action 

	
In the Message Flow Design Palette, open the Stage Actions > Message Processing list, if it is not already open.


	
Drag the assign action to the desired location in the message flow.




To configure the assign action 

	
In the Message Flow Editor, click the assign action, if it is not already selected.


	
On the Assign Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.2, "Assign Action Properties."









2.4.4 Adding and Configuring Conditional Branch Nodes in Message Flows

Use a conditional branch node to specify that message processing is to proceed along exactly one of several possible paths, based on a result returned by an XPath condition.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a conditional branch node 

	
In the Message Flow Design Palette, open the Oracle Service Bus Message Flow > Nodes list, if it is not already open.


	
Drag the conditional branch node to the desired location in the message flow.




To configure the conditional branch node 

	
In the Message Flow Editor, click the conditional branch node, if it is not already selected.


	
On the Conditional Branch Node Properties page, edit the desired properties.

For configuration details, see Section 4.11.3, "Conditional Branch Node Properties."









2.4.5 Adding and Configuring Delete Actions in Message Flows

Use a delete action to delete a context variable or a set of nodes specified by an XPath expression.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a delete action 

	
In the Message Flow Design Palette, open the Stage Actions > Message Processing list, if it is not already open.


	
Drag the delete action to the desired location in a stage action in the message flow.




To configure the delete action 

	
In the Message Flow Editor, click the delete action, if it is not already selected.


	
On the Delete Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.4, "Delete Action Properties."









2.4.6 Adding and Configuring Dynamic Publish Actions in Message Flows

Use a dynamic publish action to publish a message to a service specified by an XQuery expression.

For more information on publish behavior, see "Performing Transformations in Message Flows" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus at http://www.oracle.com/pls/as111170/lookup?id=OSBAG205.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a dynamic publish action 

	
In the Message Flow Design Palette, open the Stage Actions > Communication list, if it is not already open.


	
Drag the dynamic publish action to the desired location in the message flow.




To configure the dynamic publish action 

	
In the Message Flow Editor, click the dynamic publish action, if it is not already selected.


	
On the Dynamic Publish Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.5, "Dynamic Publish Action Properties."









2.4.7 Adding and Configuring Dynamic Routing Actions in Message Flows

Use a dynamic routing action to assign a route for a message based on routing information available in an XQuery resource.

For more information on routing, see "Modeling Message Flow in Oracle Service Bus" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus at http://www.oracle.com/pls/as111170/lookup?id=OSBAG181.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a dynamic routing action 

	
In the Message Flow Design Palette, open the Route Actions > Communication list, if it is not already open.


	
Drag the dynamic routing action to the route action in the message flow.




To configure the dynamic routing action 

	
In the Message Flow Editor, click the dynamic routing action, if it is not already selected.


	
On the Dynamic Routing Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.6, "Dynamic Routing Action Properties."









2.4.8 Adding and Configuring Error Handlers in Message Flows

Use an error handler to specify what should happen if an error occurs in a specific location in the message flow.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add an error handler 

	
In the Message Flow Design Palette, open the Oracle Service Bus Message Flow > Nodes list, if it is not already open.


	
Drag the error handler to the desired location in the message flow.


	
Drag a stage node to the error handler.


	
Add actions to the stage to define the error handler.




To configure the error handler 

	
In the Message Flow Editor, click the error handler, if it is not already selected.


	
On the Error Handler Node Properties page, edit the properties.


	
Click the stage node, if it is not already selected.


	
On the Stage Node Properties page, edit the properties.


	
Select and edit any desired actions contained by the stage.

For configuration details, see Section 4.11.7, "Error Handler Node Properties."









2.4.9 Adding and Configuring For-Each Actions in Message Flows

Use the for-each action to iterate over a sequence of values and execute a block of actions.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a for-each action 

	
In the Message Flow Design Palette, open the Stage Actions > Flow Control list, if it is not already open.


	
Drag the for-each action to the desired stage action in the message flow.




To configure the for-each action 

	
In the Message Flow Editor, click the for-each action, if it is not already selected.


	
On the For-Each Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.8, "For-Each Action Properties."









2.4.10 Adding and Configuring If-Then Actions in Message Flows

Use an if-then action to perform an action or a set of actions conditionally, based on the Boolean result of an XQuery expression.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add an if-then action 

	
In the Message Flow Design Palette, do one of the following:

	
For an if-then action in a route node, open the Route Actions > Flow Control list, if it is not already open.


	
For an if-then action in a stage node, open the Stage Actions > Flow Control list, if it is not already open.





	
Drag the if-then action to the route node or to the desired stage action in the message flow.




To configure the if-then action

In the Message Flow Editor, click each if condition and else-if condition contained by the if-then action, and define the conditions in the Condition Editor, as described in Section 4.11.9, "If-Then Action Properties."






2.4.11 Adding and Configuring Insert Actions in Message Flows

Use an insert action to insert the result of an XQuery expression at an identified place relative to nodes selected by an XPath expression.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add an insert action 

	
In the Message Flow Design Palette, open the Stage Actions > Message Processing list, if it is not already open.


	
Drag the insert action to the desired location in the message flow.




To configure the insert action 

	
In the Message Flow Editor, click the insert action, if it is not already selected.


	
On the Insert Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.10, "Insert Action Properties."









2.4.12 Adding and Configuring Java Callout Actions in Message Flows

Use a Java callout action to invoke a Java method or an EJB business service from within the message flow.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add an Java callout action 

	
In the Message Flow Design Palette, open the Stage Actions > Message Processing list, if it is not already open.


	
Drag the Java callout action to the desired location in the message flow.




To configure the Java callout action 

	
In the Message Flow Editor, click the Java callout action, if it is not already selected.


	
On the Java Callout Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.11, "Java Callout Action Properties."









2.4.13 Adding and Configuring Log Actions in Message Flows

Use the log action to construct a message to be logged and to define a set of attributes with which it will be logged.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a log action 

	
In the Message Flow Design Palette, open the Stage Actions > Reporting list, if it is not already open.


	
Drag the log action to the desired location in the message flow.




To configure the log action 

	
In the Message Flow Editor, click the log action, if it is not already selected.


	
On the Log Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.12, "Log Action Properties."









2.4.14 Adding and Configuring MFL Transform Actions in Message Flows

Use a MFL (Message Format Language) transform action to convert message content from XML to non-XML, or vice versa, in the message pipeline.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a MFL transform action 

	
In the Message Flow Design Palette, open the Stage Actions > Message Processing list, if it is not already open.


	
Drag the MFL transform action to the desired location in the message flow.




To configure the MFL transform action 

	
In the Message Flow Editor, click the MFL transform action, if it is not already selected.


	
On the MFL Transform Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.16, "MFL Transform Action Properties."









2.4.15 Adding and Configuring Operational Branch Nodes in Message Flows

Use an operational branch node to configure branching based on operations defined in a WSDL.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add an operational branch node 

	
In the Message Flow Design Palette, open the Oracle Service Bus Message Flow > Nodes list, if it is not already open.


	
Drag the operational branch node to the desired location in the message flow.




To configure the operational branch node 

	
In the Message Flow Editor, click the operational branch node, if it is not already selected.


	
On the Operational Branch Node Properties page, edit the desired properties.

For configuration details, see Section 4.11.17, "Operational Branch Node Properties."









2.4.16 Adding and Configuring Pipeline Pair Nodes in Message Flows

Use a pipeline pair node to define request and response processing.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a pipeline pair node 

	
In the Message Flow Design Palette, open the Oracle Service Bus Message Flow > Nodes list, if it is not already open.


	
Drag the pipeline pair node to the desired location in the message flow.




To configure the pipeline pair node 

	
In the Message Flow Editor, click the pipeline pair node, if it is not already selected.


	
On the Pipeline Pair Node Properties page, edit the desired properties.

For configuration details, see Section 4.11.18, "Pipeline Pair Node Properties."









2.4.17 Adding and Configuring Publish Actions in Message Flows

Use a publish action to identify a statically specified target service for a message and to configure how the message is packaged and sent to that service.

For more information on publish behavior, see "Performing Transformations in Message Flows" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus at http://www.oracle.com/pls/as111170/lookup?id=OSBAG205.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a publish action 

	
In the Message Flow Design Palette, open the Stage Actions > Communication list, if it is not already open.


	
Drag the publish action to the desired location in the message flow.




To configure the publish action 

	
In the Message Flow Editor, click the publish action, if it is not already selected.


	
On the Publish Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.19, "Publish Action Properties."









2.4.18 Adding and Configuring Publish Table Actions in Message Flows

Use a publish table action to publish a message to zero or more statically specified services.

For more information on publish behavior, see "Performing Transformations in Message Flows" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus at http://www.oracle.com/pls/as111170/lookup?id=OSBAG205.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a publish table action 

	
In the Message Flow Design Palette, open the Stage Actions > Communication list, if it is not already open.


	
Drag the publish table action to the desired location in the message flow.




To configure the publish table action 

	
In the Message Flow Editor, click the publish table action, if it is not already selected.


	
On the Publish Table Action Properties page, click <Expression> to display the XQuery/XSLT Expression Editor. Create an XQuery expression, which at runtime returns the value upon which the routing decision will be made.


	
In the Message Flow Editor, select a case action.


	
From the Operator list on the Publish Table Action Properties page, select a comparison operator. Then, in the Value field, enter a value against which the value returned from the XQuery expression will be evaluated.


	
In the Message Flow Editor, click one of the publish table's publish actions to select it.


	
On the Publish Action Properties page, click Browse to select a service. Select the service to which messages are to be published if the expression evaluates true for the value you specified. The Select a Service Resource dialog is displayed.


	
Select a service from the list, then click OK. This is the target service for the message.


	
If the service has operations defined, you can specify the operation to be invoked by selecting it from the invoking list.


	
If you want the outbound operation to be the same as the inbound operation, select the Use inbound operation for outbound check box.


	
In the Request Actions field, to configure how the message is packaged and sent to the service, click Add an Action, then select one or more actions that you want to associate with the service.


	
To insert a new case, click the Case icon, then select Insert New Case.


	
Repeat steps 4-8 for the new case.


	
Add additional cases as dictated by your business logic.


	
Click the Case icon of the last case you define in the sequence, then select Insert Default Case to add a default case at the end.


	
Configure the default case—the configuration of this case specifies the routing behavior in the event that none of the preceding cases is satisfied.

For more information, see Section 4.11.20, "Publish Table Action Properties."









2.4.19 Adding and Configuring Raise Error Actions in Message Flows

Use the raise error action to raise an exception with a specified error code (a string) and description.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a raise error action 

	
In the Message Flow Design Palette, open the Stage Actions > Flow Control list, if it is not already open.


	
Drag the raise error action to the desired location in the message flow.




To configure the raise error action 

	
In the Message Flow Editor, click the raise error action, if it is not already selected.


	
On the Raise Error Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.21, "Raise Error Action Properties."









2.4.20 Adding and Configuring Rename Actions in Message Flows

Use the rename action to rename elements selected by an XPath expression without modifying the contents of the element.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add an rename action 

	
In the Message Flow Design Palette, open the Stage Actions > Message Processing list, if it is not already open.


	
Drag the rename action to the desired location in the message flow.




To configure the rename action 

	
In the Message Flow Editor, click the rename action, if it is not already selected.


	
On the Rename Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.22, "Rename Action Properties."









2.4.21 Adding and Configuring Replace Actions in Message Flows

Use a replace action to replace a node or the contents of a node specified by an XPath expression. The node or its contents are replaced with the value returned by an XQuery expression.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a replace action 

	
In the Message Flow Design Palette, open the Stage Actions > Message Processing list, if it is not already open.


	
Drag the replace action to the desired location in the message flow.




To configure the replace action 

	
In the Message Flow Editor, click the replace action, if it is not already selected.


	
On the Replace Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.23, "Replace Action Properties."









2.4.22 Adding and Configuring Reply Actions in Message Flows

Use the reply action to specify that an immediate reply be sent to the invoker.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a reply action 

	
In the Message Flow Design Palette, open the Stage Actions > Flow Control list, if it is not already open.


	
Drag the reply action to the desired location in the message flow.




To configure the reply action 

	
In the Message Flow Editor, click the reply action, if it is not already selected.


	
On the Reply Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.24, "Reply Action Properties."









2.4.23 Adding and Configuring Report Actions in Message Flows

Use the report action to enable message reporting for a proxy service.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a report action 

	
In the Message Flow Design Palette, open the Stage Actions > Reporting list, if it is not already open.


	
Drag the report action to the desired location in the message flow.




To configure the report action 

	
In the Message Flow Editor, click the report action, if it is not already selected.


	
On the Report Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.25, "Report Action Properties."









2.4.24 Adding and Configuring Resume Actions in Message Flows

Use the resume action to resume message flow after an error is handled by an error handler. This action has no parameters and can only be used in error pipelines.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a resume action 

	
In the Message Flow Design Palette, open the Stage Actions > Flow Control list, if it is not already open.


	
Drag the resume action to the desired location in the message flow.




To configure the resume action 

	
In the Message Flow Editor, click the resume action, if it is not already selected.


	
On the Resume Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.26, "Resume Action Properties."









2.4.25 Adding and Configuring Route Nodes in Message Flows

Use the route node to handle request and response dispatching of messages to and from business services.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a route node 

	
In the Message Flow Design Palette, open the Oracle Service Bus Message Flow > Nodes list, if it is not already open.


	
Drag the route node to the desired location in the message flow.




To configure the route node 

	
In the Message Flow Editor, click the route node action, if it is not already selected.


	
On the Route Node Properties page, edit the desired properties.

For configuration details, see Section 4.11.27, "Route Node Properties."









2.4.26 Adding and Configuring Routing Actions in Message Flows

Use a routing action to identify a target service for the message and configure how the message is routed to that service.

For more information on routing, see "Modeling Message Flow in Oracle Service Bus" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus at http://www.oracle.com/pls/as111170/lookup?id=OSBAG181.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a routing action 

	
In the Message Flow Design Palette, open the Route Actions > Communication list, if it is not already open.


	
Drag the routing action to the desired location in the message flow.




To configure the routing action 

	
In the Message Flow Editor, click the routing action, if it is not already selected.


	
On the Routing Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.28, "Routing Action Properties."









2.4.27 Adding and Configuring Routing Options Actions in Message Flows

Use a routing options action to modify any or all of the following properties in the outbound request: URI, Quality of Service, Mode, Retry parameters, message Priority.

For more information on routing, see "Modeling Message Flow in Oracle Service Bus" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus at http://www.oracle.com/pls/as111170/lookup?id=OSBAG181.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a routing options action 

	
In the Message Flow Design Palette, open the Stage Actions > Communication list, if it is not already open.


	
Drag the routing options action to the desired location in the message flow.




To configure the routing options action 

	
In the Message Flow Editor, click the routing options action, if it is not already selected.


	
On the Routing Options Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.29, "Routing Options Action Properties."









2.4.28 Adding and Configuring Routing Table Actions in Message Flows

Use a routing table to select different routes based upon the results of a single XQuery expression. A routing table action contains a set of routes wrapped in a switch-style condition table.

For more information on routing, see "Modeling Message Flow in Oracle Service Bus" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus at http://www.oracle.com/pls/as111170/lookup?id=OSBAG181.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a routing table action 

	
In the Message Flow Design Palette, open the Route Actions > Communication list, if it is not already open.


	
Drag the routing table action to the desired location in the message flow.




To configure the routing table action 

	
In the Message Flow Editor, click the routing table action, if it is not already selected.


	
On the Routing Table Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.30, "Routing Table Action Properties."









2.4.29 Adding and Configuring Service Callout Actions in Message Flows

Use a service callout action to configure a synchronous (blocking) callout to an Oracle Service Bus-registered proxy or business service.

For more information on service callout actions, see "Constructing Service Callout Messages" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus at http://www.oracle.com/pls/as111170/lookup?id=OSBAG1124.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a service callout action 

	
In the Message Flow Design Palette, open the Stage Actions > Communication list, if it is not already open.


	
Drag the service callout action to the desired location in the message flow.




To configure the service callout action 

	
In the Message Flow Editor, click the service callout action, if it is not already selected.


	
On the Service Callout Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.31, "Service Callout Action Properties."









2.4.30 Adding and Configuring Skip Actions in Message Flows

Use the skip action to specify that at runtime, the execution of the current stage is skipped and the processing proceeds to the next stage in the message flow.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a skip action 

	
In the Message Flow Design Palette, open the Stage Actions > Flow Control list, if it is not already open.


	
Drag the skip action to the desired location in the message flow.




To configure the skip action 

	
In the Message Flow Editor, click the skip action, if it is not already selected.


	
On the Skip Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.32, "Skip Action Properties."









2.4.31 Adding and Configuring Stages in Message Flows

Use a stage node as a container for actions in a message flow.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a stage 

	
In the Message Flow Design Palette, open the Oracle Service Bus Message Flow > Nodes list, if it is not already open.


	
Drag the stage to the desired location in the message flow.


	
Add actions to the stage for your configuration.




To configure the stage 

	
In the Message Flow Editor, click the stage, if it is not already selected.


	
On the Stage Node Properties page, edit the desired properties.

For configuration details, see Section 4.11.33, "Stage Node Properties."









2.4.32 Adding and Configuring Transport Headers Actions in Message Flows

Use a transport header action to set header values in messages.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a transport headers action 

	
In the Message Flow Design Palette, open the Stage Actions > Communication list, if it is not already open.


	
Drag the transport headers action to the desired location in the message flow.




To configure the transport headers action 

	
In the Message Flow Editor, click the transport headers action, if it is not already selected.


	
On the Transport Headers Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.34, "Transport Headers Action Properties."









2.4.33 Adding and Configuring Validate Actions in Message Flows

Use a validate action to validate elements selected by an XPath expression against an XML schema element or a WSDL resource.

Before you begin

Display the message flow for the desired proxy service. See Section 2.4.1, "Constructing Proxy Service Message Flows."

To add a validate action 

	
In the Message Flow Design Palette, open the Stage Actions > Message Processing list, if it is not already open.


	
Drag the validate action to the desired location in the message flow.




To configure the validate action 

	
In the Message Flow Editor, click the validate action, if it is not already selected.


	
On the Validate Action Properties page, edit the desired properties.

For configuration details, see Section 4.11.35, "Validate Action Properties."











2.5 Working with Alert Destinations

The following topics describe how to create and work with alert destinations in the Oracle Service Bus plug-ins.

	
Section 2.5.1, "Creating and Editing Alert Destinations"


	
Section 2.5.2, "Adding Email Recipients to Alert Destinations"


	
Section 2.5.3, "Adding JMS Destinations to Alert Destinations"






2.5.1 Creating and Editing Alert Destinations

To create alert destinations:

	
In the Project Explorer in the Oracle Service Bus perspective, right-click a project or folder in which you want to create an alert destination.


	
From the menu, select File > New > Alert Destination to display the New Alert Destination Resource wizard.

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.



	
Note:

You can create an alert destination in an Oracle Service Bus project only.










To edit alert destinations:

	
In the Project Explorer, find the project folder containing the alert destination you want to edit.


	
Double-click the name of the alert destination to display the Alert Destination Editor. Edit information, as desired.




For configuration details, see Section 4.1.1, "Alert Destination Editor."






2.5.2 Adding Email Recipients to Alert Destinations

To add email recipients to alert destinations:

	
Create or edit an alert destination, as described in Section 2.5.1, "Creating and Editing Alert Destinations."


	
In the Email Recipients field of the Alert Destination Editor, click Add to display the Edit Email Recipient Page.









2.5.3 Adding JMS Destinations to Alert Destinations

To add JMS destinations to alert destinations:

	
Create or edit an alert destination, as described in Section 2.5.1, "Creating and Editing Alert Destinations."


	
In the JMS Destinations field of the Alert Destination Editor, click Add to display the Edit JMS Destination Page.











2.6 Working with MQ Connections

MQ connections are sharable resources that can be reused across multiple MQ proxy and business services. MQ proxy and business services must connect to a MQ queue manager before accessing an MQ queue. MQ Connection resources provide the connection required for connecting to an MQ queue manager.

Each MQ Connection resource has a connection pool. Every business or proxy service using a given MQ Connection resource to get a connection to a given queue manager uses the same connection pool that was created for that resource. Thus, multiple business services and proxy services using the same queue manager share a connection pool.

To learn more about Oracle Service Bus MQ Connection resources and the native MQ transport, see "MQ Transport" in the Oracle Fusion Middleware Developer's Guide for Oracle Service Bus at http://www.oracle.com/pls/as111170/lookup?id=OSBDV1117.

To learn more about WebSphere MQ Fundamentals, see http://www.redbooks.ibm.com/redbooks/SG247128/wwhelp/wwhimpl/java/html/wwhelp.htm.



2.6.1 Adding and Editing MQ Connections

In Oracle Service Bus, MQ connections are created as custom resources. Therefore, to add an MQ connection, you must create it as a custom resource, as follows:

	
In the Oracle Service Bus perspective, select File > New > Custom Resource to display New Custom Resource Wizard.

See Section 2.1.1, "Resource Naming Restrictions" for naming guidance.


	
On the Create a New Custom Resource page, in the Resource Type field, select MQ Connection.


	
Enter configuration information, on the Custom MQ Resource Configuration Page.



	
Note:

Do not include spaces in the MQ Connection resource name.










To edit MQ connections:

	
In the Project Explorer, find the Oracle Service Bus configuration folder containing the MQ connection resource you want to edit.


	
Double-click the name of the MQ connection to display the Custom MQ Resource Configuration Page.




For configuration details, see Section 4.5.4, "Custom MQ Resource Configuration Page."








2.7 Working with Oracle Enterprise Repository and Harvester

Oracle Enterprise Repository is an enterprise metadata repository for application resources and services. Using Oracle Enterprise Repository in conjunction with Oracle Service Registry, Oracle's UDDI solution, is a best-practice approach to locating, using, synchronizing, and governing enterprise-wide services through Oracle Service Bus.

Harvester is an Oracle Enterprise Repository tool that lets you harvest enterprise artifacts into Oracle Enterprise Repository from multiple sources, including Oracle Service Bus.

Oracle Service Bus provides native connectivity to Oracle Enterprise Repository and Harvester in the development environment, letting you both generate business services from the repository and harvest Oracle Service Bus projects to the repository. Harvester also provides command-line scripting for harvesting Oracle Service Bus projects in the runtime environment.

For more information on Oracle Enterprise Repository, see the Oracle Fusion Middleware Quick Start Guide for Oracle Enterprise Repository.

This section includes the following topics:

	
Section 2.7.1, "Generating Business Services from Oracle Enterprise Repository"


	
Section 2.7.2, "Using Harvester"


	
Section 2.7.3, "Performing Queries in Oracle Enterprise Repository from Eclipse"






2.7.1 Generating Business Services from Oracle Enterprise Repository

You can generate business services in the Oracle Service Bus development environment from service assets in Oracle Enterprise Repository.

In a best-practices deployment scenario, service assets in Oracle Enterprise Repository have associated services stored in Oracle Service Registry. When you generate business services from Oracle Enterprise Repository assets, those services can be synchronized with the associated services stored in the registry through Oracle Service Bus UDDI resources.

This section provides instructions on using the development environment to generate business services from service assets in Oracle Enterprise Repository.




	
Note:

To generate business services in Oracle Service Bus, Oracle Enterprise Repository assets must be SOAP/XML WSDL-based services using HTTP.
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5 Introduction


This chapter provides an overview of the Oracle XQuery Mapper.

Oracle XQuery Mapper is a graphical mapping tool that enables you to transform data between XML, non-XML, and Java data types, allowing you to integrate heterogeneous applications rapidly. For example, you can package data transformations in Oracle WebLogic Integration (WLI) as controls and reuse the controls in multiple business processes and applications. You can also use .xq files created in XQuery Mapper as resources in Oracle Service Bus.

The output of XQuery Mapper is a query in the XQuery language, which is defined by the World Wide Web Consortium (W3C). For more information about W3C and the XQuery language, see http://www.w3.org/XML/Query/.



5.1 Overview of XQuery Mapper

You can use XQuery Mapper to transform data between XML, non-XML, and Java data types. For example, XML data that is valid against one schema can be converted to XML that is valid against a different schema. The data can be based on XML schemas, Web Service Definition Language (WSDL) file, and Message Format Language (MFL) files.

When you select the Simple source type, you can transform standard schema types, such as boolean, byte, double, float, int, long, short, String, and Date, to any other required target data format.

A data transformation can have multiple input types, but only one target type. For example, data can be transformed from two sources to one target, as shown in the following figure.


Figure 5-1 Data Transformation from Multiple Sources to One Target

[image: Description of Figure 5-1 follows]









5.2 Support for XQuery 2002 and 2004

Oracle Service Bus supports data transformation for the following versions of XQuery:

	
XQuery 2004: Graphical design view (XQuery Mapper), source view, and test view.


	
XQuery 2002: Source view and test view.




	
Note:

For XQuery 2002-compliant XQuery files, the source view does not show compilation errors.












When you open an XQuery 2002-compliant XQuery file, it opens automatically in the XQuery 2002 Transformation Editor, which has Source and Test views, but no Design view.



5.2.1 Restrictions Applicable to the XQuery Test View

Table 5-1 describes restrictions in XQuery test view.


Table 5-1 Restrictions Applicable to the XQuery Test View

	Restriction	Applicable to XQ2002?	Applicable to XQ2004?
	
If an XQuery calls a Java user function, the Java method must be static.

	
Yes

	
Yes


	
If an input Java type argument to an XQuery is an abstract class or an interface, the test view can not process it. An error message is displayed in the results view.

	
Yes

	
No


	
The input Java type and its member variables (except those of type primitive, String, java.sql.Date and java.util.Date) must follow the standard Java Bean guidelines.

	
Yes

	
No
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9 Format Builder Main Window


This chapter provides a user interface reference for the Format Builder main window.

The main window of the Format Builder is split into two panes. The left pane shows the structural information for the data format. The right pane shows the detail for the item selected in the left pane.

You can navigate in and execute commands from the main window by using one of the following methods:

	
Section 9.1, "Using the Menu Bar"


	
Section 9.2, "Using the Toolbar"


	
Section 9.3, "Using the Tree Pane"


	
Section 9.4, "Using the Shortcut Menus"






9.1 Using the Menu Bar

The Menu bar displays the menu headings. The menus that are available depend on what is selected in the left pane. You can open menus from the menu bar or by holding down the ALT key while pressing the underscored letter in the menu heading. For example, pressing ALT + F opens the File Menu.

For a complete description of the menu commands, see Chapter 18, "Format Builder Menus"






9.2 Using the Toolbar

The Format Builder toolbar provides buttons that access some of the frequently used commands in the menus. If a command is unavailable, its button appears "grayed-out."

The toolbar buttons provided with Format Builder are described below:


Table 9-1 List of Toolbar Buttons

	Toolbar Button Name	Description
	
New

	
Creates a new Message Format


	
Open/Retrieve

	
Opens an existing Message Format.


	
Save/Store

	
Saves the current Message Format


	
Cut

	
Removes the item currently selected in the left-hand pane, and its child objects, from the tree.

Note: This action is not available if the Message Format (root) item is selected.


	
Copy

	
Makes a copy of the item currently selected in the left-hand pane for insertion elsewhere in the tree.

Note: This action is not available if the Message Format (root) item is selected.


	
Paste as Sibling

	
Inserts the cut or copied item as a sibling object of the selected item.


	
Paste as Reference

	
Inserts a reference to the cut or copied item as a sibling object of the selected item.


	
Undo

	
Reverses the previous action. The tool tip changes to indicate the action that can be undone. For example, changing the name of a field to Field1 and clicking Apply causes the tool tip to read "Undo Apply Field Field1".

Note: Format Builder supports multi-level undoing and redoing.


	
Redo

	
Reverses the effects of an Undo command. The tool tip changes to indicate the action that can be redone. For example, changing the name of a field to Field1 and then undoing that action causes the tool tip to read "Redo Apply Field Field1".

Note: Format Builder support multi-level undoing and redoing.


	
Insert Field

	
Inserts a field as a sibling of the item selected in the tree pane.


	
Insert Group

	
Inserts a group as a sibling of the item selected in the tree pane.


	
Insert Comment

	
Inserts a comment as a sibling of the item selected in the tree pane.


	
Move Up

	
Moves the selected item up one position under its parent.


	
Move Down

	
Moves the selected item down one position under its parent.


	
Promote item

	
Promotes the selected item to the next highest level in the tree. For example, Field1 is the child object of Group1. Selecting Field1 and clicking the Promote tool makes it a sibling of Group1.


	
Demote item

	
Demotes the selected item to the next lower level in the tree. For example, Group1 is the sibling of Field1. Field1 immediately follows Group1 in the tree. Selecting Field1 and clicking the Demote tool makes it a child of Group1.


	
Expand All

	
Expands all items in the tree pane to show child items.


	
Collapse All

	
Collapses the tree pane to show first level items only.


	
Format Tester

	
Opens the Chapter 17, "Format Tester" window.












9.3 Using the Tree Pane

The Tree Pane represents hierarchical/structural information about the format of the non-XML data in a tree. The root node of the tree will correspond to the MFL document being created or edited. The root node is referred to as the Message node. Child nodes are labeled with group or field names. Fields are represented by leaf nodes in the tree. Groups contain fields or other groups and are represented by non-leaf nodes in the tree.

The icon for each node encapsulates information about the node. The icon indicates whether the node represents a message, a group, a field, a comment, or a reference. The icon also indicates whether a group or field is repeating, whether a group is a Group Choice, and whether a group or field is optional or mandatory. You also have the ability to add, delete, move, copy, or rename nodes in the tree. This is done through the menus or the toolbar (see Section 9.1, "Using the Menu Bar," Section 9.2, "Using the Toolbar," and Section 9.4, "Using the Shortcut Menus").

The icons that appear in the Tree Pane are described in the following table.


Table 9-2 Tree Icon Descriptions

	Tree Icon Name	Description
	
Message Format

	
The top level element.


	
Group

	
Collections of fields, comments, and other groups or references that are related in some way (for example, the fields PAYDATE, HOURS, and RATE could be part of the PAYINFO group). Defines the formatting for all items contained in the group.


	
Optional Group

	
A group that may or may not be included in the message format.


	
Repeating Group

	
A group that has one or more occurrences.


	
Optional Repeating Group

	
A group that may or may not be included, but if included, occurs more than once.


	
Group Reference

	
Indicates that another instance of the group exists in the data. Reference groups have the same format as the original group, but you can change the optional setting and the occurrence setting for the reference group.


	
Group Choice

	
Indicates that only one of the items in the group will be included in the message format.


	
Field

	
Sequence of bytes that have some meaning to an application. (For example, the field EMPNAME contains an employee name.) Defines the formatting for the field.


	
Optional Field

	
A field that may or may not be included in the message format.


	
Repeating Field

	
A field that has one or more occurrences.


	
Field Reference

	
Indicates that another instance of the field exists in the data. Reference fields have the same format as the original field, but you can change the optional setting and the occurrence setting for the reference field.


	
Optional Repeating Field

	
A field that may or may not be included, but, if included, occurs more than once in the message format.


	
Comment

	
Contains notes about the message format or the data transformed by the message format.


	
Collapse

	
A minus sign next to an object indicates that it can be collapsed.


	
Expand

	
A plus sign next to an object indicates that it can be expanded to show more objects.












9.4 Using the Shortcut Menus

Instead of using the standard menus to find the command you need, use the right mouse button to click an item in the left pane. The menu that appears shows the most frequently used commands for that item.

For a complete description of the shortcut menu commands, see Section 18.7, "Shortcut Menu."






9.5 Using Drag and Drop

You can use the drag and drop feature of Format Builder to copy and/or move the items in the tree view.

To use drag and drop to move an item: 

	
Select the item you want to move.


	
Press and hold the left mouse button while you drag the item to the desired location.


	
When the item is in the desired location, release the left mouse button. The item is moved to the new location.




To use drag and drop to copy an item: 

	
Select the item you want to copy.


	
Press and hold the CTRL key.


	
Keeping the CTRL key depressed, press and hold the left mouse button while you drag the item to the desired location.


	
When the item is in the desired location, release the left mouse button and the CTRL key. A copy of the item is place at the new location.









9.6 Valid Names

Message formats, fields, and groups are identified by a name. This name is used as the XML tag when non-XML data is transformed to XML. Therefore the name must conform to the XML rules for a name.

The format guidelines for a name are as follows:

	
Must start with a letter or underscore.


	
Can contain letters, digits, colon, the period character, the hyphen character, or the underscore character.




The following are valid name examples:


MyField
MyField1
MyField_again
MyField-again


The following are invalid name examples:

1MyField - may not start with a digit

My>Field - the greater-than sign (>) is an illegal character

My Field - a space is not permitted

My/Field - the back slash (/), which is an illegal character

My\Field - the forward slash (\), which is an illegal character

My:Field - a semi-colon (;), which is an illegal character
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10 Message Format Detail Window


This chapter provides a user interface reference for the Format Builder message format detail.

Defines the data for which you are creating a message format (the root node of a message format file).


Table 10-1 Message Format

	Field	Description
	
Name/XML Root

	
The name of the message format. This value will be used as the root element in the transformed XML document. This name must comply with XML element naming conventions.


	
Apply Button

	
Saves your changes to the message format document.


	
Reset Button

	
Discards your changes to the detail window and resets all fields to the last saved values.


	
Help Button

	
Displays online help information for this detail window.











	
Note:

The Apply and Reset buttons are only enabled once changes are made to the detail panel's components.
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12 Field Detail Window


This chapter provides a user interface reference for the Format Builder field detail window.

Defines the fields contained in the message format. Fields are a sequence of bytes that have some meaning to an application. (For example, the field EMPNAME contains an employee name.) You can create a field as a child of the message format item, as a child of a group, or as a sibling of a group or another field.


Table 12-1 Fields in Message Format – Field Description

	Field	Description
	
Name

	
The name of the field. This name must comply with XML element naming conventions (see Section 9.6, "Valid Names" for more information).


	
Optional

	
Select this option if this is an optional field. Optional means that the data for the field might be present in the input.

If the Optional option is selected for a file, then you can set the Field is Tagged option from the Field Attributes pane. In addition, in the Field Is Tagged text box, enter a unique value for each optional field in a group. Multiple groups can use the same tag value, but the tag value for each optional field in a group must be unique.


	
Type

	
Select the data type of the field from the list. The default is String.

Note: The Field Type you select dictates the Field Data Options that appear on the dialog.

Refer to Chapter 21, "Format Builder Supported Data Types" for a list of data types supported by Format Builder.









Table 12-2 Fields in Message Format – Field Occurrence

	Field	Description
	
Occurrence

	
Choose one of the following to indicate how often this field appears in the message format:

	
Once - Indicates that the field appears only once.


	
Repeat Delimiter - Indicates that the field repeats until the specified delimiter is encountered.


	
Repeat Field - Indicates that the value of the repeat field at runtime is the number of times the field repeats.


	
Repeat Number - Indicates that the field repeats the specified number of times.


	
Unlimited - Indicates that the field repeats an unlimited number of times.




Note: Unless a field is defined as optional, the field occurs at least once.








The fields in the following sections of the detail window depend on the Field Type selected.


Table 12-3 Fields in Message Format – Field Data Options

	Field	Description
	
Data Base Type

	
If the field is a date or time field, the base type indicates what type of characters (ASCII, EBCDIC, or Numeric) make up the data.


	
Year Cutoff

	
If the field is a date field that has a 2-digit year, the year cutoff allows the 2-digit year to be converted to a 4-digit year. If the 2-digit year is greater than or equal to the year cutoff value, a '19' prefix will be added to the year value. Otherwise a '20' prefix will be used.


	
Code Page

	
The character encoding of the String field data.


	
Value

	
The value that appears in a literal field.









Table 12-4 Fields in Message Format – Field Attributes

	Field	Description
	
Field is Tagged

	
Select this option if this is a tagged field. Being tagged means that a literal precedes the data, indicating that the data is present. For example: SUP:ACME INC, SUP: is a tag. ACME INC is the field data.

If you have selected the Field is Tagged option, enter the tag in the text box to the right of the check box.


	
Field Default Value

	
Select this option if the field has a default value. Then, enter the default value in the text box to the right of the check box.









Table 12-5 Fields in Message Format – Termination

	Field	Description
	
Length

	
Variable-sized data types can be assigned a fixed length, eliminating the need to use a delimiter to specify the termination point of the field.

	
Length - Enter the number of bytes in the length field if the length field is a variable length.


	
Trim Leading/Trailing - Removes the specified data from the leading or trailing edge of the data.


	
String Length in Characters - By default, the string length is in bytes.Select this check box if string is multi-byte encoded to calculate the length in number of characters instead of bytes.


	
Pad - If the data is shorter than the specified length, enter the necessary value to the data until it is of correct length. Select the Trailing option to append padding at the end of a field. Select the Leading option to append padding at the beginning of a field.


	
Truncate - Removes a specified number of characters from a field. Select the Truncate First option to remove the specified number of characters from the beginning of the field. Select the Truncate After option to remove the specified number of characters from the end of the field.




If you select both truncation options, the Truncate First option is implemented initially, and the Truncate After option is invoked on the remaining characters.


	
Imbedded Length

	
Variable-sized data types can have their termination point specified by an imbedded length. An imbedded length precedes the data field and indicates how many bytes the data contains.

	
Description - Select the Type from the list of available options. Then, depending on the Type selected, choose Length and enter the number of bytes, or choose Delimiter and enter the delimiter character.


	
Tag/Length Order - Specifies the order of tag and length fields when both are present. Default is tag before length.


	
Trim Leading/Trailing - Removes the specified data from the leading or trailing edge of the data.


	
Truncate - Removes a specified number of characters from a field. For more information on truncation, see the Length field.





	
Delimiter

	
Variable-sized data types can have their termination point specified by a delimiter. A delimiter is a character that marks the end of the field. The field data continues until the delimiter character is encountered.

	
Value - Enter the delimiter that marks the end of the field data.


	
Trim Leading/Trailing - Removes the specified data from the leading or trailing edge of the data.


	
Truncate - Removes a specified number of characters from a field. For more information on truncation, see the Length field.





	
Delimiter Field

	
Variable-sized data types can have their termination point specified by a field that contains a delimiter character. A delimiter is a character that marks the end of the field. The field data continues until the field containing the delimiter character is encountered.

	
Field - Select the field that contains the delimiter character.


	
Default - Enter the delimiter character. You must supply a default value. The default is used when the delimiter field is not present.


	
Trim Leading/Trailing - Removes the specified data from the leading or trailing edge of the data.


	
Truncate - Removes a specified number of characters from a field. For more information on truncation, see the Length field.




For more information on delimiters, see Section 19.12, "Character Delimiters."


	
Decimal Position

	
Specifies the number of digits (0-16) to the left of the decimal point.









Table 12-6 Fields in Message Format – Literal

	Field	Description
	
Value

	
Specify the literal value. Literal value can be defined as a single value or it can be defined a list of values separated by the literal separator. When the Value is a list of values, the data for the literal field in the binary data will be one of value in the list.


	
Literal Separator

	
Supports enumeration of literal values. For literal type Field in MFL definition, a literal separator can be specified when multiple choices of value is needed for the Field.

For example, segment terminators that are supported by both EDIFACT and X12 EDI standards are: \r\n\, \r, \n, ', and ~. However, you can use Format Builder to support any other custom terminator. You can append the custom terminator to the existing list of literal values and use comma (,) as literal separator to separate multiple custom values.

In the MFL file, you should see the following structure,


<FieldFormat name='ISA_Terminator' type='Literal' value='\r\n,\r,\n,~,|' literalSeparator=','/>









Table 12-7 Fields in Message Format – Field Update Buttons

	Field	Description
	
Apply

	
Saves your changes to the message format file.


	
Duplicate

	
Makes a copy of the field currently displayed. The duplicate field contains the same values as the original field. The name of the duplicate field is the same as the original field name, with the word "New" inserted before the original name. For example, duplicating a field called "Field1" results in a field with the name "NewField1".

When you duplicate an item with a numeric value in its name, the new item name contains the next sequential number. For example, duplicating "NewField1" results in a group named "NewField2".


	
Reset

	
Discards your changes to the detail window and resets all fields to the last saved values.


	
Help

	
Displays online help information for this detail window.











	
Note:

The Apply and Reset buttons are only enabled once changes are made to the detail panel's components.
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15 Format Builder Options


This chapter provides a user interface reference for the Format Builder options.

Defines the options for Format Builder. These options control the overall operation of Format Builder. Click Tools > Options from the format builder menu to invoke the following options.


Table 15-1 Format Builder Options

	Field	Definition
	
Default Message Format Version

	
Select the MFL version used when creating new documents.

Note: Message formats contain their own format version specified on the Message Format pane.









Table 15-2 Format Builder Options – Character Encoding Options

	Field	Definition
	
Default Message Format (MFL) Encoding

	
Select the character encoding default for the Message Format Layout (MFL) from the list of encoding names and descriptions. This defines the format that your MFL document and XML output will take.


	
Default Field Code Page

	
Select the default field code page from the list of non-XML formats. This selection will be the default code page for each field that is created in your MFL document. It specifies the character encoding of the non-XML data for each field.









Table 15-3 Format Builder Options – XML Formatting Options

	Field	Definition
	
Initial Indent

	
Enter the number of spaces to indent the first line of the XML document.


	
New Line Indent

	
Enter the number of spaces to indent a new child line of the XML document.









Table 15-4 Format Builder Options – XML Content Model Options

	Field	Definition
	
Auto-generate DTD

	
Generates a DTD document when you save or store the MFL document. This document will be placed in the same directory as the message format when saving to a file.
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16 Importing Metadata


This chapter describes how to import metadata into Format Builder.

Format Builder includes the following utilities that allow you to import COBOL copybooks, gXML guideline files, and convert a C structure definition into MFL Message Definition.

	
Section 16.1, "Importing a Guideline XML File"


	
Section 16.2, "Importing an XML Schema"


	
Section 16.3, "Importing a COBOL Copybook"


	
Section 16.4, "Importing C Structures"


	
Section 16.8, "Importing an FML Field Table Class"






16.1 Importing a Guideline XML File

Format Builder includes a feature that lets you import a guideline XML (gXML) file and convert it into a message definition, which you can modify and customize to suit your needs. gXML is an open specification designed to facilitate exchange of e-commerce guidelines for business documents (like purchase orders, invoices and so on) using XML. gXML version 0.71 is supported in this release.

To import a gXML file: 

	
Choose Tools > Import > EDI Importer. The EDI Importer dialog displays.


	
Enter data in the fields as described in the following table:





Table 16-1 EDI Importer Options

	Field	Description
	
gXML File Name

	
Type the complete path and name of the gXML file that you want to import.


	
Browse

	
Click to navigate to the location of the gXML file you want to import.


	
OK Button

	
Imports the gXML file you specified.


	
Cancel Button

	
Closes the dialog and returns to Format Builder without importing.


	
About Button

	
Displays information about the EDI Importer including the version.












16.2 Importing an XML Schema

Format Builder includes a feature that lets you import an XML Schema representing the desired XML representation of your non-XML document. This can provide you with a jump-start on specifying the format of your non-XML document.

To import an XML schema: 

	
Choose Tools > Import > XML Schema Importer. The XML Schema Importer dialog displays.


	
Enter data in the fields as described in the following table:





Table 16-2 XML Schema Importer Options

	Field	Description
	
XML Schema Definition

	
Type the path and name of the file you want to import.


	
Browse

	
Click to navigate to the location of the file you want to import.


	
Root Element

	
This value will be used as the root element in the transformed XML document. This name must comply with XML element naming conventions


	
MFL Field Delimiter Default

	
A delimiter is a character that marks the end of the field. The field data continues until the field containing the delimiter character is encountered.


	
OK Button

	
Imports the XML Schema using the settings you defined.


	
Cancel Button

	
Closes the dialog and returns to Format Builder without importing.












16.3 Importing a COBOL Copybook

Format Builder includes a feature that lets you import a COBOL copybook into Format Builder and create a message definition to transform the COBOL data. When importing a copybook, comments are used to document the imported copybook and the Groups and Fields it contains.

To import a COBOL copybook: 

	
Choose Tools > Import > COBOL Copybook Importer. The COBOL Copybook Importer dialog displays.


	
Enter data in the fields as described in the following tables:





Table 16-3 COBOL Copybook Importer Options

	Field	Description
	
File Name

	
Type the path and name of the file you want to import.


	
Browse

	
Click to navigate to the location of the file you want to import.









Table 16-4 COBOL Copybook Importer Options – Byte Order

	Field	Description
	
Big Endian

	
Select this option to set the byte order to Big Endian.

Note: This option is used for IBM 370, Motorola, and most RISC designs (IBM mainframes and most Unix platforms).


	
Little Endian

	
Select this option to set the byte order to Little Endian.

Note: This option is used for Intel, VAX, and Unisys processors (Windows, VMS, Digital, Unix, and Unisys).









Table 16-5 COBOL Copybook Importer Options – Character Set

	Field	Description
	
EBCDIC

	
Select this option to set the character set to EBCDIC.

Note: These values are attributes of the originating host computer.


	
US-ASCII

	
Select this option to set the character set to US-ASCII.

Note: These values are attributes of the originating host computer.


	
Other

	
The character encoding of the field data.









Table 16-6 COBOL Copybook Importer Options – Action Buttons

	Field	Description
	
OK

	
Imports the COBOL Copybook using the settings you defined.


	
Cancel

	
Closes the dialog and returns to Format Builder without importing.


	
About

	
Displays information about the COBOL Copybook importer including version and supported copybook features.








Once you have imported a copybook, you may work with it as you would any message format definition. If an error or unsupported data type is encountered in the copybook, a message is displayed informing you of the error. You can choose to display the error or save the error to a log file for future reference.






16.4 Importing C Structures

Format Builder includes a C structure importer utility that converts a C structure definition into an MFL Message Definition by generating MFL or C Code output.

	
Section 16.5, "Starting the C Structure Importer"


	
Section 16.6, "Generating MFL Data"


	
Section 16.7, "Generating C Code"









16.5 Starting the C Structure Importer

To start the C Structure Importer:

	
From the Format Builder main window, choose Tools > Import > C Struct Importer. The C Structure Importer dialog displays.


	
The C Structure Importer dialog opens with MFL specified as the default output and contains the following fields.





Table 16-7 C Structure Importer Options – Input

	Field	Description
	
Input File

	
Enter the path and name of the file you want to import. You can also click the Browse button to navigate to the file you want to import.


	
Structure

	
This list box is populated with the list of structures found in the input file after it is parsed.The list box is empty if the input file is not parsed.


	
Parse

	
Click Parse to parse the input file. If successful, the Structure list box is populated with the list of structures found in the input file.









Table 16-8 C Structure Importer Options – Output

	Field	Description
	
Name

	
Specify an existing profile either by entering the file name or using the Browse button.


	
MFL

	
Specifies the data must be compiled on the target computer to generate MFL.


	
C Code

	
Specifies the data must be compiled on the target computer to generate C code.












16.6 Generating MFL Data

Perform the following steps to generate MFL data:

	
Enter a file name in the Input File field, or click Browse to select a file.


	
Click Parse to parse the file.

Upon completion, the Structure list box is populated with the list of structures found in the input file.


	
Select the desired structure from the Structure list box.

At this point, you must provide some profile configuration data to generate the MFL directly. You can do this by creating a new hardware profile, or specifying an existing profile.


	
Specify an existing profile or create a new one by performing one of the following procedures.

	
Specify an existing profile either by entering the file name in the Hardware Profile Name field, or click Browse to select a file. Click Edit to open the hardware profile editor if you need to view or edit the profile parameters.


	
Click New to create a new hardware profile. This opens the Hardware Profile editor loaded with the default parameters. Specify a Profile Name, a description, and modify the primitive data types and byte order to suit your needs.





	
Click OK to save your hardware profile changes and return to the C Structure Importer dialog.


	
Click OK to generate your MFL. If the generation is successful, you are returned to Format Builder with an MFL object listed in the navigation tree. The MFL object reflects the same name as the input file used in the parse operation.

If errors are detected during the generation process, the MFL Generation Errors dialog displays providing you the opportunity to view or file the error log.


	
Click Display Error Log to view any errors encountered, click Save Error Log to save the error log to the location of your choice, or click Cancel to dismiss the MFL Generation Errors dialog box.




Once you have determined what errors were generated, you can return to the C Structure Importer and repeat the prior steps.






16.7 Generating C Code

Perform the following steps to generate C code.

	
Enter a file name in the Input File field, or click Browse to select a file.


	
Click Parse to parse the file.

Upon completion, the Structure list box is populated with the list of structures found in the input file.


	
Select the desired structure from the Structure list box.


	
Select the C Code option button.


	
Enter a file name in either the MFL Gen or Data Gen fields, or click Browse to select a file.


	
Click OK. You will be warned about overwriting existing files and notified about the success or failure of the code generation.


	
Copy the generated source code to the platform in question and compile and execute it.




	
Note:

You must copy the input file containing the structure declarations as well. Both programs, when compiled, take an argument of the output file name.










	
Copy the generated MFL or data back to the platform running Format Builder.









16.8 Importing an FML Field Table Class

The FML Field Table Class Importer facilitates the integration of WebLogic Tuxedo Connector and business process management (BPM) functionality. Tuxedo application buffers are translated to and from XML by the FML to XML Translator that is a feature of WebLogic Tuxedo Connector.

The integration of Tuxedo with BPM functionality requires the creation of the XML that is passed between the WebLogic Tuxedo Connector Translator and the process engine. To create the necessary XML, use the FML Field Table Class Importer and the XML generation feature of Format Tester.



16.8.1 FML Field Table Class Importer Prerequisites

Before starting Format Builder:

	
Move the field tables associated with the FML buffer from the Tuxedo system to the Oracle WebLogic Server/WebLogic Tuxedo Connector environment.


	
Use the weblogic/wtc/jatmi/mkfldclass utility to build Java source code representing the field tables. For information about FML Field Table Administration, see the Oracle WebLogic Server documentation.


	
Compile the source code. The resulting class files are called fldtbl classes because they implement the FldTbl interface. These class must be packaged in a JAR file that can be selected from the FML Field Table Class Importer dialog.




The WLI_HOME\samples\di\fml directory contains several fldtbl class fields that you can use as samples. These samples allow you to start Format Builder without having to completing the previous three steps.




	
Note:

Because most users perform these steps when configuring WebLogic Tuxedo Connector, these class files may already exist.














16.8.2 Sample FML Field Table Class Files

The following table provides a listing and descriptions of the sample files installed for the FML Field Table Class Importer. All files are in the WLI_HOME\samples\di\fml directory.


Table 16-9 FML Field Table Class Sample Files

	Field	Description
	

bankflds.class

	
Compiled source file that serves as input to the FML Field Table Class Importer


	

bankflds.java

	
fldtbl source file generated by the mkfldclass utility


	

crdtflds.class

	
Compiled source file that serves as input to the FML Field Table Class Importer


	

crdtflds.java

	
fldtbl source file generated by the mkfldclass utility


	

tBtest1flds32.class

	
Compiled source file that serves as input to the FML Field Table Class Importer


	

tBtest1flds32.java

	
fldtbl source file generated by the mkfldclass utility












16.8.3 Creating XML with the FML Field Table Class Importer




	
Note:

If you create Java classes using WebLogic Tuxedo Connector, you can place the .class files in the \ext directory. You can then populate the Available Fields list automatically from the FML Field Table Class Importer dialog box.









To create an XML document with the FML Field Table Class Importer: 

	
Choose Tools > Import > EDI Importer. The FML Field Table Class Importer dialog displays.


	
Enter data in the fields as described in the following table:


Table 16-10 FML Field Table Class Importer Options

	Field	Description
	
Fld Table Jar File

	
Click Select to select the JAR file containing the fldtbl classes. After selecting the JAR file, all fldtbl classes are displayed in the Classes list. If the selected JAR file contains no fldtbl classes, an error message is displayed and the Fld Table Jar File and Classes fields are cleared.

The Classes section contains a list of all fldtbl classes for the currently selected JAR file. Because a single FML buffer may contain fields from several field tables, you can select one or more fldtbl class names in the list. All the fields in the selected classes are displayed in the Available Fields list.









Table 16-11 FML Field Table Class Importer Options – FML Field Selector

	Field	Description
	
Available Fields

	
Displays the list of names from the field tables. Select the desired fields from the Available Fields list and click Add.

The Available Fields list does not allow duplicate names. Even if the name of a field appears in different field tables, it is included only once in the list.


	
Selected Fields

	
Displays the list of selected fields.

To remove fields from this list, select the fields and click Remove.









Table 16-12 FML Field Table Class Importer Options – Action Buttons

	Field	Description
	
Add

	
Moves the selected field from the list of Fields Available, to the Selected Fields list.


	
Remove

	
Removes the selected field from the list of Selected Fields, to the Fields Available list.


	
OK

	
Click OK after completing the list of selected fields. The dialog box closes and the name of the generated MFL is added to the Format Builder navigation tree. The selected fields are listed in the order in which they appear in the Selected Fields list.


	
Cancel

	
Closes the dialog and returns to Format Builder without importing.








	
Edit the created MFL document to specify the order and number of occurrences of the fields in the XML document to be passed to the WebLogic Tuxedo Connector FML/XML Translator from business process management (BMP).


	
Choose Tools > Test to display the Format Tester tool.


	
From the Format Tester menu bar, choose Generate > XML to create an XML document that conforms to the MFL document in Format Builder.


	
Edit the data content of the fields in the XML document as desired.


	
From the Format Tester menu bar, choose File > Save XML to save the XML document in a file with a specified name and location.




The created XML can be imported and used in business process management functions by using the XML instance editor. For information about importing XML, see the BPM documentation.
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21 Format Builder Supported Data Types


This chapter describes the data types that Format Builder supports.

This section provides information about the following topics:

	
Section 21.1, "MFL Data Types" – This section lists the supported metadata data types used in non-XML to XML or XML to non-XML conversions.


	
Section 21.2, "COBOL Copybook Importer Data Types" – The Format Builder tool provides a utility for the conversion of COBOL copybooks into MFL files. This section lists the supported COBOL data types that can be converted to metadata data types. (This conversion occurs at design time.)


	
Section 21.3, "Unsupported C Language Features" – The Format Builder tool provides a utility for the conversion of C Structures into MFL files. This section lists the C Language constructs that cannot be converted to metadata data types. (This conversion occurs at design time.)






21.1 MFL Data Types

Table 21-1 lists the MFL data types that data transformer supports. These types are specified in the "type" attribute of a FieldFormat element.


Table 21-1 Supported MFL Data Types

	Data Type	Description
	
Binary (Base64 encoding)

	
Any character value accepted. Requires a length, length field, delimiter, or a delimiter field. Resulting XML data for this field is encoded using base-64.


	
Binary (Hex encoding)

	
Any character value accepted. Requires a length, length field, delimiter, or a delimiter field. Resulting XML data for this field is encoded using base-16.


	
Date: DD-MMM-YY

	
A string defining a date; for example, 22-JAN-00.


	
Date: DD-MMM-YYYY

	
A string defining a date; for example, 22-JAN-2000.


	
Date: DD/MM/YY

	
A string defining a date; for example, 22/01/00.


	
Date: DD/MM/YYYY

	
A string defining a date; for example, 22/01/2000.


	
Date: DDMMMYY

	
A string defining a date; for example, 22JAN00.


	
Date: DDMMMYYYY

	
A string defining a date; for example, 22JAN2000.


	
Date: MM/DD/YY

	
A string defining a date; for example, 01/22/00.


	
Date: MM/DD/YYYY

	
A string defining a date; for example, 01/22/2000.


	
Date: MMDDYY

	
A six digit numeric string defining a date; for example, 012200.


	
Date: MMDDYYYY

	
An eight digit numeric string defining a date; for example, 01222000.


	
Date: MMM-YY

	
A string defining a date; for example, JAN-00.


	
Date: MMM-YYYY

	
A string defining a date; for example, JAN-2000.


	
Date: MMMDDYYYY

	
A string defining a date; for example, JAN222000.


	
Date: MMMYY

	
A string defining a date; for example, JAN00.


	
Date: MMMYYYY

	
A string defining a date; for example, JAN2000.


	
Date: Wed Nov 15 10:55:37 CST 2000

	
The default date format of the Java platform; for example, 'WED NOV 15 10:55:37 CST 2000'


	
Date: YY-MM-DD

	
A string defining a date; for example, 00-01-22. (The string: 00-01-22 defines the date January 22, 2000.)


	
Date: YY/MM/DD

	
A string defining a date; for example, 00/01/22. (The string: 00/01/22 defines the date January 22, 2000.)


	
Date: YYMMDD

	
A string defining a date; for example, 000122. (The string: 000122 defines the date January 22, 2000.)


	
Date: YYYY-MM-DD

	
A string defining a date; for example, 2000-01-22. (The string: 2000-01-22 defines the date January 22, 2000.)


	
Date: YYYY/MM/DD

	
A string defining a date; for example, 2000/01/22. (The string: 2000/01/22 defines the date January 22, 2000.)


	
Date: YYYYMMDD

	
An eight byte numeric string of the format YYYYMMDD. A base data of String or EBCDIC may be specified to indicate the character encoding.


	
DateTime: DD/MM/YY hh:mm

	
A string defining a date and time; for example, 22/01/00 12:24.


	
DateTime: DD/MM/YY hh:mm AM

	
A string defining a date and time; for example, 22/01/00 12:24 AM.


	
DateTime: DD/MM/YY hh:mm:ss

	
A string defining a date and time; for example, 22/01/00 12:24:00.


	
DateTime: DD/MM/YY hh:mm:ss AM

	
A string defining a date and time; for example, 22/01/00 12:24:00 AM.


	
DateTime: MM/DD/YY hh:mm

	
A string defining a date and time; for example, 01/22/00 12:24.


	
DateTime: MM/DD/YY hh:mi AM

	
A string defining a date and time; for example, 01/22/00 12:24 AM.


	
DateTime: MM/DD/YY hh:mm:ss

	
A string defining a date and time; for example, 01/22/00 12:24:00.


	
DateTime: MM/DD/YY hh:mm:ss AM

	
A string defining a date and time; for example, 01/22/00 12:24:00 AM.


	
DateTime: MMDDYYhhmm

	
A string of numeric digits defining a date and time; for example, 0122001224.


	
DateTime: YYYYMMDDhhmmss

	
A fourteen byte numeric string of the format YYYYMMDDHHMISS. A Base data type may be specified.


	
DateTime: MMDDYYhhmmss

	
A string of numeric digits defining a date and time; for example, 012200122400.


	
EBCDIC

	
A string of characters in IBM Extended Binary Coded Decimal Interchange Code. Requires a length, length field, delimiter, or a delimiter field.


	
Filler

	
A sequence of bytes that is not transformed to XML. This field of data is skipped over when transforming non-XML data to XML. When transforming XML to non-XML data, this field is written to the binary output stream as a sequence of spaces.


	
FloatingPoint: 4 bytes, Big-Endian

	
A four byte big endian floating point number that conforms to the IEEE Standard 754.


	
FloatingPoint, 4 bytes, Little-Endian

	
A four byte little endian floating point number that conforms to the IEEE Standard 754.


	
FloatingPoint: 8 bytes, Big-Endian

	
A eight byte big endian floating point number that conforms to the IEEE Standard 754.


	
FloatingPoint: 8 bytes, Little-Endian

	
A eight byte little endian floating point number that conforms to the IEEE Standard 754.


	
Integer: Signed, 1 byte

	
A one byte signed integer; for example, '56' is 0x38.


	
Integer: Unsigned, 1 byte

	
A one byte unsigned integer; for example, '128' is 0x80.


	
Integer: Signed, 2 byte, Big-Endian

	
A signed two-byte integer in big endian format; for example, '4660' is 0x1234.


	
Integer: Signed, 4 byte, Big-Endian

	
A signed four-byte integer in big endian format; for example, '4660' is 0x00001234.


	
Integer: Signed, 8 bytes, Big-Endian

	
A signed eight-byte integer in big endian format; for example, '4660' is 0x0000000000001234.


	
Integer: Unsigned, 2 byte, Big-Endian

	
An unsigned two-byte integer in big endian format; for example, '65000' is 0xFDE8.


	
Integer: Unsigned, 4 byte, Big-Endian

	
An unsigned four-byte integer in big endian format; for example, '65000' is 0x0000FDE8.


	
Integer: Unsigned, 8 bytes, Big-Endian

	
A unsigned eight-byte integer in big endian format; for example, '65000' is 0x000000000000FDE8.


	
Integer: Signed, 2 bytes, Little-Endian

	
A signed two-byte integer in little endian format; for example, '4660' is 0x3412.


	
Integer: Signed, 4 bytes, Little-Endian

	
A signed four-byte integer in little endian format; for example, '4660' is 0x34120000.


	
Integer: Signed, 8 bytes, Little-Endian

	
A signed eight-byte integer in little endian format; for example, '4660' is 0x3412000000000000.


	
Integer: Unsigned, 2 bytes, Little-Endian

	
An unsigned two-byte integer in little endian format; for example,'65000' is 0xE8FD.


	
Integer: Unsigned, 4 bytes, Little-Endian

	
An unsigned four-byte integer in little endian format; for example, '65000' is 0xE8FD0000.


	
Integer: Unsigned, 8 bytes, Little-Endian

	
A unsigned eight-byte integer in little endian format; for example, '65000' is 0xE8FD000000000000.


	
Literal

	
A literal value determined by the contents of the value attribute. When non-XML data is transformed to XML, the presence of the specified literal in the non-XML data is verified by WLXT. The literal is read, but is not transformed to the XML data. When XML data is transformed to a non-XML format, and a literal is defined as part of the non-XML format, WLXT writes the literal in the resulting Non-XML byte stream.


	
Numeric

	
A string of characters containing only digits; for example, '0' through '9'. Requires a length, length field, delimiter, or a delimiter field.


	
Packed Decimal: Signed

	
IBM signed packed format. Requires a length, length field, delimiter, or a delimiter field to be specified. The length or length field should specify the size of this field in bytes.


	
Packed Decimal: Unsigned

	
IBM unsigned packed format. Requires a length, length field, delimiter, or a delimiter field to be specified. The length or length field should specify the size of this field in bytes.


	
String

	
A string of characters. Requires a length, a length field, a delimiter, or a delimiter field. If no length, length field, or delimiter is defined for a data type String, a delimiter of "\x00" (a NUL character) will be assumed.


	
String: NUL terminated

	
A string of characters, optionally NUL (\x00) terminated, residing within a fixed length field. This field type requires a length attribute or length field which determines the amount of data read for the field. This data is then examined for a NUL delimiter. If a delimiter is found, data following the delimiter is discarded. If a NUL delimiter does not exist, the fixed length data is used as the value of the field.


	
Time: hhmmss

	
A string defining a time; for example, 122400.


	
Time: hh:mm AM

	
A string defining a time; for example, 12:24 AM.


	
Time: hh:mm

	
A string defining a time; for example, 12:24.


	
Time: hh:mm:ss AM

	
A string defining a time; for example, 12:24:00 AM.


	
Time: hh:mm:ss

	
A string defining a time; for example, 12:24:00.


	
Zoned Decimal: Leading sign

	
Signed zoned decimal format (US-ASCII or EBCDIC) where the sign indicator is in the first nibble. Requires a length, length field, delimiter, or a delimiter field to be specified. The length or length field should specify the size of this field in bytes.

Note: This data type is supported with US-ASCII data only with Message Format Language Version 2.02


	
Zoned Decimal: Leading separate sign

	
Signed zoned decimal format (US-ASCII or EBCDIC) where the sign indicator is in the first byte. The first byte only contains the sign indicator and is separated from the numeric value. Requires a length, length field, delimiter, or a delimiter field to be specified. The length or length field should specify the size of this field in bytes.

Note: This data type is supported with US-ASCII data only with Message Format Language Version 2.02.


	
Zoned Decimal: Signed

	
Signed zoned decimal format (US-ASCII or EBCDIC). Requires a length, length field, delimiter, or a delimiter field to be specified. The length or length field should specify the size of this field in bytes.

Note: This data type is supported with US-ASCII data only with Message Format Language Version 2.02.


	
Zoned Decimal: Trailing separate sign

	
Signed zoned decimal format (US-ASCII or EBCDIC) where the sign indicator is in the last byte. The last byte only contains the sign indicator and is separated from the numeric value. Requires a length, length field, delimiter, or a delimiter field to be specified. The length or length field should specify the size of this field in bytes.

Note: This data type is supported with US-ASCII data only with Message Format Language Version 2.02.


	
Zoned Decimal: Unsigned

	
Unsigned zoned decimal format (US-ASCII or EBCDIC). Requires a length, length field, delimiter, or a delimiter field to be specified. The length or length field should specify the size of this field in bytes.

Note: This data type is supported with US-ASCII data only with Message Format Language Version 2.02.












21.2 COBOL Copybook Importer Data Types

Table 21-2 lists the COBOL data types and the support provided by the Importer. Support for these data types is limited. The following formats:


05 pic 9(5) comp-5
05 pic 9(5) comp-x


will be converted to an unsigned 4 byte integer type, while the following will generate errors:


05 pic X(5) comp-5
05 pic X(5) comp-x


In these samples, pic9(5) could be substituted for pic x(5).


Table 21-2 COBOL Data Types

	COBOL Type	Support
	
BLANK WHEN ZERO (zoned)

	
supported


	
COMP-1, COMP-2 (float)

	
supported


	
COMP-3, PACKED-DECIMAL

	
supported


	
COMP, COMP-4, BINARY (integer)

	
supported


	
COMP, COMP-4, BINARY (fixed)

	
supported


	
COMP-5, COMP-X

	
supported


	
DISPLAY (alphanumeric)

	
supported


	
DISPLAY numeric (zoned)

	
supported


	
edited alphanumeric

	
supported


	
edited float numeric

	
supported


	
edited numeric

	
supported


	
group record

	
supported


	
INDEX

	
supported


	
JUSTIFIED RIGHT

	
ignored


	
OCCURS (fixed array)

	
supported


	
OCCURS DEPENDING (variable-length)

	
supported


	
OCCURS INDEXED BY

	
ignored


	
OCCURS KEY IS

	
ignored


	
POINTER

	
supported


	
PROCEDURE-POINTER

	
supported


	
REDEFINES

	
supported


	
SIGN IS LEADING SEPARATE (zoned)

	
supported


	
SIGN IS TRAILING (zoned)

	
supported


	
SIGN IS TRAILING SEPARATE (zoned)

	
supported


	
SIGN IS LEADING (zoned)

	
supported


	
SYNCHRONIZED

	
ignored


	
66 RENAMES

	
not supported


	
66 RENAMES THRU

	
not supported


	
77 level

	
supported


	
88 level (condition)

	
ignored








The following values are defined as follows:

	
Supported - the data type will be correctly parsed by the importer and converted to a message format field or group.


	
Unsupported - this data type is not supported and the importer reports an error when the copybook is imported.


	
Ignored - the data type is parsed and a comment is added to the message format. No corresponding field or group is created.




Some vendor-specific extensions are not recognized by the importer, however, any copybook statement that conforms to ANSI standard COBOL will be parsed correctly by the Importer. The Importer's default data model, which is based on the IBM mainframe model, can be changed in Format Builder to compensate for character set and data "endianness".

When importing copybooks, the importer may identify fields generically that, upon visual inspection, could easily be identified by a more specific data type. For this reason, the copybook importer creates comments for each field found in the copybook. This information is useful in assisting you in editing the MFL data to better represent the original Copybook. For example:

original copybook entry:


05 birth-date    picxx/xx/xx


results in:

A field of type EBCDIC with a length of 8

Closer inspection indicates that this is intended to be a date format and could be defined as

A field of type Date: MM/DD/YY or a field of type Data: DD/MM/YY






21.3 Unsupported C Language Features

The C struct Importer utility does not parse files containing anonymous unions, bit fields, or in-line assembler code. The following samples of unsupported features are taken from the preprocessor output of a hello.c file that contained a #include <windows.h> statement:

	
Anonymous unions


#line 353 "e:\\program files\\microsoft visual studio\\vc98\\include\\winnt.h"
typedef union_LARGE_INTEGER{
  struct {
    DWORD LowPart;
    LONG HighPart;
  };
  struct {
    DWORD LowPart;
    LONG HighPart;
  } u;
#line 363 "e:\\program files\\microsoft visual studio\\vc98\\include\\winnt.h"
    LONGLONG QuadPart;
} LARGE_INTEGER


	
Bit fields


typedef struct_LDT_ENTRY {
  WORD LimitLow;
  WORD BaseLow;
  union {
    struct {
      BYTE BaseMid;
      BYTE Flags1;
      BYTE Flags2;
      BYTE BaseHi;
    } Bytes;
    struct
      DWORD BaseMid : 8;
      DWORD Type : 5;
      DWORD Dpl : 2;
      DWORD Pres : 1;
      DWORD LimitHi : 4;
      DWORD Sys : 1;
      DWORD Reserved_0 : 1;
      DWORD Default_Big : 1;
      DWORD Granularity : 1;
      DWORD BaseHi : 8;
    } Bits;
  } HighWord;
} LDT_ENTRY, *PLDT_ENTRY;


	
Inline assembler code


_inline ULONGLONG
_stdcall
Int64ShrlMod32(
  ULONGLONG Value,
  DWORD ShiftCount
  )
{
  _asm {
   mov ecx, ShiftCount
   mov eax, dword ptr [Value]
   mov edx, dword ptr [Value+4]
   shrd eax, edx, cl
   shr edx, cl
  }
}
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24 Oracle SOA Suite Transport (SOA-DIRECT)


This chapter provides an overview of the SOA-DIRECT transport and describes how to use and configure it in your services.

Oracle Service Bus provides a SOA-DIRECT transport that lets you invoke Oracle SOA Suite service components, such as BPEL processes, human tasks, rules, and Oracle Mediator components.




	
Note:

The SOA-DIRECT transport is for communicating with Oracle SOA Suite 11g and later service components. Oracle Service Bus provides a bpel-pm transport to communicate with Oracle SOA Suite 10g Release 3. For information on that transport, see Chapter 34, "Oracle BPEL Process Manager Transport (for use with Oracle SOA Suite 10g only)."









This chapter includes the following sections:

	
Section 24.1, "About the SOA-DIRECT Transport"


	
Section 24.2, "Using SOA Suite Services with Oracle Service Bus"


	
Section 24.3, "Transport Configuration Reference"


	
Section 24.4, "WS-Addressing Reference"


	
Section 24.5, "XML Examples"






24.1 About the SOA-DIRECT Transport

The SOA-DIRECT transport provides native connectivity between Oracle Service Bus and Oracle SOA Suite service components. Oracle SOA Suite provides a "direct binding" framework that lets you expose Oracle SOA Suite service components in a composite application, and the Oracle Service Bus SOA-DIRECT transport interacts with those exposed services through the SOA direct binding framework, letting those service components interact in the service bus layer and leverage the capabilities and features of Oracle Service Bus.

For more information on SOA binding components, see "Getting Started with Binding Components" and "Using the Direct Binding Invocation API" in the Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.




	
Note:

The SOA-Direct transport supports WSDL type services with SOAP 1.1, SOAP 1.2, or, alternatively, XML bindings. The SOA direct binding framework only exposes direct binding services as WSDL with SOAP 1.1 and SOAP 1.2 bindings, not XML. However, if you want to use an XML binding, you must manually customize the imported SOA service WSDLs for the direct binding services. An XML binding has no effect on the message payload, since messages between the SOA-DIRECT transport and SOA binding components are always abstract (no binding).









The SOA-DIRECT transport supports the following features:

	
Invocation of any SOA binding component services through Java remote method invocation (RMI)


	
WS-Addressing, including optional auto-generation of ReplyTo properties for asynchronous callbacks


	
Identity propagation


	
Transaction propagation


	
Attachments


	
Optimized RMI transport for invoking SOA services


	
High availability and clustering support


	
Failover and load balancing (not available for services in the Service Callback role


	
Connection and application retries on errors






24.1.1 WS-Addressing

The SOA-DIRECT transport uses only WS-Addressing for message correlation in synchronous and asynchronous communications. The transport automatically generates the following WS-Addressing properties in the SOAP header when you configure a callback proxy in the business service configuration:

	
ReplyTo – For setting the callback address and connection details in asynchronous callbacks.


	
ReferenceParameters – Contains the callback properties for ReplyTo, including JNDI and connection factory properties, for the following supported WS-Addressing versions:

	
http://www.w3.org/2005/08/addressing


	
http://schemas.xmlsoap.org/ws/2004/08/addressing





	
ReferenceProperties – Contains the callback properties for ReplyTo, including JNDI and connection factory properties, for the following supported WS-Addressing version: http://schemas.xmlsoap.org/ws/2003/03/addressing.




For ReplyTo and ReferenceParameters examples, see Section 24.4, "WS-Addressing Reference."

For all other WS-Addressing properties, you must add or transform them in Oracle Service Bus proxy service message flows if they are not available or suitable for pass-through to the SOA-DIRECT business service.

If you use correlation and callback mechanisms other than WS-Addressing, you must transform messages in proxy service pipelines to support WS-Addressing between Oracle Service Bus and SOA framework service components.

For WS-Addressing examples with the SOA-DIRECT transport, see Section 24.4, "WS-Addressing Reference" and Section 24.5, "XML Examples."






24.1.2 Security

The SOA-DIRECT transport supports one-way SSL. To use SSL, enable SSL in the domain, use the secure protocol in the endpoint URI, such as HTTPS, iiops, or t3s, and reference the secure port in the URI. For more information on the SOA-DIRECT URI, see Section 24.3.1, "SOA-DIRECT Endpoint URI."

You can provide identity propagation with the SOA-DIRECT transport by passing the caller's subject through the service or with a service account bound to the service. Because the SOA-DIRECT transport deals with only normalized, abstract messages, the transport does not support WS-Security. For more information on security settings, see Section 24.3.2, "SOA-DIRECT Transport Configuration for Business Services."






24.1.3 Environment Values

The SOA-DIRECT transport stores the following environment values for SOA-DIRECT services:

	
JNDI Service Account (security category)


	
Pass Caller's Subject (security category)


	
Invocation Service account (security category)


	
Work Manager (environment category)




For information on these values, see Section 24.3.2, "SOA-DIRECT Transport Configuration for Business Services."






24.1.4 Error Handling

The SOA-DIRECT transport recognizes connection and application errors, letting you configure the appropriate retry settings in the transport configuration. The transport throws generic errors for errors that are neither connection nor application related.



24.1.4.1 Connection Errors

The SOA-DIRECT transport raises connection errors in the following situations:

	
The target service does not exist


	
A naming exception occurs during the RMI lookup or invocation (with the exception of javax.naming.NamingSecurityException, which is a generic error).


	
A remote exception occurs during the RMI lookup or invocation.









24.1.4.2 Application Errors

The SOA-DIRECT transport raises application errors when the outbound business service receives a SOAP fault.

You can deselect Retry Application Errors on the service configuration page to prevent retries on application errors—errors that are likely to keep failing despite retries.






24.1.4.3 Generic Errors

The SOA-DIRECT transport raises a generic error in the following situations:

	
All errors other than connection and application errors.


	
A javax.naming.NamingSecurityException, which is thrown during the JNDI lookup, is not considered a connection error as are other naming exceptions.













24.2 Using SOA Suite Services with Oracle Service Bus

This section describes synchronous and asynchronous communication patterns between Oracle Service Bus and Oracle SOA Suite composites.



24.2.1 Simple Use Cases – Synchronous

This section describes the simple, most common use cases for communicating natively to and from SOA composites through Oracle Service Bus: synchronous communication.



24.2.1.1 Synchronous Invocation of a SOA Composite

The Oracle Service Bus SOA-DIRECT transport can invoke any component in a SOA composite that is exposed as a direct binding service.

Figure 24-1 illustrates a synchronous communication pattern between a client and an Oracle SOA service component through Oracle Service Bus using a SOA-DIRECT business service and direct binding service.


Figure 24-1 Client Invoking a SOA Binding Service Synchronously

[image: Description of Figure 24-1 follows]







24.2.1.1.1 Creating and Configuring the Services

Use the following guidelines to invoke an Oracle SOA direct binding service from a client through Oracle Service Bus:

	
Create a SOA-DIRECT business service in Oracle Service Bus that represents the SOA service component you want to invoke.

	
In Oracle Service Bus, create a WSDL resource based on the corresponding Oracle SOA direct binding service WSDL.

You can locate the SOA direct binding service WSDL in Oracle JDeveloper using the SOA Resource Browser, as described in "Developing SOA Composite Applications with Oracle SOA Suite" in the Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.


	
Create a new business service.


	
Select WSDL Web Service as the Service Type.


	
Select the WSDL resource you created, and choose the appropriate port or binding.




	
Note:

If you select the port, the transport type and URI will be automatically propagated in the next configuration page.










	
Select the soa-direct transport in the business service configuration.


	
Set the endpoint URI as described in Section 24.3.1, "SOA-DIRECT Endpoint URI."


	
Configure the remainder of the business service, described in Section 24.3.2, "SOA-DIRECT Transport Configuration for Business Services."





	
Create a proxy service in Oracle Service Bus that invokes the business service. Choose the transport type that is used by the client. For proxy configuration details, see Section 4.3, "Proxy Service Configuration" and Chapter 3, "Transport Configuration."




If you are using stateful services to ensure that messages are associated with the correct conversation, see Section 24.2.1.3, "Associating Messages with the Correct Conversation."








24.2.1.2 Synchronous Invocation from a SOA Composite

A SOA composite can invoke any Oracle Service Bus SB WSDL-based proxy service. To invoke an SB proxy service, the SOA service component must use a direct binding reference of Target Type "Oracle Service Bus." (For more information on target types, see the Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.)

Table 24-0 illustrates a synchronous communication pattern between an Oracle SOA service component and an external service through Oracle Service Bus.


Figure 24-2 SOA Binding Service Invoking an External Service Synchronously

[image: Description of Figure 24-2 follows]







24.2.1.2.1 Creating and Configuring the Services

Use the following guidelines to invoke an external service from a SOA composite using direct binding references:

	
Create a business service in Oracle Service Bus that represents the external service you want to invoke. Choose the transport type that is supported by this service. For business service configuration details, see Section 4.2, "Business Service Configuration." and Chapter 3, "Transport Configuration."


	
Create an SB proxy service in Oracle Service Bus that invokes the business service.

	
Create a WSDL resource to be used by the proxy that invokes the business service.


	
Create a new proxy service.


	
Select WSDL Web Service as the Service Type.


	
Select the WSDL for the proxy service, and select the desired port or binding.


	
Select the sb transport in the proxy service configuration.


	
Configure the remainder of the proxy service. For more information, see Section 4.3, "Proxy Service Configuration" and Chapter 27, "SB Transport."







	
Note:

Use the SB proxy service effective WSDL and port type to define the direct binding reference that invokes Oracle Service Bus. You can import this WSDL into an Oracle SOA Suite project.












If you are using stateful services, ensure that messages are associated with the correct conversation. See Section 24.2.1.3, "Associating Messages with the Correct Conversation."








24.2.1.3 Associating Messages with the Correct Conversation

When using stateful services, the messages sent synchronously between Oracle Service Bus and Oracle SOA composites are known as a conversation. To ensure that messages are correctly associated with each other as part of a conversation, the Oracle Service Bus SOA-DIRECT transport provides built-in support for WS-Addressing.

For more information on WS-Addressing, see Section 24.4.2, "MessageID / RelatesTo Headers." For an example of conversation ID setting, see Section 24.5.1, "Conversation ID Examples."








24.2.2 Advanced Use Cases – Asynchronous

This section describes asynchronous communications between a SOA composite and Oracle Service Bus using the SOA-DIRECT transport.




	
Note:

Only the following SOA service components currently support asynchronous conversations using WS-Addressing: BPEL Process, Mediator, and Human Task.











24.2.2.1 Asynchronous Invocation of a SOA Composite

The Oracle Service Bus SOA-DIRECT transport can invoke asynchronous SOA service components that are exposed as direct binding services.

Figure 24-3 illustrates an asynchronous communication pattern between a client and an Oracle SOA composite through Oracle Service Bus using a direct binding service, the SOA-DIRECT transport, and the SB transport.


Figure 24-3 Client Invoking a SOA Binding Service Asynchronously

[image: Description of Figure 24-3 follows]







24.2.2.1.1 Creating and Configuring the Services

Use the following guidelines to invoke the SOA direct binding service asynchronously from a client through Oracle Service Bus:

	
On the inbound client side, create the Oracle Service Bus artifacts to interact with the client: a request proxy service that invokes the outbound SOA-DIRECT business service, and a callback business service that handles the callback to the client. Use the transport type used by the client.

	
Request Proxy Service

Configure the proxy service that receives the client request. This proxy service invokes the outbound request SOA-DIRECT business service.

Since the callback is sent to a different connection, Oracle Service Bus must be able to remember the original callback location when calling back the client. When using WS-Addressing, the callback address is sent to the request proxy service in the ReplyTo address header. Before invoking the SOA-DIRECT business service, the request proxy can pass this address as a referenceParameter property inside the ReplyTo header. Following the WS-Addressing specification, the referenceParameter property is inserted in the SOAP header block of the callback. The callback SB proxy can then extract this callback address and set the callback business service URI.

For information on setting a callback address, see Section 24.4.1, "ReplyTo Header" and Section 24.5.2, "Asynchronous Composite to Composite Native Communication Through Oracle Service Bus Example."


	
Callback Business Service

Configure the business service you need to handle the callback. This business service is invoked by the outbound callback SB proxy service.

For service and transport configuration guidance, see Section 4.2, "Business Service Configuration" and Chapter 3, "Transport Configuration".





	
On the Oracle Service Bus outbound side, create the artifacts to interact with the SOA composite: a request SOA-DIRECT business service that makes the request to the Oracle SOA direct binding service exposing the asynchronous service component you want to invoke, and a callback SB proxy service that handles the callback from the direct binding service and invokes the inbound callback business service.

	
Request SOA-DIRECT Business Service

	
In Oracle Service Bus, create a WSDL resource based on the corresponding Oracle SOA direct binding service WSDL.

You can locate the SOA direct binding service WSDL in Oracle JDeveloper using the SOA Resource Browser, as described in "Developing SOA Composite Applications with Oracle SOA Suite" in the Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.


	
Create a new business service.


	
Select WSDL Web Service as the Service Type. Browse to the WSDL resource you created and select the appropriate port or binding for the direct binding service.

If you select the port, the transport type and URI are automatically propagated in the next configuration page.


	
Select the soa-direct transport in the business service configuration.


	
Set the URI, described in Section 24.3.1, "SOA-DIRECT Endpoint URI."


	
On the transport configuration page, set the Role to Asynchronous Client.


	
Optionally use the Callback Proxy option to select the SB callback proxy service you created.

When you select a callback proxy, the SOA-DIRECT transport automatically generates the WS-Addressing headers to tell the SOA direct binding service that it expects the asynchronous callback response to be sent to the specified callback proxy.

For approaches to setting a callback address if you do not select a callback proxy in the SOA-DIRECT business service, see Section 24.4, "WS-Addressing Reference" and Section 24.5.2, "Asynchronous Composite to Composite Native Communication Through Oracle Service Bus Example."


	
Configure the remainder of the business service. For more information, see Section 24.3, "Transport Configuration Reference" and Section 4.2, "Business Service Configuration."


	
Invoke this business service from the request proxy service.








	
Callback SB Proxy Service

	
Create a new proxy service.


	
Select WSDL Web Service as the Service Type.


	
Browse to the WSDL corresponding to direct binding service's WSDL, and select the appropriate port or binding.


	
Select the sb transport in the proxy service configuration.


	
Complete the proxy service configuration. For more information, see Section 4.3, "Proxy Service Configuration" and Chapter 27, "SB Transport."














24.2.2.2 Asynchronous Invocation from a SOA Composite

An asynchronous SOA service component in a SOA composite can invoke external services through Oracle Service Bus. To do so, the SOA service component must use a direct binding reference of Target Type of "Oracle Service Bus." (For more information on target types, see the Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.)

Figure 24-4 illustrates an asynchronous communication pattern between an Oracle SOA service component and an external service through Oracle Service Bus using a direct binding reference, the SB transport, and the SOA-DIRECT transport.


Figure 24-4 SOA Binding Service Invoking an External Service Asynchronously

[image: Description of Figure 24-4 follows]







24.2.2.2.1 Creating and Configuring the Services

Use the following guidelines to invoke an external service asynchronously from an Oracle SOA direct binding reference through Oracle Service Bus.

	
In Oracle Service Bus, on the inbound side, create the artifacts to interact with the SOA composite: a request SB proxy service that receives the SOA direct binding reference request and a callback SOA-DIRECT business service that handles the callback to the SOA direct binding reference.

	
Request SB Proxy Service

	
Create a WSDL resource representing the interface used to interact with the direct binding reference.


	
Create a new proxy service.


	
Select WSDL Web Service as the Service Type.


	
Browse to the WSDL you created and select the appropriate port or binding.


	
Select the sb transport in the proxy service configuration page.


	
Complete proxy service configuration. For more information, see Section 4.3, "Proxy Service Configuration" and Chapter 27, "SB Transport."

Since the callback is sent to a different connection, Oracle Service Bus must be able to "remember" the original callback location when calling back the client. When using WS-Addressing, the callback address is sent to the request proxy service in the ReplyTo address header. Before invoking the external service, the request proxy service passes this address as a referenceParameter property inside the ReplyTo header. Following the WS-Addressing specification, the referenceParameter property is inserted in the SOAP header block of the callback. The callback proxy service can then extract this callback address and set the callback business service URI.

For information on setting a callback address, see Section 24.4.1, "ReplyTo Header" and Section 24.5.2, "Asynchronous Composite to Composite Native Communication Through Oracle Service Bus Example."





	
Callback Business Service

	
Create a new business service.


	
Select WSDL Web Service as the Service Type.


	
Browse to the WSDL representing the callback interface with the direct binding reference, and select the appropriate port or binding.


	
Select the soa-direct transport in the business service configuration.


	
Set the service URI to "callback," as described in Section 24.3.1, "SOA-DIRECT Endpoint URI."

In general, the callback URI is dynamically set in the invoking proxy using URI rewriting. However, if the callback address is always known, you can provide the exact callback address instead of "callback."


	
Set the role to Service Callback on the SOA-DIRECT transport configuration page.


	
Configure the remainder of the business service, as described in Section 24.3.2, "SOA-DIRECT Transport Configuration for Business Services" and Section 4.2, "Business Service Configuration."








	
On the Oracle Service Bus outbound side, create the artifacts to interact with the external service: a request business service that makes the request to the external service and a callback proxy service that handles the callback from this service.

	
Request Business Service

Configure the business service to invoke the external service. This business service will be invoked by the request SB proxy service. Choose the transport type that is supported by this service. For business service configuration details, see Section 4.2, "Business Service Configuration" and Chapter 3, "Transport Configuration."


	
Callback Proxy Service

Configure the proxy service to pass the callback address to the business service. The callback URI is provided in the request. Use URI rewriting to extract the callback URI and forward it to the SOA-DIRECT business service. Choose the transport type that is supported by this service. For proxy service configuration details, see Section 4.3, "Proxy Service Configuration" and Chapter 3, "Transport Configuration."

For information on setting the callback addresses using WS-Addressing, see Section 24.4, "WS-Addressing Reference."


















24.3 Transport Configuration Reference

This section describes the endpoint URL format and configuration options for the SOA-DIRECT transport.



24.3.1 SOA-DIRECT Endpoint URI

Following is the URI pattern for the SOA-DIRECT transport. Optional elements are in brackets [].

callback – This is the URI for SOA-DIRECT business services in the Service Callback role handling the inbound request. The actual URI is specified dynamically at runtime in the proxy service pipeline. However, if the callback address is always known, you can provide the exact callback address.

For all other SOA-DIRECT business service roles:

[protocol://authority]/default/compositeName[!versionNumber[*label]]/serviceName

	
protocol

Use one of the following RMI / JNDI protocols:

	
iiop / iiops – For generic, server-agnostic use.


	
t3 / t3s – For use with Oracle WebLogic Server.


	
http / https – For tunneling and use with Oracle WebLogic Server.

For HTTP(S) protocols, enable HTTP tunneling on the server. For SSL protocols, enable SSL on the server.




The protocol and authority are optional when the SOA services are co-located on the same server as Oracle Service Bus.




Following are descriptions of the other endpoint URI elements:

	
authority – The IP address or host name and the port of the SOA server or cluster hosting the SOA service components.

The protocol and authority are optional when the SOA services are co-located on the same server as Oracle Service Bus.


	
default – This domain name value is always "default."


	
compositeName – The name of the composite application where the binding component service is defined.


	
!versionNumber – Optional. The composite application version number. If you do not specify a version, the current version is used.

	
*label – Optional, used with !versionNumber; the label hash used in the SOA service WSDL.





	
serviceName – The name of the SOA binding component service.




While you can specify more than one URI on a service for load balancing and failover, only one URI is allowed for services in the Service Callback role, described in Table 24-1. Therefore, load balancing and failover are not available for services in the Service Callback role.



24.3.1.1 Cluster URI

Following is the format for the endpoint URI in a cluster:

t3://example_managed1:port1,example_managed2:port2/service_path

Where t3://example_managed1:port1,example_managed2:port2 is the JNDI provider URL.






24.3.1.2 URI Examples

Following are URI examples for the SOA-DIRECT transport:

	
t3s://example:7002/default/compositeApp/1.0/myService

Points to a service deployed on a single node.


	
/default/compositeApp!1.0/myService

Points to a service co-located on the same server as Oracle Service Bus.


	
t3://soaserver.example.com:7001/default/VacationRequest!1.0*ec2dd6c5-1667-4885-a634-2364547beb2d/directclient

Points to a service deployed on a single node using a version and hash code. This is the default format in SOA binding component service WSDLs.


	
t3://example_managed1:8001,example_managed2:8002/default/myComposite/myService

Points to a clustered SOA framework environment identified by "myService." Because no specific version is specified, the most recent version of the service is used.











24.3.2 SOA-DIRECT Transport Configuration for Business Services

Table 24-1 describes the transport-specific configuration options for the SOA-DIRECT transport.


Table 24-1 SOA-DIRECT Transport Configuration

	Property	Description
	
JNDI Service Account

	
Optional. Specifies the security credentials for the JNDI lookup of the target SOA service. The service account must be static. Click Browse and select a service account. If you do not specify a service account, an anonymous subject is used.


	
Role

	
Required. Identifies the communication pattern the service uses. Select one of the following options:

	
Synchronous Client (default) – In this role, because there is no asynchronous callback, the Callback Proxy option is disabled. The WS-Addressing Version option is also disabled.


	
Asynchronous Client – In this role, because asynchronous callback is usually required, you can identify a Callback Proxy, and you must select a WS-Addressing Version. The asynchronous option is enabled only when the WSDL service is of type SOAP.


	
Service Callback – This role is for returning the asynchronous callback to a SOA service after an external service invocation.




Load balancing or failover are not available for services in the Service Callback role.


	
Callback Proxy

	
Optional. Enabled only for the Asynchronous Client role.

This option lets you specify the proxy service that receives callbacks. When you select a callback proxy, if no WS-Addressing is provided by the request or the proxy service pipeline, Oracle Service Bus automatically populates the ReplyTo property in the SOAP header. You must select a WSDL proxy service that uses the SB transport (for RMI), and the callback proxy service must understand WS-Addressing.

WS-Addressing properties that are sent in the request or set in the proxy service pipeline are used instead of the callback proxy you set in this option.

If you do not specify a Callback Proxy, and the request does not contain ReplyTo properties, you must provide ReplyTo properties in the SOAP header through the proxy service pipeline.


	
Fault Proxy

	
This option is not currently supported. You must configure your callback services to handle faults in an asynchronous pattern.


	
WS-Addressing Version

	
Required. Enabled only for the Asynchronous Client role.

Specify the default WS-Addressing version to use when no WS-Addressing is provided in the request or the proxy service pipeline. WS-Addressing properties that are sent in the request or set in the proxy service pipeline are used instead of the WS-Addressing version you set in this option.

For WS-Addressing version mismatches between environments, perform any necessary transformations in the proxy service pipeline. For more information, see Section 24.5.1.4, "Transformation Examples."


	
Dispatch Policy

	
Select the instance of Oracle WebLogic Server Work Manager that you want to use for the dispatch policy for this endpoint. The default Work Manager is used if no other Work Manager exists.

For information about Work Managers, see:

	
"Using Work Managers to Optimize Scheduled Work" in Oracle Fusion Middleware Configuring Server Environments for Oracle WebLogic Server


	
"Using Work Managers with Oracle Service Bus" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus





	
Pass Caller's Subject

	
Optional. Select this option to have Oracle Service Bus pass the authenticated subject from the proxy service when invoking the SOA service. The Invocation Service Account option, an alternative to Pass Caller's Subject, is disabled when you select this option.

Note: Make sure that domain trust is enabled between client and target server if they are in different domains. For more information, see "Important Information Regarding Cross-Domain Security Support" in Oracle Fusion Middleware Securing Oracle WebLogic Server.


	
Invocation Service Account

	
Optional. Alternative to Pass Caller's Subject, which lets you specify custom security credentials by selecting a service account for RMI invocation. You can specify any type of service account (Pass Through, Static, Mapping).

Click Browse and select a service account. If you do not specify a service account, an anonymous subject is used.














24.4 WS-Addressing Reference

This section describes specific WS-Addressing properties that the SOA-DIRECT transport uses to communicate natively with an Oracle SOA composite. This section also describes ways to provide callback addresses in asynchronous communication, as described in Section 24.2.2, "Advanced Use Cases – Asynchronous."

See Section 24.5, "XML Examples" for WS-Addressing examples.



24.4.1 ReplyTo Header

In an asynchronous communication, a service callback is sent on a different connection than the request. As a service developer, you must supply the correct callback address in an asynchronous exchange so that the callback is sent to the correct client. When using the SOA-DIRECT transport with WS-Addressing correlation, the callback address is specified in the "ReplyTo" WS-Addressing header.



24.4.1.1 Calling a SOA Composite Asynchronously with a SOA-DIRECT Business Service

The SOA-DIRECT business service can optionally generate the ReplyTo header. In the business service configuration, if you select a Callback Proxy to handle the callback, the SOA-DIRECT transport sets the correct callback address corresponding to this callback proxy in the ReplyTo header. This header is generated only if the incoming message does not already contain a ReplyTo header.

For more information, see Section 24.2.2.1, "Asynchronous Invocation of a SOA Composite."






24.4.1.2 Calling Back to a SOA Composite Asynchronously with a SOA-DIRECT Business Service

When calling an external service from an Oracle SOA composite through Oracle Service Bus, you must manually set a callback address. To do this, set the callback address as the ReplyTo value in the proxy service that invokes the callback SOA-DIRECT business service.

For more information, see Section 24.2.2.2, "Asynchronous Invocation from a SOA Composite."








24.4.2 MessageID / RelatesTo Headers

MessageID and RelatesTo WS-Addressing headers are used to store the conversation ID in conversations between Oracle Service Bus and Oracle SOA service components, ensuring related messages remain in the same conversation.

Unlike ReplyTo, the SOA-DIRECT transport does not provide built-in support for the MessageID or RelatesTo headers. Instead, you must set the correct values for those headers in the pipeline of the proxy service that invokes a SOA-DIRECT business service.

The following describe when MessageID and RelatesTo headers are used in synchronous and asynchronous conversations:

	
Synchronous conversation: The MessageID header value determines the conversation ID in the initial request. Then, for subsequent requests within the same conversation, the conversation ID must be provided in the RelatesTo header.


	
Asynchronous callbacks - The MessageID header value determines the conversation ID in the initial request. Then, for the callback, the conversation ID must be provided in the RelatesTo header.




For more implementation on establishing a conversation ID to make sure messages participate in the correct conversation, see Section 24.2.1.3, "Associating Messages with the Correct Conversation" and the Section 24.5.1, "Conversation ID Examples."








24.5 XML Examples

Following are examples of XML messaging between Oracle Service Bus and Oracle SOA service Components.



24.5.1 Conversation ID Examples

This section provides different examples of establishing a conversation ID among messages in a conversation between Oracle Service Bus and Oracle SOA composites.

In Figure 24-5, a client is synchronously invoking a BPEL Process component in an Oracle SOA composite. The business service (B1) uses the SOA-DIRECT transport to invoke a process. The proxy service (P1) handles any necessary conversation ID mapping. The SOA composite exposes the BPEL Process as a direct binding service.


Figure 24-5 Operations in a Synchronous Exchange Through Oracle Service Bus

[image: Description of Figure 24-5 follows]







24.5.1.1 Port and Message Definitions

The examples in this section use the following port and message definitions defined in the WSDL.


<wsdl:types>
    <xsd:schema
            targetNamespace="http://www.sample.org/spec/samples/types"
            elementFormDefault="qualified">
        <xsd:complexType name="ValueHolder">
            <xsd:all>
                <xsd:any minOccurs="1"/>
            </xsd:all>
        </xsd:complexType>
    </xsd:schema>
</wsdl:types>
<message name="create"/>
<message name="putRequest">
    <part name="key" type="xsd:string"/>
    <part name="value" type="types:ValueHolder"/>
</message>
<message name="putResponse">
    <part name="value" type="types:ValueHolder"/>
</message>
...
<message name="dispose"/>
<portType name="ServiceMap">
    <operation name="create">
        <input message="tns:create"/>
    </operation>
    <operation name="put">
        <input message="tns:putRequest"/>
        <output message="tns:putResponse"/>
    </operation>
    ...
    <operation name="dispose">
        <input message="tns:dispose"/>
    </operation>
</portType>






24.5.1.2 WS-Addressing that Sets the Conversation ID

This example shows how WS-Addressing is used to set the conversation ID among messages in a conversation.

Figure 24-5 shows the communication pattern.

Create Operation


<soap:Envelope>
    <soap:Header>
        <wsa03:MessageID>uuid:123456789</wsa03:MessageID>
    </soap:Header>
    <soap:Body>
        <create/>
    </soap:Body>
</soap:Envelope>


Put Operation


<soap:Envelope>
    <soap:Header>
        <wsa03:MessageID>uuid:111111111</wsa03:MessageID>
        <wsa03:RelatesTo>uuid:123456789</wsa03:RelatesTo>
    </soap:Header>
    <soap:Body>
        <put>
            <key>key</key>
            <value>
                <PO/>
            </value>
        </put>
    </soap:Body>
</soap:Envelope>
<soap:Envelope>
    <soap:Body>
        <putResponse>
            <value/>
        </putResponse>
    </soap:Body>
</soap:Envelope>


The <put> operation also has a MessageID, but it is ignored because the RelatesTo has a value that provides the conversation ID.






24.5.1.3 Message Payload Data that Sets the Conversation ID

This example shows how message payload data can be used to set the conversation ID among messages in a conversation.

In these examples, the proxy service maps the ID to the MessageID / RelatesTo SOAP headers.

Figure 24-5 shows the communication pattern.

Create Operation

Client to proxy service


<soap:Envelope>
    <soap:Body>
        <create/>
    </soap:Body>
</soap:Envelope>
<soap:Envelope>
    <soap:Body>
        <createResponse>
            <mapID>uuid:123456789</mapID>
        </createResponse>
    </soap:Body>
</soap:Envelope>


Proxy service to SOA composite (through a SOA-DIRECT business service)


<soap:Envelope>
    <soap:Header>
        <wsa03:MessageID>uuid:123456789</wsa03:MessageID>
    </soap:Header>
    <soap:Body>
        <create/>
    </soap:Body>
</soap:Envelope>


Not shown: The ID was generated in the request of the proxy service pipeline and inserted as a <wsa03:MessageID> before invoking the process. On the process side, the Create operation is one-way, so a SOAP response must be created before replying to the client. The response sends back the ID that was generated by the proxy service.

Put Operation

Client to proxy service


<soap:Envelope>
    <soap:Body>
        <put>
            <mapID>uuid:123456789</mapID>
            <key>key</key>
            <value>
                <PO/>
            </value>
        </put>
    </soap:Body>
</soap:Envelope>
<soap:Envelope>
    <soap:Body>
        <putResponse>
            <value/>
        </putResponse>
    </soap:Body>
</soap:Envelope>


Proxy service to SOA composite (through a SOA-DIRECT business service)


<soap:Envelope>
    <soap:Header>
        <wsa03:RelatesTo>uuid:123456789</wsa03:RelatesTo>
    </soap:Header>
    <soap:Body>
        <put>
            <key>key</key>
            <value>
                <PO/>
            </value>
        </put>
    </soap:Body>
</soap:Envelope>
<soap:Envelope>
    <soap:Body>
        <putResponse>
            <value/>
        </putResponse>
    </soap:Body>
</soap:Envelope>


Dispose Operation

Client to proxy service


<soap:Envelope>
    <soap:Body>
        <dispose>
            <mapID>uuid:123456789</mapID>
        </dispose>
    </soap:Body>
</soap:Envelope>


Proxy service to SOA composite (through a SOA-DIRECT business service)


<soap:Envelope>
    <soap:Header>
        <wsa03:RelatesTo>uuid:123456789</wsa03:RelatesTo>
    </soap:Header>
    <soap:Body>
        <dispose/>
    </soap:Body>
</soap:Envelope>






24.5.1.4 Transformation Examples

In these examples, the client uses a more recent version of the WS-Addressing spec (wsa04 prefix). The proxy service is responsible for transforming the SOAP headers to use the wsa03 prefix. The proxy service developer configures the transformation.

Figure 24-5 shows communication pattern.

Create Operation

Client to proxy service


<soap:Envelope>
    <soap:Header>
        <wsa04:MessageID>uuid:123456789</wsa04:MessageID>
    </soap:Header>
    <soap:Body>
        <create/>
    </soap:Body>
</soap:Envelope>


Proxy service to SOA composite (through a SOA-DIRECT business service)


<soap:Envelope>
    <soap:Header>
        <wsa03:MessageID>uuid:123456789</wsa03:MessageID>
    </soap:Header>
    <soap:Body>
        <create/>
    </soap:Body>
</soap:Envelope>


Put Operation

Client to proxy service


<soap:Envelope>
    <soap:Header>
        <wsa04:MessageID>uuid:111111111</wsa04:MessageID>
        <wsa04:RelatesTo>uuid:123456789</wsa04:RelatesTo>
    </soap:Header>
    <soap:Body>
        <put>
            <key>key</key>
            <value>
                <PO/>
            </value>
        </put>
    </soap:Body>
</soap:Envelope>
<soap:Envelope>
    <soap:Body>
        <putResponse>
            <value/>
        </putResponse>
    </soap:Body>
</soap:Envelope>


Proxy service to SOA composite (through a SOA-DIRECT business service)


<soap:Envelope>
    <soap:Header>
        <wsa03:MessageID>uuid:111111111</wsa03:MessageID>
        <wsa03:RelatesTo>uuid:123456789</wsa03:RelatesTo>
    </soap:Header>
    <soap:Body>
        <put>
            <key>key</key>
            <value>
                <PO/>
            </value>
        </put>
    </soap:Body>
</soap:Envelope>
<soap:Envelope>
    <soap:Body>
        <putResponse>
            <value/>
        </putResponse>
    </soap:Body>
</soap:Envelope>








24.5.2 Asynchronous Composite to Composite Native Communication Through Oracle Service Bus Example

The following example shows the SOAP headers involved in a SOA composite invoking another SOA composite asynchronously through Oracle Service Bus. The first SOA composite uses a BPEL Process exposed as a direct binding reference to invoke Oracle Service Bus. The second SOA composite uses a BPEL process exposed as a direct binding service to receive requests from Oracle Service Bus.

In Figure 24-6, P1 and P2 are proxy services that pass messages (and perform transformations) to B1 and B2 business services, which are required to make calls to SOA composites using the Oracle Service Bus SOA-DIRECT transport.


Figure 24-6 SOA Composite Invoking an SOA Composite Through Oracle Service Bus

[image: Description of Figure 24-6 follows]





Refer to Figure 24-6 for the following SOAP header examples.



24.5.2.1 Port and Message Definitions


<message name="LoanServiceRequestMessage">
    <part name="payload" element="types:loanApplication"/>
</message>
<message name="LoanServiceResultMessage">
    <part name="payload" element="types:loanOffer"/>
</message>
<portType name="LoanService">
    <operation name="initiate">
        <input message="tns:LoanServiceRequestMessage"/>
    </operation>
</portType>
<portType name="LoanServiceCallback">
    <operation name="onResult">
        <input message="tns:LoanServiceResultMessage"/>
    </operation>
</portType>






24.5.2.2 BP1 to P1 – Initiate operation


<soap:Envelope>
    <soap:Header>
        <wsa03:ReplyTo>
            <wsa03:Address>
                 t3://soaserver:8001/default/AmericanLoanClient/LoanserviceRequester
            </wsa03:Address>
        </wsa03:ReplyTo>
        <MessageID>AmericanLoanClient~1.0/60007</MessageID>
    </soap:Header>
    <soap:Body >
        <loanApplication>
            ...
        </loanApplication>
    </soap:Body>
</soap:Envelope>






24.5.2.3 P1/B1 to BP2


<soap:Envelope>
    <soap:Header>
        <wsa03:ReplyTo>
            <wsa03:Address>http://serverB:7001/P2</wsa03:Address>
            <wsa03:referenceParameters>
                <osb:Callback>
                    <osb:Address>
                         t3://soaserver:8001/default/AmericanLoanClient/LoanserviceRequesterRef#LoanserviceRequesterBpel
                    </osb:Address>
                </osb:Callback>
            </wsa03:referenceParameters>
        </wsa03:ReplyTo>
        <MessageID>AmericanLoanClient~1.0/60007</MessageID>
    </soap:Header>
    <soap:Body >
        <loanApplication>
            ...
        </loanApplication>
    </soap:Body>
</soap:Envelope>


The ReplyTo callback address is set by B1, which gets the value from the Callback Proxy field in the SOA-DIRECT transport configuration, as described in Section 24.3.2, "SOA-DIRECT Transport Configuration for Business Services." B1's callback proxy is P2.

You must wrap the original replyTo information and send it as reference properties so that it is echoed back in the onResult callback message (to follow).




	
Note:

This sample uses osb:Callback and osb:Address for illustration purpose only. There is no standard or Oracle Service Bus standard elements defined for WS-Addressing support.














24.5.2.4 BP2 to P2 – onResult operation


<soap:Envelope>
    <soap:Header>
        <wsa03:RelatesTo>AmericanLoanClient~1.0/60007</wsa03:RelatesTo>
        <osb:Callback>
            <osb:Address>
                  t3://soaserver:8001/default/AmericanLoanClient/LoanserviceRequesterRef#LoanserviceRequesterBpel
            </osb:Address>
        </osb:Callback>
    </soap:Header>
    <soap:Body >
        <loanOffer>
            ...
        </loanOffer>
    </soap:Body>
</soap:Envelope>


The reference property osb:Callback is sent back as a SOAP header by the Oracle BPEL Process Manager engine.






24.5.2.5 P2/B2 to BP1 – onResult operation


<soap:Envelope>
    <soap:Header>
        <wsa03:RelatesTo>AmericanLoanClient~1.0/60007</wsa03:RelatesTo>
    </soap:Header>
    <soap:Body >
        <loanOffer>
            ...
        </loanOffer>
    </soap:Body>
</soap:Envelope>


Proxy service P2 removes the temporary osb:Callback header; but prior to deleting this header, the replyTo address value is copied to the $outbound variable so that the SOA-DIRECT transport in business service B2 can send the callback message to the correct SOA service component.











JEJB Transport





29 JEJB Transport


This chapter provides an overview of the JEJB transport and describes how to use and configure it in your services.

This chapter includes the following sections:

	
Section 29.1, "About the JEJB Transport"


	
Section 29.2, "Creating and Configuring JEJB Services"


	
Section 29.3, "Use Cases"


	
Section 29.4, "Transport Configuration Reference"


	
Section 29.5, "Testing JEJB Services"


	
Section 29.6, "UDDI Integration"






29.1 About the JEJB Transport

The JEJB transport lets you pass Plain Old Java Objects (POJOs) through Oracle Service Bus. For example, you can use an EJB to invoke a remote EJB operation or a non-EJB service, or you can invoke an EJB operation with a non-EJB request. Use case details are described in Section 29.3, "Use Cases."

To a J2EE client, a JEJB proxy service pipeline looks like a stateless session bean. A JEJB proxy service, on receiving the method arguments, passes their XML representation in the pipeline $body variable. POJO arguments are represented as the XML fragment. This XML fragment contains the location of the actual POJO stored in the object repository within the pipeline. XML arguments can either be passed by value or by reference (referencing the actual object stored in the object repository). Primitive types are always passed by value.

For more detailed information on POJOs in message flows, see "Java Content in the body Variable" and "Extensibility Using Java Callouts and POJOs" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus.

The JEJB transport is always synchronous, so the pattern is always request-response.

For deployment, Oracle Service Bus automatically packages JEJB proxy services as enterprise archives (EARs).



29.1.1 Difference Between the JEJB Transport and the EJB Transport

The EJB transport, available only for business services, invokes remote EJBs through the Java Web Services (JWS) framework. The JEJB transport, which lets you invoke remote EJBs and external services with POJOs, passes POJOs directly through Oracle Service Bus to the target EJB methods using an RMI serialization/deserialization cycle.

The EJB transport provides a "Support Transaction" flag, but all Oracle Service Bus proxy services provide transactional support, making the transaction option unnecessary for JEJB business services.






29.1.2 Environment Values

The JEJB transport stores the following environment values for JEJB services:

	
Service URI


	
Work Manager


	
UDDI Auto Publish (Proxy Services)


	
Service Account (Business Services)









29.1.3 WSDL Generation

For proxy and business services, the JEJB transport generates a Document-style WSDL with Literal encoding that is used solely for describing the message passed to the pipeline. The WSDL format lets you leverage Oracle Service Bus WSDL features such as per-operation monitoring.

The message structure defined in the WSDL may differ from the actual pipeline message at runtime if you inline your POJO arguments in the message using the "Pass XMLBeans by value" option, described in Table 29-1.

Following is the behavior of the pipeline message format for XMLBeans type of parameters:

Proxy Services

	
Request Parameters: Request parameters in the pipeline message refer to an inline Xml Object if "Pass XMLBeans by value" is true; otherwise the reference is to java-content ref.


	
Response Parameter: The response may refer to an inline XML Object or the java-content ref, as the response may come in either form from the business service.




Business Services

	
Response Parameter: Return parameters in the pipeline message refer to an inline Xml Object if "Pass XMLBeans by value" is true; otherwise the reference is to java-content ref.


	
Request Parameters: Request method parameters in the pipeline message may refer to an inline XML Object or the java-content ref, as the request may come in either form from the proxy service.









29.1.4 Error Handling

This section describes how the JEJB transport handles errors.



29.1.4.1 Exception Propagation in the Response

The JEJB transport stores request exceptions in the object repository and propagates them to the JEJB proxy service through the $fault variable. $fault would contain the location of the exception instance within the <java-exception> <java-content ref="jcid"/> </java-exception> element, where jcid is the reference to the exception instance stored in the object repository.

To propagate the user exception to the client, the JEJB proxy service would expect the response in one of these formats:

	
env:Envelope/env:Fault/detail/mc:java-exception

Format, where jcid is a reference to the error in the object repository:


<detail>
    <mc:java-exception>
        <mc:java-content ref="jcid"/>
    </mc:java-exception>
    ...
</detail>


	
env:Envelope/env:Fault/detail/mc:fault/mc:java-exception

Format, where jcid is a reference to the error in the object repository:


<detail>
    <mc:fault xmlns:mc="http://www.bea.com/wli/sb/context">
        <mc:java-exception>
            <mc:java-content ref="jcid"/>
        </mc:java-exception>
        ...
    </mc:fault>
</detail>


	
env:Envelope/ env:Fault/detail/mc:fault/mc:details/con1:ReceivedFaultDetail/con1:detail/mc:java-exception

Format, where jcid is a reference to the error in the object repository:


<con:details>
    <con1:ReceivedFaultDetail  xmlns:con1="http://www.bea.com/wli/sb/stages/transform/config">
        <con1:faultcode>soapenv:Server</con1:faultcode>
        <con1:faultstring>checkExceptionConversion</con1:faultstring>
        <con1:detail>
            <mc:java-exception>
                <mc:java-content ref="jcid"/>
            </mc:java-exception>
        </con1:detail>
    </con1:ReceivedFaultDetail>
</con:details>




To raise your own exceptions to return to the caller, raise them in a Java Callout in the proxy service pipeline.



29.1.4.1.1 Java Callout and Service Callout Exceptions

If you configure a Java Callout or Service Callout in an error handler for "Reply with Failure," you must format the $body so that it conforms to one of the previously described fault structures.








29.1.4.2 Application and Connection Errors

This section describes the conditions under which the JEJB transport throws application and communication errors, which are subject to the retry configuration on a service.



29.1.4.2.1 Connection Errors

The JEJB transport throws connection errors in the following situations:

	
NamingExceptions looking up the EJBs raised during the remote call.


	
A runtime or remote exception is thrown, but the ongoing transaction has not been set as rollback-only, signifying that the error occurred before the invocation of the EJB container.






29.1.4.2.2 Application Errors

The JEJB transport throws application errors in the following situations:

	
A runtime or remote exception is thrown and the ongoing transaction has been set as rollback-only (likely by the EJB container), signifying the EJB container has been reached and a fatal error either occurred within the container or within the EJB itself.


	
Business exceptions defined in the EJB business interface.


	
An exception caused by a faulty encoding of the parameters in XML.

















29.2 Creating and Configuring JEJB Services

This section provides instructions for creating and configuring JEJB proxy and business services.



29.2.1 Creating and Packaging Your Client EJB JAR

This section provides guidelines on creating and packaging POJOs to represent EJB invocations and operations for JEJB proxy and business services.

	
Define an interface of type java.io.Serializable and include any necessary helper classes, such as business exceptions. The interface does not need to extend any class as long as the interface is valid for one of the RMI protocols described in Section 29.4.1, "JEJB Endpoint URI," or is valid for JMS messages if you are using JMS to invoke EJBs.




	
Note:

Though not required, you can:

	
Make the interface a Remote interface as defined by the EJB 2.1 specification

or


	
Annotate methods with the javax.ejb.Remote annotation to designate it as an EJB 3.0 business interface




For a simple POJO interface (no EJB Remote interface) or an interface annotated with javax.ejb.Remote, the JEJB transport provider generates the 3.0 EJB interface out of the JEJB proxy service.For a Remote interface, the JEJB transport provider generates the 2.1 EJB interface out of the JEJB proxy service.










	
The objects received as arguments must be passable to any required classes in a Java Callout archive resource.


	
An array of any type is considered a POJO.


	
Avoid unnecessary serialization/deserialization cycles by not duplicating the JARs uploaded as Archive Resources to support Java Callouts. Package all archive resource classes in a single archive JAR so that multiple Java Callouts do not serialize/deserialize the objects.


	
Package your interface and dependent classes in a single "client" JAR and import it into Oracle Service Bus. While this is the client JAR you will select when configuring a service, it is not technically a fully expanded EJB client JAR, because it contains no stubs. The actual bean (hence Oracle WebLogic Server stub generation) does not exist until a JEJB proxy service is created and activated.









29.2.2 Register a JNDI Provider Resource (Business Services)

A JNDI Provider resource lets you specify the communication protocols and security credentials used to retrieve EJB stubs bound in the JNDI tree of remote Oracle WebLogic Server domains. (For more information on how to set up a JNDI tree, see Oracle Fusion Middleware Programming JNDI for Oracle WebLogic Server.)

Typically, the target EJB is not located in the same domain as Oracle Service Bus. In this case, you must register a JNDI Provider resource. When the EJB is located in the same domain, you can define a provider to specify credentials and take advantage of stubs caching, though doing so is optional.

The JNDI provider has a high performance caching mechanism for remote connections and EJB stubs. The preferred communication protocol from Oracle Service Bus to an Oracle WebLogic Server domain is t3 or t3s. If messages need to go through a firewall, you can use HTTP tunneling.




	
Note:

Although it is possible to use an Oracle WebLogic Server Foreign JNDI Provider, Oracle recommends that you do not.

The transport does not support two-way SSL or CLIENT CERT to look-up JNDI tree or access a method on an EJB.











29.2.2.1 Adding a JNDI Provider

For information about registering and configuring a JNDI provider resource in Oracle Service Bus, see Section 4.8, "JNDI Providers.".








29.2.3 Configuring a JEJB Proxy or Business Service

This section describes the high-level steps for configuring a JEJB proxy or business service. The scenarios described in Section 29.3, "Use Cases" illustrate when you need to create JEJB proxy and business services. Each use case provides general implementation guidelines.

	
On the General page of the service, select the Transport Typed option.


	
On the Transport page:

	
Select the jejb protocol.


	
Enter the Endpoint URI information as described in Section 29.4.1, "JEJB Endpoint URI."


	
Set other global transport options as described in Section 4.3.6, "Proxy Service Transport Configuration Page" and Section 4.2.4, "Business Service Transport Configuration Page."





	
On the JEJB Transport page, configure the transport options for the service, described in Section 29.4.2, "JEJB Transport Configuration for Proxy Services" and Section 29.4.3, "JEJB Transport Configuration for Business Services."


	
Set the remaining service options as described in Section 4.3, "Proxy Service Configuration" and Section 4.2, "Business Service Configuration."


	
See your particular use case in Section 29.3, "Use Cases" for implementation guidelines.











29.3 Use Cases

Following are the supported use cases for using the JEJB transport in proxy and business services. Each use case provides implementation guidelines for you to use in conjunction with the general service configuration, as described in Section 29.2.3, "Configuring a JEJB Proxy or Business Service."



29.3.1 EJB Invokes an External Service

You can invoke an external service with an EJB through Oracle Service Bus, illustrated by Figure 29-1.


Figure 29-1 An EJB Invokes an External Service

[image: Description of Figure 29-1 follows]





In Figure 29-1, the JEJB proxy service serves as a stateless session bean to the EJB client interface. The JEJB transport provider for the proxy service generates a stateless session EJB from the remote/business interface in the client JAR and the pipeline, then deploys it as an EAR at the JNDI address specified in the endpoint URI.




	
Caution:

Be sure to install policies that protect the JNDI entries from being modified.









The EJB makes a call to a remote interface provided by the proxy service EJB client JAR, passing transaction and security details to the proxy service as well.

The EJB client interface is a POJO with method arguments that the JEJB transport provider represents as a WSDL and passes into the proxy service $body variable as XML. You can introspect the $body content to transform the message into the required format to pass to the business service and invoke the external service. The actual POJO is stored in the object repository, and the XML in the $body references it with a <java-content ref=""> element.

In the response, provide a Java Callout that converts the response to an EJB return format that gets passed to the calling EJB method. View the proxy service's generated WSDL to see the expected message format. For information on viewing the generated WSDL, see "Viewing Resource Details" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus.




	
Note:

In the proxy service pipeline, you can pass POJO arguments to Java Callouts, to another proxy service using, for example, a Service Callout or a Publish action, or to a business service.














29.3.2 Non-EJB Client Invokes an EJB

You can invoke an EJB with a non-EJB client through Oracle Service Bus, as illustrated in Figure 29-2.


Figure 29-2 A Non-EJB Client Invokes an EJB

[image: Description of Figure 29-2 follows]





In Figure 29-2, a non-EJB client makes a call to a proxy service configured with a transport that matches the request; for example, a JMS proxy service making an invocation with a JMS topic or queue.

You configure a Java Callout in the request, which converts the request into an XML representation of an EJB call in the $body variable. Put operations in the $operation variable. View the business service's generated WSDL to see the expected message format. For information on viewing the generated WSDL, see "Viewing Resource Details" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus.

The JEJB business service uses its generated WSDL to map the incoming message to the EJB remote interface and invoke the remote EJB method directly.






29.3.3 EJB Invokes EJB

You can invoke an EJB with an EJB through Oracle Service Bus, as illustrated in Figure 29-3.


Figure 29-3 An EJB Invokes an EJB

[image: Description of Figure 29-3 follows]





In Figure 29-3, the EJB call is passed through the proxy and business services to invoke another EJB method. Rather than making a direct RMI call outside of Oracle Service Bus, this architecture lets you leverage Oracle Service Bus features such as message routing, UDDI integration, alerts, monitoring, reporting, and result caching.

The JEJB transport provider for the proxy service generates a stateless session EJB from the remote/business interface in the client JAR and the pipeline, and then deploys it as an EAR at the JNDI address specified in the endpoint URI.

At runtime the JEJB proxy service receives a POJO as method argument, stores it in the object repository, and generates an XML representation of the POJO in the proxy service $body variable according to the generated proxy service WSDL. The proxy service passes the message to the business service, and the business service uses its generated WSDL to map the message to the remote interface and invoke the remote method directly.

To keep your pipeline logic independent of the JEJB transport, you can route messages from the JEJB proxy service to a local proxy service. The local proxy service can then perform the pipeline logic before forwarding the messages to the JEJB business service. If you use this pattern, make sure the local proxy is of type WSDL (with support for the business service operations) so that it has access to the Java objects.








29.4 Transport Configuration Reference

This section provides details on constructing endpoint URIs and configuring the JEJB transport in proxy and business services.



29.4.1 JEJB Endpoint URI

Following are the endpoint URI formats for JEJB proxy and business services.




	
Note:

JEJB services do not support co-located calls.











29.4.1.1 Proxy Service JEJB Endpoint URI

The URL format is ejb_jndi_name. The URI configured for a JEJB proxy service becomes the global JNDI name for locating the stateless session bean generated by the JEJB transport from the remote/business interface in the client JAR.




	
Note:

For EJB 3.0, ejb_jndi_name is the mappedName attribute of the @javax.ejb.Stateless annotation in the generated bean. The lookup JNDI name for the generated EJB service is suffixed with #interface_class, which is the fully qualified name of the business interface.









You can access the JEJB proxy service as:

	
EJB 2.1 – protocol://host:port/ejb_jndi_name


	
EJB 3.0 – protocol://host:port/ejb_jndi_name#interface_class




The protocol can be one of the following RMI protocols:

	
iiop / iiops – For generic, server-agnostic use.


	
t3 / t3s – For use with Oracle WebLogic Server.


	
http / https – For tunneling and use with Oracle WebLogic Server.




For example:

	
EJB 2.1 – t3://localhost:7001/osb.jejb.myJejbProxy


	
EJB 3.0 – t3://localhost:7001/osb.jejb.myJejbProxy#com.example.MyEjb3









29.4.1.2 Business Service JEJB Endpoint URI

Following is the endpoint URI format for a JEJB business service:

jejb:jndi_provider_name:ejb_jndi_name

The jndi_provider_name is the remote JNDI context.

The ejb_jndi_name is the remote EJB's JNDI name.

For example:

	
EJB 2.1 – jejb:myProvider:osb.jejb.myJejbBiz21


	
EJB 3.0 – jejb:myProvider:myBiz31#osb.jejb.myJejbBiz

where #osb.jejb.myJejbBiz is the fully qualified business interface.







	
Note:

If your EJBs are running on IBM WebSphere, ejb_jndi_name must be in the following format:

cell/nodes/node_name/servers/server_name/ejb_jndi_name

or

cell/clusters/cluster_name/ejb_jndi_name

as described in the IBM WebSphere documentation at http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=/com.ibm.websphere.nd.iseries.doc/info/iseriesnd/ae/rnam_example_prop3.html
















29.4.2 JEJB Transport Configuration for Proxy Services

Use this page to configure transport settings for proxy services using the JEJB transport protocol.

Table 29-1 describes the transport-specific configuration options for business services that use the JEJB transport.


Table 29-1 JEJB Transport Configuration for Proxy Services

	Option	Description
	
Dispatch Policy

	
Select the instance of Oracle WebLogic Server Work Manager that you want to use for the dispatch policy for this endpoint. The default Work Manager is used if no other Work Manager exists.

For information about Work Managers, see:

	
"Using Work Managers to Optimize Scheduled Work" in Oracle Fusion Middleware Configuring Server Environments for Oracle WebLogic Server


	
"Using Work Managers with Oracle Service Bus" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus





	
EJB Spec Version

	
Select the EJB version of the remote EJB interface.


	
Pass XMLBeans by value

	
Select this option if you want the transport to generate an "inlined" XML representation of POJO arguments (an XMLObject) whose parameters you can access and manipulate with XQuery expressions.

Note: Type information is not available inline for XMLObjects passed by value. If you use this option, you cannot pass the typed XMLObject as the argument in a Java Callout in a proxy service pipeline.

Do not select this option if you want to pass the POJO by reference, which also results in better performance.

For more information, see Section 29.1.3, "WSDL Generation."


	
Transaction Attribute

	
Select one of the following options for handling transactions:

	
Supports – The transport accepts an incoming transaction. Quality of service is exactly-once if the operation is invoked in a transaction and best-effort if the operation is invoked outside of a transaction.


	
Required – The transport accepts an incoming transaction. If no ongoing transaction exists, the transport starts one. Quality of service is exactly-once.


	
RequiresNew – The transport always starts a new transaction, suspending an ongoing transaction. Quality of service is exactly-once.


	
Mandatory – The transport invokes the method in the existing transaction. Quality of service is exactly-once.


	
NotSupported – The transport suspends an existing transaction and resumes it on invocation. Quality of service is best-effort.


	
Never – The transport does not invoke the method in a transaction. Quality of service is best-effort.





	
Client JAR

	
Click Browse and select an EJB client JAR resource from the list displayed. The client JAR contains the remote or business interface for the remote EJB. The Client JAR is registered as a generic Archive Resource.


	
Home Interface

	
EJB 2.1 only – Select the required EJBHome interface from the options populated by the client JAR.


	
Remote Interface

	
EJB 2.1 only – This field is automatically populated based on the configuration of the Home Interface.


	
Business Interface

	
EJB 3.0 only – Select the business interface from the client JAR that you want to invoke.


	
Target Namespace

	
This field is populated by information picked up from the JAR.


	
Methods

	
Select the required methods. Click + to expand the method, which lets you edit the default parameter values.

You can change the default operation name for a given method. By default, the operation name is the method name. If an EJB contains methods with same name (overloaded), you must change the operation names so that they are unique. WSDLs require unique operation names.












29.4.3 JEJB Transport Configuration for Business Services

Use this page to configure transport settings for business services using the JEJB transport protocol.

Table 29-2 describes the transport-specific configuration options for business services that use the JEJB transport.


Table 29-2 JEJB Transport Configuration for Business Services

	Option	Description
	
Dispatch Policy

	
Select the instance of Oracle WebLogic Server Work Manager that you want to use for the dispatch policy for this endpoint. The default Work Manager is used if no other Work Manager exists.

For information about Work Managers, see:

	
"Using Work Managers to Optimize Scheduled Work" in Oracle Fusion Middleware Configuring Server Environments for Oracle WebLogic Server


	
"Using Work Managers with Oracle Service Bus" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus





	
EJB Spec Version

	
Select the EJB version of the remote EJB interface.


	
Pass XMLBeans by value

	
Select this option if you want the transport to generate an "inlined" XML representation of POJO arguments (an XMLObject) whose parameters you can access and manipulate with XQuery expressions.

Note: Type information is not available inline for XMLObjects passed by value. If you use this option, you cannot pass the typed XMLObject as the argument in a Java Callout in a proxy service pipeline.

Do not select this option if you want to pass the POJO by reference, which also results in better performance.

For more information, see Section 29.1.3, "WSDL Generation."


	
Pass Caller's Subject

	
As an alternative to selecting a Service Account, select this option to have Oracle Service Bus pass the authenticated subject from the proxy service when invoking the EJB.


	
Service Account

	
Click Browse and select a JNDI service account from the list displayed. If no service account is specified, an anonymous subject is used.For more information, see Section 4.19, "Service Accounts."


	
Client JAR

	
Click Browse and select an EJB client JAR resource from the list displayed. The client JAR contains the remote or business interface for the remote service. The Client JAR is registered as a generic Archive Resource.


	
Home Interface

	
EJB 2.1 only – Select the required EJBHome interface from the options populated by the JAR.


	
Remote Interface

	
EJB 2.1 only – This field is automatically populated based on the configuration of the Home Interface.


	
Business Interface

	
EJB 3.0 only – Select the business interface from the client JAR that you want to invoke.


	
Target Namespace

	
This field is populated by information picked up from the JAR.


	
Methods

	
Select the required methods. Click + to expand the method, which lets you edit the default parameter values.

You can change the default operation name for a given method. By default, the operation name is the method name. If an EJB contains methods with same name (overloaded), you must change the operation names so that they are unique. WSDLs require unique operation names.














29.5 Testing JEJB Services

In the Oracle Service Bus Test Console you can test JEJB services that pass POJOs by value ("Pass XMLBeans by value" option), but not by reference. The Test Console supports only primitive, String, and XML arguments. The transport passes supported POJO arguments and their values as XML specifying the invocation point (the EJB method).






29.6 UDDI Integration

This section describes the UDDI publish and import details for JEJB proxy services:



29.6.1 UDDI Publish

JEJB proxy services publish the following properties to a UDDI registry:

	
URI


	
EJB Spec Version


	
Client JAR


	
Home Interface (for EJB 2.1 only)


	
Remote Interface (the Business Interface for EJB 3.0)


	
Method Names (Not included are operation aliases, parameters, or return details. Method names are passed in one property with all the method signatures appended. Method signatures are separated by the # character.









29.6.2 UDDI Import

This section describes how the JEJB transport handles service import from a UDDI registry.

	
URI – The JEJB transport provider attempts to match the host:port information from the URI property in the UDDI registry with a JNDI provider resource registered on the server.

If the transport provider cannot find a JNDI provider, the import fails. However, if the no JNDI provider is found, but the host:port matches the localhost IP and listen port, the resulting business service will be local (no JNDI provider).


	
Client JAR – The transport provider downloads the client JARs and, if the manifest classpath exists in the JARs, creates the corresponding JAR resources in the matching directory structure. The first URI in the list is the root client JAR. If no manifest classpath exists in the JARs, you must manually add the resource JARs as dependencies to the root JAR. If a resource in the imported client JAR has the same name as another resource in the domain, the imported resource overwrites the existing resource.

Make sure that the client JAR you are importing does not already exist in your domain.


	
Method Names – Methods included in the corresponding property are automatically selected in the endpoint configuration. All the other methods are marked as excluded (that is, they are not selected).












WS Transport





32 WS Transport


This chapter provides an overview of the WS transport and describes how to use and configure it in your services.

The Web Services Reliable Messaging (WSRM) specification describes a protocol that allows messages to be delivered reliably between distributed applications even if a software, system, or network failure occurs.

WS-ReliableMessaging is a specification co-developed by IBM, Oracle, Microsoft and TIBCO Systems. This specification is not the same as the WS-Reliability (WSR), which is a competing specification developed by OASIS.

WSRM functionality is available in Oracle Service Bus as the WS transport. Oracle Service Bus supports the specification submitted in February 2005. For more information about the specification, see Web Services Reliable Messaging Protocol (WS-ReliableMessaging) at http://schemas.xmlsoap.org/ws/2005/02/rm/.

The WS transport implements both inbound and outbound requests for services derived from SOAP 1.1 and SOAP 1.2 based WSDLs with WSRM policy. However, the WSRM policy can be a part of the WSDL or can be attached to the service. In addition, security policies can also be declared in the WSDL or can be associated with a WSDL-based service. When you configure WSDL-based services with WSRM policies using the Oracle Service Bus Administration Console, you must choose the WS transport for the service. Oracle Service Bus checks for the WSRM policy when you save the service configuration and throws a validation error if WSRM policies are not declared for the WSDL associated with the service.

The following are the key features of the WS Transport:

	
One-way and request/response message patterns. For more information, see Section 32.1.1, "Messaging Patterns."


	
Exactly-once transfer between WS transport and other transports (JMS, SB, and Tuxedo transports) that support XA transactions.


	
HTTPS with basic authentication, and with client-certificate authentication (two-way SSL) but without client authentication,. For more information, see Section 32.2, "Authentication and Authorization of Services."


	
Retaining WSRM security configuration while importing resources. For more information, see Section 32.5, "Importing and Exporting Resources."


	
Assignment of transport-level access control policy to a WS proxy service in Oracle Service Bus Administration Console. Only an administrator can assign this policy. For more information, see Section 32.3.4, "Assigning Transport Access Control to Proxy Services."


	
WS-Addressing specification submitted in August 2004. For more information, see Web Services Addressing (WS-Addressing) at http://www.w3.org/Submission/ws-addressing/.


	
WS-I Basic Profile compliance. For more information, see Section 32.1.4, "Web Services Interoperability."


	
Quality of Service (QoS) in Oracle Service Bus for WS proxy service is always set as Exactly Once. For more information, see "Quality of Service" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus.

You can set the QoS only in the RM policy file using the <beapolicy:QOS> element. This element has one attribute, QOS, which can take any of the following values:

	
AtMostOnce


	
AtLeastOnce


	
ExactlyOnce


	
OnOrder




	
Note:

QoS for WS transport is different from QoS for Oracle Service Bus.













	
You can associate only SOAP 1.1 and SOAP 1.2 based WSDLs with WSRM policy with a proxy or business service. For more information, see Section 32.3.3, "Configuring Proxy Services to Use the WS Transport" and Section 32.3.6, "Configuring Business Services to Use the WS Transport."






32.1 Supported Functionality

This section provides detailed information about functionality supported by the WS transport.



32.1.1 Messaging Patterns

WSRM supports both one-way and request/response messaging patterns. The WS transport does not support reliable response. While the request is always reliable, the response is not sent reliably.

For business services, sending a request to an external web service is asynchronous. Successful invocation implies that the message is given to the RM layer successfully and it will be delivered reliably. However, successful invocation does not mean that the message is sent to the endpoint and has successfully invoked the web service.

For the request/response messaging pattern, the response is received from the external web service for a request. In this case, the request and response paths have two different transactions and run in two different threads. The response pipeline is executed evenly for one-way messaging message pattern. For the one-way pattern, response pipeline invocation means that the message reliably reached the target destination and the web service invocation is complete.






32.1.2 Policies

A proxy service or business service that uses the WS transport must have a WS-Policy with RM assertions. This also implies that services that use any other transport must not have any WS-Policy with RM assertions. WS-Policy with RM assertions and WSSP v1.2 transport-level security assertions are supported for the WS transport.

However, WSSP v1.2 message-level security assertions and 9.X Oracle proprietary security assertions are not supported. RM assertions should only be bound at the service level and not at the operation or operation request/response levels.




	
Note:

You must use only one RM assertion for a WS-Policy.











32.1.2.1 WS-Policy Configurations

WS-Policies can be configured in any one of the following two ways:

	
WS-Policy configuration is specified as part of the WSDL associated with the service. The policies specified in the WSDL may be included in the WSDL or referred in the WSDL.


	
WS-Policy is assigned to the service from the Oracle Service Bus Administration Console.




	
Note:

You can use only one of these methods to associate a security policy with the service. So, if you configure a policy using the Oracle Service Bus Administration Console, any policies defined in the WSDL are ignored.



















32.1.3 Streaming Content for Large Messages

The WS transport does not have streaming support for large messages because the underlying infrastructure (WLS JAX-RPC stack) uses a fully materialized payload. However, when you configure a proxy service for large message processing, the message is fully materialized into a Java object by the WS transport using the streaming optimization in Oracle Service Bus. During the proxy service configuration, you can specify whether to stream content for large message processing by buffering content either in memory or to disk. For more information, see "Streaming body Content" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus.






32.1.4 Web Services Interoperability

The WS transport supports web services interoperability through WS-I Basic Profile. Currently, Oracle Service Bus proxy services do not follow all the WS-I Basic Profile restrictions. However, any services configured to use this transport strictly follow the WS-I Basic Profile specification. WS proxy services do not have a WS-I Compliance check in the service configuration and always follow WS-I Basic Profile. This is valid for SOAP1.1 WSDL bindings as WS-I Basic Profile applies only to SOAP 1.1.








32.2 Authentication and Authorization of Services

This section provides information about how proxy and business services are authenticated and authorized.



32.2.1 Proxy Service Authentication

WS proxy services support both basic and client-certificate (two-way SSL) authentication. When basic authentication is specified in the WS-Policy, all HTTP requests, including RM protocol messages to the WS proxy service must have a valid username and password.

Proxy service authentication is supported as follows:

	
Outbound client-certificate authentication using SSL key-pair assigned to the service key provider referenced by the proxy service.


	
Username-password identity propagation through a WS proxy service (with basic authentication) to any other outbound transport, or outbound WSS username token.


	
Credential mapping between WS proxy service (with basic or two-way SSL authentication) and any other transport.


	
Sending asynchronous responses from WS proxy service to a RM client through HTTP or HTTPS. The default protocol used by proxy and business services is HTTP.


	
Asynchronous responses from a WS proxy service to an RM client connect to the AcksTo or ReplyTo endpoint references specified by the RM client. The RM client can use either HTTP or HTTPS URL. If the RM client uses HTTPS, the RM client can request a client certificate during the SSL handshake. The WS transport uses the SSL key-pair of the service key provider upon request.









32.2.2 Proxy Service Authorization

Administrators can assign a transport-level access control policy to a WS proxy service in Oracle Service Bus Administration Console. As with all transports, this policy is enforced after the inbound transport provider passes the request message to the Oracle Service Bus binding layer before invoking the request pipeline. For more information, see Section 32.3.4, "Assigning Transport Access Control to Proxy Services."






32.2.3 Business Service Authentication

WS business services support basic authentication and client-certificate authentication. Outbound basic authentication is supported by means of a service account. Username/password identity propagation and credential mapping are provided by the service account. However, a static account can also be used for authentication. The service account can be static, pass-through or mapped. Pass-through authentication allows passing a username/password from the client request to the back-end RM service. Mapped service accounts allow credential mapping. Static service accounts are used when fixed credentials are required.

WS business services also support SSL client-certificate authentication (two-way SSL). The key-pair (private key and certificate) used for outbound two-way SSL is not configured on the WS business service, but on the service key provider referenced by the proxy service.

Routing a single message to a WS business service may involve multiple HTTP/S requests from the Oracle Service Bus server and back-end service. All such messages are subject to the authentication method configured in the WS business service. In other words, if the service is configured for basic authentication, all messages sent from Oracle Service Bus include the HTTP Authorization header with the username/password and if the message is configured for client-certificate authentication, Oracle Service Bus uses the key-pair to authenticate all messages.








32.3 Using the WS Transport

You can use the WS transport to reliably deliver messages in a distributed network.

The WSRM functionality is available as a transport only for SOAP 1.1 and SOAP 1.2 based WSDLs with WSRM policy. Ensure that the services are associated with a SOAP 1.l or 1.2 WSDLs with RM-policy or that a RM-policy is attached to the services. You can configure the WS-Policy in a WSDL or assign it to a service. For more information, see Section 32.3.1.1, "Configuring WS Policies."

Prior to configuring proxy and business services to use the WS transport, ensure that the required WSDLs or WS-Policy files are available in your Oracle Service Bus domain. For more information, see Section 32.3.1, "Adding Resources to an Oracle Service Bus Domain," Section 32.3.3, "Configuring Proxy Services to Use the WS Transport," and Section 32.3.6, "Configuring Business Services to Use the WS Transport."

You can optionally configure an error queue for services and Oracle Service Bus delivers failed messages into the queue. The queue can be a distributed queue. Because this queue is not created automatically, you must create it prior to configuring the services. For more information, see Section 32.3.2, "Configuring an Error Queue."

In addition, you can also import and export resources using the Oracle Service Bus Administration Console. For more information, see Section 32.5, "Importing and Exporting Resources" and Section 32.6, "Importing and Publishing Services Using UDDI Registries."



32.3.1 Adding Resources to an Oracle Service Bus Domain

You can add WSDLs, and custom WS-Policy files to the domain using the Oracle Service Bus Administration Console.



32.3.1.1 Configuring WS Policies

The WS transport can be used only with SOAP WSDLs that have a WSRM policy. You can configure a WS-Policy in a WSDL or assign a WS-Policy to a Service in the Oracle Service Bus service configuration tools. For more information, see Section 32.1.2, "Policies."

When no RM police assertions are specified for the WSDL associated with a service (you configure a service using a WSDL with no policy), a validation message appears when you activate the session.


Figure 32-1 Conflicts – When no RM policy assertions are specified for the WSDL

[image: Description of Figure 32-1 follows]





To resolve this conflict, you need to update the WSDL or attach the policy to the service. For more information, see Section 32.3.1.2, "Attaching WS Policies to a Service" and Chapter 51, "Using WS-Policy in Oracle Service Bus Proxy and Business Services."






32.3.1.2 Attaching WS Policies to a Service

To attach a WS-Policy file to a service:

	
Locate the proxy or business service and click the name of the service.

The View a Proxy Service or Business Service page appears.


	
Select the Policies tab. You can view the service policy configuration details.


	
Select the From Pre-defined Policy or WS-Policy Resource option.


	
Expand the proxy service folder and click Add.

The Select WS-Policy page appears.


	
You can search for the required policy and select the policy from the list of predefined policies or custom policy resources and click Submit.


	
Click Update.




The selected policy is now attached to the proxy service or business service.




	
Note:

When you attach a WS-Policy to a service, any policies defined in the WSDL associated with the service are ignored.
















32.3.2 Configuring an Error Queue

By default, undelivered messages are discarded after the specified number of retries. However, you can optionally configure error queues for business services and Oracle Service Bus delivers messages that fail in the message flow into these queues.

You must configure a JMS queue for errors. Oracle recommends that you configure a error queue locally instead of a remote queue.

For business services, when response timeout occurs, the response pipeline is invoked with an error. If sequence expiration interval is reached, the message is placed in an error queue configured for the business service and the response pipeline is invoked with an error. However, if the response timeout has already occurred, the message is placed in the error queue, but the response pipeline is not invoked.




	
Note:

For both one-way and request-response services, putting failed messages in the error queue is only a best effort.














32.3.3 Configuring Proxy Services to Use the WS Transport

Proxy services using the WS transport must be associated with WS-Policy with RM assertions. For more information, see Section 32.1.2, "Policies."

A proxy service receives the requests from clients and passes it to the message flow after the processing related to WSRM is done. The proxy service could also send the response back to the client after receiving it from the response pipeline. A proxy service using the WS transport can be invoked from any other proxy service and it follows the same behavior as it is invoked by an external client.

When an HTTP proxy server is configured (per WLS wsee stack), WS proxy services send asynchronous messages using the HTTP proxy server.

Proxy services based on WSDL with SOAP 1.2 binding support SOAP 1.2 messages only and throw a fault with version mismatch error for SOAP 1.1 messages. Similarly, proxy services based on WSDL with SOAP 1.1 binding support SOAP 1.1 messages only and throw a fault with version mismatch error for SOAP 1.2 messages.

When you create a proxy service from the Oracle Service Bus Administration Console, select the transport protocol as ws in the Transport Configuration page.




	
Note:

For more information about configuring proxy services, see Chapter 2, "Working with Proxy Services."









Table 32-1 describes the fields you can specify to configure a proxy service to use the WS transport:


Table 32-1 Fields Required to Configure a Proxy Service to Use the WS Transport

	Field	Description
	
Protocol

	
Select ws from the list of available protocols.


	
Endpoint URI

	
Endpoint configuration for a proxy service that uses the WS transport is similar to that of http/s proxy service configuration. Specify the URI in /contextPath format.

Note: Make sure that the context path is unique for proxy services that use either HTTP or the WS transport.








Now, you must specify configuration details specific to the WS transport.

Table 32-2 describes the dispatch policy and advanced options like the retry count and retry delay values you can specify to configure the WS transport for a proxy service.


Table 32-2 Fields Required to Configure WS Transport for a Proxy Service

	Field	Description
	
Dispatch Policy

	
Select the instance of Oracle WebLogic Server Work Manager that you want to use for the dispatch policy for this endpoint. The default Work Manager is used if no other Work Manager exists.

For information about Work Managers, see:

	
"Using Work Managers to Optimize Scheduled Work" in Oracle Fusion Middleware Configuring Server Environments for Oracle WebLogic Server


	
"Using Work Managers with Oracle Service Bus" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus





	
Retry Count

	
The number of times, the WSRM layer tries to deliver a message to the Oracle Service Bus message flow. The default is 3.

If an unhandled exception occurs in the request flow of a proxy, the incoming WS Transport message is redelivered to the message flow up to the number of times specified by this value. This is important for reliably processing the WS transport messages.

Note: When the message delivery fails, the current transaction is rolled back, but the message is not removed from the queue. The server tries to send the message until the message is successfully delivered or the retry limit is reached. When the retry limit is reached, that message is removed from the queue or moved to an error queue. The error queue can be a distributed queue and can be created from the Oracle WebLogic Server Administration Console. For more information, see Section 32.3.2, "Configuring an Error Queue."


	
Retry Delay

	
The duration that the server should wait before retrying to deliver the message. The default is 5 seconds.








For more information about configuring proxy services using the WS transport, see WS Transport Configuration Page in Chapter 2, "Working with Proxy Services."






32.3.4 Assigning Transport Access Control to Proxy Services

Administrators can assign a transport-level access control policy to a WS Proxy Service in the Oracle Service Bus Administration Console. As with all transports, this policy is enforced after the inbound transport provider passes the request message to the Oracle Service Bus binding layer before invoking the request pipeline.

Transport-level access control policies are managed within Oracle Service Bus sessions. When the session is activated, the access policy is stored in an Authorization Provider. At runtime, the binding layer calls the security framework authorization APIs, which in turn call the authorization provider.

To determine the access control of the proxy service resources at runtime, administrators can add one or more policy conditions. For example, a basic policy might simply name the Operator user. At runtime, the security framework interprets this policy as "only an Operator can access the proxy service resources." For more information, see Section 32.3.4.1, "Adding Policy Conditions."




	
Caution:

Proxy services configured in the Oracle Service Bus Administration Console to use the WS transport can also be viewed in the Oracle WebLogic Server Administration Console. Administrators can assign an access control policy from the Oracle WebLogic Server Administration Console and the Oracle Service Bus Administration Console. However, policies assigned from the Oracle WebLogic Server Administration Console will have no effect and are not evaluated at runtime. Only access control policies assigned in the Oracle Service Bus Administration Console are enforced.









To assign transport access control to a proxy service:

	
Locate the proxy service and click the proxy service name.


	
In the View a Proxy Service page, click the Security tab.


Figure 32-2 Security tab for a Proxy Service

[image: Description of Figure 32-2 follows]





	
Click the name of the proxy service.

You can set the transport-level policy of the proxy service in this page.


Figure 32-3 Transport-Level Policy

[image: Description of Figure 32-3 follows]





	
Click Add Conditions. The Choose a Predicate page appears.


	
Select the required predicate and click Next. The Edit Arguments page appears.


	
Enter the parameters and values associated with the predicate to define the policy conditions.

Administrators can:

	
Create complex conditions and combine them using the logical operators AND and OR (which is an inclusive OR). A combination of conditions can be uncombined later, if required.


	
Negate any condition, which would make sure that the inverse of the specified policy condition is applied.


	
Specify the order in which the policy conditions are executed.


	
Remove existing policy conditions.


	
Apply the AND and OR operators between multiple conditions.




At runtime, the entire collection of conditions must be true for the proxy service.

For more information about the parameters to be specified for each predicate, see Section 32.3.4.1, "Adding Policy Conditions."


	
Click Save.


	
Click Back and click Update.




The specified access control policy conditions are now associated with the proxy service and applied at runtime.



32.3.4.1 Adding Policy Conditions

The policy conditions set by an administrator control access the access control to the proxy service resources. When you add a condition to a policy statement, you can use any of the existing predicates or policy conditions. Each predicate is a predefined statement that can be used to define the security policy statement. For each predicate, you need to edit the arguments that are associated with that predicate.

Click Add Conditions to view the list of predicates.


Figure 32-4 List of Predicates

[image: Description of Figure 32-4 follows]





These predicates include:

	
Basic policy conditions that include adding specified users, groups, or roles, allowing or denying access to everyone, and so on.


	
Date and time based policy conditions, which are used to grant access to the resources based on the date or time you specify.


	
Context element policy conditions, which are used to create policies based on the value of HTTP Servlet Request attributes, HTTP Session attributes, and EJB method parameters.




To Add or Remove a role to the policy condition: 

	
Select Role from the Predicate List.


	
Click Next. The Edit Arguments page appears.


	
Specify the role and click Add.

You can add one or more roles to this policy condition. If you add multiple roles, the condition evaluates as true if the user is a member of ANY of the roles associated with this policy condition.




	
Note:

To remove any role, select the role in the Remove list and click Remove.










	
Click Finish.




The condition is added to the policy statement and displayed on the policy conditions page.

To add a group to the policy condition: 

	
Select Group from the Predicate List.


	
Click Next. The Edit Arguments page appears.


	
Specify the group name and click Add.

You can add one or more groups to this policy condition. If you add multiple groups, the condition evaluates as true if the user is a member of ANY of the groups associated with this policy condition.




	
Note:

To remove any group, select the group in the Remove list and click Remove.










	
Click Finish.




The condition is added to the policy statement and displayed on the policy conditions page.

To add a user to the policy condition: 

	
Select User from the Predicate List.


	
Click Next. The Edit Arguments page appears.


	
Specify the user name and click Add.

You can add one or more users to this role.




	
Note:

To remove any user, select the user in the Remove list and click Remove.










	
Click Finish.




The condition is added to the policy statement and displayed on the policy conditions page.

To enable access to proxy service resources only on specified days of the week: 

	
Select Access occurs on specified days of the week from the Predicate List.


	
Click Next. The Edit Arguments page appears.


	
Enter the day of the week.


	
Enter the GMT offset. If the time zone in your location is ahead of GMT, enter GMT + hh:mm and if time zone in your location is behind GMT, enter GMT -hh:mm.


	
Click Finish.




The condition is added to the policy statement and displayed on the policy conditions page.

To enable access to proxy service resources only between a specified time: 

	
Select Access occurs between specified hours from the Predicate List.


	
Click Next. The Edit Arguments page appears.


	
Enter the start time and the end time between which access to resources to enabled. Enter time in hh:mm AM|PM format.


	
Enter the GMT offset. If the time zone in your location is ahead of GMT, enter GMT + hh:mm and if time zone in your location is behind GMT, enter GMT -hh:mm.


	
Click Finish.




The condition is added to the policy statement and displayed on the policy conditions page.

To enable access to proxy service resources only when the context element's value is greater than a numeric constant: 

	
Select Context element's value is greater than a numeric constant from the Predicate List.


	
Click Next. The Edit Arguments page appears.


	
Enter the name of the context element.


	
Enter a numeric value. Access to resources is enabled only when the specified context element's value is greater than this number.


	
Click Finish.




The condition is added to the policy statement and displayed on the policy conditions page.

To deny access to everyone: 

	
Select Deny Access to everyone from the Predicate List.


	
Click Finish.




All users and groups are denied access to the proxy service resources.

To enable access to proxy service resources only when the context element's value is equal to a numeric constant: 

	
Select Context element's value equals a numeric constant from the Predicate List.


	
Click Next. The Edit Arguments page appears.


	
Enter the name of the context element.


	
Enter a numeric value. Access to proxy service resources is enabled only when the specified context element's value is equal to this number.


	
Click Finish.




The condition is added to the policy statement and displayed on the policy conditions page.

To enable access to proxy service resources only before a specified date: 

	
Select Access occurs before from the Predicate List.


	
Click Next. The Edit Arguments page appears.


	
Enter the date before which access to proxy service resources is enabled. Enter date in m/d/yy or m/d/yy hh:mm:ss AM|PM format.


	
Enter the GMT offset. If the time zone in your location is ahead of GMT, enter GMT + hh:mm and if time zone in your location is behind GMT, enter GMT -hh:mm.


	
Click Finish.




The condition is added to the policy statement and displayed on the policy conditions page.

To enable access to proxy service resources only on the specified day of the month: 

	
Select Access occurs on the specified day of the month from the Predicate List.


	
Click Next. The Edit Arguments page appears.


	
Enter the day of the month on which access to proxy service resources is enabled.

Access to proxy service resources is enabled only after an ordinal day in the month. Enter the ordinal number of the day within the current month with values in the range from -31 to 31. Negative values count back from the end of the month, so the last day of the month is specified as -1. 0 indicates the day before the first day of the month.


	
Enter the GMT offset. If the time zone in your location is ahead of GMT, enter GMT + hh:mm and if time zone in your location is behind GMT, enter GMT -hh:mm.


	
Click Finish.




The condition is added to the policy statement and displayed on the policy conditions page.

To enable access to proxy service resources only when the context element's value is equal to a string constant: 

	
Select Context element's value equals a string constant from the Predicate List.


	
Click Next. The Edit Arguments page appears.


	
Enter the name of the context element.


	
Enter a string value. Access to proxy service resources is enabled only when the specified context element's value is equal to this string value.


	
Click Finish.




The condition is added to the policy statement and displayed on the policy conditions page.

To enable access to proxy service resources only when the defined context element is available: 

	
Select Context element defined from the Predicate List.


	
Click Finish.




Access to proxy service resources is enabled only when the specified context element exists.

To allow access to everyone: 

	
Select Allow Access to everyone from the Predicate List.


	
Click Finish.




Access to proxy service resources is enabled to all users and groups.

To enable access to proxy service resources only after a specified date: 

	
Select Allow access after from the Predicate List.


	
Click Next. The Edit Arguments page appears.


	
Enter the date after which access to proxy service resources is enabled. Enter date in m/d/yy or m/d/yy hh:mm:ss AM|PM format.


	
Enter the GMT offset. If the time zone in your location is ahead of GMT, enter GMT + hh:mm and if time zone in your location is behind GMT, enter GMT -hh:mm.


	
Click Finish.




The condition is added to the policy statement and displayed on the policy conditions page.

To enable access to proxy service resources only before the specified day of the month: 

	
Select Access occurs before the specified day of the month from the Predicate List.


	
Click Next. The Edit Arguments page appears.


	
Enter the day of the month before which access to proxy service resources is enabled.

Access to proxy service resources is enabled only before an ordinal day in the month. Enter the ordinal number of the day within the current month with values in the range from -31 to 31. Negative values count back from the end of the month, so the last day of the month is specified as -1. 0 indicates the day before the first day of the month.


	
Enter the GMT offset. If the time zone in your location is ahead of GMT, enter GMT + hh:mm and if time zone in your location is behind GMT, enter GMT -hh:mm.


	
Click Finish.




The condition is added to the policy statement and displayed on the policy conditions page.

To enable access to proxy service resources only when the context element's value is less than a numeric constant: 

	
Select Context element's value is less than a numeric constant from the Predicate List.


	
Click Next. The Edit Arguments page appears.


	
Enter the name of the context element.


	
Enter a numeric value. Access to proxy service resources is enabled only when the specified context element's value is less than this number.


	
Click Finish.




The condition is added to the policy statement and displayed on the policy conditions page.

To enable access to proxy service resources only after the specified day of the month: 

	
Select Access occurs after the specified day of the month from the Predicate List.


	
Click Next. The Edit Arguments page appears.


	
Enter the day of the month after which access to proxy service resources is enabled.

Access to proxy service resources is enabled only after an ordinal day in the month. Enter the ordinal number of the day within the current month with values in the range from -31 to 31. Negative values count back from the end of the month, so the last day of the month is specified as -1. 0 indicates the day before the first day of the month.


	
Enter the GMT offset. If the time zone in your location is ahead of GMT, enter GMT + hh:mm and if time zone in your location is behind GMT, enter GMT -hh:mm.


	
Click Finish.




The condition is added to the policy statement and displayed on the policy conditions page.

To enable access to proxy service resources only when Server is running in development mode: 

	
Select Server is in development mode from the Predicate List.


	
Click Finish.




Users and groups can access the proxy service resources only when the server is running in development mode.








32.3.5 Routing the WS Transport Through an HTTP Proxy Server

When an HTTP proxy server is configured, WS business services send outbound messages using the HTTP proxy server. For information about specifying the HTTP proxy server details in your client application, see "Using a Proxy Server When Invoking a Web Service" in "Invoking Web Services" in Oracle Fusion Middleware Getting Started With JAX-RPC Web Services for Oracle WebLogic Server.






32.3.6 Configuring Business Services to Use the WS Transport

Business services using the WS transport must be associated with WS-Policy with RM assertions. For more information, see Section 32.1.2, "Policies." A business service acts as a client for invoking an external reliable web service. It sends a request to the service and the response is received by an application deployed by Oracle Service Bus, which invokes the response path.

When you create a business service from the Oracle Service Bus Administration Console based on the WSDL resource, select the transport protocol as ws in the Transport Configuration page.




	
Note:

For more information about configuring business services, see Section 2.2, "Working with Business Services."









Table 32-3 describes the fields you must specify to configure a business service to use the WS transport, specify the following fields:


Table 32-3 Configuring a Business Service to use WS Transport

	Field	Description
	
Protocol

	
Select ws from the list of available protocols.


	
Load Balancing Algorithm

	
Specify the load balancing algorithm as any one of the following values:

	
Round-robin


	
Random


	
Random-weighted


	
None





	
Endpoint URI

	
Point to the location of the web service. Endpoint configuration for a business service that uses the WS transport is similar to that of http/https configuration. Specify the URI in http://host:port number/name or https://host:port number/name format.

Business services can have multiple endpoint URIs pointing to different reliable web services.


	
Retry Count

	
In case of delivery failure when sending outbound requests, specify the number of times to retry individual URL endpoints. The number in this field indicates the total number of times URIs are retried (not the number of URIs in the list).


	
Retry Iteration Interval

	
Specify the number of seconds the system should pause between retries of all the endpoint URIs in the list.


	
Retry Application Errors

	
Select Yes or No.

In case of delivery failure when sending outbound requests, specify whether or not to retry endpoint URIs based on application errors (for example, a SOAP fault). For more information, see Section 32.4, "Error Handling."








To configure the WS transport for a business service, specify the values as described in Table 32-4:


Table 32-4 Configuring WS Transport for Business Service

	Field	Description
	
Response Timeout

	
If the response does not come in the defined interval after sending a request, response pipeline is invoked with an error saying that service is timed out. A value of 0 implies that there would be no response timeout.


	
Service Account

	
Specify a service account.

Note: This is only applicable if the WS business service has a WS-Policy that requires basic authentication

For more information, see Section 2.1.15, "Creating Service Account Resources."


	
Queue Error Messages

	
Select this option to send failed requests to an error queue. The following fields are available only if you select this option.


	
Error Queue URI

	
Error queue used for failed requests in the business service. Specify the URI in jms://host:port/conn-factory-jndi-name/queue-jndi-name format.

Notes: This queue can be a distributed queue. It is not created automatically so, make sure that a valid queue is available. For more information, see Section 32.3.2, "Configuring an Error Queue."

While Oracle WebLogic Server allows forward slashes in JNDI names, such as "myqueues/myqueue", JNDI names with forward slashes interfere with the URI format required by Oracle Service Bus, and you cannot use those names. To work around this issue, define a JMS foreign server and reference that foreign server in the URI. For more information, see "Configure foreign servers" in the Oracle Fusion Middleware Oracle WebLogic Server Administration Console Online Help.


	
JMS Error Queue Service Account

	
The service account to be used for connecting to the JMS error queue.


	
Use SSL for Error Queue

	
Select this option to use SSL for connecting to a JMS error queue.








For more information about configuring business services using the WS transport, Section 2.2, "Working with Business Services."








32.4 Error Handling

You can configure the WS transport-based business services to handle application errors by specifying whether or not to retry business service endpoint URIs when application errors occur. See Section 4.2.4, "Business Service Transport Configuration Page."

An application error occurs when a WS transport-based business service receives a SOAP fault as a response and the BEA-380001 error code is generated.




	
Note:

When a response timeout or sequence timeout occurs for a request to a business service, the Oracle Service Bus server tries to send the message to the next URI based on the load balancing algorithm. This behavior does not depend on the Retry Application Errors option.














32.5 Importing and Exporting Resources

When a resource exists in an Oracle Service Bus domain, you can preserve the security and policy configuration details while importing that resource to Oracle Service Bus by selecting the Preserve Security and Policy Configuration option. When you select this option, the values in the existing resource are preserved when you import them, even if the security and policy configurations have been updated in the resource.

For information about importing resources, see Section 2.1.14, "Importing Resources."






32.6 Importing and Publishing Services Using UDDI Registries

When a proxy service is published to an UDDI registry, the service is converted into WS business service with the WSDL. If present, the authentication configuration is also exported to UDDI.

When a WSDL-based business service with WSRM policy is imported from an UDDI registry to Oracle Service Bus, the service is imported as a WS business service that is automatically configured to use the WS transport. For more information, see Section 32.1.2, "Policies."

For more information, see "UDDI" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus.







Design Considerations





38 Design Considerations


This chapter describes concepts, functionality, and design considerations for developing a custom transport provider for use with Oracle Service Bus.

Careful planning of development activities can greatly reduce the time and effort you spend developing a custom transport provider.

This chapter includes the following sections:

	
Section 38.1, "What is a Transport Provider?"


	
Section 38.2, "What is the Transport SDK?"


	
Section 38.3, "Do You Need to Develop a Custom Transport Provider?"


	
Section 38.4, "Transport Provider Components"


	
Section 38.5, "The Transaction Model"


	
Section 38.6, "The Security Model"


	
Section 38.7, "The Threading Model"


	
Section 38.8, "Designing for Message Content"






38.1 What is a Transport Provider?

A transport provider implements the interfaces of the Transport SDK and provides a bridge between Oracle Service Bus and mechanisms by which messages are sent or received. Such mechanisms can include specific transport protocols, such as HTTP, as well as other entities, such as a file or an email message. A transport provider manages the life cycle and runtime behavior of transport endpoints. An endpoint is a resource where messages originate or are targeted.

Figure 38-1 illustrates the basic flow of messages through Oracle Service Bus. A client sends a message to Oracle Service Bus using a specific transport protocol. A transport provider processes the inbound message, handling communication with the service client endpoint and acting as the entry point for messages into Oracle Service Bus.


Figure 38-1 Message Flow Through Oracle Service Bus

[image: Description of Figure 38-1 follows]





The binding layer, also shown in Figure 38-1, packs and unpacks messages, handles message security, and hands messages off to the Oracle Service Bus Pipeline.




	
Tip:

For more information on Oracle Service Bus message brokering and the role of the transport layer, see Oracle Fusion Middleware Concepts and Architecture for Oracle Service Bus. For more detailed sequence diagrams that describe the message flow through Oracle Service Bus, see Appendix A, "Transport SDK UML Sequence Diagrams."









By default, Oracle Service Bus includes transport providers that support several commonly used transport protocols, such as HTTP, JMS, File, FTP, and others. These native providers let you configure proxy and business services that require these common transport protocols.




	
Tip:

For more information using and configuring native transport providers, see Part V, "Transports".














38.2 What is the Transport SDK?

This section briefly describes the purpose and features of the Transport SDK. This section includes these topics:

	
Section 38.2.1, "Purpose of the SDK"


	
Section 38.2.2, "Transport SDK Features"


	
Section 38.2.3, "Transport Provider Modes"


	
Section 38.2.4, "Related Features"






38.2.1 Purpose of the SDK

Oracle Service Bus processes messages independently of how they flow into or out of the system. The Transport SDK provides a layer of abstraction between Oracle Service Bus and components that deal with the flow of data in and out of Oracle Service Bus. This layer of abstraction lets you develop new transport providers to handle unique transport protocols.

The SDK abstracts from the rest of Oracle Service Bus:

	
Handling specific transport bindings


	
Deploying service endpoints on the transport bindings. An endpoint is either capable of transmitting or receiving a message.


	
Collecting monitoring information


	
Managing endpoints (such as performing suspend/resume operations and setting connection properties)


	
Enforcing Service Level Agreement (SLA) behavior (such as timing out connections)









38.2.2 Transport SDK Features

This section describes the primary features of the Transport SDK.



38.2.2.1 Handling Inbound and Outbound Messages

A transport provider developed with the Transport SDK handles inbound and outbound messages as follows:

	
Inbound messages typically come into Oracle Service Bus from an outside source, such as an HTTP client. The Transport SDK packages the payload and transport level headers, if any, into a generic data structure. The Transport SDK then passes the message, in its generic format, to the Oracle Service Bus pipeline.


	
Outbound messages originate from Oracle Service Bus business services and go to an externally managed endpoint, such as a Web service or JMS queue. The Transport SDK receives a generic data structure from the Oracle Service Bus pipeline, converts it to the corresponding transport-specific headers and payload, and sends it out to an external system.




The Transport SDK handles outbound and inbound messages independently. An inbound message can be bound to one transport protocol and bound to a different transport protocol on the outbound endpoint.






38.2.2.2 Deploying Transport-Related Artifacts

Certain transports include artifacts that need to be deployed to Oracle WebLogic Server. For instance, a JMS proxy is implemented as a message-driven bean. This artifact, an EAR file, must be deployed when the new JMS proxy is registered. Similarly, the EJB transport provider employs an EAR file that must be deployed when a new EJB business service is registered. Other kinds of artifacts might require deployment, such as a JMS transport, which may create queues and topics as part of the service registration. The SDK lets you support these artifacts and lets you participate in the WLS deployment cycle. If the deployment of one of these artifacts fails, the Oracle Service Bus session is notified and the deployment is canceled. This feature of the SDK allows for the atomic creation of services. If something fails, the session reverts to its previous state.




	
Note:

To participate in WLS deployment cycle, the transport provider must implement the TransportWLSArtifactDeployer interface. The primary benefit of this technique is atomic Oracle WebLogic Server deployment, which can be rolled back if needed. For more information on this interface, see Section 41.3.2, "Summary of General Interfaces," and see Section 39.11, "When to Implement TransportWLSArtifactDeployer."














38.2.2.3 Processing Messages Asynchronously

Because the server has a limited number of threads to work with when processing messages, asynchrony is important. This feature allows Oracle Service Bus to scale to handle large numbers of messages. After a request is processed, the thread is released. When the business service receives a response (or is finished with the request if it is a one-way message), it notifies Oracle Service Bus asynchronously through a callback.

See also Section 38.5.2, "Support for Synchronous Transactions" and Section 38.7, "The Threading Model."








38.2.3 Transport Provider Modes

With the Transport SDK, you can implement inbound property modes and outbound property modes. These connection and endpoint modes are specified in the transport provider's XML Schema definition file. For more information on this file, see Section 39.3.3, "3. Create an XML Schema File for Transport-Specific Artifacts." This schema is available to the Oracle Service Bus Pipeline for filtering and routing purposes.






38.2.4 Related Features

This section lists related features that are provided by the transport manager. The transport manager provides the main point of centralization for managing different transport providers, endpoint registration, control, processing of inbound and outbound messages, and other functions. These features do not require specific support by a transport provider.



38.2.4.1 Load Balancing

The Transport SDK supports load balancing and failover for outbound messages. Supported load balancing options are:

	
None – For each outbound request, the transport provider cycles through the URIs in the list in which they were entered and attempts to send a message to each URI until a successful send is completed.


	
Round Robin – Similar to None, but in this case, the transport provider keeps track of the last URI that was tried. Each time a message is sent, the provider starts from the last position in the list.


	
Random – The transport provider tries random URIs from the list in which they were entered.


	
Weighted Random – Each URI is associated with a weight. An algorithm is used to pick a URI based on this weight.









38.2.4.2 Monitoring and Metrics

The transport manager handles monitoring metrics such as response-time, message-count, error-count, failover-count, throttling-time, and cache-hit-count.










38.3 Do You Need to Develop a Custom Transport Provider?

This section explains the basic use cases for writing a custom transport provider. In some cases, it is appropriate to chose an alternative approach. This section includes the following topics:

	
Section 38.3.1, "When to Use the Transport SDK"


	
Section 38.3.2, "When Alternative Approaches are Recommended"






38.3.1 When to Use the Transport SDK

One of the prime use cases for the Transport SDK is to support a specialized transport that you already employ for communication between your internal applications. Such a transport may have its own concept of setup handshake, header fields, metadata, or transport-level security. Using the Transport SDK, you can create a transport implementation for Oracle Service Bus that allows configuring individual endpoints, either inbound, outbound or both. With a custom transport implementation, the metadata and header fields of the specialized transport can be mapped to context variables available in a proxy service pipeline.

Use the Transport SDK when the transport provider needs to be seamlessly integrated into all aspects of Oracle Service Bus for reliability, security, performance, management, user interface, and the use of the UDDI registry.

Some cases where it is appropriate to use the Transport SDK to develop a custom transport include:

	
Using a proprietary transport that requires custom interfaces and supports an organization's existing applications.


	
Using a CORBA or IIOP protocol for communicating with CORBA applications.


	
Using other legacy systems, such as IMS and Mainframe.


	
Using variations on existing transports, such as SFTP (Secure FTP) and the native IBM WebSphere MQ API (instead of WebSphere MQ JMS).


	
Using industry-specific transports, such as LLP, AS3, and ACCORD.


	
Using raw sockets, perhaps with TEXT or XML messages. A sample implementation of this type of transport is described in Chapter 42, "Sample Socket Transport Provider."




Alternatively, you can use the Transport SDK to support a specialized protocol over one of the existing transports provided with Oracle Service Bus. Examples of this could include supporting:

	
Messages consisting of parsed or binary XML over HTTP.


	
WS-RM or other new Web service standards over HTTP.


	
Request-response messaging over JMS, but with a different response pattern than either of the two patterns supported by the Oracle Service Bus JMS transport (for example, a response queue defined in the message context).









38.3.2 When Alternative Approaches are Recommended

Creating a new Oracle Service Bus transport provider using the Transport SDK can be a significant effort. The Transport SDK provides a rich, full featured environment so that a custom transport has all of the usefulness and capabilities of the transports that come natively with Oracle Service Bus. But such richness brings with it some complexity. For certain cases, you might want to consider easier alternatives.

If you need an extension merely to support a different format message sent or received over an existing protocol, it may be possible to use the existing transport and use a Java Callout to convert the message. For example, suppose you have a specialized binary format (such as ASN.1 or a serialized Java object) being sent over the standard JMS protocol. In this case, you might consider defining the service using the standard JMS transport with the service type being a messaging service with binary input/output messages. Then, if the contents of the message are needed in the pipeline, a Java Callout action can be used to convert the message to or from XML. For information on using Java Callouts, see "Extensibility Using Java Callouts and POJOs" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus.

Other cases where it is best not to use the Transport SDK to develop a custom transport provider include:

	
When combining existing Oracle solutions with Oracle Service Bus satisfies the transport requirement: Oracle WebLogic Server, Oracle WebLogic Integration, Oracle Data Service Integrator, Oracle Business Process Management, Oracle Tuxedo, Oracle WebLogic Portal.


	
When service enablement tools, like Eclipse, provide a simpler and more standards-based mechanism to implement SOA practices.


	
When alternative connectivity solutions (certified with Oracle Service Bus) also address the requirement. For example: iWay adapters and Cyclone B2B.


	
When EJBs can be used instead as a means to abstract some type of simple Java functionality.











38.4 Transport Provider Components

This section presents UML diagrams that depict the runtime and design-time components of a transport provider. This section includes these topics:

	
Section 38.4.1, "Overview"


	
Section 38.4.2, "Design-Time Component"


	
Section 38.4.3, "Runtime Component"






38.4.1 Overview

In general, a custom transport provider consists of a design-time part and a runtime part. The design-time part is concerned with registering endpoints with the transport provider. This configuration behavior is provided by the implementation of the UI interfaces. The runtime part implements the mechanism of sending and receiving messages.

When you develop a new custom transport provider, you need to implement a number of interfaces provided by the SDK. This section includes UML diagrams that model the organization of the design-time and runtime parts of the SDK.




	
Tip:

In Oracle Service Bus, implementations of the TransportProvider interface represent the central point for management of transport protocol-specific configuration and runtime properties. A single instance of a TransportProvider object exists for every supported protocol. For example, there are single instances of HTTP transport provider, JMS transport provider, and others.









For more information, see Chapter 39, "Developing a Transport Provider," for a list of the required interfaces. A summary of the interfaces and classes provided by the Transport SDK are discussed in Chapter 41, "Transport SDK Interfaces and Classes." Detailed descriptions are provided in the Oracle Fusion Middleware Java API Reference for Oracle Service Bus.






38.4.2 Design-Time Component

The design-time part of a custom transport provider consists of the user interface configuration. This configuration is called by the Oracle Service Bus Administration Console or IDE when a new business or proxy service is being registered. Figure 38-2 shows a UML diagram that depicts the structure of the design time part of a transport provider. Some of the interfaces described in the diagram include:

	
TransportManager – A transport provider communicates with the transport manager through this interface. The implementation is not public.


	
TransportProvider – Third parties must implement this interface. The TransportProvider keeps track of TransportEndpoint objects. TransportProvider also manages the life cycle of the endpoints. For example, you can suspend a transport endpoint, which is managed through the TransportProvider interface.


	
TransportUIBinding – Helps the Oracle Service Bus Administration Console render the transport specific pages.





Figure 38-2 Design Time UML Diagram

[image: Description of Figure 38-2 follows]








	
Note:

Each transport endpoint has a configuration that consists of some properties that are generic to all endpoints of any transport provider, such as a URI, and some properties that are specific to endpoints of that provider only. Figure 38-3 shows the relationship between the shared endpoint configuration properties and transport provider specific configuration properties. See Section 38.5.1, "Overview of Transport Endpoint Properties." for more information.










Figure 38-3 EndPointConfiguration Properties

[image: Description of Figure 38-3 follows]









38.4.3 Runtime Component

The runtime part of a custom transport provider:

	
Receives messages and delivers them to the Oracle Service Bus runtime.


	
Delivers outbound messages from Oracle Service Bus runtime to external services.




In the runtime framework, the transport provider calls the transport manager to acknowledge that an inbound message has been received. The transport message context contains the header and body of the inbound message. For the outbound message, there is a TransportSendListener and TransportSender. The transport provider retrieves the header and body from the message.

Figure 38-2 shows a UML diagram that depicts the structure of the runtime part of a transport provider.


Figure 38-4 Runtime UML Diagram

[image: Description of Figure 38-4 follows]











38.5 The Transaction Model

Before you develop a new transport provider using the Transport SDK, it is important to consider the transaction model for your message endpoints. This section discusses the transaction model used by Oracle Service Bus and how that model relates to the Transport SDK.

This section includes these topics:

	
Section 38.5.1, "Overview of Transport Endpoint Properties"


	
Section 38.5.2, "Support for Synchronous Transactions"






38.5.1 Overview of Transport Endpoint Properties

A transport endpoint is an Oracle Service Bus resource, such as a JMS proxy service, where messages are originated or targeted. In Oracle Service Bus, transport endpoints are managed by protocol-specific transport providers, plug-in objects that manage the life cycle and runtime behavior of transport endpoints.

To understand the transactional model of Oracle Service Bus, it is useful to review some of the properties of service transport endpoints.



38.5.1.1 Transactional vs. Non-Transactional Endpoints

A given endpoint may or may not be transactional. A transactional endpoint has potential to start or enlist in a global transaction context when processing a message. The following examples illustrate how transactional properties vary depending on the endpoint:

	
A JMS proxy service that uses the XA connection factory is a transactional endpoint. When the message is received, the container ensures that a transaction is started so that the message is processed in the context of a transaction.


	
A Tuxedo proxy service may or may not be a transactional endpoint. A Tuxedo proxy service is only transactional if a transaction was started by the Tuxedo client application before the message is received.


	
While an HTTP proxy service will not typically have an associated transaction when invoked by an HTTP client, you can set an option in the HTTP proxy service configuration that starts a transaction and executes the message flow in the context of that transaction.









38.5.1.2 Supported Message Patterns

A given endpoint can use one of the following message patterns:

	
One Way – No responses are expected. An example of a one-way endpoint is a JMS proxy service that does not expect a response.


	
Synchronous – A request or response is implied. In this case, the response message is paired with the request message implicitly because no other traffic can occur on the transport channel from the time the request is issued until the time the response is received. In most cases, a synchronous message implies blocking calls for outbound requests. An EJB endpoint is synchronous. An HTTP endpoint is also synchronous: a new request cannot be sent until a response is received.


	
Asynchronous – A request and response is implied. The response is correlated to a request through a transport-specific mechanism, such as a JMS transport and correlation through a JMSCorrelationID message property. For example, a JMS business service endpoint with request and response is asynchronous.











38.5.2 Support for Synchronous Transactions

All Oracle Service Bus proxy services support transaction propagation, can start a transaction if none already exists, and can optionally ensure that the response occurs in the context of the transaction, even if the outbound business service is asynchronous—in essence transforming an asynchronous pattern effectively into a synchronous pattern. Outbound business services can provide additional transaction support, such as suspending an existing transaction.

Synchronous transactional transports support the following use cases:



38.5.2.1 Use Case 1 (Response Pipeline Processing)

Response pipeline processing is included in an incoming transaction when the inbound transport supports synchronous transactions or when you configure a proxy service to propagate a transaction to the response. This case is supported when the inbound transport is paired with any other outbound transport, with the exception described in the note below.




	
Note:

A deadlock situation occurs when the inbound transport is synchronous transactional and the outbound transport is asynchronous transactional. The deadlock occurs because the outbound request is not available to be received by the business service until after the transaction commits, but the transaction was started externally and does not commit until Oracle Service Bus gets the response and returns. The transport manager recognizes this situation and avoids the deadlock by throwing a runtime error.

For example, if a synchronous transactional inbound endpoint is used, such as a Tuxedo proxy service, and the outbound endpoint is asynchronous transactional, such as a JMS business service, the outbound request does not commit the transaction until the response is received. It cannot be received until the external entity receives the request and processes it.









Also in this case, the Oracle Service Bus Publish action performed in the response pipeline is part of the transaction just like publish actions in the request pipeline are part of the transaction.




	
Note:

There are several actions that can potentially participate in a transaction (in either the request or response pipeline). These include Publish, Service Callout, and Report actions.









For example, if an inbound Tuxedo transport is synchronous transactional, it can be committed only after the request and response pipeline have been completed. In this case, the transport manager transfers the transaction context from the inbound to the outbound thread. When the response thread is finished, the transaction control and outcome are returned to the invoking client.






38.5.2.2 Use Case 2 (Service Callout Processing)

Oracle Service Bus Service Callouts allow you to make a callout from a proxy service to another service. If a Service Callout action is made to a synchronous transactional transport, the case of Exactly Once quality of service is supported in addition to Best Effort quality of service. Exactly Once means that messages are delivered from inbound to outbound exactly once, assuming a terminating error does not occur before the outbound message send is initiated. Best Effort means that each dispatch defines its own transactional context (if the transport is transactional). When Best Effort is specified, there is no reliable messaging and no elimination of duplicate messages; however, performance is optimized. See also Section 39.7, "Working with TransportOptions."

Callouts to synchronous transactional transports are optionally part of an existing transaction. For example, while the request pipeline is executing during a global transaction, Service Callouts are permitted to participate in the transaction. For example, if there is a callout to an EJB service, the service can participate in that transaction if it wants to by setting its quality of service value to Exactly Once.

For more information on Service Callouts, see Section 2.4.29, "Adding and Configuring Service Callout Actions in Message Flows."






38.5.2.3 Use Case 3 (Suspending Transactions)

Before calling the transport provider to send an outbound request the transport framework will suspend a transaction if the following conditions apply:

	
The outbound service endpoint is transactional.


	
There is a global XA transaction in progress.


	
The quality of service is set to Best Effort.




The suspended transaction will resume, after the "send" operation is complete.






38.5.2.4 Use Case 4 (Multiple URIs)

If a given outbound service endpoint has multiple URIs associated with it, and is transactional, failover only occurs while the transaction, if any, is not marked for rollback. For example, if a URI is called, and the service returns an error, a failover is normally triggered. In this event, the transport framework detects that the transaction has been marked for rollback; therefore, the framework does not perform a failover to a different URI.










38.6 The Security Model

The Transport SDK allows customers and third-parties to plug in new transports into Oracle Service Bus. Within the Oracle Service Bus security model, transport providers are considered trusted code. It is critical that transport provider implementations are carefully designed to avoid potential security threats by creating security holes. Although this document does not contain specific guidelines on how to develop secure transport providers, this section discusses the following security goals of the Transport SDK:

	
Section 38.6.1, "Inbound Request Authentication"


	
Section 38.6.2, "Outbound Request Authentication"


	
Section 38.6.3, "Link-Level or Connection-Level Credentials"


	
Section 38.6.4, "Uniform Access Control to Proxy Services"


	
Section 38.6.5, "Identity Propagation and Credential Mapping"






38.6.1 Inbound Request Authentication

Transport providers are free to implement whatever inbound authentication mechanisms are appropriate to that transport. For example: the HTTP transport provider supports these authentication methods:

	
HTTP BASIC


	
Custom authentication tokens carried in HTTP headers




The HTTPS transport provider supports SSL client authentication, in addition to the ones listed above. Both HTTP and HTTPS transport providers also support anonymous client requests.

The transport provider is responsible for implementing any applicable transport level authentication schemes, if any. If the transport provider authenticates the client it must make the client Subject object available to Oracle Service Bus by calling TransportManager.receiveMessage() within the scope of weblogic.security.Security.runAs(subject). For information on this method, see the Oracle Fusion Middleware Java API Reference for Oracle Service Bus.




	
Tip:

For information on the Java class Subject, see http://docs.oracle.com/javase/6/docs/api/javax/security/auth/Subject.html.









The proxy will use this Subject in the following ways:

	
During access control to the proxy service


	
To populate the message context variable $inbound/ctx:security/ctx:transportClient/*


	
As the input for identity propagation and credential mapping (unless there is also message-level client authentication)




If the transport provider does not support authentication, or if it supports anonymous requests, it must make sure the anonymous subject is on the thread before dispatching the request. Typically the transport provider will already be running as anonymous, but if this is not the case, then the provider must call:


Subject anonymous = SubjectUtils.getAnonymousUser() 
Security.runAs(anonymous, action)


The transport provider is also responsible for providing any Oracle Service Bus Administration Console configuration pages required to configure inbound client authentication.

The transport provider must clearly document its inbound authentication model.






38.6.2 Outbound Request Authentication

Transport providers are free to implement whatever outbound authentication schemes are appropriate to that transport. The transport SDK includes APIs to facilitate outbound username/password authentication, (two-way) SSL client authentication, and JAAS Subject authentication.



38.6.2.1 Outbound Username/Password Authentication

Outbound username/password authentication can be implemented by leveraging Oracle Service Bus service accounts. Service accounts are first-class, top-level Oracle Service Bus resources. Service accounts are created and managed in the Oracle Service Bus Administration Console. Transport providers are free to design their transport-specific configuration to include references to service accounts. That way the transport provider can make use of the credential management mechanisms provided by Oracle Service Bus service accounts.

Transport providers don't have to worry about the details of service account configuration. There are three types of service accounts:

	
Static – A static service account is configured with a fixed username/password.


	
Mapped – A mapped service account contains a list of remote-users/remote-passwords and a map from local-users to remote-users. Mapped service accounts can optionally map the anonymous subject to a given remote user.


	
Pass-through – A pass-through service account indicates that the username/password of the Oracle Service Bus client must be sent to the back-end.




An outbound endpoint can have a reference to a service account. The reference to the service account must be stored in the transport-specific endpoint configuration. When a proxy service routes a message to this outbound endpoint, the transport provider passes the service account reference to CredentialCallback.getUsernamePasswordCredential(ref). Oracle Service Bus returns the username/password according to the service account configuration. This has the advantage of separating identity propagation and credential mapping configuration from the transport-specific details, simplifying the transport SDK. It also allows sharing this configuration. Any number of endpoints can reference the same service account.




	
Note:

The CredentialCallback object is made available to the transport provider by calling TransportSender.getCredentialCallback().









CredentialCallback.getUsernamePasswordCredential() returns a weblogic.security.UsernameAndPassword instance. This is a simple class which has methods to get the username and password. The username/password returned depends on the type of service account. If the service account is of type static, the fixed username/password is returned. If it is mapped, the client subject is used to look up the remote username/password. If it is pass-through, the client's username/password is returned.




	
Note:

A mapped service account throws CredentialNotFoundException if:

	
if there is no map for the inbound client, or


	
the inbound security context is anonymous and there is no anonymous map

















38.6.2.2 Outbound SSL Client Authentication (Two-Way SSL)

Oracle Service Bus also supports outbound SSL client authentication. In this case, the proxy making the outbound SSL request must be configured with a PKI key-pair for SSL. (This is done with a reference to a proxy service provider, the details are out of the scope of this document. To obtain the key-pair for SSL client authentication, the transport provider must call CredentialCallback.getKeyPair(). The HTTPS transport provider is an example of this.






38.6.2.3 Outbound JAAS Subject Authentication

Some transport providers send a serialized JAAS Subject on the wire as an authentication token. To obtain the inbound subject the transport provider must call CredentialCallback.getSubject().




	
Note:

The return value may be the anonymous subject.
















38.6.3 Link-Level or Connection-Level Credentials

Some transports require credentials to connect to services. For example, FTP endpoints may be required to authenticate to the FTP server. Transport providers can make use of static service accounts to retrieve a username/password for establishing the connection. Mapped or pass-through service accounts cannot be used in this case because these connections are not made on behalf of a particular client request. If a transport provider decides to follow this approach, the endpoint must be configured with a reference to a service account. At runtime, the provider must call TransportManagerHelper.getUsernamePassword(), passing the reference to the static service account.






38.6.4 Uniform Access Control to Proxy Services

Oracle Service Bus enforces access control to proxy services for every inbound request. Transport providers are not required to enforce access control or to provide interfaces to manage the access control policy.




	
Note:

The access control policy covers the majority of the use cases; however, a transport provider can implement its own access control mechanisms (in addition to the access control check done by Oracle Service Bus) if required for transport provider specific reasons. If that is the case, please contact your Oracle representative. In general Oracle recommends transport providers let Oracle Service Bus handle access control.









When access is denied, TransportManager.receiveMessage() throws an AccessNotAllowedException wrapped inside a TransportException. Transport providers are responsible for checking the root-cause of the TransportException. A transport provider may do special error handling when the root cause is an AccessNotAllowedException. For example, the HTTP/S transport provider returns an HTTP 403 (forbidden) error code in this case.




	
Note:

Oracle Service Bus makes the request headers available to the authorization providers for making access control decisions.














38.6.5 Identity Propagation and Credential Mapping

As explained in Section 38.6.2, "Outbound Request Authentication," Oracle Service Bus provides three types of service accounts. A transport provider can make use of service accounts to get access to the username/password for outbound authentication. A service account hides all of the details of identity propagation and credential mapping from Oracle Service Bus transport providers.








38.7 The Threading Model

This section discusses the threading model used by Oracle Service Bus and how the model relates to the Transport SDK. This section includes these topics:

	
Section 38.7.1, "Overview"


	
Section 38.7.2, "Inbound Request Message Thread"


	
Section 38.7.3, "Outbound Response Message Thread"


	
Section 38.7.4, "Support for Asynchrony"


	
Section 38.7.5, "Publish and Service Callout Threading"






38.7.1 Overview

Figure 38-5 illustrates the Oracle Service Bus threading model for a hypothetical transport endpoint processing a single inbound message.

A front end artifact, such as a Servlet, is responsible for getting the inbound message. A request can be routed to an outbound endpoint and sent asynchronously. At this point, the thread is released. At some later point, a response is sent back to Oracle Service Bus (using a callback). The response is received, packaged, and handed to the Oracle Service Bus pipeline. Later, the pipeline notifies the inbound endpoint that the response is ready to be sent to the client. This processing is scalable because a thread is only tied up as long as it is needed.


Figure 38-5 Sample Oracle Service Bus Threading Model

[image: Description of Figure 38-5 follows]









38.7.2 Inbound Request Message Thread

The following actions occur in the same thread:

	
An inbound message is received by the front end artifact of the transport endpoint. This front end artifact could be, for example, an HTTP servlet or JMS message-driven bean instance.


	
The message is packaged into a TransportMessageContext object by the transport endpoint implementation and passed to the Oracle Service Bus runtime. For more information on the TransportMessageContext interface, see Section 41.5, "Metadata and Header Representation for Request and Response Messages."


	
The pipeline performs request pipeline actions configured for the proxy.


	
While processing the inbound message in Oracle Service Bus pipeline, in the same (request) thread, Oracle Service Bus runtime calls on the registered outbound transport endpoint, which may or may not be managed by the same provider, to deliver an outbound message to an external service.


	
At some later point, the external service asynchronously calls on the outbound endpoint to deliver the response message. The outbound endpoint must have been registered previously with a transport specific callback object.




	
Note:

At this point, the initial request thread is released and placed back into the Oracle WebLogic Server thread pool for use by another request.

















38.7.3 Outbound Response Message Thread

The following actions occur in the same thread:

	
The response message is packaged into a TransportMessageContext object and delivered back to Oracle Service Bus runtime for response processing. This processing occurs in a different thread than the request thread. This new thread is called the response thread.


	
After the response message is processed, Oracle Service Bus runtime calls on the InboundTransportMessageContext object to notify it that it is now time to send the response back to the original caller. For more information on the InboundTransportMessageContext interface, see Section 41.5, "Metadata and Header Representation for Request and Response Messages."

If the transport provider does not have a native implementation of an asynchronous (non-blocking) outbound call, it still needs to deliver the response back to Oracle Service Bus runtime on a separate thread than that on which the inbound request message was received. To do this, it can execute the call in a blocking fashion in the request thread and then use a Transport SDK helper method to deliver the response back to Oracle Service Bus runtime.

For example, the EJB transport provider does not have an asynchronous (non-blocking) outbound call. The underlying API is a blocking API. To work around this, the provider makes its blocking call, then schedules the response for processing with TransportManagerHelper.schedule(). For more information on the EJB transport provider, see Chapter 28, "EJB Transport."









38.7.4 Support for Asynchrony

By design, the transport subsystem interacts asynchronously with Oracle Service Bus. The reason for this is that asynchronous behavior is more scalable, and therefore, more desirable than synchronous behavior. Rather than create two separate APIs, one for asynchronous and one for synchronous interaction, Oracle Service Bus runtime expects asynchronous interaction. It is up to the transport developer to work around this by a method such as posting a blocking call and posting the response in a callback. In any case, the response must be executed in a different thread from the request.






38.7.5 Publish and Service Callout Threading

The threading diagram shown in Figure 38-5 focuses on routing. The transport subsystem behaves the same way for Oracle Service Bus Publish and Service Callout actions which can occur in the middle of the request or response pipeline processing. These actions occur outside the scope of the transport subsystem and in the scope of an Oracle Service Bus pipeline. Therefore, some differences exist between the threading behavior of Publish and Service Callout actions and transport providers.

Note, however, the following cases:

	
Service Callout – The pipeline processor will block the thread until the response arrives asynchronously. The blocked thread would then resume execution of the pipeline. The purpose is to bind variables that can later be used in pipeline actions to perform business logic. Therefore, these actions must block so that the business logic can be performed before the response comes back.


	
Publish – The pipeline processor may or may not block the thread until the response arrives asynchronously. This thread then continues execution of the rest of the request or response pipeline processing.



	
Tip:

A Service Callout action lets you configure a synchronous (blocking) call to a proxy or business service that is already registered with Oracle Service Bus. Use a Publish action to identify a target service for a message and configure how the message is packaged and sent to that service. For more information on Service Callout and Publish actions, see Section 2.4.29, "Adding and Configuring Service Callout Actions in Message Flows" and Section 2.4.17, "Adding and Configuring Publish Actions in Message Flows."

















38.8 Designing for Message Content

This section includes these topics:

	
Section 38.8.1, "Overview"


	
Section 38.8.2, "Sources and Transformers"


	
Section 38.8.3, "Sources and the MessageContext Object"


	
Section 38.8.4, "Built-In Transformations"






38.8.1 Overview

Transport providers have their own native representation of message content. For example, HTTP transport uses java.io.InputStream, JMS has Message objects of various types, Tuxedo has buffers, and the WLS Web Services stack uses SAAJ. However, within the runtime of a proxy service, the native representation of content is the Message Context. While Oracle Service Bus supports some common conversion scenarios, such as InputStream to/from Message Context, this conversion between transport representation and the Message Context is ultimately the transport provider's responsibility.

In general, the Transport SDK is not concerned with converting directly between two different transport representations of content. However, if two transports use compatible representations and the content does not require re-encoding, the SDK may allow the source content to be passed-through directly (for example, passing a FileInputStream from an inbound File transport to an outbound HTTP transport). However, if the source content requires any sort of processing, it makes more sense to unmarshall the source content into the Message Context first and then use the standard mechanisms to generate content for the outgoing transport.






38.8.2 Sources and Transformers

Content is represented as an instance of the Source interface. Transport SDK interfaces that deal with message content, such as TransportSender and TransportMessageContext, all use the Source interface when passing message payloads. The requirements on a Source are minimal. A Source must support push- and pull-based conversions to byte-based streams using the two methods defined in the base Source interface. A Source may or may not take into account various transformation options, such as character-set encoding, during serialization, as specified by the TransformOptions parameter.

While all Source objects must implement the base serialization interface, the underlying representation of the Source object's content is implementation specific. This allows for Source objects based on InputStreams, JMS Message objects, Strings, or whatever representation is most natural to a particular transport. Typically, Source implementations allow direct access to the underlying content, in addition to the base serialization methods. For example, StringSource, which internally uses a String object to store its content offers a getString() method to get at the internal data. The ultimate consumer of a Source can then extract the underlying content by calling these source-specific APIs and potentially avoid any serialization overheads.

Sources may also be transformed into other types of Sources using a Transformer object. If a Source consumer, such as a transport provider, is given a Source instance that it does not recognize, it can often transform it into a Source instance that it does recognize. The underlying content can then be extracted from that known Source using the source-specific APIs. However, often a transport provider simply serializes the content and send it using the base serialization methods. See also Section 41.4, "Source and Transformer Classes and Interfaces."






38.8.3 Sources and the MessageContext Object

Sources are the common content representation between the transport layer and the binding layer. The binding layer is the entity responsible for converting content between the Source representation used by the transport layer and the Message Context used by the pipeline runtime. How that conversion happens depends upon the type of service (its binding type) and the presence of attachments. While not strictly part of the Transport SDK, any transport provider that defines its own Source objects should be familiar with this conversion process.

When attachments are not present, the incoming Source represents just the core message content. The MessageContext is initialized by converting the received Source to a specific type of Source and then extracting the underlying content. For example, for XML-based services, the incoming Source is converted to an XmlObjectSource. The XmlObject is then extracted from the XmlObjectSource and used as the payload inside the $body context variable. SOAP services are similarly converted to XmlObjectSource except that the extracted XmlObject must be a SOAP Envelope so that the <SOAP:Header> and <SOAP:Body> elements can be extracted to initialize the $header and $body context variables.

Below are the canonical Source types used for the set of defined service-types:

	
SOAP – XmlObjectSource


	
XML – XmlObjectSource


	
TEXT – StringSource


	
MFL – MFLSource




For binary services, no Source conversion is done. Instead, the Source is registered with a SourceRepository and the resulting <binary-content/> XML is used as the payload inside $body.

When attachments are present, the incoming Source is first converted to a MessageContextSource. From the MessageContextSource, two untyped Source objects are obtained, one representing the attachments and one representing the core message. The Source for the core message is handled as described previously. The Source representing attachments is converted to an AttachmentsSource. From the AttachmentsSource, XML is obtained and is used to initialize the $attachments context variable and a SourceRepository containing the registered Sources that represent any binary attachment content. This entire process is illustrated in Figure 38-6.


Figure 38-6 Flow of Attachments

[image: Description of Figure 38-6 follows]





A similar conversion occurs when creating a Source from data in the MessageContext to be passed to the transport layer. The core message is represented by a Source instance that can be converted to the canonical Source for the service type. In most cases, the Source will already be an instance of the canonical Source, but not always. When attachments are present, the Source delivered to the transport layer will be a source that can be converted to an instance of MessageContextSource. If the transport provider supports Content-Type as a pre-defined transport header, then the delivered Source will likely be an instance of MessageContextSource. Otherwise, the delivered Source will likely be an instance of MimeSource, but this can also be converted to a MessageContextSource.

The reason for this difference is that transports that natively support Content-Type as a transport header require that the top-level MIME headers appear in the transport headers rather than in the payload. Examples of this are HTTP and Email. Transports that do not natively support Content-Type must have these top-level MIME headers as part of the payload, as the Content-Type header is critical for decoding a multipart MIME package.






38.8.4 Built-In Transformations

Table 38-1 shows sources and lists the source types to which they can be converted by built-in transformers. For example, there is a built-in transformer that handles converting a StringSource into an XmlObjectSource; however, there is no transformer that can convert a StringSource into an XmlObjectSource. Typically, these transformers take advantage of their knowledge of the internal data representation used by both Source types.


Table 38-1 Built-In Transformations

	Public Source	Can Be Transformed To
	
Source

	
	
StreamSource


	
ByteArraySource


	
StringSource


	
XmlObjectSource


	
DOMSource


	
MFLSource


	
SAAJSource





	
StreamSource

	
StreamSource


	
ByteArraySource

	
ByteArraySource


	
StringSource

	
	
StringSource


	
XmlObjectSource


	
DOMSource





	
XmlObjectSource

	
	
StringSource


	
XmlObjectSource


	
DOMSource


	
MFLSource





	
DOMSource

	
	
StringSource


	
XmlObjectSource


	
DOMSource


	
MFLSource





	
MFLSource

	
	
XmlObjectSource


	
DOMSource


	
MFLSource





	
MimeSource

	
	
MimeSource


	
SAAJSource


	
MessageContextSource





	
SAAJSource

	
	
MimeSource


	
SAAJSource


	
MessageContextSource





	
MessageContextSource

	
	
MimeSource


	
SAAJSource


	
MessageContextSource











These generic transformations are done without any knowledge of the initial Source type but instead rely on the base serialization methods that are implemented by all Sources: getInputStream() and writeTo(). So, although it is ultimately possible to convert an XmlObjectSource to a ByteArraySource, it is not done using any special knowledge of the internal details of XmlObjectSource.




	
Note:

Many custom Sources implemented by Transports can be handled by these generic transformations, especially if the underlying data is an unstructured collection of bytes. For example, the File Transport uses a custom Source that pulls its content directly from a file on disk. However, as that data is just a set of bytes without structure, there is no need to provide custom transformations to, for example, XmlObjectSource. The generic transformation Source XmlObjectSource can handle this custom FileSource using just the base serialization methods that all Sources must implement.









For more information, see Section 41.4, "Source and Transformer Classes and Interfaces."









Developing a Transport Provider





39 Developing a Transport Provider


This chapter describes the basic steps involved in developing a custom transport provider.

The Transport SDK provides a layer of abstraction between transport protocols and the Oracle Service Bus runtime system. This layer of abstraction makes it possible to develop and plug in new transport providers to Oracle Service Bus. The Transport SDK interfaces provide this bridge between transport protocols, such as HTTP, and the Oracle Service Bus runtime.




	
Tip:

Before beginning this chapter, be sure to review Chapter 38, "Design Considerations," first.









This chapter includes the following sections:

	
Section 39.1, "Development Road Map"


	
Section 39.2, "Before You Begin"


	
Section 39.3, "Basic Development Steps"


	
Section 39.4, "Important Development Topics"






39.1 Development Road Map

The process of designing and building a custom transport provider is complex. This section offers a recommended path to follow as you develop your transport provider. Development of a custom transport provider breaks down into these basic stages:

	
Section 39.1.1, "Planning"


	
Section 39.1.2, "Developing"


	
Section 39.1.3, "Packaging and Deploying"






39.1.1 Planning

Review the following planning steps before developing a custom transport provider.

	
Decide if you really need to develop a custom transport provider. See Section 38.3, "Do You Need to Develop a Custom Transport Provider?"


	
Run and study the example socket transport provider. The source code for this provider is installed with Oracle Service Bus and is publicly available for you to examine and reuse. See Chapter 42, "Sample Socket Transport Provider."


	
Review Chapter 38, "Design Considerations." This chapter discusses the architecture of a transport provider and many aspects of transporter provider design, such as the security model and the threading model employed by transport providers.


	
Review Section 39.2, "Before You Begin."









39.1.2 Developing

Section 39.3, "Basic Development Steps" outlines the steps you need to take to develop a transport provider, including schema configurations and interface implementations.

Section 39.4, "Important Development Topics" discusses in detail several topics that you might need to refer to during the development cycle. This section includes detailed information on topics such as Section 39.5, "Handling Messages," Section 39.6, "Transforming Messages," Section 39.8, "Handling Errors," and others.






39.1.3 Packaging and Deploying

For detailed information on packaging and deploying a transport provider, see Chapter 43, "Deploying a Transport Provider."








39.2 Before You Begin

Before you begin to develop a custom transport provider, you need to consider and review a number of design issues, which include:

	
Deciding if you really need to develop a custom transport provider. See Section 38.3, "Do You Need to Develop a Custom Transport Provider?"


	
Deciding if your message endpoints are transactional or non-transactional. See Section 38.5.1.1, "Transactional vs. Non-Transactional Endpoints."


	
Deciding if your message endpoints are one way, synchronous, or asynchronous. See Section 38.5.1.2, "Supported Message Patterns,"" and Section 38.5.2, "Support for Synchronous Transactions."


	
Deciding on the security requirements for outgoing and incoming messages. See Section 38.6, "The Security Model."


	
Understanding the threading model used by Oracle Service Bus. See Section 38.7, "The Threading Model."


	
Understanding whether your transport provider will support synchronous or asynchronous outbound calls. See Section 38.7.4, "Support for Asynchrony."


	
Reviewing the interfaces and classes provided with the Transport SDK, and becoming familiar with how they fit into the design time and runtime parts of a transport provider. See Chapter 41, "Transport SDK Interfaces and Classes."


	
Understanding how to package and deploy a custom transport provider. See Chapter 43, "Deploying a Transport Provider."


	
Reviewing the flow of method calls through the transport framework. See Appendix A, "Transport SDK UML Sequence Diagrams."









39.3 Basic Development Steps

The basic steps to follow when developing a custom transport provider include:

Section 39.3.1, "1. Review the Transport Framework Components"

Section 39.3.2, "2. Create a Directory Structure for Your Transport Project"

Section 39.3.3, "3. Create an XML Schema File for Transport-Specific Artifacts"

Section 39.3.4, "4. Define Transport-Specific Artifacts"

Section 39.3.5, "5. Define the XMLBean TransportProviderConfiguration"

Section 39.3.6, "6. Implement the Transport Provider User Interface"

Section 39.3.7, "7. Implement the Runtime Interfaces"

Section 39.3.8, "8. Deploy the Transport Provider"



39.3.1 1. Review the Transport Framework Components

Figure 39-1 illustrates the components that you must implement and configure to create a custom transport provider. The transport manager controls and manages the registration of transport providers and handles communication with Oracle Service Bus. A transport provider manages the life cycle and runtime behavior of transport endpoints (resources where messages originate or are targeted). You use the Transport SDK to develop custom transport providers. Using the Transport SDK to develop a custom transport provider is the subject of this chapter.


Figure 39-1 Transport Subsystem Overview

[image: Description of Figure 39-1 follows]





The parts of the transport subsystem that you must implement and configure include:

	
Transport UI Bindings – The user interface component for the transport provider. Related interfaces are summarized in Section 41.6, "User Interface Configuration."


	
Transport endpoint – Responsible for sending and accepting messages. Related interfaces are summarized in Section 41.3, "General Classes and Interfaces."


	
Endpoint configuration – Stores endpoint configurations. Related interfaces are listed in Section 41.2, "Schema-Generated Interfaces."


	
Transport message context – Contains metadata for request and response headers and other parts of the message (inbound and outbound). See also Section 41.4, "Source and Transformer Classes and Interfaces," and Section 41.5, "Metadata and Header Representation for Request and Response Messages."


	
WLS Artifact deployer – (optional) Deploys artifacts, such as servlets that receive and send messages.


	
Transport sender – Retrieves metadata for the outbound message and the payload. Related interfaces are summarized in Section 41.3.2, "Summary of General Interfaces."


	
Transport listener – Allows the outbound endpoint to post the result of an outbound request to the rest of Oracle Service Bus. See also Section 41.5, "Metadata and Header Representation for Request and Response Messages."


	
Request/Response Metadata – Related interfaces are summarized in Section 41.5, "Metadata and Header Representation for Request and Response Messages."









39.3.2 2. Create a Directory Structure for Your Transport Project

Before developing a new transport provider, take time to set up an appropriate directory structure for your project. The recommended approach is to copy the directory structure used for the sample socket transport provider. For a detailed description of this structure, see Section 42.2, "Sample Location and Directory Structure."






39.3.3 3. Create an XML Schema File for Transport-Specific Artifacts

Create an XML schema (xsd) file for transport-specific definitions. You can base this file on the schema file developed for the sample socket transport provider: OSB_ORACLE_HOME/samples/servicebus/sample-transport/schemas/SocketTransport.xsd




	
Note:

The SocketTransport.xsd file imports the file TransportCommon.xsd. This file is the base schema definition file for service endpoint configurations. This file is located in OSB_ORACLE_HOME/lib/sb-schemas.jar. You might want to review the contents of this file before continuing.














39.3.4 4. Define Transport-Specific Artifacts

Define XML schema for the following transport-specific artifacts in the XML schema file described in the previous section, Section 39.3.3, "3. Create an XML Schema File for Transport-Specific Artifacts."

	
EndpointConfiguration


	
RequestMetaDataXML


	
ResponseMetaDataXML




	
Note:

Only simple XML types are supported when defining transport provider-specific metadata and headers. For example, complex types with nested elements are not supported. Furthermore, an additional restriction is that there can be at most one header with a given name.












	
Tip:

Each of these schema definitions is converted into a corresponding Java file and compiled. You will find these converted Java source files for the sample socket transport provider in the directory: sample-transport/build/classes/com/bea/alsb/transports/sock/impl














39.3.4.1 EndPointConfiguration

EndPointConfiguration is the base type for endpoint configuration, and describes the complete set of parameters necessary for the deployment and operation of an inbound or outbound endpoint. This configuration consists of generic and provider-specific parts. For more information on the EndPointConfiguration schema definition, refer to the documentation elements in the TransportCommon.xsd file.

You need to specify a provider-specific endpoint configuration in the schema file. Example 39-1 shows an excerpt from the SocketTransport.xsd.


Example 39-1 Sample SocketEndPointConfiguration Definition


<xs:complexType name="SocketEndpointConfiguration">
    <xs:annotation>
      <xs:documentation>
        SocketTransport - specific configuration
      </xs:documentation>
    </xs:annotation>
    <xs:sequence>
      <xs:choice>
        <xs:element name="outbound-properties"
                    type="SocketOutboundPropertiesType"/>
        <xs:element name="inbound-properties"
                    type="SocketInboundPropertiesType"/>
      </xs:choice>
      <xs:element name="request-response" type="xs:boolean">
        <xs:annotation>
          <xs:documentation>
            Whether the message pattern is synchronous
            request-response or one-way.
          </xs:documentation>
        </xs:annotation>
      </xs:element>
...








39.3.4.2 RequestMetaDataXML

It is required that each transport provider store metadata (message headers) in a Plain Old Java Object (POJO) and pass that to the pipeline. Examples of information that might be transmitted in the metadata are the Content-Type header, security information, or locale information. A RequestMetaData POJO is a generic object that extends the RequestMetaData abstract class and describes the message metadata of the incoming or outgoing request. The transport provider has to deliver the message metadata to Oracle Service Bus runtime in a RequestMetaData POJO. See also Section 39.5.3, "Request and Response Metadata Handling."

RequestMetaDataXML is an XML representation of the same RequestMetaData POJO. This XML representation uses Apache XML Bean technology. It is only needed by Oracle Service Bus runtime if or when processing of the message involves any actions in the pipeline that need an XML representation of the metadata, such as setting the entire metadata to a specified XML fragment on the outbound request.

You need to specify request metadata configuration in the schema file. Example 39-2 shows an excerpt from the SocketTransport.xsd.


Example 39-2 Sample SocketRequestMetaDataXML Definition


<xs:complexType name="SocketRequestMetaDataXML">
    <xs:annotation>
      <xs:documentation/>
    </xs:annotation>
    <xs:complexContent>
      <xs:extension base="ts:RequestMetaDataXML">
        <xs:sequence>
          <xs:element name="client-host"
                      type="xs:string" minOccurs="0">
            <xs:annotation>
              <xs:documentation>
                Client host name
              </xs:documentation>
            </xs:annotation>
          </xs:element>
          <xs:element name="client-port" type="xs:int" minOccurs="0">
            <xs:annotation>
              <xs:documentation>Client port</xs:documentation>
            </xs:annotation>
          </xs:element>
        </xs:sequence>
      </xs:extension>
    </xs:complexContent>
  </xs:complexType>








39.3.4.3 RequestHeadersXML

RequestHeadersXML is the base type for a set of inbound or outbound request headers. You need to specify the RequestHeadersXML configuration in the schema file. Example 39-2 shows an excerpt from the SocketTransport.xsd.


Example 39-3 Sample SocketRequestHeadersXML Definition


<xs:complexType name="SocketRequestHeadersXML">
    <xs:annotation>
      <xs:documentation/>
    </xs:annotation>
    <xs:complexContent>
      <xs:extension base="ts:RequestHeadersXML">
        <xs:sequence>
          <xs:element name="message-count" type="xs:long" minOccurs="0">
            <xs:annotation>
              <xs:documentation>
                Number of messages passed till now.
              </xs:documentation>
            </xs:annotation>
          </xs:element>
        </xs:sequence>
      </xs:extension>
    </xs:complexContent>
  </xs:complexType>








39.3.4.4 ResponseMetaDataXML

ResponseMetaDataXML is the base type for metadata for a response to an inbound or outbound message. You need to specify the ResponseMetaDataXML configuration in the schema file. Example 39-2 shows an excerpt from the SocketTransport.xsd.


Example 39-4 Sample SocketResponseMetaDataXML Definition


<xs:complexType name="SocketResponseMetaDataXML">
    <xs:complexContent>
      <xs:extension base="ts:ResponseMetaDataXML">
        <xs:sequence>
          <xs:element name="service-endpoint-host"
                      type="xs:string" minOccurs="0">
            <xs:annotation>
              <xs:documentation>
                Host name of the service end point connection.
              </xs:documentation>
            </xs:annotation>
          </xs:element>
          <xs:element name="service-endpoint-ip"
                      type="xs:string" minOccurs="0">
            <xs:annotation>
              <xs:documentation>
                IP address of the service end point connection.
              </xs:documentation>
            </xs:annotation>
          </xs:element>
        </xs:sequence>
      </xs:extension>
    </xs:complexContent>
  </xs:complexType>








39.3.4.5 ResponseHeadersXML

ResponseHeadersXML is the base type for a set of response headers. You need to specify the ResponseHeadersXML configuration in the schema file. Example 39-2 shows an excerpt from the SocketTransport.xsd.


Example 39-5 Sample SocketResponseHeadersXML Definition


<xs:complexType name="SocketResponseHeadersXML">
    <xs:annotation>
      <xs:documentation/>
    </xs:annotation>
    <xs:complexContent>
      <xs:extension base="ts:ResponseHeadersXML"/>
    </xs:complexContent>
  </xs:complexType>










39.3.5 5. Define the XMLBean TransportProviderConfiguration

To configure the TransportProviderConfiguration XML bean, edit the transport provider configuration file. This XML file is located in the config directory in the transport provider root directory. See Section 42.2, "Sample Location and Directory Structure," for the location of this file (SocketConfig.xml) in the sample socket transport provider implementation.

	
If proxy services can use your transport, set the inbound-direction-supported element to true.


	
If business services use your transport, set the outbound-direction-supported element to true.


	
If your transport is self-described, include an element self-described with the value set to true. A self-described transport is one whose services are responsible for describing their shape (schema or WSDL) based on their endpoint configuration.


	
To publish a tModel for your transport to UDDI, include an element UDDI. See Section 39.10, "Publishing Proxy Services to a UDDI Registry" for more info.




	
Tip:

The schema for TransportProviderConfiguration is defined in TransportCommon.xsd, which is located in OSB_ORACLE_HOME/lib/sb-schemas.jar. Refer to the schema file for more information.

















39.3.6 6. Implement the Transport Provider User Interface

When you add a business or proxy service using the Oracle Service Bus Administration Console, you select a transport provider in the service creation wizard. The wizard includes the transport providers that are provided with Oracle Service Bus and any custom transport providers that were developed with the Transport SDK.

This section discusses the Transport SDK API components that bind your custom transport provider to the Oracle Service Bus Administration Console user interface. You must implement these APIs to connect your provider to the user interface.




	
Tip:

This section assumes that you are familiar with the service creation wizard. See Section 42.5, "Configuring the Socket Transport Sample," for a detailed, illustrated example.









Creating the Custom Transport User Interface 

	
After users create a new service and choose the Service Type in the service creation wizard, they must then select an appropriate transport provider for the Service Type. To validate the selection, the wizard calls the following method of the TransportUIBinding interface:


public boolean isServiceTypeSupported(BindingTypeInfo binding)


This method determines if the transport provider is suitable for the selected Service Type.


	
After users select a valid transport provider, they enter an endpoint URI. To validate this URI, the wizard calls the following method of the TransportUIBinding interface:


public TransportUIError[] validateMainForm(TransportEditField[] fields)


	
Next, the wizard displays the transport-specific configuration page. To render this page, the wizard calls the following method of the TransportUIBinding interface:


public TransportEditField[] getEditPage(EndPointConfiguration config, BindingTypeInfo binding) throws TransportException 


The Transport SDK offers a set of TransportUIObjects that represent fields in the configuration page. For example, you can add text boxes, check boxes, and other types of UI elements. Use the TransportUIFactory to create them. After creation use the same factory to specify additional properties and obtain TransportEditField objects that can be displayed by the service creation wizard.




	
Tip:

You can associate events with most of the UI fields. An event acts like a callback mechanism for the TransportUIBinding class and lets you refresh, validate, and update the configuration page. When an event is triggered, the wizard calls the method:


updateEditPage(TransportEditField[] fields, String name) throws TransportException 










	
When users finishes the transport configuration, the wizard calls the validation method:


TransportUIError[] validateProviderSpecificForm(TransportEditField[] fields)


	
After the service is saved, the transport manager calls the following method of the TransportProvider class:


void validateEndPointConfiguration(TransportValidationContext context)


If no error is reported, a new endpoint is created. The Transport Manager then calls the method:


TransportEndPoint createEndPoint(EndPointOperations.Create context) throws TransportException


If this method returns successfully, the new service is listed in the Oracle Service Bus Administration Console and the underlying transport configuration is associated with an endpoint on the TransportProvider.




	
Note:

The endpoint configuration is saved in the Oracle Service Bus session and does not need to be persisted or recovered in case of a server restart by the transport provider.










	
Once the session is activated, you must deploy the endpoint to start processing requests. See Section 39.11, "When to Implement TransportWLSArtifactDeployer" and Section 43.4, "Deploying to a Cluster," to learn more about deploying an endpoint and processing requests.




	
Tip:

For the sample socket transport provider, you can find the implementations of these interfaces in the sample-transport/src directory.

















39.3.7 7. Implement the Runtime Interfaces

A new custom transport provider must implement the following runtime interfaces. For a summary of the Transport SDK interfaces and related classes, see Chapter 41, "Transport SDK Interfaces and Classes." For detailed information on interfaces and classes, see the Oracle Fusion Middleware Java API Reference for Oracle Service Bus.




	
Tip:

For the sample socket transport provider, you can find the implementations of these interfaces in the sample-transport/src directory.









Implement the Following Runtime Interfaces 

	
TransportProvider


	
TransportWLSArtifactDeployer




	
Note:

Only implement the TransportWLSArtifactDeployer interface if the transport provider needs to deploy Oracle WebLogic Server-related artifacts, such as EAR/WAR/JAR files, that go into an Oracle WebLogic Server change list at the time of endpoint creation. For more information, see Section 39.11, "When to Implement TransportWLSArtifactDeployer."










	
TransportEndPoint


	
InboundTransportMessageContext


	
OutboundTransportMessageContext


	
Transformer




	
Note:

Only implement the Transformer interface if the transport provider needs to work with non-standard payload bindings, for example, anything other than Stream, DOM, SAX, or XMLBean. For more information, see Section 39.6, "Transforming Messages."

















39.3.8 8. Deploy the Transport Provider

For detailed information on deployment, see Chapter 43, "Deploying a Transport Provider."








39.4 Important Development Topics

This section discusses several topics that you will encounter while developing a custom transport provider. These topics include:

	
Section 39.5, "Handling Messages"


	
Section 39.6, "Transforming Messages"


	
Section 39.7, "Working with TransportOptions"


	
Section 39.8, "Handling Errors"


	
Section 39.9, "Defining Custom Environment Value Types"


	
Section 39.10, "Publishing Proxy Services to a UDDI Registry"


	
Section 39.11, "When to Implement TransportWLSArtifactDeployer"


	
Section 39.12, "Creating Help for Custom Transports"









39.5 Handling Messages

This section discusses message handling in transport providers and includes these topics:

	
Section 39.5.1, "Overview"


	
Section 39.5.2, "Sending and Receiving Message Data"


	
Section 39.5.3, "Request and Response Metadata Handling"


	
Section 39.5.4, "Character Set Encoding"


	
Section 39.5.5, "Co-Located Calls"


	
Section 39.5.6, "Returning Outbound Responses to Oracle Service Bus Runtime"






39.5.1 Overview

The Transport SDK features a flexible representation of message payloads. All Transport SDK APIs dealing with payload use the Source interface to represent message content.

The Source-derived message types provided with the Transport SDK include:

	
StreamSource


	
ByteArraySource


	
StringSource


	
XmlObjectSource


	
DOMSource


	
MFLSource


	
SAAJSource


	
MimeSource




	
Note:

StreamSource is a single use source; that is, it implements the marker interface SingleUseSource. With the other Sources, you can get the input stream from the source multiple times. Each time the Source object gets the input stream from the beginning. With a SingleUseSource, you can only get the input stream once. Once the input is consumed, it is gone (for example, a stream from a network socket); however, Oracle Service Bus buffers the input from a SingleUseSource, essentially keeping a copy of all of its data.

If you implement a Source class for your transport provider, you need to determine whether you can re-get the input stream from the beginning. If the nature of the input stream is that it can only be consumed once, your Source class should implement the marker interface SingleUseStream.












The Transport SDK provides a set of Transformers to convert between Source objects. You can implement new transformations, as needed, as long as they support transformations to/from a set of canonical representations. See Section 39.6, "Transforming Messages" for more information. See also Section 38.8, "Designing for Message Content."






39.5.2 Sending and Receiving Message Data

When implementing inbound endpoints to deliver the inbound message to Oracle Service Bus runtime, you need to call TransportManager.receiveMessage(). The transport provider is free to expose the incoming message payload in either one of the standard Source-derived objects, such as stream, DOM or SAX, or a custom one.

If Oracle Service Bus needs to send a response message back to the client that sent the request, it will call methods setResponseMetaData() and setResponsePayload() followed by close() on InboundTransportMessageContext to indicate that the response is ready to be sent back. When Oracle Service Bus runtime calls the inbound transport message context close() method, this will be done from a different thread than that on which the inbound request message was received. The transport provider should be aware of this as it may affect the semantics of transactions. Also, the transport provider cannot attempt to access the response payload and/or metadata until close() method has been called.






39.5.3 Request and Response Metadata Handling

It is required that each transport provider store metadata and headers in a Plain Old Java Object (POJO) and pass that to the pipeline. There are some cases where Oracle Service Bus requires an XMLBean. In these cases, you need to implement a conversion from POJO to XMLBean using the API.

The following are the methods you must provide to convert from a POJO to XML:


RequestHeaders.toXML()

RequestMetaData<T>.toXML()

ResponseHeaders.toXML()

ResponseMetaData<T>.toXML()


For the reverse direction (XML to POJO) you need to implement:


TransportEndPoint.createRequestMetaData(RequestMetaDataXML)

InboundTransportMessageContext.createResponseMetaData(ResponseMetaDataXML)






39.5.4 Character Set Encoding

Each transport provider is responsible for specifying the character set encoding of the incoming message payload to Oracle Service Bus. For outgoing messages (outbound request and inbound response), the transport provider is responsible for telling Oracle Service Bus what character set encoding to use for the outgoing payload. The character-set encoding is specified in request and response metadata.

In virtually every case, the character-set encoding that the transport is responsible for inserting into the metadata is exactly the encoding that is statically specified in the service configuration. One of the few exceptions to this is HTTP transport, which inspects Content-Type for any "charset" parameters and overrides any encoding configured in the service. This is necessary in order to conform to HTTP specifications. Other transport protocols may need to handle similar issues.




	
Tip:

In general, the encoding for a service is fixed. If someone sends an UTF-16 encoded message to a proxy that is specified to be SHIFT_JIS, then that is generally considered to be an error. Transport providers should not need to inspect the message simply to determine encoding.









For outgoing messages, the transport provider tells Oracle Service Bus what encoding it requires for the outbound request, and Oracle Service Bus performs the conversion if necessary.

Transports should always rely on this encoding for outgoing messages and should not assume that it is the same as the encoding specified in the service configuration. If there is a discrepancy, the transport can choose to allow it, but others could consider it an error and throw an exception. Also the transport has the additional option of leaving the encoding element blank. That leaves the pipeline free to specify the encoding (for example, through pass-through).






39.5.5 Co-Located Calls

If a given transport provider supports proxy service endpoints, it is possible to configure the request pipeline such that there is a routing step that routes to that provider's proxy service. Furthermore there could be a Publish or a Service Callout action that sends a message to a proxy service instead of a business service. This use case is referred to as co-located calls.

The transport provider needs to be aware of co-located calls, and handle them accordingly. Depending on the nature of the proxy service endpoint implementation, the transport provider may choose to optimize the invocation such that this call bypasses the entire transport communication stack and any inbound authentication/authorization, and instead is a direct call that effectively calls TransportManager.receiveMessage() immediately.




	
Tip:

Oracle Service Bus has implemented this optimization with the HTTP, File, Email and FTP transport providers. The JMS provider does not use this optimization due to the desire to separate the transactional semantics of send operation versus receive operations.









To use this optimization in a custom transport provider, you need to extend the CoLocatedTransportMessageContext class and call its send() method when TransportProvider.sendMessageAsync() is invoked.






39.5.6 Returning Outbound Responses to Oracle Service Bus Runtime

When Oracle Service Bus runtime sends a message to an outbound endpoint and there is a response message to be returned, the transport provider must return this response asynchronously. That means TransportSendListener.onReceiveResponse() or TransportSendListener.onError() methods need to be called from a different thread than the one on which TransportProvider.sendMessageAsync() was called.

If the transport provider has a built-in mechanism by which the response arrives asynchronously, such as responses to JMS requests or HTTP requests when the async response option is used, it happens naturally. However, if the transport provider has no built-in mechanism for retrieving responses asynchronously, it can execute the outbound request in a blocking fashion and then schedule a new worker thread using the TransportManagerHelper.schedule() method, in which the response is posted to the TransportSendListener.








39.6 Transforming Messages

When Oracle Service Bus needs to set either the request payload to an outbound message or the response payload to an inbound message, it asks the transport provider to do so through an object derived from the Source interface. The transport provider then needs to decide what representation the underlying transport layer requires and use the Transformer.transform() method to translate the Source object into the desired source.




	
Tip:

For more information on message transformation, see Section 38.8, "Designing for Message Content." For a list of built-in transformations, see Section 38.8.4, "Built-In Transformations," and Section 41.4, "Source and Transformer Classes and Interfaces."









A custom transport provider can support new kinds of transformations. Suppose a transport provider needs to work with a DOM object in order to send the outbound message. When called with setRequestPayload(Source src), the transport provider needs to call the method:


TransportManagerHelper.getTransportManager().getTransformer().
transform(src, DOMSource.class, transformOptions)


The return value of the method gives a DOMSource, which can then be used to retrieve the DOM node.




	
Note:

If the transport provider requires a stream, there is a shortcut: each Source object supports transformation to stream natively.









You can add new transformations to a custom transport provider. For example, suppose you want to add a new kind of Source-derived class, called XYZSource. For performance reasons, transport providers are encouraged to provide conversions from XYZSource to one of the two canonical Source objects, XmlObjectSource and StreamSource when applicable. Without such transformation, generic transformers will be used, which rely on the StreamSource representation of XYZSource. Of course, if XYZSource is a simple byte-based Source with no internal structure, then relying on the generic transformers is usually sufficient. Note that any custom transformer that is registered with TransportManager is assumed to be thread-safe and stateless.

To support attachments, the transport provider has three options:

	
The Source returned by TransportMessageContext must be an instance of MessageContextSource. A limitation of this option is that MessageContextSource requires that the content has already been partitioned into a core-message Source and an attachments Source.


	
The Source is an instance of MimeSource and the Headers objects contain a multipart Content-Type header.


	
The Content-Type is a pre-defined header for the transport provider with the specific value multipart/related. Both HTTP(S) and Email transports rely on this third option for supporting attachments.









39.7 Working with TransportOptions

A TransportOptions object is used to supply options for sending or receiving a message. A TransportOptions object is passed from the transport provider to the transport manager on inbound messages. On outbound messages, a TransportOptions object is passed from the Oracle Service Bus runtime to the transport manager, and finally to the transport provider.

This section includes these topics:

	
Section 39.7.1, "Inbound Processing"


	
Section 39.7.2, "Outbound Processing"


	
Section 39.7.3, "Request Mode"






39.7.1 Inbound Processing

The transport provider supplies these parameters to TransportManager.receiveMessage():

	
QOS – Specifies exactly-once or best-effort quality of service. Exactly-once quality of service is specified when the incoming message is transactional.


	
Throw On Error – If this flag is set, an exception is thrown to the callee of method TransportManager.receiveMessage() when an error occurs during the Oracle Service Bus pipeline processing. The options for throwing the exception include: throw the exception back to the inbound message or create a response message from the error and notify the inbound message with the response message. Typically, you set Throw On Error to true when QOS is exactly-once (for transactional messages).

For example, JMS/XA sets this flag to true to throw the exception in the same request thread, so it can mark the exception for rollback. HTTP sets the flag to false, because there is no retry mechanism. The error is converted to a status code and a response message is returned.


	
Any transport-specific opaque data – Opaque data can be any data that is set by the transport provider and passed through the pipeline to the outbound call. This technique provides optimizes performance when the same transport is used on inbound and outbound. The opaque data is passed directly through the pipeline from the inbound transport to the outbound transport. For example, the HTTP/S transport provider can pass the username and password directly from the inbound to the outbound to efficiently support identity pass-through propagation.









39.7.2 Outbound Processing

For outbound processing, the Oracle Service Bus runtime supplies these parameters to the transport manager, which uses some of the parameters internally and propagates some parameters to TransportProvider.sendMessageAsync(). These parameters include:

	
QOS – Specifies whether or not "exactly-once" quality of service can be achieved. For example, for HTTP, if quality of service is set to exactly once, the HTTP call is blocking. If it is set to best effort, it is a non-blocking HTTP call.


	
Mode – Specifies one-way or request response. See also Section 38.2.3, "Transport Provider Modes."


	
URI, Retry Interval, and Count – The transport provider uses the URI to initialize the outbound transport connection. For example, the HTTP transport provider uses the URI when instantiating a new HttpURLConnection. The transport provider is not required to use Retry Interval and Count.


	
OperationName – The transport provider can use OperationName if it needs to know what outbound Web Service is being used. The transport manager uses this parameter to keep track of monitoring statistics.


	
Any transport-specific opaque data – An example of transport-specific opaque data is the value of the "Authorization" header for HTTP/S.









39.7.3 Request Mode

The request mode is defined as an enumeration with two values: REQUEST_ONLY (also called "one-way") and REQUEST_RESPONSE. These modes are interpreted as follows for requests and responses:

	
On outbound requests, the pipeline indicates the mode through TransportOptions and the transport provider must honor the mode.


	
On inbound requests, the pipeline knows the mode and closes the inbound request and does not send a response if it computes the mode REQUEST_ONLY.


	
If a response is sent by the pipeline, then there is a response even if the response is empty.


	
For transports that are inherently one-way, the transport must not specify response metadata.











39.8 Handling Errors

There are three different use cases to consider with respect to the effect runtime exceptions have on the transactional model. These cases include:

	
Section 39.8.1, "Case 1": The exception occurs somewhere in the request pipeline but before the outbound call to the business service.


	
Section 39.8.2, "Case 2": The exception occurs during the business service call.


	
Section 39.8.3, "Case 3": The exception occurs sometime after the business service call in the response pipeline.


	
Section 39.8.4, "Catching Application Errors"


	
Section 39.8.5, "Catching Connection Errors"






39.8.1 Case 1

The exception occurs somewhere in the request pipeline but before the outbound call to the business service, as shown in Figure 39-2. For example, executing a specific XQuery against the contents of the request message raises an exception.

If there is a user-configured error handler configured for the request pipeline, the error will be handled according to the user configuration. Otherwise, the proxy service will either catch an exception when calling TransportManager.receiveMessage() or will be notified in the InboundTransportMessageContext.close() method of the error through response metadata, based on the transport options passed as an argument to the receiveMessage() call. If the proxy service indicates that the exception should be thrown, surround receiveMessage() with a try/catch clause and mark the transaction for rollback.


Figure 39-2 Error Case 1

[image: Description of Figure 39-2 follows]









39.8.2 Case 2

The exception occurs during the business service call, as shown in Figure 39-3. The outbound transport provider either:

	
Throws an exception from TransportProvider.sendMessageAsync(). For example, the outbound provider throws an exception if there was an error while establishing a socket connection to external service. This situation could occur if the business service cannot be called because of an incorrect URL, a faulty connection, or other reasons. In these cases, the transport provider must raise an exception.


	
Notifies the listener through TransportSendListener.onError(). For example, if the business service was called, but the call resulted in an error (such as a SOAP fault), the transport provider needs to call TransportSendListener.onError() instead of raising an exception.




In the first instance, the exception handling is the same as that described in Section 39.8.1, "Case 1". In the second instance, if there is an error handler configured for the response pipeline, the error is handled according to the user configuration. Otherwise, the exception is propagated back to the proxy service endpoint in InboundTransportMessageContext.close() through the response metadata.


Figure 39-3 Error Case 2

[image: Description of Figure 39-3 follows]









39.8.3 Case 3

The exception occurs sometime after the business service call in the response pipeline, as shown in Figure 39-4. Again, in the absence of a user-defined error handler for the response pipeline, the proxy service endpoint is notified of the error with the InboundTransportMessageContext.close() method with appropriate response metadata. If the inbound transport endpoint is a synchronous transactional endpoint, it is guaranteed that the transaction that was active at the time request was received is still active and it may be rolled back. If the inbound endpoint is not transactional or not synchronous, there is not an inbound transactional context to roll back, so some other action might need to be performed.


Figure 39-4 Error Case 3

[image: Description of Figure 39-4 follows]









39.8.4 Catching Application Errors

When business services try to access an external service and an error occurs in the external service application, such as a SOAP fault, subsequent retries by the services are likely to produce errors until the application is fixed.

Oracle Service Bus lets you identify application errors, giving you the option of preventing retries on application errors when your transport is used.

This section describes how to catch application errors in your transport and configure your transport to prevent application error retries.



39.8.4.1 Identifying Application Errors

In your transport provider code you must identify the conditions under which an application error occurs.

For example, in the Oracle Service Bus HTTP transport, an application error is one in which the HTTP response has a 500 status code, has a non-empty payload, and has a content type that is consistent with the service type, such as XML for SOAP.

When an error meets the application error conditions you define, return a TRANSPORT_ERROR_APPLICATION type using one of the following methods:

	
Errors in the request – Throw a TransportException with the error code TRANSPORT_ERROR_APPLICATION in TransportProvider.sendMessageAsync().


	
Errors in the response – Schedule TransportSendListener.onError() with the error code TRANSPORT_ERROR_APPLICATION.




The transport SDK can then identify application errors when they occur and handle them accordingly.

The transport SDK also sends application errors to the pipeline $fault variable.






39.8.4.2 Configuring Application Error Retries

In your <Transport>Config.xml file, enter the following element as a child of the <ProviderConfiguration> element, according to the TransportCommon.xsd schema in /osb_10.3/lib/sb-schemas.jar:

<declare-application-errors>true</declare-application-errors>

This entry provides a Retry Application Errors option on the business service's main transport configuration page when a user selects your transport. If you do not provide this element, the default value is false, application errors are not caught, and no option is provided to retry application errors.








39.8.5 Catching Connection Errors

Oracle Service Bus lets you identify connection errors in your transport, which triggers the transport SDK to take inaccessible endpoint URIs offline automatically. For example, in a cluster with Oracle Service Bus running on Managed Servers, a Managed Server that experiences a connection error on a service request can automatically mark the endpoint URI as offline.

You can re-enable endpoint URIs in the following ways:

	
On configuring the business service, an you can set a Retry Count and Retry Iteration Interval to determine the frequency and number of retries after connection errors. A successful connection to the service after a retry automatically reactivates the endpoint URI.

A Retry Iteration Interval of zero (0) takes the endpoint URI offline indefinitely and requires you to manually re-enable the endpoint URI.


	
You can manually re-enable offline endpoint URIs in the Oracle Service Bus Administration Console, on the Operational Settings page for the business service.




The automated connection error functionality does not apply to the following situations:

	
If a service pipeline dynamically sets an endpoint URI in $outbound/ctx:transport/ctx:uri, the transport SDK cannot take the URI offline, because the endpoint URI is not defined in the service configuration.


	
The transport SDK does not persist connection status. After a server restart, all endpoint URIs are considered online.




For more information, see "Managing Endpoint URIs for Business Services" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus.



39.8.5.1 Identifying Connection Errors

This section describes how to identify connection errors in your transport. Once caught, a connection error triggers the transport SDK to take the affected endpoint URI offline automatically.

In your transport provider code, you must identify the conditions under which a connection error occurs.

For example, in the Oracle Service Bus HTTP transport, a connection error is one in which the HTTP response has a 404 status code or there is an IOException when a connection is attempted on the endpoint URI.

When an exception meets the connection error conditions you define, return a TRANSPORT_ERROR_CONNECTION type using one of the following methods:

	
Errors in the request – Throw a TransportException with the error code TRANSPORT_ERROR_CONNECTION in TransportProvider.sendMessageAsync().


	
Errors in the response – Schedule TransportSendListener.onError() with the error code TRANSPORT_ERROR_CONNECTION.




The transport SDK can then identify connection errors when they occur and handle them accordingly.

The transport SDK also sends connection errors to the pipeline $fault variable and adds them to the response.










39.9 Defining Custom Environment Value Types

This section describes how to define custom environment value types that you want to use in your transport implementation. When you use the TransportProvider.getEnvValues() method to return environment values for an endpoint, you will be able to declare environment values of these custom types.

When your transport is used, custom environment value types can be used in the same ways that standard environment value types are used in Oracle Service Bus, such as for customization, find and replace, and preservation of values on configuration import. For example, you may want to be able to define and preserve references to a service account or a JMS queue in your transport configuration.

Environment value types can be any of the following categories: environment, operational, and security.

Add custom variables to your <Transport>Config.xml file. The schema that determines the XML structure is TransportCommon.xsd, located in /osb_10.3/lib/sb-schemas.jar.

Following is an example of a custom security variable in the JMS transport's JmsConfig.xml:


<env-value-type>
    <name>JMS Service Accounts</name>
    <localized-display-name>
        <localizer-class>com.bea.wli.sb.transports.messages.
         TransportsTextLocalizer</localizer-class>
        <message-id>JMS_SERVICE_ACCOUNTS</message-id>
    </localized-display-name>
    <localized-description>
        <localizer-class>com.bea.wli.sb.transports.messages.
          TransportsTextLocalizer</localizer-class>
        <message-id>JMS_SERVICE_ACCOUNTS</message-id>
    </localized-description>
    <simple-value>true</simple-value>
    <category>security</category>
</env-value-type>


Following are descriptions of key elements for custom environment value types:

	
name – The variable name used by the transport SDK.


	
display-name – The name for the variable that appears in the Oracle Service Bus user interface. Following is the localization alternative:

	
localized-display-name – Alternative, localized version of display-name.


	
localizer-class – The localization properties text file containing the localized display-name. The .properties extension is not required.


	
message-id – The property in the localization properties file that provides the value of the display name.





	
description – Description of the environment value type. For localization, use the localized-description element instead with the localizer-class and message-id child elements as described in display-name.


	
simple-value – If the environment value type is of the category "environment," simple-value determines whether or not this type is searchable with find and replace functionality in Oracle Service Bus (value of true or false).


	
category – The category of the environment value type: "environment," "security," or "operational." When the category is "security" or "operational," you can decide whether or not to preserve the environment value type during configuration import. When the category is "environment," the environment value type is available for find and replace.









39.10 Publishing Proxy Services to a UDDI Registry

Universal Description, Discovery, and Integration (UDDI) is a standard mechanism for describing and locating Web services across the internet. You might want to publish proxy services based on a custom transport provider to a UDDI registry. This allows proxy services to be imported into another Oracle Service Bus server in a different domain as the one hosting the business service.

To publish a proxy service, the transport provider needs to define a tModel that represents the transport type in the "UDDI" section of TransportProviderConfiguration XML schema definition. (For more information on the schema-generated interfaces, see Section 41.2, "Schema-Generated Interfaces.")

This tModel must contain a CategoryBag with a keyedReference whose tModelKey is set to the UDDI Types Category System and keyValue is "transport." You are required to provide only the UDDI V3 tModel key for this tModel.

If UDDI already defines a tModel for this transport type, you should copy and paste the definition into the UDDI section.

An example of such a tModel is provided in Example 39-6.


Example 39-6 Example tModel


<?xml version="1.0" encoding="UTF-8"?>
<ProviderConfiguration xmlns="http://www.bea.com/wli/sb/transports">
   . . .
   . . .
  <UDDI>
    <TModelDefinition>
      <tModel tModelKey="uddi:bea.uddi.org:transport:socket">
        <name>uddi-org:socket</name>
        <description>Socket transport based webservice</description>
        <overviewDoc>
          <overviewURL useType="text">
            http://www.bea.com/wli/sb/UDDIMapping#socket
          </overviewURL>
        </overviewDoc>
        <categoryBag>
          <keyedReference keyName="uddi-org:types:transport"
                          keyValue="transport"
                          tModelKey="uddi:uddi.org:categorization:types"/>
        </categoryBag>
      </tModel>
    </TModelDefinition>
  </UDDI>
</ProviderConfiguration>


If UDDI does not already define a tModel for this transport type, Oracle Service Bus can publish the tModel you define here to configured registries. When a UDDI registry is configured to Oracle Service Bus, the "Load tModels into Registry" option can be specified. That option causes all of the tModels of Oracle Service Bus, including the tModels for custom transport providers, to be published to the UDDI registry. After deploying your transport provider, you can update your UDDI registry configuration to publish your tModel.

During UDDI export, TransportProvider.getBusinessServicePropertiesForProxy(Ref) is called and the resulting map is published to the UDDI registry. The provider is responsible for making sure to preserve all important properties of the business service in the map so that during the UDDI import process the business service definition can be correctly constructed without loss of information.

During UDDI import, TransportProvider.getProviderSpecificConfiguration(Map) is called and the result is an XmlObject that conforms to the provider-specific endpoint configuration schema, which goes into the service definition.







	
Tip:

OASIS, the Organization for the Advancement of Structured Information Standards, is responsible for creating the UDDI standard. To read more about UDDI, including the full technical specification, go to: http://www.oasis-open.org/committees/tc_home.php?wg_abbrev=uddi-spec














39.11 When to Implement TransportWLSArtifactDeployer

Two sets of transport provider interfaces are provided that deal with individual service registration. TransportProvider has methods like create/update/delete/suspend/resume and TransportWLSArtifactDeployer has the same methods. This section discusses these two implementations and explains when you need to implement TransportWLSArtifactDeployer.

Only implement TransportWLSArtifactDeployer if your provider needs to make changes to Oracle WebLogic Server artifacts in the Oracle Service Bus domain. The methods on TransportWLSArtifactDeployer are only called on an Admin Server. In this case, changes are made through the DomainMBean argument that is passed in, and then the changes are propagated to the entire cluster.

The TransportProvider methods are called on all servers (Administration and Managed Servers) in the domain. Because you cannot make changes to Oracle Service Bus domain artifacts on a Managed Server, the purpose of the method calls on TransportProvider is to update its internal data structures only.

When a given Transport provider implements the TransportWLSArtifactDeployer interface, the methods on TransportWLSArtifactDeployer are called before the corresponding methods on TransportProvider. For example, TransportWLSArtifactDeployer.onCreate() is called before TransportProvider.createEndPoint().

For more information on TransportWLSArtifactDeployer, see Section 41.3.2, "Summary of General Interfaces."






39.12 Creating Help for Custom Transports

You can provide online help for your custom transports in the design environment (Eclipse) and the runtime environment (Oracle Service Bus Administration Console). Providing help is optional, but it can be extremely useful in guiding service creators through the transport configuration process.

Figure 39-5 shows help included with a custom transport in the development and runtime environments.


Figure 39-5 Custom Transport Help in the Development and Runtime Environments

[image: Description of Figure 39-5 follows]





This section includes the following topics:

	
Section 39.12.1, "Custom Transport Help Overview"


	
Section 39.12.2, "Providing Custom Transport Help in Eclipse"


	
Section 39.12.3, "Providing Custom Transport Help in the Oracle Service Bus Administration Console"






39.12.1 Custom Transport Help Overview

This section describes the different options available for providing custom transport help in Eclipse and the Oracle Service Bus Administration Console.




	
Note:

Because of potential user interface and functionality differences between transport configuration in Eclipse and the Oracle Service Bus Administration Console, consider creating separate help topics for both environments.











39.12.1.1 Eclipse Help

Eclipse help is based on the Eclipse help framework. You have choices for your custom transport help implementation in Eclipse.

	
Section 39.12.1.1.1, "Context-Sensitive Help (F1)"


	
Section 39.12.1.1.2, "Eclipse Help Table of Contents"






39.12.1.1.1 Context-Sensitive Help (F1)

Context-sensitive help, launched by pressing F1 in Eclipse, shows help topics within Eclipse instead of launching a separate help window that displays the entire help system. Figure 39-6 shows how context-sensitive help appears in Eclipse.


Figure 39-6 Pressing F1 on a Transport Configuration Page to Display Help for the Transport

[image: Description of Figure 39-6 follows]





All of the native Oracle Service Bus transports provide context-sensitive help from their respective transport configuration editors.

The benefit of context-sensitive help is quick user access to targeted help topics without leaving Eclipse, which is particularly useful for help with custom transports.






39.12.1.1.2 Eclipse Help Table of Contents

You can provide help content for your custom transport in the Eclipse help system, accessible from the Eclipse Help menu. When you launch Eclipse help, a separate window displays the contents of the entire help system.

Figure 39-7 shows online help for transports in the Eclipse help system.


Figure 39-7 Custom Transport Help in Eclipse

[image: Description of Figure 39-7 follows]





Your help topic(s) can appear in different locations of the help system table of contents, as shown in Figure 39-7, depending on how you package and configure your custom transport. For example, you can merge your transport help with the transport section of the Oracle Service Bus help topics, or you can provide your transport help at the top level of the help system.








39.12.1.2 Oracle Service Bus Administration Console Help

You can also provide transport configuration help at runtime in the Oracle Service Bus Administration Console. The Oracle Service Bus Administration Console provides its own integrated help system, but Oracle Service Bus displays custom transport help stand-alone in its own browser window, as shown in Figure 39-8. Custom transport help is displayed when you click Help on the transport configuration page.


Figure 39-8 Custom Transport Help from the Oracle Service Bus Administration Console

[image: Description of Figure 39-8 follows]





The following sections show you how to provide online help for your custom transport in both Eclipse and in the Oracle Service Bus Administration Console.








39.12.2 Providing Custom Transport Help in Eclipse

If you make your custom transport available for service configuration in the Eclipse, you can provide help content that appears as context-sensitive help in Eclipse, in the Eclipse help system, or both. This section shows you how.

The sample socket transport and the Oracle Service Bus native transports provide a best-practice reference implementation for Eclipse help and are used as examples in this section.

Transport help is part of the Eclipse plug-in you create for your transport. For details on plug-in creation, see Chapter 40, "Developing Oracle Service Bus Transports for Eclipse."



39.12.2.1 Providing Context-Sensitive Help in Eclipse

Providing context-sensitive help gives users information about transport configuration directly in Eclipse, where they are configuring the transport.

You can provide context-sensitive help on the transport configuration pages in the service editor in Eclipse.

The following steps are required for providing context-sensitive help:

	
In plugin.xml, add an extension for org.eclipse.help.contexts that points to a context.xml file. See the org.eclipse.help.contexts example in Example 39-7.

This entry tells the plug-in where to find the context.xml file. The path to context.xml is relative to the plug-in root.


	
Create a context.xml file that maps the transport configuration user interface context IDs to help files. Oracle Service Bus provides context IDs for custom transports automatically. See Section 39.12.2.3.3, "context.xml."


	
Create your help topics. See Section 39.12.2.3.4, "Help Content and Resources."


	
Package all the help files. See Section 39.12.2.4, "Packaging Help for the Transport Plug-in."









39.12.2.2 Providing Help in the Eclipse Help System

You can add your transport help to the main Eclipse help system. Your help topics appear in the table of contents, as shown in Figure 39-7.

	
In plugin.xml, add an extension for org.eclipse.help.toc that points to a toc.xml file. See the org.eclipse.help.contexts example in Example 39-7. Use the following guidance for setting the primary attribute.

	
If you are packaging your plug-in as a JAR file, or if you want your transport help to appear in the top level of the help table of contents, as shown in the "Sample Transport" entry in Figure 39-7, set primary="true".


	
If you want your transport help to be merged with the Oracle Service Bus help topics, as shown in Figure 39-7, set primary="false".

To merge your transport help with the main Oracle Service Bus help, your transport plug-in must be packaged as an exploded directory.




For details on plug-in packaging, see Chapter 40, "Developing Oracle Service Bus Transports for Eclipse."


	
Create a toc.xml file that provides the table of contents structure for your transport help. See the examples in Section 39.12.2.3.2, "toc.xml."


	
Create your help topics. See Section 39.12.2.3.4, "Help Content and Resources."


	
Package all the help files. See Section 39.12.2.4, "Packaging Help for the Transport Plug-in."









39.12.2.3 Help Implementation Reference

Eclipse help, which is based on the Eclipse help framework, requires the resources described in this section.

Use this reference section in conjunction with the previous procedures for implementing transport help in Eclipse.




	
Note:

Oracle Service Bus provides a sample help implementation in its sample socket transport, located at OSB_ORACLE_HOME/samples/servicebus/sample-transport. The sample transport is a good reference implementation for developing your own custom transports and help. The sample plugin.xml is in the /eclipse subdirectory, and the help resources are in the /help subdirectory.









This section describes the following Eclipse help resources:

	
Section 39.12.2.3.1, "plugin.xml" – The key file that identifies the components you want to add to Eclipse; in this case, an addition to the help system.


	
Section 39.12.2.3.2, "toc.xml" – The hierarchy of your help topics that appears in the help system table of contents, as shown in Figure 39-7.


	
Section 39.12.2.3.3, "context.xml" – Enables context-sensitive help for your transport configuration user interface.


	
Section 39.12.2.3.4, "Help Content and Resources" – The HTML files, CSS file(s), images, and any other help resources you want to provide.






39.12.2.3.1 plugin.xml

The plugin.xml file is the key to adding your transport and transport help files to the Eclipse environment. You must add entries in plugin.xml for your help table of contents (toc.xml) and for context-sensitive help (context.xml).

Example 39-7 shows the toc.xml and context.xml (contexts_socketTransport.xml) entries in the sample socket transport's plugin.xml file, located in the OSB_ORACLE_HOME/samples/servicebus/sample-transport/eclipse directory.


Example 39-7 Sample transport plugin.xml


<?xml version="1.0" encoding="UTF-8"?>
<?eclipse version="3.2"?>
<plugin>
...
   <extension
         point="org.eclipse.help.toc">
      <toc file="/help/en/toc.xml" primary="true"/>
   </extension>
   <extension
         point="org.eclipse.help.contexts">
      <contexts
            file="/help/en/contexts_socketTransport.xml"
            plugin="Socket_Transport"/>
   </extension>
</plugin>




Key Parts of plugin.xml 

	
All paths are relative to the plug-in root directory.


	
The org.eclipse.help.toc extension point makes the connection to the Eclipse help system left navigation area.

The <toc file...> entry references the toc.xml file containing the help topic hierarchy you create for your transport help.


	
The primary="true" attribute is important. If set to true, your transport table of contents appears at the top level of the Eclipse help system. Set it to true if you are packaging your custom transport plug-in as a JAR file.

If set to false, Eclipse expects your toc.xml to be merged into an existing toc.xml hierarchy, such as the main Oracle Service Bus help system. See the following toc.xml section for more information.


	
The entry for the org.eclipse.help.contexts lets you implement Eclipse-based context-sensitive (F1) help for your transport. Context-sensitive help topic links appear in the Related Topics area of the Help view in Eclipse.




For details on plug-in packaging, see Chapter 40, "Developing Oracle Service Bus Transports for Eclipse."






39.12.2.3.2 toc.xml

The toc.xml file determines how your custom transport help appears in the left navigation area of the Eclipse help system. Example 39-8 shows how you provide your transport help at the top level of the Eclipse help system table of contents.


Example 39-8 Sample Socket Transport toc.xml for a Top-Level Entry in the Eclipse Help System


<?xml version="1.0" encoding="UTF-8" standalone="yes" ?>
<?NLS TYPE="org.eclipse.help.toc"?>
<toc label="Socket Transport Sample">
    <topic label="Socket Transport Configuration Page (Business Services)"
        href="help/en/tpSOCKETTransportBizService.html"/>
    <topic label="Socket Transport Configuration Page (Proxy Services)"
        href="help/en/tpSOCKETTransportProxyService.html"/>
    <topic label="Configuring the Socket Transport Sample (Service Bus Console)"
        href="help/en/example.html"/>
</toc>


When including your transport help as a top-level entry in the Eclipse help system, be sure to set primary="true" in the org.eclipse.help.toc extension point in plugin.xml.








39.12.2.3.3 context.xml

The context.xml file, shown in Example 39-9, maps the context IDs of your transport editor page to help topics. When users press F1 on your transport configuration pages, Eclipse displays your help links in the Help view, as shown in Figure 39-6.


Example 39-9 Sample context.xml (contexts_socketTransport.xml) for the sample socket transport


<?xml version="1.0" encoding="UTF-8"?>
<?NLS TYPE="org.eclipse.help.contexts"?>
<contexts> 
    <!-- Default Socket Transport help -->
<context id="tpSOCKETTransportBizService" 
    title="Socket Transport Configuration page (Business Service)">
    <description>The Sample socket transport illustrates Transport SDK
        concepts.</description>
    <topic href="help/en/tpSOCKETTransportBizService.html" 
        label="Socket Transport Configuration Page (Business Services)"/>
</context>
<context id="tpSOCKETTransportProxyService" 
        title="Socket Transport Configuration page (Proxy Service)">
    <description>The Sample socket transport illustrates Transport SDK
        concepts.</description>
    <topic href="help/en/tpSOCKETTransportProxyService.html" 
        label="Socket Transport Configuration Page (Proxy Services)"/>
</context>
</contexts>




Key Points About context.xml 

	
The context id attribute value is the context ID of the editor user interface.


	
The topic href attribute tells Eclipse which help topic to link to when the user presses F1.


	
The topic label attribute determines the link text that appears in the Related Topics area of the Eclipse Help view.


	
The description element provides the text above the displayed link when the user presses F1.


	
Context IDs for your transport user interfaces are available automatically. Use the patterns in Table 39-1 for the context id attribute, following the exact text and case sensitivity. If your id values are incorrect, context-sensitive help will not work for your transport.





Table 39-1 Context IDs for Transport Configuration Pages

	User Interface Component	Value for Id Attribute
	
Transport configuration page in the business service editor

	
tp<TRANSPORT_ID>TransportBizService – For example:

tpSOCKETTransportBizService


	
Transport configuration page in the proxy service editor

	
tp<TRANSPORT_ID>TransportProxyService – For example:

tpSOCKETTransportProxyService








The <TRANSPORT_ID> value comes from your implementation of the TransportProvider class, where you set the String ID of the transport. Notice that the <TRANSPORT_ID> must be all uppercase letters even if you named the transport ID with lowercase letters.

	
You can give your context.xml a unique name (with an .xml extension) and put it anywhere within the plug-in directory as long as you provide the correct path to it in plugin.xml.


	
All paths in context.xml are relative to the plug-in root directory.









39.12.2.3.4 Help Content and Resources

You have a lot of flexibility in deciding what type of help content to provide, from a simple page of text with no graphics to multiple pages with many graphics, PDF files, embedded video and so on.

For example, you could create a single HTML file and reference it from the toc.xml and context.xml files; or you could create separate help files that describe the transport configuration fields for business services and proxy services and also provide a high-level overview, pointing at the three help files in different combinations from toc.xml and context.xml.

You can store your help topics and resources anywhere in your transport plug-in, as long as you reference them correctly in toc.xml and/or context.xml.

Because of potential user interface and functionality differences between transport configuration in Eclipse and the Oracle Service Bus Administration Console, consider creating separate help topics for Eclipse and for the Oracle Service Bus Administration Console.








39.12.2.4 Packaging Help for the Transport Plug-in

Your transport plug-in should contain the following:

	
The plugin.xml file


	
A transport JAR containing your transport classes and supporting files


	
A help directory containing the toc.xml, context.xml, and help files




Whether you package your transport plug-in as a JAR or as an exploded directory, following is a recommended packaging structure for your transport help with relation to other resources:

/plugin_root

plugin.xml

transport.jar

/help

/en (locale)

toc.xml

context.xml

/html

<help files and resources>

Notice that with the /en directory the help is packaged to support localization. To provide localization, you must create a plug-in for each locale, as described in the Eclipse documentation.




	
Note:

You can also package your help files in a doc.zip file. For more information, see "Help server and file locations" in the Eclipse Platform Plug-In Developer Guide at http://help.eclipse.org/galileo/topic/org.eclipse.platform.doc.isv/guide/ua_help_content_files.htm.














39.12.2.5 Related Topics

For complete information on the Eclipse help framework, see the Eclipse help system at http://help.eclipse.org/galileo/topic/org.eclipse.platform.doc.isv/guide/ua_help.htm.

For information on plug-in packaging, see Chapter 40, "Developing Oracle Service Bus Transports for Eclipse."








39.12.3 Providing Custom Transport Help in the Oracle Service Bus Administration Console

This section shows you how to provide help for your custom transport at runtime in the Oracle Service Bus Administration Console. Oracle Service Bus displays custom transport help as a stand-alone help page in a browser, as shown in Figure 39-8.

Figure 39-9 provides a high-level view of the Oracle Service Bus Administration Console help framework for custom transports.


Figure 39-9 Oracle Service Bus Administration Console Help Framework

[image: Description of Figure 39-9 follows]





By implementing a specific Oracle Service Bus interface, you use the getHelpPage() method to launch a single HTML page when the user clicks Help in the Oracle Service Bus Administration Console when your user interface has focus. The HTML file can contain the following:

	
Text, inline CSS definitions, inline JavaScript functions


	
References to graphics and other resources, as long as those resources are hosted in a Web application or an external Web site




In most situations, you should be able to provide all the help for your custom transport with text and inline formatting.

However, if you want to provide full-featured Web-based help that includes graphics and other external resources, those resources must be hosted in a Web application or an external Web site. You must either reference those external resources in the HTML file or provide a link from the HTML file to an external location. For example, the sample socket transport help provides a link from the starting HTML file to a help topic with graphics that is running in a custom Web application. Using an embedded JavaScript call, you could also set up your HTML file to automatically redirect to the expanded help URL you want.

Following are the tasks involved in creating custom transport help in the Oracle Service Bus Administration Console:

	
Section 39.12.3.1, "Implementing the CustomHelpProvider Interface"


	
Section 39.12.3.2, "Creating an HTML File to Launch"


	
Section 39.12.3.3, "Creating a Simple Web Application to Display Expanded Help (Optional)"


	
Section 39.12.3.4, "Packaging Transport Help for the Oracle Service Bus Administration Console"






39.12.3.1 Implementing the CustomHelpProvider Interface

To develop the configuration user interface for your custom transport, you implement the TransportUIBinding interface in a custom class. To provide help for your transport configuration user interface in the Oracle Service Bus Administration Console, you must also implement the CustomHelpProvider interface. CustomHelpProvider contains the getHelpPage() method you need to launch help for your transport configuration page in the Oracle Service Bus Administration Console.

The sample socket transport implements CustomHelpProvider in its SocketTransportUIBinding.java class, located at OSB_ORACLE_HOME/samples/servicebus/sample-transport/src/com/bea/alsb/transports/sock.

Example 39-10 contains snippets that illustrate the implementation of CustomHelpProvider.


Example 39-10 Implementing CustomHelpProvider to provide help for your transport in the Oracle Service Bus Administration Console


public class SocketTransportUIBinding
    implements TransportUIBinding, CustomHelpProvider {
.
.
.
  public Reader getHelpPage() {
    String helpFile = "help/en/contexts_socketTransport.html";
    ClassLoader clLoader = Thread.currentThread().getContextClassLoader();
    InputStream is = clLoader.getResourceAsStream(helpFile);
    InputStreamReader helpReader = null;
    if(is!=null)
      helpReader = new InputStreamReader(is);
    else
      SocketTransportUtil.logger
        .warning(SocketTransportMessagesLogger.noHelpPageAvailableLoggable().
                getMessage(uiContext.getLocale()));
    return helpReader;
  }
}


In Example 39-10, Reader getHelpPage() returns a Reader stream that the Oracle Service Bus Administration Console uses to send the HTML page to the browser. The helpFile path is relative to the root within the transport JAR.

If you are providing help in multiple languages, use TransportUIContext.getLocale() to help provide the appropriate path to the localized content; in this case, providing the locale value for /help/<locale>/your.html.








39.12.3.2 Creating an HTML File to Launch

Create an HTML file for the getHelpPage() method to launch, as illustrated by help/en/contexts_socketTransport.html in Example 39-10.

If you want to keep your help implementation simple, create the HTML file to use text, inline CSS definitions, and inline JavaScript functions. If you do this, you do not need to create a separate Web application to host graphics or other external resources.

However, if you want to provide more expanded help with graphics and other resources, reference those external resources in your HTML file, such as


img src="/help_socket/help/en/wwimages/addProject.gif"


or


a href="http://www.yoursite.com"


You can also set the HTML file up to automatically redirect to the expanded help with an embedded JavaScript call, as shown in Example 39-11, which redirects from the sample socket transport HTML page to the expanded help_socket Web application help content.


Example 39-11 JavaScript function that provides a redirect


<script language="JavaScript" type="text/javascript">
<!-- Begin
window.location="/help_socket/help/en/example.html";
// End -->
</script>


The sample socket transport HTML file provides a link to its expanded help. The HTML file, contexts_socketTransport.html, is located at OSB_ORACLE_HOME/samples/servicebus/sample-transport/resources/help/en/.








39.12.3.3 Creating a Simple Web Application to Display Expanded Help (Optional)

If you want to go beyond a basic text HTML file for your transport help, you can provide expanded help with graphics and other resources in various ways:

	
Link from the self-contained HTML file to an existing URL; for example, if you have an existing Web site that contains your transport documentation. All that is required is that you provide a link to the URL from the self-contained HTML file. You can also insert references to graphics and other resources hosted on an external site.


	
Create a Web application for the expanded help, bundle it with your transport, and link to it or reference graphics and other resources from the HTML file. This topic provides instructions on creating a Web application that is bundled in your transport EAR to display your expanded transport help.




Create the following files for your Web application:



39.12.3.3.1 META-INF/application.xml

In application.xml, give your Web application a context root that is used for the Web application's root URL. For example, Example 39-12 shows the context root for the sample socket transport Web application.


Example 39-12 application.xml for the sample socket transport Web application


<application>
    <display-name>Socket Transport</display-name>
    <description>Socket Transport</description>
    <module>
        <web>
            <web-uri>webapp</web-uri>
            <context-root>help_socket</context-root>
        </web>
    </module>
</application>


The sample socket transport application.xml file is located at OSB_ORACLE_HOME/samples/servicebus/sample-transport/META-INF/.

This entry maps the file system directory /webapp to an alias Web application root URL:


http://server:port/help_socket/ 


With your help files inside the Web application in a directory such as /help/en/, the full URL to your expanded help would be:


http://server:port/help_socket/help/en/index.html


But your internal links to it only need to be


/help_socket/help/en/index.html


where index.html is the landing HTML page.








39.12.3.3.2 WEB-INF/web.xml

In web.xml, enter a display name and description for the Web application. This is standard deployment descriptor information. For example, Example 39-13 shows the name and description of the sample socket transport Web application.


Example 39-13 web.xml for the sample socket transport Web application


<web-app>
    <display-name>Sample Socket Transport Help WebApp</display-name>
    <description>
        This webapp implements the help webapp for the socket transport.
    </description>
</web-app>


The sample socket transport web.xml file is located at OSB_ORACLE_HOME/samples/servicebus/sample-transport/webapp/WEB-INF/.








39.12.3.3.3 Help Content and Resources

Create and package your expanded help files inside the Web application directory. In the sample socket transport, the help files are stored in OSB_ORACLE_HOME/samples/servicebus/sample-transport/resources/help/en.




	
Note:

The reason the socket transport help files are not stored in the /webapp directory is because the help directory contains help files and resources for both the Eclipse plug-in and the Oracle Service Bus Administration Console. When the sample socket ANT build creates the transport JAR, transport EAR, and Eclipse plug-in, it packages the help in different ways. For the transport EAR build, it moves the help files under the /webapp directory.









Because of potential user interface and functionality differences between transport configuration in Eclipse and the Oracle Service Bus Administration Console, consider creating separate help topics for Eclipse and for the Oracle Service Bus Administration Console.








39.12.3.4 Packaging Transport Help for the Oracle Service Bus Administration Console

Your transport EAR should contain the following:

	
A transport JAR stored in APP-INF/lib containing:

	
Your transport classes and supporting files


	
The HTML file for your transport help, ideally in a directory such as help/en/ for localization support





	
Optionally, a Web application containing expanded help for your transport
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42 Sample Socket Transport Provider


This chapter describes how to build and run the sample socket transport provider. This sample and its source code are installed with Oracle Service Bus. The sample serves as an example implementation of a custom transport provider.

This chapter includes the following sections:

	
Section 42.1, "Sample Socket Transport Provider Design"


	
Section 42.2, "Sample Location and Directory Structure"


	
Section 42.3, "Building and Deploying the Sample"


	
Section 42.4, "Start and Test the Socket Server"


	
Section 42.5, "Configuring the Socket Transport Sample"


	
Section 42.6, "Testing the Socket Transport Provider"






42.1 Sample Socket Transport Provider Design

The primary purpose of the sample socket transport provider is to serve as an example transport provider implementation. This publicly available sample demonstrates the implementation and configuration details of the Transport SDK.

This section includes these topics:

	
Section 42.1.1, "Concepts Illustrated by the Sample"


	
Section 42.1.2, "Basic Architecture of the Sample"


	
Section 42.1.3, "Configuration Properties"






42.1.1 Concepts Illustrated by the Sample

The sample transport is designed to send and receive streamed data to and from a configured TCP socket in Oracle Service Bus. The sample transport is intended to illustrate the following Transport SDK concepts:

	
Implementing the set of Transport SDK APIs that are required to build a custom transport.


	
Performing transport endpoint validations, such as checking that no socket endpoint is listening on the configured address.


	
Implementing several UI configuration options, including socket properties and message patterns.


	
Implementing a one-way or synchronous request-response message pattern.


	
Using POJOs (Plain Old Java Objects) for metadata and headers of endpoint requests and responses.


	
Showing how streaming is used in the Oracle Service Bus pipeline.









42.1.2 Basic Architecture of the Sample

Figure 42-1 shows the basic architecture of the sample socket transport provider. Any client can connect to the server socket. Data is received at the server socket and passes through the pipeline. The response comes back through the outbound transport. The response is finally sent back to the inbound transport and back to the client.


Figure 42-1 Sample Socket Transport Architecture

[image: Description of Figure 42-1 follows]









42.1.3 Configuration Properties

Figure 42-2 illustrates the configuration properties for the transport endpoint. These properties are configured in the schema file: SocketTransport.xsd. See Section 42.2, "Sample Location and Directory Structure" for information on the location of this file. This file lets you extend the basic set of properties defined in the common schema provided with the SDK. Refer to the SocketTransport.xsd file for information on each of the properties.




	
Tip:

See also Section 39.3.4, "4. Define Transport-Specific Artifacts," for more information on these configuration properties.










Figure 42-2 SocketEndpointConfiguration Properties

[image: Description of Figure 42-2 follows]





Also in the SocketTransport.xsd file are the request/response header and metadata properties, as illustrated in Figure 42-3. Refer to the SocketTransport.xsd file for more information on these properties.


Figure 42-3 Request/Response Header and Metadata Configurations

[image: Description of Figure 42-3 follows]











42.2 Sample Location and Directory Structure

The sample socket transport provider is installed with Oracle Service Bus and is located in the following directory: OSB_ORACLE_HOME/samples/servicebus/sample-transport.

This section briefly describes some of the key folders in the sample project. You can use this directory structure as a model for developing your custom transport provider.

Table 42-1 lists and briefly describes key sample-transport directories.


Table 42-1 Key Sample Transport Provider Directories

	Directory	Description
	
build

	
Created when you build the sample socket transport. Contains the built and packaged transport for use in Oracle Service Bus.


	
eclipse

	
Contains the plugin.xml file needed to add the sample transport to the Eclipse environment.


	
l10n

	
Contains Internationalization files:

SocketTransportMessages.xml – Configuration file for text messages which are displayed on the Oracle Service Bus Administration Console.

SocketTransportTextMessages.xml


	
META-INF

	
Contains application deployment descriptor files:

application.xml – J2EE application descriptor file

weblogic-application.xml – WebLogic application descriptor file


	
resources

	
SocketConfig.xml – Socket transport provider configuration that is used by the Transport SDK.

Sample help files for the transport.


	
schemas

	
Contains the relevant schemas defined for this transport:

SocketTransport.xsd – Describes Socket Endpoint Request/Response Metadata/headers


	
src

	
Source tree of the sample transport


	
test

	
(not shown) Test files directory:

src – Source tree for test server and client


	
webapp

	
Contains the deployment descriptors required for the sample transport help Web application.








The following Ant build files are also located in the sample-transport directory:

	
build.properties – Properties file for Ant.


	
build.xml – An Ant build file with different targets for compile, build, stage, and deploy.









42.3 Building and Deploying the Sample

This section explains how to build and deploy the sample transport provider.



42.3.1 Setting Up the Environment

Follow these steps to set the environment for building the sample.

	
Create a new domain or use one of the preconfigured domains that are installed with Oracle Service Bus.


	
Set the domain environment by running the following script:

DOMAIN_HOME/bin/setDomainEnv.cmd (setDomainEnv.sh on a UNIX system)









42.3.2 Building the Transport

To build the socket transport, do the following:

	
In a command window, go to the sample home directory:

OSB_ORACLE_HOME/samples/servicebus/sample-transport


	
Execute the following command: ant build. This command compiles the source files in OSB_ORACLE_HOME/samples/servicebus/sample-transport/build.


	
After a successful build, execute the following command: ant stage. This command does the following:

	
Copies sock_transport.ear sock_transport.jar to OSB_ORACLE_HOME/lib/transports.


	
Creates OSB_ORACLE_HOME/eclipse/plugins com.bea.alsb.transports.socket_version to register the socket sample as a plug-in to Eclipse.












42.3.3 Deploying the Sample Transport Provider

To deploy the sample transport provider on a server, do the following:

	
Set the following variables in sample-transport/build.properties:


wls.hostname

wls.port

wls.username

wls.password

wls.server.name


	
Deploy the transport provider on the server by running the following command:


ant deploy











42.4 Start and Test the Socket Server

The sample project includes a simple socket server and a client to test the server. You can use this socket server to test the socket transport provider.

This section includes the following topics:

	
Section 42.4.1, "Start the Socket Server"


	
Section 42.4.2, "Test the Socket Transport"






42.4.1 Start the Socket Server

Run the following command to start the external service, which is a server socket that listens on a specified port and receives/sends the messages.


java -classpath .\test\build\test-client.jar -Dfile-encoding=utf-8 -Drequest-encoding=utf-8 com.bea.alsb.transports.sample.test.TestServer <port> <message-file-location>


where:

	
port – The port number at which ServerSocket is listening, which is the port number in the business service.


	
message-file-location – (optional) The location of the message-file which will be sent as a response to the business service.


	
file-encoding – A system property that is the encoding of the file. (default = utf-8)


	
request-encoding – The encoding of the request that is sent by the socket business service. (default = utf-8)









42.4.2 Test the Socket Transport

Run the following command to start the service, which is a client to a configured socket proxy-service. It sends a message and receives the response from Oracle Service Bus.


java -classpath .\test\build\test-client.jar -Dfile-encoding=utf-8 -Dresponse-encoding=utf-8 com.bea.alsb.transports.sample.test.TestClient <host-name> <port> <thread-ct> <message-file-location>


where:

	
host-name – The host name of the Oracle Service Bus server.


	
port – The port number at which the proxy service is listening.


	
thread-ct – The number of clients that can send a message to Oracle Service Bus.


	
message-file-location – (optional) The location of the message file that will be sent as a response to the business service.


	
file-encoding – An optional argument specifying the encoding of the file. (default = utf-8)


	
response-encoding – The encoding of the response received from the socket proxy service. (default = utf-8)











42.5 Configuring the Socket Transport Sample

The sample consists of a test server and a test client. The client sends a message to the server. You configure Oracle Service Bus to receive and process the message.

This section describes these tasks:

	
Section 42.5.1, "Create a New Project"


	
Section 42.5.2, "Create a Business Service"


	
Section 42.5.3, "Create a Proxy Service"


	
Section 42.5.4, "Edit the Pipeline"






42.5.1 Create a New Project

To create a new project:

	
Start the Oracle Service Bus Administration Console.


	
Open the Project Explorer.


	
In the Change Center, click Edit.


	
In the Projects panel, enter SocketTest in the Enter New Project Name field.


	
Click Add Project. The new project appears in the project table.









42.5.2 Create a Business Service

Create a business service to talk to the server.

	
Click the SocketTest project name in the project table. The SocketTest panel appears.


	
From the Create Service menu, select Business Service. The General Configuration panel appears.


	
In the General Configuration panel, enter SocketBS in the Service Name field.


	
Be sure Any XML Service is selected in the Service Type list, and click Next.


	
From the Protocol menu, select socket, as shown in Figure 39-1.


	
In the Endpoint URI field, enter: tcp://localhost:7031, and click Add.


	
Click Next.


	
In the next panel, accept the defaults by clicking Next.


	
After viewing the Summary panel, click Save.


	
In the Change Center, click Activate.









42.5.3 Create a Proxy Service

In this section, you create a proxy service.

	
From the Create Resource menu, select Proxy Service.


	
In the General Configuration panel, enter SocketProxy in the Service Name field.


	
Be sure that Any XML Service is selected in the Service Type list, and click Next.


	
From the Protocol menu, select socket.


	
In the Endpoint URI field, enter tcp://7032, and click Next.


	
In the next panel, accept the defaults and click Next.


	
After viewing the Summary panel, click Save.


	
In the Change Center, click Activate.


	
Click Submit.









42.5.4 Edit the Pipeline

Now that the business and proxy services are defined, you can edit the pipeline to route incoming messages to the business service.

To edit the pipeline:

	
In the Change Center, click Create.


	
In the Resources section, click the View Message Flow icon in the SocketProxy row, as shown in Figure 42-4.


Figure 42-4 Selecting the Message Flow Icon

[image: Description of Figure 42-4 follows]





	
In the Edit Message Flow window, click the SocketProxy icon and select Add Route from the menu, as shown in Figure 42-5.


Figure 42-5 Editing the Message Flow

[image: Description of Figure 42-5 follows]





	
Click the RouteNode1 icon and select Edit Route from the menu.


	
In the Edit Stage Configuration window, click Add an Action.


	
In the Route Node window, click Add an Action and select Communication > Routing from the menu, as shown in Figure 42-6.


Figure 42-6 Adding an Action

[image: Description of Figure 42-6 follows]





	
In the next panel, select <Service>.


	
In the Select Service window, select SocketBS from the list, and click Submit.


	
In the Edit Stage Configuration window, click Save.


	
Optionally, click the RouteNode1 icon and change the name to SocketBS.


	
Click Save.


	
In the Change Center, click Activate, and then click Submit.











42.6 Testing the Socket Transport Provider

In this section you test the transport provider using Oracle Service Bus Administration Console.

	
Start the test server, as explained previously in Section 42.4.1, "Start the Socket Server."


	
In the Project Explorer, click SocketTest.


	
In the SocketProxy row of the Resources table, click the Launch Test Console icon, as shown in Figure 42-7.


Figure 42-7 Starting the Test Console

[image: Description of Figure 42-7 follows]





	
In the Test Console, enter any valid XML stanza in the text area, or use the Browse button to select a valid XML file on the local system. For example, in Figure 42-8, a simple XML expression <x/> is entered in the text area.


Figure 42-8 Test Console

[image: Description of Figure 42-8 follows]





	
Click Execute. If the test is successful, information similar that shown in Figure 42-9 appears in the Test Console. In addition, the XML text input into the Test Console is echoed in the server console.


Figure 42-9 Successful Test

[image: Description of Figure 42-9 follows]





	
Close the Test Console.
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43 Deploying a Transport Provider


This chapter describes how to package and deploy a custom transport provider for use with Oracle Service Bus.

This chapter includes the following sections:

	
Section 43.1, "Packaging the Transport Provider"


	
Section 43.2, "Deploying the Transport Provider"


	
Section 43.3, "Undeploying a Transport Provider"


	
Section 43.4, "Deploying to a Cluster"






43.1 Packaging the Transport Provider

You must package your custom transport provider as a self-contained EAR file. You can then deploy the EAR with the Oracle Service Bus Kernel EAR and other Oracle Service Bus related applications.




	
Tip:

The sample socket transport provider example illustrates how a transport provider is organized and deployed. See Section 42, "Sample Socket Transport Provider," for more information.









Each transport provider consists of two distinct parts:

	
Configuration – The configuration part of a transport provider is used by Oracle Service Bus Administration Console to register endpoints with the transport provider. This configuration behavior is provided by the implementation of the UI interfaces.Section 41.6, "User Interface Configuration."


	
Runtime – The runtime part of a transport provider implements the business logic of sending and receiving messages.




	
Tip:

A best practice is to package the transport provider so that the configuration and runtime parts are placed in separate deployment units. This practice makes cluster deployment simpler. See Section 43.4, "Deploying to a Cluster" for more information. See also Section 38.4, "Transport Provider Components."

















43.2 Deploying the Transport Provider

This section discusses how to deploy a transport provider.




	
Tip:

For more information on deploying applications to Oracle Service Bus, see the Oracle Fusion Middleware Deployment Guide for Oracle Service Bus.









After you create a deployable EAR file for your transport provider, you need to deploy it to the Oracle Service Bus domain. You can deploy the EAR by whatever method you prefer:

	
Programmatically (using WebLogic Deployment Manager JSR-88 API)


	
Using the Oracle WebLogic Server Administration Console


	
Adding an entry similar to Example 43-1 to the Oracle Service Bus domain config.xml file





Example 43-1 Application Deployment Entry


<app-deployment>
    <name>My Transport Provider</name>
    <target>AdminServer, myCluster</target>
    <module-type>ear</module-type>
    <source-path>$USER_INSTALL_DIR$/servicebus/lib/mytransport.ear</source-path>
    <deployment-order>1234</deployment-order>
</app-deployment>







	
Note:

The deployment order of your transport provider EAR file should be high enough so that the entire Oracle Service Bus Kernel EAR is deployed before the transport provider.











43.2.1 Transport Registration

On server restart, you want to ensure that your deployed transport can immediately begin to handle service requests. To ensure immediate transport availability, extend the weblogic.application.ApplicationLifecycleListener class and use the preStart() method to register your transport using TransportManager.registerProvider().

The sample socket transport has an ApplicationListener class that you can use for reference, located at OSB_ORACLE_HOME/samples/servicebus/socket-transport/src/com/bea/alsb/transports/sock.

When extending ApplicationLifecycleListener, be sure to register your extending class in META-INF/weblogic-application.xml. The sample socket transport provides the following entry for its ApplicationListener class in OSB_ORACLE_HOME/samples/servicebus/sample-transport/META-INF/weblogic-application.xml:


<weblogic-application>
  <listener>
    <!-- This class gives callbacks for the deployment lifecycle and socket
    transport is registered with ALSB whenever the application is started.
    -->
    <listener-class>com.bea.alsb.transports.sock.ApplicationListener
    </listener-class>
  </listener>
</weblogic-application>








43.3 Undeploying a Transport Provider

Once a transport provider has been registered with Oracle Service Bus, the undeployment or unregistration of the transport provider is not supported.






43.4 Deploying to a Cluster

Your transport provider must be deployed on all the servers/clusters where Oracle Service Bus is deployed. This means that if Oracle Service Bus is deployed only on the Admin Server (which it always is), you must deploy the transport provider on the Admin Server; if Oracle Service Bus is deployed in an admin + Managed Server topology, you must deploy the transport provider on the Admin Server and that particular Managed Server; and if Oracle Service Bus is deployed in a cluster, you must deploy your transport provider on the Admin Server and the cluster. Oracle Service Bus is always deployed on the Admin Server regardless of the domain topology.

The application code inside your transport provider EAR file needs to be aware dynamically of where the transport is being deployed (such as the Admin Server or a Managed Server) and exhibit only configuration behavior on the Admin Server and only runtime behavior on the Managed Server.

For example, in the initialization pseudo code in some_transport.ear, you can use this logic to decide whether or not to activate the configuration or runtime portion of the provider:


protected SomeTransportProvider() throws TransportException {
    . . . some other initialization code . . .
    if (!isRuntimeEnabled)
        _engine = new RuntimeEngine(. . .);
}


In this case, creating an instance of the RuntimeEngine class is runtime behavior and only needs to happen on a managed node in a multi-server domain or on the administration node in a single server domain.

Furthermore, as mentioned previously, in a cluster environment, TransportProvider.createEndPoint() and deleteEndPoint() are called on an Admin Server as well as Managed Servers in the cluster (with the exception of WLS HTTP router/front-end host). Some transport providers can choose not to do anything other than registering the fact that there is an endpoint with the given configuration, such as HTTP. In general the transport provider needs to examine whether createEndPoint() or deleteEndPoint() is called on the administration or Managed Server to decide the appropriate behavior.
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Part VII



Security

This guide describes how to secure Oracle Service Bus and the messages it handles. Chapters include:

	
Chapter 44, "Introduction"


	
Chapter 45, "Understanding Oracle Service Bus Security"


	
Chapter 46, "Oracle Service Bus Security FAQ"


	
Chapter 47, "Configuring Administrative Security"


	
Chapter 48, "Securing Oracle Service Bus in a Production Environment"


	
Chapter 49, "Configuring Transport-Level Security"


	
Chapter 50, "Securing Oracle Service Bus with Oracle Web Services Manager"


	
Chapter 51, "Using WS-Policy in Oracle Service Bus Proxy and Business Services"


	
Chapter 52, "Configuring Message-Level Security for Web Services"


	
Chapter 53, "Using SAML with Oracle Service Bus"


	
Chapter 54, "Configuring Custom Authentication"


	
Chapter 55, "Message-Level Security with .Net 2.0"








Introduction





44 Introduction


This chapter describes the intended audience of the Oracle Service Bus security documentation and provides links to related Oracle WebLogic Server security documentation.

The Oracle Service Bus security documentation describes how to use standard technologies such as SSL and Web Services Security along with Oracle proprietary technologies to ensure that only authorized users can access resources and messages in an Oracle Service Bus domain.



44.1 Document Audience

This document is intended for the following audiences:

	
Application Architects – Architects who, in addition to setting security goals and designing the overall security architecture for their organizations, evaluate Oracle Service Bus security features and determine how to best implement them. Application Architects have in-depth knowledge of Java programming, Java security, and network security, as well as knowledge of security systems and leading-edge, security technologies and tools.


	
Security Developers – Developers who focus on defining the system architecture and infrastructure for security products that integrate into Oracle Service Bus and on developing custom security providers for use with Oracle Service Bus. They work with Application Architects to ensure that the security architecture is implemented according to design and that no security holes are introduced, and work with Server Administrators to ensure that security is properly configured. Security Developers have a solid understanding of security concepts, including authentication, authorization, auditing (AAA), in-depth knowledge of Java and Java Management eXtensions (JMX), and working knowledge of Oracle WebLogic Server, Oracle Service Bus, and security provider functionality.


	
Application Developers – Developers who are Java programmers that focus on developing client applications, adding security to Web applications and Enterprise JavaBeans (EJBs), and working with other engineering, quality assurance (QA), and database teams to implement security features. Application Developers have in-depth knowledge of Java (including J2EE components such as servlets/JSPs and JSEE) and Java security.


	
Server Administrators – Administrators work closely with Application Architects to design a security scheme for the server and the applications running on the server, to identify potential security risks, and to propose configurations that prevent security problems. Related responsibilities may include maintaining critical production systems, configuring and managing security realms, implementing authentication and authorization schemes for server and application resources, upgrading security features, and maintaining security provider databases. Server Administrators have in-depth knowledge of the Java security architecture, including Web services, Web application and EJB security, Public Key security, SSL, and Security Assertion Markup Language (SAML).


	
Application Administrators – Administrators who work with Server Administrators to implement and maintain security configurations and authentication and authorization schemes, and to set up and maintain access to deployed application resources in defined security realms. Application Administrators have general knowledge of security concepts and the Java Security architecture. They understand Java, XML, deployment descriptors, and can identify security events in server and audit logs.









44.2 Related Information

Oracle Service Bus uses the Oracle WebLogic security framework as the foundation for higher level security services, including authentication, identity assertion, authorization, role mapping, auditing, and credential mapping. In addition to this document, the following documents provide information about Oracle WebLogic security:

	
Oracle Fusion Middleware Understanding Security for Oracle WebLogic Server


	
Oracle Fusion Middleware Security and Administrator's Guide for Web Services


	
Oracle Fusion Middleware Securing a Production Environment for Oracle WebLogic Server


	
Oracle Fusion Middleware Securing Oracle WebLogic Server


	
Oracle Fusion Middleware Securing Resources Using Roles and Policies for Oracle WebLogic Server
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45 Understanding Oracle Service Bus Security


This chapter provides an overview of the Oracle Service Bus security model and its features, including inbound and outbound security.

Oracle Service Bus supports open industry standards for ensuring the integrity and privacy of communications and to ensure that only authorized users can access resources in an Oracle Service Bus domain. It uses the underlying WebLogic security framework as building blocks for its security services.

The Oracle WebLogic security framework divides the work of securing a domain into several components (providers), such as authentication, authorization, credential mapping, and auditing. You configure only those providers that you need for a given Oracle Service Bus domain.

This chapter includes the following sections:

	
Section 45.1, "Inbound Security"


	
Section 45.2, "Outbound Security"


	
Section 45.3, "Options for Identity Propagation"


	
Section 45.4, "Administrative Security"


	
Section 45.7, "Configuring the Oracle WebLogic Security Framework: Main Steps"


	
Section 45.8, "Context Properties Are Passed to Security Providers"


	
Section 45.9, "Using Security Providers"






45.1 Inbound Security

Inbound security ensures that Oracle Service Bus proxy services handle only the requests that come from authorized clients. (By default, any anonymous or authenticated user can connect to a proxy service.) It can also ensure that no unauthorized user has viewed or modified the data as it was sent from the client.

Proxy services can have two types of clients: service consumers and other proxy services. Figure 45-1 illustrates that communication between proxy services and their clients is secured by inbound security, while communication between proxy services and business services is secured by outbound security.


Figure 45-1 Inbound and Outbound Security

[image: Description of Figure 45-1 follows]





You set up inbound security when you create proxy services and you can modify it as your needs change. For outward-facing proxy services (which receive requests from service consumers), consider setting up strict security requirements such as two-way SSL over HTTPS. For proxy services that are guaranteed to receive requests only from other Oracle Service Bus proxy services, you can use less secure protocols.

If a proxy service uses public key infrastructure (PKI) technology for digital signatures, encryption, or SSL authentication, create a service key provider to provide private keys paired with certificates. For more information, see "Service Key Providers" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus.

For each proxy service, you can configure the following inbound security checks:

	
Transport-level security applies security checks as part of establishing a connection between a client and a proxy service. The security requirements that you can impose through transport-level security depend on the protocol that you configure the proxy service to use.

For example, for proxy services that communicate over the HTTP protocol, you can require that all clients authenticate against a database of users that you create in the Security Configuration module of the Oracle Service Bus Administration Console. You then create an access control policy that specifies conditions under which authenticated users are authorized to access the proxy service.

Oracle Service Bus also supports client-specified custom authentication tokens for inbound transport-level requests.

For information about configuring transport-level security for each supported protocol, see Chapter 49, "Configuring Transport-Level Security."


	
Custom Authentication for message-level security. Oracle Service Bus supports client-specified custom authentication credentials for inbound transport- and message-level requests. The custom authentication credentials can be in the form of a custom token, or a username and password.

For information on configuring custom authentication transport- and message-level security, see Chapter 54, "Configuring Custom Authentication."


	
Message-level security (for proxy services that are Web Services) is part of the WS-Security specification. It applies security checks before processing a SOAP message or specific parts of a SOAP message.

Part of the configuration for message-level security can be embedded in the WSDL document and WS-Policy document that are associated with the Web service. These documents specify whether SOAP messages must be digitally signed and encrypted and which Web service operations can be invoked only by authorized users.

There is an alternative way to bind WS-Policy to services. The WS-Policy page lets you bind policies to the service as a whole, to individual operations in the service, or to the request message or response message of individual operations.

If a proxy service or business service uses a WS-Policy statement to secure access to one or more of its operations, and if you have configured the service as an active intermediary (as opposed to a pass-through service), you use the Oracle Service Bus Administration Console to create a message-level access control policy. The policy specifies conditions under which users, groups, or security roles are authorized to invoke the protected operations.

For more information about configuring message-level security, see Chapter 52, "Configuring Message-Level Security for Web Services."









45.2 Outbound Security

Outbound security secures communication between a proxy service and a business service. Most of the tasks that you complete for outbound security are for configuring proxy services to comply with the transport-level or message-level security requirements that business services specify.

For example, if a business service requires user name and password tokens, you create a service account, which either directly contains the user name and password, passes along the user name and password that was contained in the inbound request, or provides a user name and password that depend on the user name that was contained in the inbound request. For more information, see Section 2.1.15, "Creating Service Account Resources."

If a business service requires the use of PKI technology for digital signatures, or SSL authentication, you create a service key provider, which provides private keys paired with certificates. For more information, see "Service Key Providers" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus.






45.3 Options for Identity Propagation

A key group of decisions that you must make when designing security for Oracle Service Bus is how to handle (propagate) the identities that clients provide. You can configure Oracle Service Bus to do any of the following:

	
Authenticate the credentials that clients provide


	
Perform authorization checks


	
Pass client credentials to business services unchanged


	
Map client credentials to a different set of credentials that a business service can authenticate and authorize


	
Bridge between security technologies




Table 45-1 describes the decisions that affect how Oracle Service Bus propagates client identities to business services.


Table 45-1 Options for Identity Propagation

	Decision	Description
	
Which type of credentials do you require clients to provide?

	
For transport-level security, Oracle Service Bus adapts to your existing security requirements. Clients of Oracle Service Bus can supply user name and password tokens, SSL certificates, or any other type of custom authentication token that is supported by an Identity Assertion provider that you configure.

For message-level security, Oracle Service Bus supports the Username Token, X.509 Token, any other type of custom authentication token that is supported by an Authentication or Identity Assertion provider that you configure, and SAML Token profiles (see Section 45.9, "Using Security Providers").

If you are establishing security requirements for a new business service that uses Web Services Security, Oracle recommends that you require clients to provide SAML tokens. SAML is the emerging standard for propagating user identities within Web services. See Chapter 53, "Using SAML with Oracle Service Bus."


	
Do you require Oracle Service Bus to authenticate clients or to simply pass the client-supplied credentials to business services for authentication?

	
When you require clients to authenticate with Oracle Service Bus, you add an additional layer of security. In general, the more security layers you add, the more secure you make a domain.

To enable Oracle Service Bus to authenticate users, you must create user accounts in the Oracle Service Bus Administration Console. If your set of users is very large, you must consider whether maintaining a large database of user accounts in the Oracle Service Bus Administration Console is worth the effort.


	
If Oracle Service Bus authenticates clients that provide X.509 tokens or SAML tokens, which Oracle Service Bus user maps to the tokens?

	
Oracle recommends that you require clients to authenticate with Oracle Service Bus and that you modify the default access-control policies to authorize only specific, authenticated users to have access to your proxy services.

To authenticate and authorize clients who supply X.509 certificates, SAML tokens, or other types of credentials other than user names and passwords, you must configure an identity assertion provider that maps the client's credential to an Oracle Service Bus user. Oracle Service Bus will use this user name to establish a security context for the client.


	
If Oracle Service Bus authenticates clients that provide custom authentication tokens, which Oracle Service Bus user maps to the tokens?

	
Oracle recommends that you require clients to authenticate with Oracle Service Bus and that you modify the default access-control policies to authorize only specific, authenticated users to have access to your proxy services.

To authenticate and authorize clients who supply custom authentication tokens other than user names and passwords, you must configure an Identity Assertion provider that maps the client's credential to an Oracle Service Bus user. Oracle Service Bus will use this user name to establish a security context for the client.


	
If Oracle Service Bus authenticates clients that provide user name and password tokens, decide whether you want to:

	
Pass the client's user name and password to the business service


	
Map the client's user name to a new user name and password and pass the new credentials to the business service




	
If a custom username/password token is used, as described in Section 54.1, "What Are Custom Authentication Tokens?," then the username and password in the custom token can be used for outbound HTTP BASIC or outbound WS-Security Username Token authentication if a pass-through service account is used.

If you pass the client-supplied user name and password to the business service, then clients are responsible for maintaining the credentials that the business service requires. If the business service changes its security requirements, then you must notify each client to make corresponding changes.

If you expect a business service to change its requirements frequently, then consider mapping the credentials supplied by clients to the credentials required by the business service. The more clients for a business service, the more work will be required to maintain this credential mapping.








Table 45-2 describes all combinations of the requirements that you can impose for inbound and outbound transport-level security.


Table 45-2 Combinations of Transport-Level Security Requirements

	This Inbound Requirement...	Can Be Used With This Outbound Requirement...	How to Configure
	
Client supplies user name and password in the HTTP header and Oracle Service Bus authenticates the client.

	
Pass the client's credentials in an HTTP header.

	
	
Configure inbound HTTP security. See Section 49.2.1, "Configuring Inbound HTTP Security: Main Steps."

Be sure to add the client's user name to the Oracle Service Bus Security Configuration module.


	
Configure outbound HTTP security. See Section 49.2.2, "Configuring Outbound HTTP Security: Main Steps."




Be sure to create a pass-through service account and attach the account to the business service.


	
Same as previous requirement.

	
Map the client's credentials to a different Oracle Service Bus user and pass the new credentials in an HTTP header.

	
	
Configure inbound HTTP security. See Section 49.2.1, "Configuring Inbound HTTP Security: Main Steps."

Be sure to add the client's user name to the Oracle Service Bus Security Configuration module.


	
Configure outbound HTTP security. See Section 49.2.2, "Configuring Outbound HTTP Security: Main Steps."




Be sure to create a user-mapping service account and attach the account to the business service.


	
Client supplies user name and password in the HTTP header and Oracle Service Bus does not authenticate the client.

	
Pass the client's credentials in an HTTP header.

	
	
Configure inbound HTTP security. See Section 49.2.1, "Configuring Inbound HTTP Security: Main Steps."

Be sure to configure the proxy service for HTTP, no authentication or HTTPS, one-way SSL, no authentication.


	
Configure outbound HTTP security. See Section 49.2.2, "Configuring Outbound HTTP Security: Main Steps."




Be sure to configure the business service for HTTP BASIC authentication or HTTPS, one-way SSL, BASIC authentication.

Also create a pass-through service account and attach the account to the business service.


	
Client supplies custom authentication token in the HTTP header. Oracle Service Bus authenticates the client.

	
Map the client's credentials to a different Oracle Service Bus user and pass the new credentials in an HTTP header.

	
	
Configure inbound HTTP security. See Section 49.2.1, "Configuring Inbound HTTP Security: Main Steps."

Be sure to add the client's user name to the Oracle Service Bus Security Configuration module.


	
Configure outbound HTTP security. See Section 49.2.2, "Configuring Outbound HTTP Security: Main Steps."




Be sure to create a user-mapping service account and attach the account to the business service.


	
Any form of local authentication (HTTP or HTTPS BASIC, HTTPS CLIENT CERT with credential mapping)

	
Pass the client's credentials to an EJB over RMI. The EJB container authenticates the user.

	
Create a pass-through service account and attach the account to the business service. See Section 2.1.15, "Creating Service Account Resources."








Table 45-3 describes all combinations of the requirements that you can impose for inbound and outbound message-level security. In some cases, the inbound requirement for transport-level security affects the requirements that you can impose for outbound message-level security.


Table 45-3 Combinations of Message-Level Security Requirements

	This Inbound Requirement...	Can Be Used With This Outbound Requirement...	How to Configure
	
Client supplies user name and password, or custom authentication token, in the HTTP header and Oracle Service Bus authenticates the client.

	
Pass the client's credentials in a SOAP header.

	
	
Configure inbound HTTP security. See Section 49.2.1, "Configuring Inbound HTTP Security: Main Steps."

Be sure to add the client's user name to the Oracle Service Bus Security Configuration module.


	
Create a pass-through service account and attach the account to the business service. See Section 2.1.15, "Creating Service Account Resources."





	
Same as previous requirement.

	
Map the client's credentials to a different Oracle Service Bus user and pass the new credentials in a SOAP header.

	
	
Configure inbound HTTP security. See Section 49.2.1, "Configuring Inbound HTTP Security: Main Steps."

Be sure to add the client's user name to the Oracle Service Bus Security Configuration module.


	
Create a user-mapping service account and attach the account to the business service. SeeSection 2.1.15, "Creating Service Account Resources."





	
Same as previous requirement.

	
Map the client credentials to a SAML token. Oracle Service Bus asserts the user identity.

	
	
Configure inbound HTTP security. See Section 49.2.1, "Configuring Inbound HTTP Security: Main Steps."

Be sure to add the client's user name to the Oracle Service Bus Security Configuration module.


	
Configure a SAML credential mapping provider. See Section 53.1, "Mapping Identity to a SAML Token."





	
Client supplies custom user name and password, or custom authentication token, in the message header or body and Oracle Service Bus authenticates the client.

	
Pass the client's credentials in a SOAP header.

	
	
Configure an Authentication or Identity Assertion provider to handle the custom token or username and password.

Be sure to add the client's user name to the Oracle Service Bus Security Configuration module.


	
Create a pass-through service account and attach the account to the business service. See Section 2.1.15, "Creating Service Account Resources."





	
Same as previous requirement.

	
Map the client's credentials to a different Oracle Service Bus user and pass the new credentials in a SOAP header.

	
	
Configure an Authentication or Identity Assertion provider to handle the custom token or username and password.

Be sure to add the client's user name to the Oracle Service Bus Security Configuration module.


	
Create a user-mapping service account and attach the account to the business service. See Section 2.1.15, "Creating Service Account Resources."





	
Same as previous requirement.

	
Map the client credentials to a SAML token. Oracle Service Bus asserts the user identity.

	
	
Configure an Authentication or Identity Assertion provider to handle the custom token or username and password.

Be sure to add the client's user name to the Oracle Service Bus Security Configuration module.


	
Configure a SAML credential mapping provider. See Section 53.1, "Mapping Identity to a SAML Token."





	
Client supplies user name and password in the HTTP header and Oracle Service Bus does not authenticate the client.

	
Pass the client's credentials in a SOAP header.

	
	
Configure inbound HTTP security. See Section 49.2.1, "Configuring Inbound HTTP Security: Main Steps."

Be sure to configure the proxy service for HTTP, no authentication or HTTPS, one-way SSL, no authentication.


	
Configure outbound HTTP security. See Section 49.2.2, "Configuring Outbound HTTP Security: Main Steps."




Be sure to configure the business service for HTTP BASIC authentication or HTTPS, one-way SSL, BASIC authentication.

Also create a pass-through service account and attach the account to the business service.


	
Client supplies a certificate as part of HTTPS CLIENT-CERT authentication (two-way SSL) and Oracle Service Bus authenticates the client.

	
Map the client credentials to a SAML token. Oracle Service Bus asserts the user identity.

	
	
Configure inbound HTTP security. See Section 49.2.1, "Configuring Inbound HTTP Security: Main Steps."


	
Configure a SAML credential mapping provider. See Section 53.1, "Mapping Identity to a SAML Token."





	
An active intermediary proxy service enforces Web-Services Security with the User Name Token Profile.

	
Encode the credentials as a user name and password token in the SOAP message.

	
Create an active intermediary proxy service with a WS-Policy statement that requires passwords (not password digests). See Section 52.3.1, "Creating an Active Intermediary Proxy Service: Main Steps."


	
Same as previous requirement.

	
Encode the credentials as a SAML token in the SOAP message.

	
	
Create an active intermediary proxy service with a WS-Policy statement that requires passwords. See Section 52.3.1, "Creating an Active Intermediary Proxy Service: Main Steps."


	
Configure a SAML credential mapping provider. See Section 53.1, "Mapping Identity to a SAML Token."





	
An active intermediary proxy service enforces Web-Services Security with the X.509 Token Profile.

	
Encode the credentials as a SAML token in the SOAP message.

	
	
Create an active intermediary proxy service with a WS-Policy statement that requires digital signatures and optionally requires authentication with an X.509 token. See Section 52.3.1, "Creating an Active Intermediary Proxy Service: Main Steps."


	
Configure a SAML credential mapping provider. See Section 53.1, "Mapping Identity to a SAML Token."





	
An active intermediary proxy service enforces Web-Services Security with the SAML Token Profile.

	
Generate a new SAML token in the outbound SOAP message.

	
	
Create an active intermediary proxy service with a WS-Policy statement that requires a SAML token. See Section 53.3, "Authenticating SAML Tokens in Proxy Service Requests."


	
Configure a SAML credential mapping provider. See Section 53.1, "Mapping Identity to a SAML Token."





	
A pass-through proxy service, which can pass user names and passwords, X.509 tokens, or SAML tokens.

	
A business service that uses either the User Name Token Profile, the X.509 Token Profile, or the SAML Token Profile.

	
	
Create a pass through proxy service. See Section 52.3.1, "Creating an Active Intermediary Proxy Service: Main Steps."


	
Create a business service that enforces one of the token profiles. See Section 52.4, "Configuring Business Service Message-Level Security: Main Steps" or Section 53.2, "Configuring SAML Pass-Through Identity Propagation."











For inbound Tuxedo requests, you can configure any of the following security requirements:

	
Encode the client's credentials in an outbound call to a Tuxedo service.


	
Encode the client's credentials in an outbound SOAP message as either a user name token or a SAML token.


	
Map the client's credentials to a different Oracle Service Bus user and pass the new credentials in an outbound HTTP header.


	
Map the client's credentials to a different Oracle Service Bus user and pass the new credentials to an EJB over RMI. The EJB container authenticates the user.




For information about using Tuxedo with Oracle Service Bus, see Chapter 35, "Tuxedo Transport."



45.3.1 Example: Authentication with a User Name Token

Figure 45-2 illustrates how user identities flow through Oracle Service Bus when you configure Oracle Service Bus as follows:

	
Require clients to provide user names and passwords in their requests

You can require Web services clients to provide credentials at the transport level, the message level, or both. If you require clients to provide credentials at both levels, Oracle Service Bus uses the message-level credentials for identity propagation and credential mapping.


	
Authenticate clients





Figure 45-2 How Service Accounts Are Used

[image: Description of Figure 45-2 follows]





The illustration begins with the inbound request and ends with the outbound request:

	
A client sends a request to a proxy service. The request contains the user name and password credentials.

Clients can send other types of tokens for authentication, such as an X.509 certificate or a custom authentication token. If a client sends an X.509 certificate token or a custom token, you must configure an identity assertion provider to map the identity in the token to an Oracle Service Bus security context.


	
The proxy service asks the domain's authentication provider if the user exists in the domain's authentication provider store.

If the user exists, the proxy service asks the domain's authorization provider to evaluate the access control policy that you have configured for the proxy service.


	
If the proxy service's access control policy allows the user access, the proxy service processes the message. As part of generating its outbound request to a business service, the proxy service asks the business service to supply the user name and password that the business service requires.

The business service asks its service account for the credentials. Depending on how the service account is configured, it does one of the following:

	
Requires the proxy service to encode a specific (static) user name and password.


	
Requires the proxy service to pass along the user name and password that the client supplied.


	
Maps the user name that was returned from the authentication provider to some other (remote) user name, then requires the proxy service to encode the remote user name.





	
The proxy service sends its outbound request with the user name and password that was returned from the service account.











45.4 Administrative Security

To secure access to administrative functions, such as creating proxy services or business services, Oracle Service Bus provides four security roles with pre-defined access privileges:

	
IntegrationAdmin


	
IntegrationDeployer


	
IntegrationMonitor


	
IntegrationOperator




A security role is an identity that can be dynamically conferred upon a user or group at runtime. You cannot change the access privileges for these administrative security roles, but you can change the conditions under which a user or group is in one of the roles.

The Oracle Service Bus roles have permission to modify only Oracle Service Bus resources; they do not have permission to modify Oracle WebLogic Server or other resources on Oracle WebLogic Server. When assigning administrative users to roles, assign at least one user to the Oracle WebLogic Server Admin role. The Oracle WebLogic Server security roles are described in Table 47-2.

For more information, see Chapter 47, "Configuring Administrative Security."






45.5 Access Control Policies

Access control determines who has access to the resources in Oracle Service Bus. An access control policy specifies conditions under which users, groups, or roles can access a proxy service. For example, you can create a policy that always allows users in the GoldCustomer role to access a proxy service and that allows users in the SilverCustomer role to access the proxy service only after 12pm on weeknights.

An access control policy is an association between a WebLogic resource and one or more users, groups, or security roles. A security policy protects the WebLogic resource against unauthorized access. Access control policies are boolean expressions assigned to specific resources. When there is an attempt to access the resource, the expression is evaluated. The expression consists of one or more conditions joined by boolean operators, such as a role (operator) and access time (8 am to 5 pm). For more information about access control policies, see "Security Fundamentals" in Oracle Fusion Middleware Understanding Security for Oracle WebLogic Server.

Oracle Service Bus relies on Oracle WebLogic Server security realms to protect its resources. Each security realm consists of a set of configured security providers, users, groups, security roles, and (access control) security policies. To access any resources belonging to a realm, a user must be assigned a security role defined in that realm, as described in Section 47.1, "Administrative Security Roles and Privileges." When a user attempts to access an Oracle Service Bus resource, Oracle WebLogic Server authenticates and authorizes the user by checking the security role assigned to the user in the relevant security realm and relevant security policy.




	
Note:

Only an Oracle WebLogic Server administrator can define security policies or edit security roles in the Oracle Service Bus Administration Console.









For all proxy services, you can create a transport-level policy, which applies a security check when a client attempts to establish a connection with the proxy service. Only requests from users who are listed in the transport-level policy are allowed to proceed.

For proxy services that are WS-Security active intermediaries, or that implement message-level custom authentication, you can also create a message-level policy. This type of policy applies a security check when a client attempts to invoke one of the secured operations. Only users who are listed in the message-level policy are allowed to invoke the operation.

The Oracle Service Bus Administration Console contains a Security Configuration module for viewing and configuring users, groups, and security roles. Additionally, the Oracle Service Bus Administration Console lets you view and configure credentials.



45.5.1 Configuring Proxy Service Access Control

You can configure transport-level access control for all proxy services. You can also configure access control at the message-level for any WS-Security active intermediary proxy service, or for any proxy service that implements message-level custom authentication,. To configure access control, you must assign an access control policy to the proxy service, either at the transport-level or message-level (or both).

The default transport-level and message-level access control policy for all proxy services is to allow access to all requests. You must assign an access control policy to the proxy service to protect it.

You configure transport-level and message-level access control policies in the Oracle Service Bus Administration Console, as described in "Editing Transport-Level Access Policies" and "Editing Message-Level Access Policies."






45.5.2 Access Control Policy Management

Access control policies are persisted in authorization providers, and there is a reference to them in the Oracle Service Bus repository.

Access control policies are managed within an Oracle Service Bus design session and not outside the session, as was the case in releases prior to 3.0. Because the changes are made within a session, you can commit or discard the changes as with other resources.

Although ACLs can be managed from the Oracle Service Bus Administration Console, you can change policies outside Oracle Service Bus. However, changing policies outside of Oracle Service Bus can make the reference in Oracle Service Bus out-of-date and invalid.

Therefore, for consistent management, either completely manage ACLs outside of Oracle Service Bus sessions (using the authorization provider MBeans or third-party authorization provider tools) or completely manage them from within Oracle Service Bus sessions. Any combination of the two approaches can result in an inconsistent view of policies.

Oracle Service Bus manages access control policy only for proxy services. You must manage access control policy management for other server resources, such as JMS queues, JNDI entries, EJBs, applications, Oracle WebLogic Server instances, data sources, and so forth from the Oracle WebLogic Server Administration Console.




	
Note:

When you clone a service, ACLs are also cloned in the session. If the user commits the session, ACLs on the service will be committed to the authorization provider. Therefore, when you clone a service you need to decide if you want the clone to have the same ACLs as the original. If you do not want this, then make sure to edit the ACLs of the clone.











45.5.2.1 Deleting a Proxy Service

Deleting a proxy service deletes all of the ACLs referenced by the proxy from the repository controlled by Oracle Service Bus, as well as from the appropriate authorization provider.






45.5.2.2 Deleting the Access Control Policy Assigned to a Proxy Service

You can also delete the access control policies assigned to a service without deleting the service. To do this:

	
Create a session.


	
From the View a Proxy Service > Security tab, use the edit Transport Access Control option to delete the policies.


	
Commit the session.









45.5.2.3 Moving or Renaming a Proxy Service

Renaming a proxy service correctly moves all of the policies. You need only rename or move the service in an Oracle Service Bus session.






45.5.2.4 Renaming a Proxy Service Operation

When an operation is renamed, the existing operation is transparently deleted and a new operation is created.

However, when an operation name is changed by changing the WSDL, Oracle Service Bus considers any policies for the old operation to be invalid, removes the reference from the Oracle Service Bus repository, and deletes the policies from the appropriate authorization provider.

In this case Oracle Service Bus does not know that the old operation is renamed to the new operation, and it does not add anything new for the new operation. That is, Oracle Service Bus considers that there are no policies for this new operation.

You need to add the appropriate policy to the new operation manually. You can do this in the same session as the rename of operation, after the rename is done.










45.6 Preserving Security Configuration During Import

As of this release of Oracle Service Bus, you can export or import Oracle Service Bus resources without losing any associated security configuration data.

Oracle Service Bus includes import check boxes that you can use to determine whether to preserve or overwrite the existing security configuration.

For example, assume that you want to configure your credentials in a staging area, export a project that contains these credentials, and then import the project in your production environment. When you export the project, the security configuration is included in the Oracle Service Bus configuration jar. When you then import the project on your target system, how the resources are treated depends on whether they already exist on the target system:

	
New resources that exist only in the jar file always use the security configuration from the jar file.


	
For resources that exist on the import target server as well as in the jar file, the new import check box lets you decide whether to preserve the existing security configuration or to overwrite it with the configuration in the jar file.




The three import check boxes allow you to decide which, if any, aspects of the security configuration must be preserved during import:

	
Preserve Security and Policy Configuration


	
Preserve Credentials


	
Preserve Access Control Policies




	
Note:

These check boxes work the same way for Oracle Service Bus configuration files created for a project-level export and for an individual resource export.












These check boxes are described in more detail in the sections that follow.



45.6.1 Preserve Security and Policy Configuration Check Box

When the Preserve Security and Policy Configuration check box is set (the default), the following configuration parameters are preserved:

	
Proxy service security and policy configuration:

	
A reference to the service key provider.


	
The set of WS-Policies that are bound directly to the service through the Policies tab.




	
Note:

If the service is using WSDL-based policies, the policies are not preserved by this check box. This is because the WSDL might itself be updated and the service must reflect the WSDL.









The control also preserves the type of the WS-Policy Binding, either Custom (through the Policies tab) or WSDL-based.


	
The state of the Process WS-Security Header option.


	
Message-level custom authentication configuration.





	
Proxy service transport-specific security configuration:

	
For HTTP, the HTTPS flag and the authentication mode (anonymous, BASIC, client certificate, or custom token).


	
For JMS, the JMS and JNDI service accounts.


	
For email and FTP, the service account reference.


	
The SFTP authentication configuration.





	
Business service security and policy configuration:

	
WS-Policy bindings


	
The Pass Caller's Subject setting.


	
A reference to the service account for outbound WS-Security.





	
Business service transport-specific security configuration:

	
For HTTP, the authentication mode (anonymous, BASIC, or client certificate) and the service account reference.


	
For JMS, references to the JMS and JNDI service accounts.


	
For FTP, EJB, Tuxedo, and DSP, the service account reference.


	
The SFTP authentication configuration.












45.6.2 Preserve Credentials Check Box

When the Preserve Credentials check box is set (the default), the following credentials are preserved during the import process:

	
PKI credentials in service key providers.

A PKI credential mapping provider maps Oracle Service Bus service key providers to key-pairs that can be used for digital signatures and encryption (for Web Services Security) and for outbound SSL authentication. For more information, see "Configuring a PKI Credential Mapping Provider" in Oracle Fusion Middleware Securing Oracle WebLogic Server.


	
Username and passwords in service accounts.


	
Username and password in SMTP server, JNDI provider, and UDDI registries.









45.6.3 Preserve Access Control Check Box

When the Preserve Access Control Policies check box is set (the default), all access control policies for the imported proxy services are preserved during the import process.








45.7 Configuring the Oracle WebLogic Security Framework: Main Steps

Many of the initial configuration tasks for Oracle Service Bus security require you to work in the Oracle WebLogic Server Administration Console to configure the WebLogic security framework. After these initial tasks, you can complete most security tasks from the Oracle Service Bus Administration Console.

To configure the WebLogic security framework for Oracle Service Bus:

	
If you plan to use SSL as part of transport-level security, do the following:

	
In the Oracle WebLogic Server Administration Console, configure identity and trust. See "Configuring Identity and Trust" and "Important Information Regarding Cross-Domain Security Support" in Oracle Fusion Middleware Securing Oracle WebLogic Server.


	
In the Oracle WebLogic Server Administration Console, configure SSL. See "Configuring SSL" in Oracle Fusion Middleware Securing Oracle WebLogic Server.




Oracle recommends the following for your SSL configuration:

	
If you configure two-way SSL, you must choose between two modes: Client Certificate Requested But Not Enforced or Client Certificates Requested and Enforced. Oracle recommends that whenever possible you choose Client Certificate Requested and Enforced. For more information, see "Secure Sockets Layer (SSL)" in Oracle Fusion Middleware Understanding Security for Oracle WebLogic Server.


	
In a production environment, make sure that Host Name Verification is enabled. See "Using Host Name Verification" in "Configuring SSL" in Oracle Fusion Middleware Securing Oracle WebLogic Server.





	
In the Oracle WebLogic Server Administration Console, configure authentication providers, which your proxy services use for inbound security.

Table 45-4 describes the authentication providers that are commonly configured for Oracle Service Bus. For a description of all authentication providers that you can configure, see "Security Providers" in Oracle Fusion Middleware Securing Oracle WebLogic Server.


Table 45-4 Authentication Providers

	If You Require Clients to Provide...	Configure...
	
Simple user names and passwords

	
The WebLogic Authentication provider and use the Oracle Service Bus Administration Console to enter the user names and passwords of the clients that you want to allow access.

Note: As described in Section 45.9.1, "Configuring Authentication Providers," Oracle recommends that you use the default WebLogic Authentication provider for all Oracle WebLogic Server and Oracle Service Bus administrative accounts.

See "Adding Users" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus.


	
X.509 tokens for inbound HTTPS and two-way SSL authentication

	
All of the following:

	
The WebLogic Identity Assertion provider, which can validate X.509 tokens but does not by default. Make sure that you enable this provider to support X.509 tokens. In addition, enable this provider to use a user name mapper. See "Identity Assertion and Tokens" in Oracle Fusion Middleware Understanding Security for Oracle WebLogic Server.


	
WebLogic CertPath Provider, which completes and validates certificate chains by using trusted Certificate Authority based checking.





	
Custom authentication and username/password tokens for inbound HTTP and message-level authentication

	
An Identity Assertion provider, possibly user-written or from a third-party, that can validate the token type. Make sure that you enable this provider to support the token.


	
X.509 tokens for inbound Web Services Security X.509 Token Authentication

	
If any of your proxy services or business services are Web services that use abstract WS-Policy statements, you must also configure the following:

In the Web Service security configuration named __SERVICE_BUS_INBOUND_WEB_SERVICE_SECURITY_MBEAN__ add the UseX509ForIdentity property and set it to true. See "Use X.509 Certificates to Establish Identity" in the Oracle Fusion Middleware Oracle WebLogic Server Administration Console Online Help.


	
SAML tokens

	
All of the following:

	
WebLogic SAML Identity Assertion Provider V2, which authenticates users based on Security Assertion Markup Language 1.1 (SAML) assertions.


	
WebLogic SAML Credential Mapping Provider V2, which maps Oracle Service Bus users to remote users.











	
If needed, in the Oracle WebLogic Server Administration Console, configure one or more Identity Assertion providers to handle the token types, such as X.509 or custom token types, for which you require support. For a description of all Identity Assertion providers that you can configure, see "Security Providers" in Oracle Fusion Middleware Securing Oracle WebLogic Server.


	
If you plan to create proxy services or business services that require WS-Security digital signatures on inbound requests, enable the Certificate Registry provider, which is a Certification Path provider that validates inbound certificates against a list of certificates that you register.

See "Configure Certification Path Providers" in the Oracle Fusion Middleware Oracle WebLogic Server Administration Console Online Help.


	
If you configure message-level security (in inbound requests or outbound requests) to require user name and password tokens, and if you want messages to provide a password digest instead of cleartext passwords, do the following:

	
In the Oracle WebLogic Server Administration Console, find the two Web Service security configurations that Oracle Service Bus provides and set the value of the UsePasswordDigest property to true.

The Oracle Service Bus Web Service security configurations are named:

__SERVICE_BUS_INBOUND_WEB_SERVICE_SECURITY_MBEAN__ and

__SERVICE_BUS_OUTBOUND_WEB_SERVICE_SECURITY_MBEAN__

For information on setting the values in Web Service security configurations, see "Use a Password Digest in SOAP Messages" in the Oracle Fusion Middleware Oracle WebLogic Server Administration Console Online Help.


	
For each authentication provider that you configured, in the Oracle WebLogic Server Administration Console, select the Password Digest Enabled check box.


	
For each identity assertion provider that you configured, in the Oracle WebLogic Server Administration Console set wsse:PasswordDigest as one of the active token types.





	
If you plan to create a service key provider (which passes key-certificate pairs in outbound requests), use the Oracle WebLogic Server Administration Console to configure a PKI credential mapping provider. In any Oracle WebLogic Server domain that hosts Oracle Service Bus, you can configure at most one PKI credential mapping provider.

A PKI credential mapping provider maps Oracle Service Bus service key providers to key-pairs that can be used for digital signatures and encryption (for Web Services Security) and for outbound SSL authentication. For more information, see "Configuring a PKI Credential Mapping Provider" in Oracle Fusion Middleware Securing Oracle WebLogic Server.

You store the key-pairs that the PKI credential mapping provider uses in a keystore. You can store the PKI credential mappings in Oracle WebLogic Server's identity keystore or in a separate keystore. Configure each Oracle WebLogic Server instance to have access to its own copy of each keystore. All entries referred to by the PKI credential mapper must exist in all keystores (same entry with the same alias). For information about configuring keystores in Oracle WebLogic Server, see "Identity and Trust" in Oracle Fusion Middleware Understanding Security for Oracle WebLogic Server.




	
Note:

When you create an Oracle Service Bus domain, by default the domain contains a user name/password credential mapping provider, which you can use if you need credential mapping for user names and passwords. In addition to this user name/password credential mapping provider, you can add one PKI credential mapping provider. An Oracle Service Bus domain can contain at most one user name/password credential mapping provider, one PKI credential mapping provider, and multiple SAML credential mapping providers.










	
To enable security auditing, do the following:

	
In the Oracle WebLogic Server Administration Console, configure an auditing provider. See "Configuring the WebLogic Auditing Provider" in Oracle Fusion Middleware Securing Oracle WebLogic Server.


	
To enable auditing of events related to WS-Security, when you start each Oracle Service Bus server, include the following Java option in the server's startup command:


-Dcom.bea.wli.sb.security.AuditWebServiceSecurityErrors=true




Oracle Service Bus supports the auditing of security events but it does not support configuration auditing, which emits log messages and generates audit events when a user changes the configuration of any resource within a domain or invokes management operations on any resource within a domain. See "Enabling Configuration Auditing" in Oracle Fusion Middleware Securing Oracle WebLogic Server.


	
If you have not already done so, in the Oracle WebLogic Server Administration Console, activate your changes. If you have made changes that require you to restart Oracle WebLogic Server, the Administration Console will indicate that a restart is required. If you see such a message, restart all Oracle WebLogic Server instances that host Oracle Service Bus so your modifications to the security providers will be in effect for the remaining configuration steps.









45.8 Context Properties Are Passed to Security Providers

Context Properties provide a way (the ContextHandler interface) to pass additional information to the WebLogic Security Framework so that a security provider can obtain contextual information beyond what is provided by the arguments to a particular provider method. A ContextHandler is a high-performing WebLogic class that obtains additional context and container-specific information.

Oracle Service Bus makes use of the ContextHandler interface and passes several context properties to the security framework for transport-level and message-level authentication, transport-level and message-level access control, and credential mapping.

This section describes the situations in which Oracle Service Bus-specific context properties are used.



45.8.1 Context Properties for HTTP Transport-Level Authentication

When an HTTP proxy service is configured for authentication, the HTTP transport provider passes an Oracle Service Bus implementation of the Oracle WebLogic Server ContextHandler. There is no user configuration required for this feature.

The ContextHandler properties in Table 45-5 are passed at runtime, under the following conditions:

	
To Authentication providers, if the proxy is configured for HTTP BASIC authentication.


	
To Identity Assertion providers, if the proxy is configured for CLIENT-CERT identity assertion.


	
To Identity Assertion providers, if the proxy is configured for HTTP custom token identity assertion.





Table 45-5 ContextHandler Properties for HTTP Transport Authentication

	Property Name	Type	Property Value
	

com.bea.contextelement.alsb.service-info

	

com.bea.wli.sb.services.ServiceInfo

	
An instance of ServiceInfo that contains information about the proxy service.


	

com.bea.contextelement.alsb.transport.endpoint

	

com.bea.wli.sb.transports.TransportEndPoint

	
This is the HTTP or HTTPS endpoint.


	

com.bea.contextelement.alsb.transport.http.http-request

	

javax.servlet.http.HttpServletRequest 

	
This is the HttpServletRequest object.


	

com.bea.contextelement.alsb.transport.http.http-response

	

javax.servlet.http.HttpServletResponse

	
This is the HttpServletResponse object.












45.8.2 ContextHandler Properties for Access Control and Message-Level Custom Authentication

The ContextHandler properties shown in Table 45-6 are passed at runtime, under the following conditions:

	
To Authentication providers when performing message-level custom username/password authentication.


	
To Identity Assertion providers when performing message-level custom token identity assertion.


	
To Authorization providers when performing transport-level or message-level access control.





Table 45-6 ContextHandler Properties for Message-Level Custom Authentication and Access Control

	Property Name	Type	Property Value
	

com.bea.contextelement.alsb.router.ProxyService

	

java.lang.String

	
The service name (full-name; for example /myproject/myfolder/svc-a).


	

com.bea.contextelement.alsb.router.ServiceUri

	

java.net.URI

	
The base URI from which the message was received.


	

com.bea.contextelement.alsb.router.inbound.TransportProvider

	

java.lang.String

	
The Id of the transport provider that received this message.


	

com.bea.contextelement.alsb.router.inbound.request.MessageId

	

java.lang.String

	
This is the transport provider-specific message identifier. Ideally it should uniquely identify the message among other messages going through the Oracle Service Bus runtime. However, Oracle Service Bus does not depend on the message Id being unique. The message Id is added to the message context and thus visible in the pipeline.


	

com.bea.contextelement.alsb.router.inbound.request.CharacterEncoding

	

java.lang.String

	
Character encoding used in the message payload, or null.


	

com.bea.contextelement.wli.Message

	

java.io.InputStream

	
The request message as an input stream.












45.8.3 Additional Transport-Specific Context Properties

In addition to the properties in Table 45-7, other transport-specific properties may be present. For each transport request-header (see the transport SDK), a property with the name


com.bea.contextelement.alsb.router.inbound.request.headers.<provider-id>.<header-name>


is present, where provider-id is the transport provider id, and header-name is one of the request-headers declared in the provider's schema file.

The type and semantics of these properties is transport-specific. For HTTP proxy services, the properties in Table 45-3 are also available.


Table 45-7 Additional Message-Level Security ContextHandler Properties for HTTP Proxy Services

	Property Name	Type	Property Value
	

com.bea.contextelement.alsb.router.inbound.request.metadata.http.relative-URI

	

java.lang.String

	
The relative URI of the request.


	

com.bea.contextelement.alsb.router.inbound.request.metadata.http.query-string

	

java.lang.String

	
The query string that is contained in the request URL after the path.


	

com.bea.contextelement.alsb.router.inbound.request.metadata.http.client-host

	

java.lang.String

	
The fully qualified name of the client that sent the request.


	

com.bea.contextelement.alsb.router.inbound.request.metadata.http.client-address

	

java.lang.String

	
The Internet Protocol (IP) address of the client that sent the request.












45.8.4 Administrator-Supplied Context Properties for Message-Level Authentication

Both custom username/password authentication and custom token authentication allow users (who are in the IntegrationAdmin or IntegrationDeployer roles) to pass additional context information to the security provider in the Context Properties field on the Security tab.

You can configure additional context properties by entering the Property Name as a literal string, and the Value Selector as a valid XPath expression. (XPath expressions can also be literal strings.)

The XPath expression is evaluated at runtime against the same message part that is used for the custom token or custom username/password. That is, the Value Selector XPath expressions are evaluated against the header for SOAP-based proxy services, and against the body for non-SOAP-based proxy services.






45.8.5 Security Provider Must Have Knowledge of the Property Name

A ContextHandler is essentially a name/value list and, as such, it requires that a security provider know what names to look for. Therefore, for both transport- and message-level custom authentication, the XPath expressions are evaluated only if an Authentication provider or Identity Assertion provider asks for the value of one of these properties.

This means that your configured Authentication or Identity Assertion provider must explicitly know which property names to request through the ContextHandler.getValue(propertyName) method. The only way to satisfy this requirement is for you, or a third party, to write a custom Authentication or Identity Assertion provider.

For example, Example 45-1 shows how to get the HttpServletRequest property from a provider that you write.


Example 45-1 Getting the HttpServletRequest Property


:
Object requestValue = handler.getValue("com.bea.contextelement.alsb.transport.http.http-request");
if ((requestValue == null) || (!(requestValue instanceof HttpServletRequest)))
return;
HttpServletRequest request = (HttpServletRequest) requestValue;
log.println(" " + HTTP_REQUEST_ELEMENT + " method: " + request.getMethod());
log.println(" " + HTTP_REQUEST_ELEMENT + " URL: " + request.getRequestURL());
log.println(" " + HTTP_REQUEST_ELEMENT + " URI: " + request.getRequestURI());
return;


If the security provider does not need the value of the user-defined property, then the XPath expression is not evaluated.








45.8.6 Oracle WebLogic Server Administrative Channel is Supported

This release of Oracle Service Bus can use the Oracle WebLogic Server administrative channel.

As described in "Understanding Network Channels" in Oracle Fusion Middleware Configuring Server Environments for Oracle WebLogic Server, a Oracle WebLogic Server network channel is a configurable resource that defines the attributes of a network connection to Oracle WebLogic Server.

You can configure a particular type of network channel, called an administrative channel, to isolate "administration" and application ("business") traffic in a WebLogic domain. The administrative channel is a secured channel that accepts only SSL connections.

In Oracle Service Bus, business traffic is comprised of all messages sent to and from Oracle Service Bus proxy services and business services. SSL business traffic must use the default Oracle WebLogic Server secure network channel.

Administration traffic is comprised of all communication with the Oracle WebLogic Server Administration Console, Oracle Service Bus Administration Console, internal traffic within a cluster, and traffic between administration scripts and admin or Managed Servers.

When an administrative channel is enabled in a domain, all of the administration traffic in that domain must go through that channel. Otherwise, the administration traffic also uses the default Oracle WebLogic Server secure network channel.

Using the Administrative Channel: Main Steps 

	
Close any open browser connections to the Oracle Service Bus Administration Console for the domain.

As soon as you activate the administrative channel in Oracle WebLogic Server, the Oracle Service Bus Administration Console for the domain becomes unavailable at the current URL. The Help system also becomes unavailable.


	
Enable the domain-wide administration port in the Oracle WebLogic Server Administration Console (which configures an administrative channel on your behalf), or explicitly create an administrative channel. Both of these tasks are described in "Configuring Network Resources" in Oracle Fusion Middleware Configuring Server Environments for Oracle WebLogic Server.

The domain-wide administration port control is located on the Domain > Configuration > General page. The default administration port is 9002.

Be sure to activate the change.


	
Open a browser connection to the new URL for the Oracle Service Bus Administration Console for the domain.

The URL is https://hostname:9002/sbconsole if you enabled the domain-wide administration port and accepted the default port number.


	
Revise any startup scripts that refer to the old URL. If you are using the Windows graphical interface to launch the Oracle Service Bus Administration Console for the domain, revise the shortcut property to reflect the new URL.











45.9 Using Security Providers

This section provides instructions on using security providers with Oracle Service Bus.

This section includes the following topics:

	
Section 45.9.1, "Configuring Authentication Providers"


	
Section 45.9.2, "Using a Custom Authorization Provider to Protect Oracle Service Bus Resources"


	
Section 45.9.3, "About Errors When Using Security Provider Policies"






45.9.1 Configuring Authentication Providers

Check the provided Oracle WebLogic Server Authentication providers to see if one meets your needs. Oracle WebLogic Server includes a broad array of Authentication providers, including the following:

	
The WebLogic Authentication provider accesses user and group information in Oracle WebLogic Server's embedded LDAP server. This is the default out-of-the-box authentication provider. This provider is not optimized for use with very large numbers of users.


	
LDAP Authentication providers access external LDAP stores. You can use an LDAP Authentication provider to access any LDAP server. Oracle WebLogic Server provides LDAP Authentication providers already configured for Open LDAP, Oracle Directory Server Enterprise Edition, Microsoft Active Directory, and Novell NDS LDAP servers.


	
RDBMS Authentication providers access external relational databases. Oracle WebLogic Server provides three RDBMS Authentication providers: SQL Authenticator, Read-only SQL Authenticator, and Custom RDBMS Authenticator.


	
The SAML Authentication provider, which authenticates users based on Security Assertion Markup Language 1.1 (SAML) assertions.




See "Improving the Performance of WebLogic and LDAP Authentication Providers" in Oracle Fusion Middleware Securing Oracle WebLogic Server for guidance on improving the performance of these authentication providers.

As described in "Why Customize the Default Security Configuration" in Oracle Fusion Middleware Securing Oracle WebLogic Server, you may want to use an Authentication provider that accesses a database other than Oracle WebLogic Server's embedded LDAP server. For example, you might want to use a different authentication provider for the majority of user accounts, but continue to use the default authentication provider (embedded LDAP) for Oracle Service Bus and Oracle WebLogic Server administrative user accounts.

Using the WebLogic Authentication provider for all Oracle WebLogic Server and Oracle Service Bus administrative user accounts provides reliable access in the event of a network or database problem. Oracle recommends that you use the default WebLogic Authentication provider for all Oracle WebLogic Server and Oracle Service Bus administrative accounts for this reason.

If one of the bundled Authentication providers meets your needs, see "Configuring Authentication Providers" in Oracle Fusion Middleware Securing Oracle WebLogic Server for instructions on how to configure this Authentication provider in the Oracle WebLogic Server Administration Console.

If none of the Authentication providers included in Oracle WebLogic Server suits your needs, you (or a third-party) must first write a custom Authentication provider and then use the Oracle WebLogic Server Administration Console to add that provider to the security realm, as described in the following steps:




	
Note:

Only a broad overview of the required tasks is included here. You will need to consult the Oracle WebLogic Server documentation to actually complete the tasks.









Adding a Provider to a Security Realm 

	
"Create Runtime Classes Using the Appropriate SSPIs" (in Oracle Fusion Middleware Developing Security Providers for Oracle WebLogic Server).


	
"Generate an MBean Type Using the WebLogic MBeanMaker"


	
"Configure the Custom Authentication Provider Using the Administration Console"









45.9.2 Using a Custom Authorization Provider to Protect Oracle Service Bus Resources

You can use Oracle Service Bus resources with custom Authorization providers, but those providers must understand the type and format of the Oracle Service Bus resources.

There are three possible resource objects for Oracle Service Bus that an Authorization provider must be able to detect and handle:

	
Section 45.9.2.2, "Oracle Service BusProxyServiceResource Object"


	
Section 45.9.2.3, "ProjectResourceV2 Object"


	
Section 45.9.2.4, "ConsoleResource Object"




These resource objects are described in the sections that follow.



45.9.2.1 WebLogic Authorization Provider Usage Information

This section briefly describes the Oracle WebLogic Server Authorization provider SSPI. See "Authorization Providers" in Oracle Fusion Middleware Developing Security Providers for Oracle WebLogic Server for complete information.

You protect resources by binding access control policies to resources through the Oracle Service Bus Administration Console, third-party tools or scripts. The Oracle WebLogic Server Security Service Provider Interface (SSPI) requires containers, such as Oracle Service Bus, to implement the Resource SPI. These implementations represent concrete resources.

The Authorization provider database contains a map from resource to policy. When an attempt is made to access a resource, the container calls the runtime SSPI to get an access control decision. The container passes a resource instance indicating which resource is being accessed.

An Authorization provider has one method, getAccessDecision(). The getAccessDecision() method obtains the implementation of the AccessDecision SSPI. The AccessDecision SSPI itself has one method, isAccessAllowed(). isAccessAllowed has five parameters, one of which is the Resource object for which access is being requested.

isAccessAllowed determines if the requestor should be allowed to access the named resource. To do this, the Authorization provider must find the right access control policy to evaluate. The provider must first look for a policy bound to the resource passed in. The lookup can use either the getId() or toString() method as a lookup key, as described in "Looking Up WebLogic Resources in a Security Provider's Runtime Class" in Oracle Fusion Middleware Developing Security Providers for Oracle WebLogic Server. If no policy is found, the Authorization provider must then get the parent resource and look again. This process is repeated until a policy is found or the parent is null, in which case no policy is found. When no policy is found, isAccessAllowed must return false.

This algorithm lets you create coarse-grained policies that protect all proxy services in a given project or folder, all resources in a project, or all Oracle Service Bus proxy services in an Oracle Service Bus domain. More specific, finer-grained policies take precedence over coarse-grained policies.




	
Note:

The Oracle Service Bus Administration Console user interface does not provide pages for protecting proxy services at the folder, project or domain level.














45.9.2.2 Oracle Service BusProxyServiceResource Object

The ALSBProxyServiceResource object is used for transport-level and message-level access control to Oracle Service Bus proxy services. The ALSBProxyServiceResource resource extends weblogic.security.service.ResourceBase, which itself implements weblogic.security.spi.Resource.

ALSBProxyServiceResource implements the following methods, as described in weblogic.security.spi.Resource:

getType() – Returns the type, where type is "<alsb-proxy-service>"

getKeys() – Returns up to four key-value properties: path, proxy, action, and operation. The properties are defined as follows:

	
path is the full-name of the proxy service. For example, path=project/folder1/folder2


	
proxy is the name of the proxy service. For example, proxy=myProxy


	
action is one of two values, invoke or wss-invoke. For example, action=invoke

The action attribute is used to distinguish between transport-level and message-level access control. invoke is used for transport-level access control. wss-invoke is used for message-level access control; that is, access control on WS-Security active intermediaries or proxies with custom message-level authentication. The operation attribute is only allowed when action is wss-invoke.


	
operation is the name of the operation to invoke, and is used only when action is wss-invoke. For example, operation=processPO. The operation attribute is only allowed when action is wss-invoke.

An ALSBProxyServiceResource has from 1 to 4 keys. The following table explains how the various combinations protect proxy services. The most specific policies take precedence.


	If the Resource Contains These Keys	A Policy Bound to the Resource Protects:
	
path

	
The policy protects all proxy services in the given path


	
path and proxy

	
The policy protects all access to the given proxy service (transport-level as well as message-level)


	
path, proxy, and action

	
If action="invoke":

The policy is the transport-level policy to the given proxy

If action="wss-invoke":

The policy is the message-level policy to the given proxy (for all operations)


	
path, proxy, action="wss-invoke", and operation

	
The policy is a message-level policy for the given proxy and operation










getPath() – Gets the path (project and folders) to the proxy service. This is the path where the proxy service exists within the Oracle Service Bus configuration framework.

getProxyServiceName() – Gets the name of the proxy service. For example, proxy=myProxy.

getAction() – Gets one of two values, invoke or wss-invoke. For example, action=invoke.

getOperation() – Gets the name of the operation to invoke, and is used only when action is wss-invoke. For example, operation=processPO.

makeParent() – Creates a new ALSBProxyServiceResource object that represents the parent of the current ALSBProxyServiceResource resource. makeParent() uses the path of the proxy service to create the parent.



45.9.2.2.1 ALSBProxyServiceResource Examples

The following examples show various uses of the ALSBProxyServiceResource object.

	
Using ALSBProxyServiceResource for transport-level access control for proxy project/folder/myProxy:


type=<alsb-proxy-service>, path=project/folder, proxy=myProxy, action=invoke


	
Using ALSBProxyServiceResource for message-level access control for operation processPO on proxy project/folder/myProxy:


type=<alsb-proxy-service>, path=project/folder, proxy=myProxy, action=wss-invoke, operation=processPO


	
Using the parentage hierarchy for an ALSBProxyServiceResource, from fine-grained to coarse-grained:


type=<alsb-proxy-service>, path=myProject/f1/f2, proxy=myProxy, action=wss-invoke, operation=foo
type=<alsb-proxy-service>, path=myProject/f1/f2, proxy=myProxy, action=wss-invoke
type=<alsb-proxy-service>, path=myProject/f1/f2, proxy=myProxy
type=<alsb-proxy-service>, path=myProject/f1/f2
type=<alsb-proxy-service>, path=myProject/f1
type=<alsb-proxy-service>, path=myProject
type=<alsb-project>, project-name=myProject
type=<alsb-proxy-service>











45.9.2.3 ProjectResourceV2 Object

The ProjectResourceV2 is the root resource for all ALSBProxyServiceResource objects in a given project. ProjectResourceV2 extends ResourceBase.

Setting an access control policy on a ProjectResourceV2 provides a coarse-grained access control policy for all proxy services in the given project that do not have more specific policies.

ProjectResourceV2 has the following methods:

getType() – Returns the type, where type is "<alsb-project>".

getKeys() – Returns the key, where key is "project-name".

getName() – Gets the name of the ProjectResourceV2 object.

makeParent() – There is no parent for an ProjectResourceV2 object. This method therefore returns the object name that was used to create the ProjectResourceV2 object, or null if ProjectResourceV2 does not exist.






45.9.2.4 ConsoleResource Object

The com.bea.wli.security.resource.ConsoleResource object is used for access control to the Oracle Service Bus Administration Console. However, we do not recommend that you set access control policies for ConsoleResource objects through a custom Authorization provider. This is because these policies are subject to change in future Oracle Service Bus releases.

We instead recommended that even if you need to use a custom Authorization provider, you also continue to use the Oracle WebLogic Server XACML Authorization provider to maintain the policies for the ConsoleResource object. In this case of two Authorization providers, you must also configure an Adjudication provider.








45.9.3 About Errors When Using Security Provider Policies

If you are using a plug-in security provider with Oracle WebLogic Server to store policies for use with Oracle Service Bus, you may encounter an error that says Oracle Service Bus cannot determine whether or not required policies are available; for example, error BEA-387896, as described in the Oracle Fusion Middleware Messages for Oracle Service Bus.

An error message like that does not necessarily mean the policies do not exist, or that you have a connection or configuration problem with the security provider. Oracle Service Bus uses an Oracle WebLogic Server SSPI to read policies that security providers can implement. However, the SSPI read functionality is optional. It is possible that a security provider does not allow read access by not implementing this SSPI. In such a case, Oracle Service Bus cannot reliably determine whether or not the security provider contains the required policies, even when the required policies could very well exist in the security provider.

To determine whether or not such a warning indicates a real problem, try creating or modifying resources in the Oracle Service Bus Administration Console. Also, try securing a proxy service with an access control policy and test it. See "Editing Message-Level Access Policies" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus for more details on how to configure an access control policy on a proxy service. If you can successfully create or manipulate resources as well as test a secured proxy service while using the security provider, then the security provider is configured correctly and you can safely ignore the error message.
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This chapter provides answers to frequently asked questions about Oracle Service Bus security.

This chapter includes the following sections:

	
Section 46.1, "How are Oracle Service Bus and Oracle WebLogic Server Security related?"


	
Section 46.2, "What is Transport-Level Security?"


	
Section 46.3, "What is Web Services Security?"


	
Section 46.4, "What is Web Service Policy?"


	
Section 46.5, "What are Web Service Policy assertions?"


	
Section 46.6, "Are Access Control Policy and Web Service Policy the same?"


	
Section 46.7, "What is Web Services Security Pass-Through?"


	
Section 46.8, "What is a Web Services Security Active Intermediary?"


	
Section 46.9, "What is outbound Web Services Security?"


	
Section 46.10, "What is SAML?"


	
Section 46.12, "What is the Certificate Lookup And Validation Framework?"


	
Section 46.13, "Does Oracle Service Bus support identity propagation in a proxy service?"


	
Section 46.14, "If both transport-level authentication and message-level authentication exist on inbound messages to the proxy service, which identity is propagated?"


	
Section 46.11, "Is it possible to customize the format of the subject identity in a SAML assertion?"


	
Section 46.15, "Is single sign-on supported in Oracle Service Bus?"


	
Section 46.16, "Are security errors monitored?"


	
Section 46.17, "Can I configure security for MBeans?"






46.1 How are Oracle Service Bus and Oracle WebLogic Server Security related?

Oracle Service Bus leverages the WebLogic Security Framework. The details of this framework are described in "WebLogic Security Framework" in "WebLogic Security Service Architecture" in Oracle Fusion Middleware Understanding Security for Oracle WebLogic Server. Before configuring security in Oracle Service Bus, you must configure an Oracle WebLogic Server security realm and other server configurations (such as SSL) in Oracle WebLogic Server, as described in Section 45.7, "Configuring the Oracle WebLogic Security Framework: Main Steps.".






46.2 What is Transport-Level Security?

Transport-level security refers to the transport protocols that secure the connection over which messages are transported. An example of transport-level security is HTTPS (HTTP over SSL). SSL provides point-to-point security, but does not protect the message when intermediaries exist in the message path. For more information, see Chapter 49, "Configuring Transport-Level Security."






46.3 What is Web Services Security?

Web Services Security (WS-Security) is an OASIS standard that defines interoperable mechanisms to incorporate message-level security into SOAP messages. WS-Security supports message integrity and message confidentiality. It also defines an extensible model for including security tokens in a SOAP envelope and a model for referencing security tokens from within a SOAP envelope. WS-Security token profiles specify how specific token types are used within the core WS-Security specification. Message integrity is achieved through the use of XML digital signatures; message confidentiality is accomplished through the use of XML encryption. WS-Security lets you specify which parts of a SOAP message are digitally signed or encrypted. Oracle Service Bus supports WS-Security over HTTP (including HTTPS) and JMS.






46.4 What is Web Service Policy?

The Web Services Policy Framework (WS-Policy) provides a general-purpose model and corresponding syntax to describe and communicate the policies of a Web service. WS-Policy defines a base set of constructs that can be used and extended by other Web service specifications to describe a broad range of service requirements, preferences, and capabilities. For more information, see Chapter 51, "Using WS-Policy in Oracle Service Bus Proxy and Business Services."






46.5 What are Web Service Policy assertions?

The Web Services Policy Assertions Language (WS-PolicyAssertions) specifies a set of common message policy assertions that can be specified within a security policy. The specification defines general messaging-related assertions for use with WS-Policy. Separate specifications describe the syntax and semantics of domain-specific assertions for security assertions and reliable-messaging assertions.






46.6 Are Access Control Policy and Web Service Policy the same?

No. Access control policy is a boolean expression that is evaluated to determine which requests to access a particular resource (such as a proxy service, Web application, or EJB) are granted and which should be denied access. Typically access control policies are based on the roles of the requestor. WS-Policy is metadata about a Web service that complements the service definition (WSDL). WS-Policy can be used to express a requirement that all service clients must satisfy, such as, all requests must be digitally signed by the client.






46.7 What is Web Services Security Pass-Through?

In a WS-Security pass-through scenario, the client applies WS-Security to the request and/or response messages. The proxy service does not process the security header, instead, it passes the secured request message untouched to a business service. Although Oracle Service Bus does not apply any WS-Security to the message, it can route the message based on values in the header. After the business service receives the message, it processes the security header and acts on the request. The business service must be configured with WS-Policy security statements. The secured response message is passed untouched back to the client. For example, the client encrypts and signs the message and sends it to the proxy service. The proxy service does not decrypt the message or verify the digital signature, it simply routes the message to the business service. The business service decrypts the messages and verifies the digital signature, and then processes the request. The response path is similar. This is sometimes called a passive intermediary.






46.8 What is a Web Services Security Active Intermediary?

In an active intermediary scenario, the client applies WS-Security to the request and/or response messages. The proxy service processes the security header and enforces the WS-Security policy. For example, the client encrypts and signs the message and sends it to the proxy service, the proxy decrypts the message and verifies the digital signature, then routes the message. Before the proxy service sends the response back to the client, the proxy signs and encrypts the message. The client decrypts the message and verifies the proxy's digital signature.






46.9 What is outbound Web Services Security?

Outbound WS-Security refers to security between Oracle Service Bus proxy services and business services. It includes both the request and response between business applications and proxy services. For more information, see Section 52.1, "About Message-Level Security."






46.10 What is SAML?

SAML (Security Assertion Markup Language) is an OASIS standards-based extensible XML framework for exchanging authentication and authorization information, allowing single sign-on capabilities in modern network environments.






46.11 Is it possible to customize the format of the subject identity in a SAML assertion?

By default, the subject identity within an outbound SAML token is the same as the inbound username. The format of the subject identity can be customized by writing a custom SAML name mapper-provider. For more information, see "Configuring a SAML Credential Mapping Provider" in Oracle Fusion Middleware Securing Oracle WebLogic Server.






46.12 What is the Certificate Lookup And Validation Framework?

The Certificate Lookup and Validation (CLV) providers complete certificate paths and validate X509 certificate chains. The two types of CLV providers are:

CertPath Builder—receives a certificate, a certificate chain, or certificate reference (the end certificate in a chain or the Subject DN of a certificate) from a Web service or application code. The provider looks up and validates the certificates in the chain.

CertPath Validator—receives a certificate chain from the SSL protocol, a Web service, or application code and performs extra validation, such as revocation checking.

At least one CertPath Builder and one CertPath Validator must be configured in a security realm. Multiple CertPath Validators can be configured in a security realm. If multiple providers are configured, a certificate or certificate chain must pass validation with all the CertPath Validators for the certificate or certificate chain to be valid. Oracle WebLogic Server provides the functionality of the CLV providers in the WebLogic CertPath provider and the Certificate Registry. For more information see "The Certificate Lookup and Validation Process" in "WebLogic Security Service Architecture" in Oracle Fusion Middleware Understanding Security for Oracle WebLogic Server.






46.13 Does Oracle Service Bus support identity propagation in a proxy service?

Yes, Oracle Service Bus supports two methods for propagating identities:

	
By generating SAML assertions in conformance with the Web Services Security.

This is done by setting a SAML holder-of-key or sender-vouches WS-Policy on the business service routed to by the proxy.


	
If a business service requires user name and password tokens, you can configure the business service's service account to pass through the user credentials from the original client request. See Chapter 2, "Creating Service Account Resources."









46.14 If both transport-level authentication and message-level authentication exist on inbound messages to the proxy service, which identity is propagated?

If both transport authentication and message-level authentication exist, the message-level subject identity is propagated.






46.15 Is single sign-on supported in Oracle Service Bus?

Strictly speaking single sign-on (SSO) is not applicable to Oracle Service Bus messaging scenarios for several reasons. First, Oracle Service Bus is stateless; there is no notion of a session or conversation among multiple parties. Second, Oracle Service Bus clients are typically other enterprise software applications, not users behind a Web browser. Therefore, it is acceptable to require that these clients send credentials such as username and password on every request, provided that the communication is secured by means such as SSL or WS-Security. However, SSO between the Oracle Service Bus Administration Console and the Oracle WebLogic Server Administration Console is supported. For more information, see "Single Sign-On" in "Security Fundamentals" in Oracle Fusion Middleware Understanding Security for Oracle WebLogic Server.






46.16 Are security errors monitored?

Only WS-Security errors are monitored by the Oracle Service Bus monitoring framework. Transport-level security errors such as SSL handshake errors, transport-level authentication and transport-level access control are not monitored. For more information, see "Monitoring Oracle Service Bus at Runtime" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus. However, it is possible to configure an Auditor provider to audit transport-level authentication and authorization.






46.17 Can I configure security for MBeans?

Oracle Service Bus includes two managed beans (MBeans) that configure such runtime behavior as which types of credentials are available to abstract WS-Policy statements. By default, only users in the Admin and Deployer security roles can modify these MBeans, however you can change these defaults. See "Create JMX Policies" in the Oracle Fusion Middleware Oracle WebLogic Server Administration Console Help.
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This chapter describes administrative security and security roles in Oracle Service Bus.

To give users access to administrative functions such as creating proxy services, you assign them to one of four security roles with pre-defined access privileges. A security role is an identity that can be dynamically conferred upon a user or group based on conditions that are evaluated at runtime. You cannot change the access privileges for the Oracle Service Bus administrative security roles, but you can change the conditions under which a user or group is in one of the roles.

The following sections describe administrative security for Oracle Service Bus:

	
Section 47.1, "Administrative Security Roles and Privileges"


	
Section 47.2, "Administrative Security Groups"


	
Section 47.3, "Configuring Administrative Security: Main Steps"




For more information about security roles, see "Users, Groups, and Security Roles" in Oracle Fusion Middleware Securing Resources Using Roles and Policies for Oracle WebLogic Server.



47.1 Administrative Security Roles and Privileges

Table 47-1 describes the Oracle Service Bus administrative security roles and summarizes their access privileges.


Table 47-1 Oracle Service Bus Administrative Security Roles

	Role	Pre-Defined Access Privileges
	
IntegrationAdmin and IntegrationDeployer

	
Has complete access to all Oracle Service Bus resources, including the ability to create, edit, or delete user names, passwords, and credential alias bindings in service accounts and service key providers. The user names and passwords that this role can create are used only by service accounts for outbound authentication; they are not used to authorize access to Oracle Service Bus resources.

Cannot create, edit, or delete users, groups, roles, or access control policies in the Security Configuration module of the Oracle Service Bus Administration Console.


	
IntegrationOperator

	
This group has the following privileges:

	
Has read access to all Oracle Service Bus resources.


	
Cannot export resources.


	
Has access to create, view, edit and delete alert rules.


	
Has access to session management, including create, commit, discard and undo of sessions. Cannot view all sessions.


	
Has access to create, edit, view and delete operational settings of services.





	
IntegrationMonitor

	
	
Has read access to all Oracle Service Bus resources.


	
Cannot export resources.














	
Note:

In this release, IntegrationAdministrators and IntegrationDeployers have the same privileges. This might change in future releases.









The Oracle Service Bus roles have permission to modify only Oracle Service Bus resources; they do not have permission to modify Oracle WebLogic Server or other resources on Oracle WebLogic Server. To give permission to modify Oracle WebLogic Server its other resources, add a user to one of the Oracle WebLogic Server security roles described in Table 47-2. In each Oracle Service Bus domain, make sure that you add at least one user to the Admin role.


Table 47-2 Oracle WebLogic Server Security Roles

	Oracle WebLogic Server Role	Default Access Privileges
	
Admin

	
Has complete access to all Oracle WebLogic Server and Oracle Service Bus objects and functions, including the ability to create, edit, or delete users, groups, roles, or access control policies.


	
Deployer

	
Has read access to all objects. Can create, delete, edit, import or export resources, services, service key providers, or projects.


	
Operator

	
Has read and export access to all objects. Can configure alerts, enable or disable metric collection, and suspend or resume services.


	
Monitor

	
Has read access to all objects. Can export any resource, service, service key provider, or project.










47.1.1 Role-Based Access in the Oracle Service Bus Administration Console

Table 47-3 through Table 47-8 show the actions that each Oracle Service Bus security role can perform in the Oracle Service Bus Administration Console.

Permission to perform an action is indicated by a (Y) in the table. Only the Oracle WebLogic Server Admin role has Security Configuration privileges.


Table 47-3 Role-Based Operations Access in Oracle Service Bus Administration Console

	Actions	Integration Admin	Integration Deployer	Integration Operator	Integration Monitor
	
View Statistics

	
Y

	
Y

	
Y

	
Y


	
Reset Statistics

	
Y

	
Y

	
Y

	
N


	
View Alerts

	
Y

	
Y

	
Y

	
Y


	
Delete Alerts

	
Y

	
Y

	
Y

	
N


	
View Alert History

	
Y

	
Y

	
Y

	
Y


	
View Server Summary

	
Y

	
Y

	
Y

	
Y


	
View Dashboard Settings

	
Y

	
Y

	
Y

	
Y


	
Set Dashboard Settings

	
Y

	
Y

	
Y

	
Y


	
Set Smart Search Settings

	
Y

	
Y

	
Y

	
N


	
View Smart Search Settings

	
Y

	
Y

	
Y

	
Y


	
Set Global Settings

	
Y

	
Y

	
Y

	
N


	
View Global Settings

	
Y

	
Y

	
Y

	
Y


	
Set Tracing Settings

	
Y

	
Y

	
Y

	
N


	
View Tracing Settings

	
Y

	
Y

	
Y

	
N


	
View Message Reports

	
Y

	
Y

	
Y

	
Y


	
Purge Messages

	
Y

	
Y

	
Y

	
N









Table 47-4 Role-Based Resource Browser Access in Oracle Service Bus Administration Console

	Actions	Integration Admin	Integration Deployer	Integration Operator	Integration Monitor
	
Create Proxy Service

	
Y

	
Y

	
N

	
N


	
View Proxy Service

	
Y

	
Y

	
Y

	
Y


	
Edit Proxy Service

	
Y

	
Y

	
N

	
N


	
Delete Proxy Service

	
Y

	
Y

	
N

	
N


	
Create Business Service

	
Y

	
Y

	
N

	
N


	
View Business Service

	
Y

	
Y

	
Y

	
Y


	
Edit Business Service

	
Y

	
Y

	
N

	
N


	
Delete Business Service

	
Y

	
Y

	
N

	
N


	
Run Test Console

	
Y

	
Y

	
N

	
N


	
Create WSDLs

	
Y

	
Y

	
N

	
N


	
View WSDLs

	
Y

	
Y

	
Y

	
Y


	
Edit WSDLs

	
Y

	
Y

	
N

	
N


	
Delete WSDLs

	
Y

	
Y

	
N

	
N


	
Create XML Schemas

	
Y

	
Y

	
N

	
N


	
View XML Schemas

	
Y

	
Y

	
Y

	
Y


	
Edit XML Schemas

	
Y

	
Y

	
N

	
N


	
Delete XML Schemas

	
Y

	
Y

	
N

	
N


	
Create WS-Policy

	
Y

	
Y

	
N

	
N


	
View WS-Policy

	
Y

	
Y

	
Y

	
Y


	
Edit WS-Policy

	
Y

	
Y

	
N

	
N


	
Delete WS-Policy

	
Y

	
Y

	
N

	
N


	
Create XQuery

	
Y

	
Y

	
N

	
N


	
View XQuery

	
Y

	
Y

	
Y

	
Y


	
Edit XQuery

	
Y

	
Y

	
N

	
N


	
Delete XQuery

	
Y

	
Y

	
N

	
N


	
Create XSLT

	
Y

	
Y

	
N

	
N


	
View XSLT

	
Y

	
Y

	
Y

	
Y


	
Edit XSLT

	
Y

	
Y

	
N

	
N


	
Delete XSLT

	
Y

	
Y

	
N

	
N


	
Create MFL

	
Y

	
Y

	
N

	
N


	
View MFL

	
Y

	
Y

	
Y

	
Y


	
Edit MFL

	
Y

	
Y

	
N

	
N


	
Delete MFL

	
Y

	
Y

	
N

	
N


	
Create JARs

	
Y

	
Y

	
N

	
N


	
View JARs

	
Y

	
Y

	
Y

	
Y


	
Edit JARs

	
Y

	
Y

	
N

	
N


	
Delete JARs

	
Y

	
Y

	
N

	
N


	
Create Service Account

	
Y

	
Y

	
N

	
N


	
View Service Account

	
Y

	
Y

	
Y

	
Y


	
Edit Service Account

	
Y

	
Y

	
N

	
N


	
Delete Service Account

	
Y

	
Y

	
N

	
N


	
Create service key provider

	
Y

	
Y

	
N

	
N


	
View service key provider

	
Y

	
Y

	
Y

	
Y


	
Edit service key provider

	
Y

	
Y

	
N

	
N


	
Delete service key provider

	
Y

	
Y

	
N

	
N


	
Create Alert Rule

	
Y

	
Y

	
Y

	
N


	
View Alert Rule

	
Y

	
Y

	
Y

	
Y


	
Edit Alert Rule

	
Y

	
Y

	
Y

	
N


	
Delete Alert Rule

	
Y

	
Y

	
Y

	
N









Table 47-5 Role-Based Project Explorer Access in Oracle Service Bus Administration Console

	Actions	Integration Admin	Integration Deployer	Integration Operator	Integration Monitor
	
Create Project

	
Y

	
Y

	
N

	
N


	
View Project

	
Y

	
Y

	
Y

	
Y


	
Edit Project

	
Y

	
Y

	
N

	
N


	
Delete Project

	
Y

	
Y

	
N

	
N


	
Create Folder

	
Y

	
Y

	
N

	
N


	
View Folder

	
Y

	
Y

	
Y

	
Y


	
Edit Folder

	
Y

	
Y

	
N

	
N


	
Delete Folder

	
Y

	
Y

	
N

	
N









Table 47-6 Role-Based Security Configuration Access in Oracle Service Bus Administration Console

	Actions	Integration Admin	Integration Deployer	Integration Operator	Integration Monitor
	
Create User

	
N

	
N

	
N

	
N


	
View User

	
Y

	
Y

	
Y

	
Y


	
Edit User

	
N

	
N

	
N

	
N


	
Delete User

	
N

	
N

	
N

	
N


	
Create Group

	
N

	
N

	
N

	
N


	
View Group

	
Y

	
Y

	
Y

	
Y


	
Edit Group

	
N

	
N

	
N

	
N


	
Delete Group

	
N

	
N

	
N

	
N


	
Create Role

	
N

	
N

	
N

	
N


	
View Role

	
Y

	
N

	
N

	
N


	
Edit Role

	
N

	
N

	
N

	
N


	
Delete Role

	
N

	
N

	
N

	
N


	
Create Policy

	
N

	
N

	
N

	
N


	
View Policy

	
N

	
N

	
N

	
N


	
Edit Policy

	
N

	
N

	
N

	
N


	
Delete Policy

	
N

	
N

	
N

	
N









Table 47-7 Role-Based System Administration Access in Oracle Service Bus Administration Console

	Actions	Integration Admin	Integration Deployer	Integration Operator	Integration Monitor
	
Import Resources

	
Y

	
Y

	
N

	
N


	
Export Resources

	
Y

	
Y

	
N

	
N


	
Create UDDI Registries

	
Y

	
Y

	
N

	
N


	
View UDDI Registries

	
Y

	
Y

	
Y

	
Y


	
Edit UDDI Registries

	
Y

	
Y

	
N

	
N


	
Delete UDDI Registries

	
Y

	
Y

	
N

	
N


	
Import from UDDI

	
Y

	
Y

	
N

	
N


	
Synchronize Auto-Import Status

	
Y

	
Y

	
Y

	
Y


	
Detach UDDI

	
Y

	
Y

	
N

	
N


	
Publish to UDDI

	
Y

	
Y

	
N

	
N


	
Auto-Publish Status

	
Y

	
Y

	
Y

	
Y


	
Publish Auto-Publish Status

	
Y

	
Y

	
N

	
N


	
Create JNDI Providers

	
Y

	
Y

	
N

	
N


	
View JNDI Providers

	
Y

	
Y

	
Y

	
Y


	
Edit JNDI Providers

	
Y

	
Y

	
N

	
N


	
Delete JNDI Providers

	
Y

	
Y

	
N

	
N


	
Create SMTP Servers

	
Y

	
Y

	
N

	
N


	
View SMTP Servers

	
Y

	
Y

	
Y

	
Y


	
Edit SMTP Servers

	
Y

	
Y

	
N

	
N


	
Delete SMTP Servers

	
Y

	
Y

	
N

	
N


	
Find Value (Customization)

	
Y

	
Y

	
N

	
N


	
Replace With (Customization)

	
Y

	
Y

	
N

	
N


	
Create File (Customization)

	
Y

	
Y

	
N

	
N


	
Select File (Customization)

	
Y

	
Y

	
N

	
N


	
Select Items (Customization)

	
Y

	
Y

	
N

	
N


	
Execute File (Customization)

	
Y

	
Y

	
N

	
N









Table 47-8 Role-Based Change Center Access in Oracle Service Bus Administration Console

	Actions	Integration Admin	Integration Deployer	Integration Operator	Integration Monitor
	
Edit Session

	
Y

	
Y

	
Y

	
N


	
View All Sessions

	
Y

	
Y

	
N

	
N


	
View Changes

	
Y

	
Y

	
Y

	
N


	
Activate Changes

	
Y

	
Y

	
Y

	
N


	
Discard Changes

	
Y

	
Y

	
Y

	
N


	
Exit Session

	
Y

	
Y

	
Y

	
N














47.2 Administrative Security Groups

To facilitate the process of assigning users to the pre-defined administrative roles, Oracle Service Bus also provides four corresponding security groups. While membership in a role is dynamic, membership in a group is static: an administrator places a user in a group and the user remains in the group until the administrator changes the assignment.

In the simplest scenario for configuring administrative security, you create a user, add the user to one of the four administrative groups, and the user is automatically always a member of the corresponding role with all of the pre-defined access privileges.

In a more complex scenario, you might create two of your own groups, MyAdministratorsEast and MyAdministratorsWest, and assign users appropriately. You configure the pre-defined IntegrationAdmin security role so that the MyAdministratorsWest group is in the role from 8am to 8pm EST, while the MyAdministratorsEast group is in the role from 8pm to 8am EST.

Table 47-9 describes the administrative groups that Oracle Service Bus provides. You can create your own groups in addition to these.


Table 47-9 Oracle Service Bus Groups

	By Default, This Group...	Is Always in This Role...
	
IntegrationAdministrators

	
IntegrationAdmin. See Table 47-1.


	
IntegrationDeployers

	
IntegrationDeployer. See Table 47-1.


	
IntegrationOperators

	
IntegrationOperator. See Table 47-1.


	
IntegrationMonitors

	
IntegrationMonitor. See Table 47-1.












47.3 Configuring Administrative Security: Main Steps

You can create or modify users, groups, and roles when you are in or out of an Oracle Service Bus session. Any additions or modifications to this data take effect immediately and are available to all sessions. If you discard a session in which you added or modified the data, the security data is not discarded.

To configure administrative security:

	
Log in to the Oracle Service Bus Administration Console with a user account that is in the Oracle WebLogic Server Admin role.


	
(Optional) Create your own security groups.

See "Adding Groups" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus.


	
Create users and assign them to one of the Oracle Service Bus groups or one of your own groups.

See "Adding Users" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus.


	
(Optional) Modify the conditions under which users and groups are in the pre-defined Oracle Service Bus security roles.

By default, the four default groups are always in the Oracle Service Bus security roles, but you can change this default. To more easily manage your list of users, Oracle recommends that you never add users directly to a role. Instead, add users to a group and add the group to the role.

See "Adding Roles" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus.
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This chapter describes how to use Security Assertion Markup Language (SAML) policies for exchanging authentication and authorization information between clients and services in Oracle Service Bus.

You can use SAML with either the WLS 9 policy framework or with Oracle Web Services Manager. Oracle recommends that you use Oracle Web Services Manager for service security, as described in Chapter 50, "Securing Oracle Service Bus with Oracle Web Services Manager."

For detailed instructions on setting up your environment to use SAML, see "Configuring SAML" in the Oracle Fusion Middleware Security and Administrator's Guide for Web Services and the SAML configuration topics in Oracle Fusion Middleware Securing Oracle WebLogic Server. The SAML configuration steps in those guides are a prerequisite to using SAML in Oracle Service Bus.

This chapter includes the following topics:

	
Section 53.1, "Mapping Identity to a SAML Token"


	
Section 53.2, "Configuring SAML Pass-Through Identity Propagation"


	
Section 53.3, "Authenticating SAML Tokens in Proxy Service Requests"


	
Section 53.4, "Configuring SAML Authentication with Service Bus (SB) Transport"


	
Section 53.5, "Using SAML Identity Switching"


	
Section 53.6, "Troubleshooting SAML with Oracle Service Bus"






53.1 Mapping Identity to a SAML Token

If your clients do not provide SAML tokens but your business services require them, you can configure a proxy service to map the client's identity to a SAML token.

This technique requires the business service to be a Web service with WS-Policy statements that require authentication using SAML tokens.

To configure SAML credential mapping:

	
Configure a proxy service to authenticate clients using any of the following techniques:

	
HTTP or HTTPS BASIC (client provides user name and password in the request)


	
HTTPS Client certificate


	
Message-level authentication (using any of the supported token profiles)

If a client request includes a WS-Security security header, you must configure the proxy service to process this header on the proxy service side of the message. In Oracle Service Bus, you cannot add a SAML header (or any other WS-Security header) to a SOAP envelope that already contains a WS-Security header, neither can you add SAML (or other) security tokens to an existing security header.


	
Third-party authentication




When the proxy service authenticates the user, the proxy automatically generates a Subject before forwarding the message to a business service.


	
Configure the business service to include a SAML client policy. The policy generates a SAML token for the authenticated user in the Subject.




For a list of Oracle Web Services Manager SAML policies supported with Oracle Service Bus, see Section 50.2.8, "Supported Seed Policies and Unsupported Assertions."




	
Note:

The procedure in this section assumes a proxy-to-business service invocation. When your use case involves proxy-to-proxy invocations prior to the business service invocation, it is helpful to understand how Oracle Service Bus handles security headers. For that information, see Section 31.5, "Using Oracle WSM Security with Local Proxies."














53.2 Configuring SAML Pass-Through Identity Propagation

If your clients provide SAML tokens to a pass-through proxy service, you can propagate the client's SAML token to the business service.

This technique requires the business service to be a Web service with policy statements that require authentication using SAML tokens.

To configure SAML pass-through identity propagation:

	
Proxy Service – Configure a pass-through proxy service as described in Section 52.3.2, "Creating a Pass-Through Proxy Service: Main Steps."


	
Business Service – Configure a SOAP-HTTP or SOAP-JMS business service with policy statements that require authentication using SAML tokens, as described in Section 52.4, "Configuring Business Service Message-Level Security: Main Steps."









53.3 Authenticating SAML Tokens in Proxy Service Requests

If your clients provide SAML tokens to an active intermediary proxy service, you can configure the proxy service to assert the client's identity.

To configure a proxy service to use SAML tokens to authenticate clients:

	
When configuring the identity assertion provider, note the following requirements:

	
The confirmation method from the policy must match the SAML profile in the SAML asserting party.


	
Specify the asserting party target URL to be the relative URL of the proxy service (omitting the protocol and host information).


	
For signed assertions, add the certificate to the Identity Asserter registry.





	
Create an active intermediary proxy service that communicates over the HTTP, HTTPS, or JMS protocol. The proxy service must be a Web service with a policy statement that requires authentication and accepts SAML tokens.

A proxy service that communicates over the "local" transport type cannot use a SAML token profile to authenticate.









53.4 Configuring SAML Authentication with Service Bus (SB) Transport

If you are using SAML-based authentication with the SB transport, follow these configuration requirements:

	
On the asserting party, configure the SAML Credential mapper with URI http://openuri.org/sb_proxy_uri, where sb_proxy_uri is the SB transport service URI.


	
When configuring the Identity Assertion provider on the Oracle Service Bus side (the relying party), use the asserting party target URL as the proxy endpoint URI. Do not include the protocol and host information. For example, /sb_proxy_uri.









53.5 Using SAML Identity Switching

Oracle Web Services Manager provides a wss11_saml_token_identity_switch_with_message_protection_client_policy that lets you perform identity switching. The policy, which you attach to a business service, propagates a different identity than the one based on the authenticated Subject from the proxy service. For more information about the policy, see "Configuring SAML Web Service Clients for Identity Switching" in the Oracle Fusion Middleware Security and Administrator's Guide for Web Services.

If you set the policy property subject.precedence = false and provide a credential store format (CSF) key for the identity you want to switch to, the business service ignores the current subject and creates a SAML token with the credentials in the csf-key.

If you set subject.precedence = true, the current subject is used to create the SAML token. However, if the subject is anonymous, Oracle Web Services Manager attempts to use the csf-key to perform the identity switching.

For information on working with CSF, see "Overview of Application Development with CSF" in Oracle Fusion Middleware Application Security Guide.



53.5.1 Protecting the Identity-Switching Resource

To prevent malicious access to the identity-switching functionality, you must grant special permissions to the resources that perform identity switching. For example, in Oracle Service Bus, you give permissions to the project containing the identity-switching business service.

Use the Oracle Enterprise Manager Fusion Middleware Control to give the Oracle Service Bus project the proper permissions, as described in "Set the WSIdentityPermission Permission" in the Oracle Fusion Middleware Security and Administrator's Guide for Web Services. Using that topic for guidance, enter the following information in the permissions fields:

	
Permission Class – oracle.wsm.security.WSIdentityPermission


	
Resource Name – Name (not the path) of the Oracle Service Bus project containing the business service


	
Permission Actions – assert











53.6 Troubleshooting SAML with Oracle Service Bus

Question: I am trying to propagate my proxy service transport identity to a destination business service and keep receiving error, Unable to add security token for identity. What does this mean?

Answer: There are various causes for this error. Generally this means one of the following problems:

	
The SAML Credential Mapper is not configured correctly. Double check that the configuration is in accordance with the instructions in "Configuring SAML" in the Oracle Fusion Middleware Security and Administrator's Guide for Web Services.


	
Another common source of this error is that there is no subject information to propagate. To generate a SAML token, you must have a transport-level or message-level subject. Make sure that the client has a subject. This can be done by inspecting the $security message context variable.




Question: I am trying to propagate my proxy service transport identity to a destination business service using SAML holder-of-key and keep receiving error, Failure to add signature. What does this mean?

Answer: There are various causes for this error, but most likely is that the credentials are not configured for the business service's service key provider. When Oracle Service Bus generates an outbound holder-of-key assertion, it also generates a digital signature over the message contents, so that the recipient can verify not only that a message is received from a particular user but that the message has not been tampered with. To generate the signature, the business service must have a service key provider with a digital signature credential associated with it.

Question: I am trying to configure an active intermediary proxy service that receives SAML identity tokens and keep receiving errors that look like: The SAML token is not valid. How do I fix this?

Answer: This is generally caused by a missing SAML Identity Asserter or SAML Identity Asserter asserting party configuration for the proxy service. For a proxy service to receive SAML assertions in active intermediary mode, it must have a SAML Identity Asserter configured. For more details, see "Configuring a SAML Identity Assertion Provider" in Oracle Fusion Middleware Securing Oracle WebLogic Server.







Configuring Custom Authentication





54 Configuring Custom Authentication


This chapter describes how to configure custom transport- and message-level authentication in Oracle Service Bus.

Oracle Service Bus supports client-specified custom authentication credentials for both transport- and message-level proxy service requests. The custom authentication credentials can be in the form of tokens, or a username and password token combination.

Oracle Service Bus accepts and attempts to authenticate a custom token passed to a proxy service in an HTTP header, SOAP header (for SOAP-based proxy services) or in the payload (for non-SOAP proxy services). You use the proxy service configuration wizard to configure the proxy service with the mechanism by which the token is passed, and the token type.

Oracle Service Bus also accepts and attempts to authenticate a username and password token passed in a SOAP header (for SOAP based proxy services), or in the payload for non-SOAP proxy services. You use the proxy service configuration wizard to configure the proxy service with the mechanism by which the username and password are passed.




	
Note:

The custom authentication mechanisms work alone or in concert with the message-level security for Web services described in Chapter 52, "Configuring Message-Level Security for Web Services." See Section 54.9, "Combining WS-Security with Custom Username/Password and Tokens" for information about using both types of security.









The following custom authentication mechanisms are supported:

	
Transport-Level Security

	
Custom token in an HTTP header





	
Message-Level Security

	
For SOAP-based proxy services

	
Custom token in a SOAP header


	
Username/password in a SOAP header





	
For non-SOAP-based proxy services

	
Custom token in the payload of any XML-based proxy services


	
Username/password in the payload of any XML-based proxy services










This chapter includes the following sections:

	
Section 54.1, "What Are Custom Authentication Tokens?"


	
Section 54.1.1, "Custom Authentication Token Use and Deployment"


	
Section 54.2, "Understanding Transport-Level Custom Authentication"


	
Section 54.3, "Understanding Message-Level Custom Authentication"


	
Section 54.5, "Configuring Identity Assertion Providers for Custom Tokens"


	
Section 54.6, "Configuring Custom Authentication Transport-Level Security"


	
Section 54.7, "Configuring Custom Authentication Message-Level Security"


	
Section 54.8, "Propagating the Identity Obtained From Custom Authentication Tokens"


	
Section 54.9, "Combining WS-Security with Custom Username/Password and Tokens"






54.1 What Are Custom Authentication Tokens?

An authentication token is some data, represented as a string or XML, that identifies an entity (user or process), such as an X509 client certificate. Typically, authentication tokens are designed to be used within specific security protocols. Some authentication tokens are cryptographically protected and some are not. Some authentication tokens carry key material.

In the context of Oracle Service Bus, a custom authentication token can be a username/password or an opaque identity assertion token in a user-defined location in the request. A username/password token is allowed in a SOAP header (for SOAP-based services) or in the payload of some non-SOAP proxy service. An identity assertion token is allowed in an HTTP header, in a SOAP header (for SOAP-based services), or in the payload of some non-SOAP proxy services. The Oracle Service Bus domain must include an Identity Assertion provider that supports the token type.

Oracle Service Bus uses the authenticated user to establish a security context for the client. The security context established by authenticating a custom token or username and password can be used as the basis for outbound credential mapping and access control.

To authenticate and authorize clients who supply tokens for authentication, you must configure an Identity Assertion provider that maps the client's credential to an Oracle Service Bus user. Oracle Service Bus uses this resulting username to establish a security context for the client.



54.1.1 Custom Authentication Token Use and Deployment

The addition of custom authentication token support in Oracle Service Bus addresses two customer needs. In the first scenario, a proxy service request has a username/password somewhere in the message payload, for example in a SOAP header. Oracle Service Bus must get this username/password and authenticate the user.

In the second scenario, the message contains some kind of authentication token (other than username/password), such as a secure-token-xyz token. The token may be in an HTTP header or in the message payload. Oracle Service Bus must get the token and authenticate it. In either case, a security context is established if authentication succeeds.

Most security-related configuration is typically done at deployment time, and custom authentication fits that model: it can be configured directly on the production environment at deployment time. Alternatively, you can configure authentication during staging and import it into the production environment.

Custom authentication, which includes both username/password tokens and custom tokens, is an integral part of the proxy service definition. When a proxy service is exported, any configuration of custom tokens is included in the jar file. When a new version of the proxy service is imported, the previous configuration is overwritten with whatever configuration is contained in the jar file.

Only users in the IntegrationDeployer or IntegrationAdministrator roles can configure custom token authentication. Users in the IntegrationOperator or IntegrationMonitor roles have read-only access to this configuration.








54.2 Understanding Transport-Level Custom Authentication

You can authenticate client requests at the transport-level through custom authentication tokens. You specify a custom token in an HTTP header. The HTTP (and HTTPS) configuration page of the service definition wizard lets you configure client authentication. The options for HTTP and HTTPS proxy services are:

	
None


	
Basic


	
Custom Authentication


	
Client Certificate (HTTPS Only)




These are mutually exclusive options.

If you choose custom authentication, you must also specify the name of the HTTP header that is to carry the token, and the token type.

The steps for configuring transport-level custom credentials are described in Section 2.3, "Working with Proxy Services."

The custom authentication token can be any active token type, previously configured for an Identity Assertion provider, that is carried in an HTTP header.

You need to configure, or create and configure, an Identity Assertion provider that handles the token type you plan to use. See Section 54.5, "Configuring Identity Assertion Providers for Custom Tokens."

After you have configured the transport-level custom credentials, you can then additionally configure the message level security configuration, as described in Chapter 52, "Configuring Message-Level Security for Web Services."



54.2.1 Importing and Exporting and Transport-Level Custom Token Authentication

Transport-level custom authentication tokens are published to the UDDI. The client-auth property is present in the instanceParms of the HTTP or HTTPS transport attributes whenever authentication is configured. As described in "Transport Attributes" in the Oracle Fusion Middleware Administrator's Guide for Oracle Service Bus, the possible values of client-auth are BASIC, CLIENT-CERT and CUSTOM-TOKEN. Whenever the value is CUSTOM-TOKEN, two additional properties are present: token-header and token-type.




	
Note:

Oracle Service Bus business service definitions do not support custom token authentication. If you import a service from UDDI that has client-auth equal to CUSTOM-TOKEN, the service is imported as if it does not have any authentication configuration.
















54.3 Understanding Message-Level Custom Authentication

Oracle Service Bus supports client-specified custom authentication credentials for proxy service message-level requests. The custom authentication credentials can be in the form of a custom token, or a username and password.

Oracle Service Bus accepts and attempts to authenticate a custom token passed to a proxy service in a SOAP header (for SOAP-based proxy services), or in the payload (for non-SOAP proxy services). You use the proxy service configuration wizard to configure the proxy service with the mechanism by which the token is passed, and the token type.

Oracle Service Bus also accepts and attempts to authenticate a username and password token passed in a SOAP header (for SOAP based proxy services), or in the payload for non-SOAP proxy services. You use the proxy service configuration wizard to configure the proxy service with the mechanism by which the username and password are passed.

The following proxy service message-level authentication mechanisms are now supported:

	
For SOAP-based proxy services

	
Custom token in a SOAP header


	
Username/password in a SOAP header





	
For non-SOAP-based proxy services

	
Custom token in the payload of any XML-based proxy services


	
Username/password in the payload of any XML-based proxy services







Message-level custom tokens and message-level username and password are supported on proxy services of the following binding types:

	
WSDL-SOAP


	
WSDL-XML


	
Abstract SOAP


	
Abstract XML


	
Mixed – XML (in the request)


	
Mixed – MFL (in the request)









54.4 Format of XPath Expressions

The configuration for both custom username/password and custom token is similar. In both cases, you specify XPath expressions that enable Oracle Service Bus to locate the necessary information. The root of these XPath expressions is as follows:

	
Use soap-env:Envelope/soap-env:Header if the service binding is anySOAP or WSDL-SOAP.


	
Use soap-env:Body (specifically, the contents of the $body variable) if the service binding is not SOAP based.




	
Note:

All XPath expressions must be in a valid XPath 2.0 format. The XPath expressions must use the XPath "declare namespace" syntax to declare any namespaces used, as follows:


declare namespace ns='http://webservices.example.com/MyExampleService';


For example,


declare namespace y="http://foo";./y:my-custom-token/text()

















54.5 Configuring Identity Assertion Providers for Custom Tokens

An Identity Assertion provider is a specific form of Authentication provider that allows users or system processes to assert their identity using tokens. A client's identity is established through the use of client-supplied tokens. The Identity Assertion provider validates the token. If the token is successfully validated, the Identity Assertion provider maps the token to an Oracle Service Bus username, and returns the username. Identity is said to be "asserted" when the token is mapped to the username. Oracle Service Bus then uses this user name to establish a security context for the client.

If you want the proxy service to consume a custom token, check the provided Oracle WebLogic Server Identity Assertion providers to see if one meets your needs. Oracle WebLogic Server includes a broad array of Identity Assertion providers, including the following:

	
The WebLogic Identity Assertion provider validates X.509 and IIOP-CSIv2 tokens and optionally can use a user name mapper to map that token to a user.


	
The SAML Identity Assertion provider, which acts as a consumer of SAML security assertions.




If you want the Oracle Service Bus proxy service to consume a custom token that is not handled by one of the bundled Identity Assertion providers, for example a secure-token-xyz token, you (or a third-party) must first write an Oracle WebLogic Server Identity Assertion provider that supports the token type and use the Oracle WebLogic Server Administration Console to add that provider to the security realm.

You develop Identity Assertion providers to support the specific types of custom tokens that you will be using to assert the identities of users. You can develop an Identity Assertion provider to support multiple token types. While you can have multiple Identity Assertion providers in a security realm with the ability to validate the same token type, only one Identity Assertion provider can actually perform this validation.

The Identity Assertion process is shown in Figure 54-1, and works as follows:

	
The proxy service gets the authentication token from the inbound request.


	
The token is passed to an Identity Assertion provider that is responsible for validating tokens of that type and that is configured as "active."


	
The Identity Assertion provider validates the token.


	
If the token is successfully validated, the Identity Assertion provider maps the token to a username, and returns the username.


	
Oracle Service Bus then continues the authentication process with this username and, if successful, obtains the authenticated subject.


	
Oracle Service Bus creates the security context. The security context established by authenticating a custom token or username and password can be used as the basis for outbound credential mapping and access control.




See "Identity Assertion and Tokens" in Oracle Fusion Middleware Understanding Security for Oracle WebLogic Server for additional information.


Figure 54-1 Identity Assertion and Custom Tokens

[image: Description of Figure 54-1 follows]







54.5.1 Object Type of Custom Tokens

For transport-level identity assertion, the header value is passed as a java.lang.String to the identity assertion providers. For message-level identity assertion, the XPath expression is evaluated as follows:

	
If the XPath expression returns multiple nodes, an error is raised and identity assertion is not called.


	
If the XPath expression returns an empty result, identity assertion is called with a null argument.


	
If the XPath expression returns a single token of type TEXT or ATTR (See XmlCursor.TokenType at http://xmlbeans.apache.org/docs/2.0.0/reference/org/apache/xmlbeans/XmlCursor.TokenType.html), the string value of the text node or attribute is passed (as returned by XmlCursor.getStringValue()). Otherwise, a single XmlObject is passed.









54.5.2 Configuring a Custom Token Type in an Identity Assertion Provider

The steps required to complete these tasks are described in detail in the following Oracle WebLogic Server documents:

	
"How to Create New Token Types" in Oracle Fusion Middleware Developing Security Providers for Oracle WebLogic Server describes how to create custom token types for an Identity Assertion provider.


	
Oracle Fusion Middleware Developing Security Providers for Oracle WebLogic Server describes how to configure identity assertion providers in the Oracle WebLogic Server Administration Console.




For your convenience, the steps for creating custom token types for an Identity Assertion provider and configuring that provider in the Oracle WebLogic Server Administration Console are briefly listed here. However, you will need to consult the Oracle WebLogic Server documentation to actually complete the tasks.



54.5.2.1 Steps for Configuring a Custom Token Type in an Identity Assertion Provider

You can develop a custom Identity Assertion provider by following these steps:

	
Create the new token types. See "How to Create New Token Types" in Oracle Fusion Middleware Developing Security Providers for Oracle WebLogic Server.


	
"Create Runtime Classes Using the Appropriate SSPIs," described in Oracle Fusion Middleware Developing Security Providers for Oracle WebLogic Server. That section shows the SampleIdentityAsserterProviderImpl.java class, which is the runtime class for the sample Identity Assertion provider.


	
"Generate an MBean Type Using the WebLogic MBeanMaker," described in Oracle Fusion Middleware Developing Security Providers for Oracle WebLogic Server.


	
"Configure the Custom Identity Assertion Provider Using the Administration Console," described in Oracle Fusion Middleware Developing Security Providers for Oracle WebLogic Server.


	
Define the active token type. For this task, see "Configuring Identity Assertion Providers" in Oracle Fusion Middleware Securing Oracle WebLogic Server and "How to Make New Token Types Available for Identity Assertion Provider Configurations" in Oracle Fusion Middleware Developing Security Providers for Oracle WebLogic Server.









54.5.2.2 Setting the Supported and Active Types in the MBean

When you configure a custom Identity Assertion provider, the Supported Types field displays a list of the token types that the Identity Assertion provider supports. You enter zero or more of the supported types in the Active Types field.

The content for the Supported Types field is obtained from the SupportedTypes attribute of the MBean Definition File (MDF), which you use to generate your custom Identity Assertion provider's MBean type. An example from the sample Identity Assertion provider is shown in Example 54-1. For more information about MDFs and MBean types, see "Generate an MBean Type Using the WebLogic MBeanMaker" in Oracle Fusion Middleware Developing Security Providers for Oracle WebLogic Server.


Example 54-1 SampleIdentityAsserter MDF: SupportedTypes Attribute


<MBeanType>
...   
<MBeanAttribute 
Name = "SupportedTypes" 
Type = "java.lang.String[]"
Writeable = "false"
Default = "new String[] {&quot;SamplePerimeterAtnToken&quot;}"
/>
...
</MBeanType>


Similarly, the content for the Active Types field is obtained from the ActiveTypes attribute of the MBean Definition File (MDF). You can default the ActiveTypes attribute in the MDF so that it does not have to be set manually with the Oracle WebLogic Server Administration Console. An example from the sample Identity Assertion provider is shown in Example 54-2.





Example 54-2 SampleIdentityAsserter MDF: ActiveTypes Attribute with Default


<MBeanAttribute
Name= "ActiveTypes"
Type= "java.lang.String[]"
Default = "new String[] { &quot;SamplePerimeterAtnToken&quot; }"
/>


While defaulting the ActiveTypes attribute is convenient, you should only do this if no other Identity Assertion provider will ever validate that token type. Otherwise, it would be easy to configure an invalid security realm (where more than one Identity Assertion provider attempts to validate the same token type). Best practice dictates that all MDFs for Identity Assertion providers turn off the token type by default; then an administrator can manually make the token type active by configuring the Identity Assertion provider that validates it.












54.6 Configuring Custom Authentication Transport-Level Security

You ultimately configure custom authentication for transport-level security. However, before you get to this step of the process, you must first configure, or potentially create and configure, an Identity Assertion provider that understands the token type you plan to use.

The steps required to complete these tasks are described in detail in the following Oracle WebLogic Server documents:

	
If one of the bundled Identity Assertion providers meets your needs, see "Configure Identity Assertion Providers" in Oracle Fusion Middleware Securing Oracle WebLogic Server for instructions on how to configure this Identity Assertion provider in the Oracle WebLogic Server Administration Console.


	
Oracle Fusion Middleware Developing Security Providers for Oracle WebLogic Server describes how to create custom token types for an Identity Assertion provider.


	
"Configuring Identity Assertion Providers" in Oracle Fusion Middleware Securing Oracle WebLogic Server describes how to configure identity assertion providers in the Oracle WebLogic Server Administration Console.






54.6.1 Steps for Configuring Custom Authentication Transport-Level Security

The steps for configuring custom authentication transport-level security are as follows:

	
Determine which custom token format you will be using.


	
Determine if an existing provider meets your needs. "Choosing an Authentication Provider" in Oracle Fusion Middleware Securing Oracle WebLogic Server offers guidance on this task.


	
Configure, or create and configure, an Identity Assertion provider that supports the token format.


	
The Identity Assertion provider maps the token to a username. Add the client's username to the Oracle Service Bus Security Configuration module.


	
On the protocol-dependent transport configuration page, specify the Authentication Header where Oracle Service Bus is to find the token and the Authentication Token Type. Only those token types that are currently active for a configured Identity Assertion provider are displayed.











54.7 Configuring Custom Authentication Message-Level Security

You ultimately configure custom authentication message-level security. However, before you get to this step of the process, you must first configure, or potentially create and configure, an Authentication provider or Identity Assertion provider that understands the token type you plan to use.

The steps required to complete these tasks are described in detail in the following Oracle WebLogic Server documents:

	
If one of the bundled Authentication or Identity Assertion providers meets your needs, see "Configuring Authentication Providers" in Oracle Fusion Middleware Securing Oracle WebLogic Server for instructions on how to configure this Authentication provider in the Oracle WebLogic Server Administration Console.


	
"How to Create New Token Types" in Oracle Fusion Middleware Developing Security Providers for Oracle WebLogic Server describes how to create custom token types for an identity assertion provider.


	
"Configuring Identity Assertion Providers" in Oracle Fusion Middleware Securing Oracle WebLogic Server describes how to configure identity assertion providers in the Oracle WebLogic Server Administration Console.






54.7.1 Steps for Configuring Custom Authentication Message-Level Security

The steps for configuring custom authentication message-level security are as follows:

	
Determine which custom username/password or token format you will be using.


	
Determine if an existing provider meets your needs. "Choosing an Authentication Provider" in Oracle Fusion Middleware Securing Oracle WebLogic Server offers guidance on this task.

If you specify any Context Properties you will probably need to create your own provider because the provider must know which property names to expect.


	
Configure, or create and configure, an authentication provider or identity assertion provider that supports the username/password or token format, respectively. This provider must also understand any Context Properties that you want to provide.


	
Add the client's user name to the Oracle Service Bus Security Configuration module.


	
On the Security page, configure a new or existing proxy service for the User Name XPath, User Password XPath, or Token Type and Token Path, as appropriate.


	
Specify the Property Name and Value Selector of any Context Properties that you want to provide.











54.8 Propagating the Identity Obtained From Custom Authentication Tokens

The security context established through a custom token or custom username/password is in no way unique, and you can use it for credential mapping. If you implement both transport-level authentication and message-level authentication, the message-level security context is always used for credential mapping and identity propagation.

For example, if the proxy service authenticates the client through a secure-token-xyz token in a SOAP header, the authenticated subject is used during any mapped service account lookup. The subject is also used when generating SAML tokens on outbound messages. Java callouts can also run under the authentication context associated with a custom token or custom username/password.

If a custom username/password is used, the username/password in the custom token can be used for outbound HTTP BASIC or outbound WS-Security Username Token authentication if a pass-through service account is used.






54.9 Combining WS-Security with Custom Username/Password and Tokens

You can secure Oracle Service Bus proxy services with either transport-level security (for example, HTTPS) and message-level security (for example, WS-Security and custom tokens), or a combination of both. That is, you can configure an Oracle Service Bus proxy service with both transport-level authentication and message-level authentication.

For example, client requests can be authenticated at the transport level with custom tokens in HTTP headers, and at the message level with WSS security tokens, custom tokens, or username/passwords, except in the Web Services Security header.

However, note the following restriction: Although it is possible to combine WS-Security and message-level custom tokens, the WS-Security policy must not require proxy service authentication based on WS-Security tokens. Message-level custom tokens and WS-Security proxy service authentication are mutually exclusive.

Consider the following distinction:

	
It is allowable to configure a proxy service that expects a custom token of type MyToken in SOAP header <foo:MyToken> and that has a WS-Security policy that requires signing or encryption of some message parts (for example, the <foo:MyToken> header and SOAP body).


	
It is not allowable to configure a proxy service that requires a custom token in header <foo:MyToken> and that also has a WS-Security policy that requires a SAML token or any other form of authentication.
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